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Chapter 1 Introduction

Tecplot is a powerful tool for visualizing a wide range of technical data. It offers line plotting, 2D 
and 3D surface plots in a variety of formats, and 3D volumetric visualization.

The user documentation for Tecplot is divided into 6 books:

Getting Started Manual
User’s Manual (this document)
Reference Manual
Quick Reference Guide
Data Format Guide
Add-on Developer’s Kit - User’s Manual
Add-on Developer’s Kit - Getting Results
Add-on Developer’s Kit - Reference Manual
Installation Instructions
Release Notes

The Getting Started Manual is intended for beginning Tecplot users. It provides a brief overview of 
the capabilities of Tecplot, as well as a series of tutorials.   The Add-on Developer’s Kit manuals 
and Macro Programming Manual are recommended for advanced Tecplot users.

1 - 1 Start-Up

Windows
By default, Tecplot is installed in your Program Files directory at: C:\Program Files\Tec-
plot\Tec360. A shortcut is placed in a Tecplot 360 folder in the Start Menu. For detailed informa-
tion, please refer to “Windows Installation” in the Installation Guide.

UNIX
On UNIX systems, run Tecplot by typing:

 tecplot
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at the shell prompt.

Set your TEC360HOME environment variable to point to it the absolute path of the Tecplot direc-
tory. For detailed installation information, please refer to the Installation Guide.

1 - 2 Interface
The Tecplot interface is divided into 5 major sections:

Status Line

Sidebar

Menubar Toolbar

Tecplot Workspace

1- 2.1 Menubar
The menu bar offers rapid access to most of Tecplot’s features.

Tecplot’s features are organized into the following menus:
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• File - Use the File menu to read or write data files and plot layouts, print and 
export plots, record and play macros, set configuration preferences.

• Edit - Use the Edit menu to undo, cut, copy, paste, and clear objects, as well as 
change the draw order for selected items (push or pop).

• View - Use the View menu to manipulate the point of view of your data, 
including scale, view range, and 3D rotation. You can also use the View menu 
to copy and paste views between frames. 

The View menu includes sizing options for convenience. Center moves the plot 
image so that the data points are centered within the frame. (Only the data is 
centered; text, geometries, and the 3D axes are not considered.) Fit to Full Size
fits the entire plot into the frame. Nice Fit to Full Size sets the axis range to begin 
and end on major axis increments (if axes are dependent Tecplot adjusts the ver-
tical axis length to accommodate a major tick mark). Make Current View Nice
modifies the range on a specified axis to fit the minimum and maximum of the 
variable assigned to that axis, then snaps the major tick marks to the ends of the 
axis. (If axis dependency is not independent this may affect the range on another 
axis.) Data Fit fits the data points to the frame.

• Plot - Use the Plot menu to control the style of your plots. The menu items 
available are dependent upon the active plot type (selected from the sidebar).

• Insert - Use the Insert menu to add text, geometries (polylines, circles, 
squares, ellipses, and rectangles), or image files.

• Animate - Use the Animate menu to animate: IJK Planes, IJK Blanking, Iso-
surfaces, mappings, slices, streamtraces, time and zones.

• Data - Use the Data menu to create, manipulate, and examine data. Types of 
data manipulation available in Tecplot include zone creation, interpolation, tri-
angulation, as well as creation or alteration of variables.

Cut, Copy, and Paste work only within Tecplot. To 
place a graphics image of your layout into another 
program, use Copy Plot to Clipboard (in Windows 
and Macintosh only)
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• Frame - Use the Frame menu to create, edit, and control frames.

• Options - Use the Options menu to control the attributes of your workspace, 
including the color map, paper grid, display options, and rulers.

• Tools - Use the Tools menu to launch the or an add-on

• Analyze - Use the Analyze menu to examine grid quality, perform integrations, 
generate particle paths, extract flow features, and estimate numerical errors.

• Help - Use the Help menu to get quick help on features. By selecting About 
Tecplot you can obtain specific information about your license.

1- 2.2 Sidebar
The sidebar provides easy access for frequently used plot controls. The functions available in the 
Sidebar are dependent upon the plot type of the active frame. For 2D or 3D Cartesian plot types, 
you can add or subtract zone layers, zone effects and derived objects from your plot using the Side-
bar. For line plots (XY and polar) you can add or subtract mapping layers using the Sidebar. 

To customize your plot, simply:

• Select the desired Plot Types

• Use the toggle switches to add and subtract Zone Layers/Map Layers, Zone 
Effects, or Derived Objects. Use the Zone Style/Mapping Style dialogs to fur-
ther customize your plot by adding or subtracting zones from specific plot lay-
ers/mappings, changing the way a zone or group of zones is displayed or 
changing various plot settings.



Plot Types Menu

Zone Layers/Map Layers

Zone Effects
(3D Only)

Figure 1-1. The Tecplot sidebar for a field 
plot (left) and a line plot (right).   
The features available in the 
Sidebar are dependent upon the 
plot type. For 3D Cartesian 
plots, you may add and subtract 
zone layers, derived objects and 
effects for your plot. You may 
also use the Placement Plane for 
positioning some 3D objects 
(3D plots only). For 2D 
Cartesian plots (not shown), you 
may add and subtract zone 
layers and some derived objects 
for your plot. For field plots (3D 
or 2D), you may animate 
transient data directly from the 
Sidebar. For Line plots you may 
add and subtract map layers. 
NOTE: XY Line plots have 
more available map layers than 
polar line plots.

Derived Objects
(Iso-surfaces 
are 3D Only)

Placement 
Plane 

Placement Plane 

(3D Only)
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Plot Types
The Plot type, combined with a frame’s data set, active layers and their associated attributes, define 
a plot. Each plot type represents one view of the data. There are five plot types are available:

• 3D Cartesian - 3D plots of surfaces and volumes.

• 2D Cartesian - 2D plots of surfaces, where the vertical and horizontal axis are 
both dependent variables (i.e. x = f(A) and y = f(A), where A is another vari-
able). 

• XY Line - line plots of independent and dependent variables on a Cartesian 
grid. Typically the horizontal axis (x) is the independent variable and the y-axis 
a dependent variable, y = f(x).

• Polar Line - line plots of independent and dependent variables on a polar grid.

• S (Sketch) - Create plots without data such as drawings, flow charts, and view-
graphs.

Zone Layers/Map Layers
A layer is a way of representing a frame’s data set. The complete plot is the sum of all the active 
layers, axes, text, geometries, and other elements added to the data plotted in the layers. There are 
six zone layers for 2D and 3D Cartesian, four map layers for XY Line, two for Polar Line, and none 
for Sketch.

The six zone layers for 2D and 3D Cartesian plot types are:

•  Mesh - A grid of lines connecting the data points within each zone.

•  Contour- Iso-valued lines, the region between these lines can be set to contour 
flooding.

•  Vector - The direction and magnitude of vector quantities.

•  Scatter - Symbols at the location of each data point.

•  Shade - Used to tint each zone with a solid color, or to add light-source shading to a 
3D surface plot. Used in conjunction with the Lighting zone effect you may set Pan-
eled or Gouraud shading. Used in conjunction with the Translucency zone effect you 
may create a translucent surface for your plot.

•  Edge - Zone edges and creases for ordered data and creases for finite-element data.
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The four XY Line map layers are:

•  Lines - Plots a pair of variables, X and Y, as a set of line segments or a fitted curve.

•  Symbols - A pair of variables, X and Y, as individual data points represented by a 
symbol you specify.

•  Bars - A pair of variables, X and Y, as a horizontal or vertical bar chart.

•  Error Bars - Allows you to add error bars to your plot.

The two map layers for Polar Line are:

•  Lines - A pair of variables, X and Y, as a set of line segments or a fitted curve.

•  Symbols - A pair of variables, e.g. X and Y, as individual data points represented by 
a symbol you specify.

Zone Effects
For 3D Cartesian plot types, use the Sidebar to turn lighting and translucency on or off. Only 
shaded and flooded contour surface plot types are affected.

Derived Objects
For Cartesian plot types (2D and 3D): Toggle-on Iso-surfaces, Slices or Streamtraces from the Side-

bar. Their corresponding Details dialogs can be accessed via the browse button.

Placement Plane
When you are using certain tools to add objects to your plot, toggle-
on Use Placement Plane in the Sidebar to place them along a given 
plane (3D Plots only). Use the X,Y and Z buttons to select the plane 
to use and use the slider to reposition the placement plane. The 
placement plane will appear as a gray slice in your plot.   The Place-
ment Plane is available for:

• Placing streamtraces (using the Add Streamtrace Tool )

• Placing slices (using the Slice Tool )
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• Adding Contour Levels (using the Add Contour Level Tool )

• Deleting Contour Levels (using the Remove Contour Level Tool )

• Probing (using the Probing tool )

Snap Modes
Allow you to place objects precisely by locking them to the nearest reference point, either on the 
axis grid or on the workspace paper.

• Snap to Grid - constrain object movement to whole steps on the axis grid. 
This can be useful for aligning text and geometries with specific plot features.

• Snap to Paper - constrain object movement to whole steps on the paper's 
ruler grid. This can be useful for positioning frames precisely for printing, or 
for absolute positioning of text, geometries, and other plot elements.

Details Button
The Details button is located immediately below the snap modes. It is context sensitive.  Use this 
button to call up the dialog most directly applicable to your current action. When the currently 

selected tool is either the Selector  or the Adjustor , but no objects are selected in the 

workspace, the Details button is labeled Quick Edit.

Redraw Buttons
The redraw buttons allow you to keep your plot up to date: Redraw All (CTRL+D) redraws all 
frames (Shift-Redraw All causes Tecplot to completely regenerate the workspace); Redraw 
(CTRL+R) redraws only the current frame.
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Sidebar - Auto Redraw
Use Auto Redraw - When selected, Tecplot will automatically redraw the plot whenever style or 
data changes. Some users prefer to turn this option off while setting multiple style settings and then 
manually pressing Tecplot's Redraw or Redraw All button on the sidebar to see a full plot. 

Sidebar - Cache Graphics
Tecplot uses OpenGL to render plots. OpenGL provides for the ability to cache graphic instructions 
for rendering and can re-render the cached graphics much faster than having Tecplot send the 
instructions again. This is particularly true for interactive manipulation of a plot. However this per-
formance potential comes at the cost of using more memory. If the memory need is too high the 
overall performance could be less. Tecplot has three graphics cache modes: cache all graphics, 
cache only lightweight graphics objects, and do not cache graphics.

When Cache Graphics is selected in the Sidebar, Tecplot assumes there is enough memory to gener-
ate the graphics cache. Assuming this is true Tecplot's rendering performance will be optimal for 
interactive manipulation of plots.

When memory constraints are very limited consider toggling-off Cache Graphics. If you intend on 
interacting with the plot also consider setting the “Plot Approximation” mode set to “All Frames 
Always Approximated”.

See “Graphics Cache” on page 549 for more information.

Sidebar - Plot Approximations
When Plot Approximation is selected, and if the number of data points is above the point threshold, 
(see below) Tecplot will render the approximate plot for style, data, and interactive view changes 
followed immediately by the full plot. This option provides for good interactive performance with 
the final plot always displayed in the full representation.

See  “Plot Approximation” on page 548 for more information.

1- 2.3 Toolbar
Each of the tools represented in the toolbar changes the mouse mode and allows you to 

NOTE: Even if Tecplot is in the middle of an 
auto-redraw, it can be interrupted with a 
mouse click or key press.
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interactively edit your plot.

Selector Tool

- Use the Selector tool to select objects in your workspace. The selected objects can be mod-

ified using the Quick Edit Dialog and (in some cases) the Selector tool itself.

The following objects can be moved (translated) using the Selector tool:

•  frames

•  axis grid area

•  text

•  geometries

•  contour labels

•  streamtraces

•  streamtrace termination line

•  legends

•  3D frame axis

To select an object and open that object's attributes dialog either double-click on any object, or drag 
the cursor to select groups of objects (calls up Group Select dialog). Click OK, then Object Details.

Adjustor Tool

Use the Adjustor tool to perform the any of following modifications to your plot and data:

•  Location of individual or groups of data points in the grid.

Double-click on a tool to launch the Details
dialog associated with the tool.
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•  Values of the data set variables at a particular point.

•  Length or placement of individual axes (2D Cartesian and XY Line plot types 
only).

•  Spacing between an axis label and its associated axis (2D Cartesian and XY Line 
plot types only).

•  Shape of a polyline.

For all other scenarios, the behavior of the Adjustor mode is identical to that of the Selector tool.

To select multiple points - you can either Shift-click after selecting your initial point to select addi-
tional points, or you can draw a group select band to select the points within the band. (In line plots, 
you can select points from only one mapping at a time.)

Once you have selected all desired points, move the Adjustor over the selection handles of one of 
the points, then click-and-drag to the desired location of the first data point. The other selected 
points will move as a unit with with respect to the chosen data point, maintaining their relative 
positions.

Group Select
The Group Select dialog is opened when you select a group of objects with the Selector or Adjustor 
tools.

The Group Select dialog allows you to specify the following object types (if the selection rectangle 
does not include a specific object, its associated check box is inactive):

The Adjustor tool can alter your data. Be 
sure you want to use the Adjustor tool 
before dragging points in the data region

For XY Line plots, if several mappings are using the same 
data for one of the variables, adjusting one of the mappings 
will result in simultaneous adjustments to the others. You can 
avoid this by pressing the H or V keys on your keyboard while 

adjusting the selected point. The H and V keys restrict the adjustment to the 
horizontal and vertical directions, respectively.
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•  Text.

•  Geometries.

•  Frames.

•  Zones.

•  Axis Grid Area.

•  Contour Labels.

•  Streamtraces.

The Group Select dialog offers the following attribute filters:

•  Geoms of Type - Choose geometries of a particular type from the drop-down 
menu.

•  Geoms with Line Pattern - Choose all geometries having a particular line pattern.

•  Text with Font - Choose all text displayed in a particular font. 

•  Objects with Color - Choose all objects of a particular color. You choose the 
appropriate color from the Select Color dialog.

Zoom Tool

Zoom into or away from the plot.

When a mouse-click occurs (without dragging) the zooming is centered at the location of your 
click.

There are two zoom modes – plot zooming and paper zooming.

For plot zooming, drag the magnifying glass cursor to draw a box about the region that you want to 
fit into the frame. The box may be larger than the frame. Making the box larger than the frame 
zooms away from the plot.The region within the view box will be resized to fit into the frame.

If Snap to Grid (located in the Sidebar) is 
selected, you cannot make the zoom box larger 
than the grid area.
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To return to the previous view, choose Last from the View menu (Ctrl+L). To restore the original 
2D view, choose Fit to Full Size (Ctrl+F).

The results of plot zooming for the 2D plot type are dependent upon the axis mode selected in the 
Axis Details dialog (accessed via the Plot menu):

• 2D Independent Axis Mode - Allows the selected region to expand to exactly 
fit in the frame. The axes are rescaled independently to fit the zoom box.

• 2D Dependent Axis Mode - In dependent mode, the axes are not fit perfectly 
to the zoom box. The longest dimension from the zoom box is applied to asso-
ciated axis and the other axis is resized according to the dependency relation.

For paper zooming, Shift-drag the magnifying glass cursor to draw a box about the region that you 
want to magnify. The plot is resized such that the longest dimension of the zoom box fits into the 
workspace. You can fit one or all frames to the workspace by using the Fit Selected Frames to 
Workspace or Fit All Frames to Workspace options from the View>Workspace menu. To return to 
the default paper view, choose Fit Paper to Workspace from the View>Workspace menu.

Clicking anywhere in your plot while the zoom tool is 
active, centers the zoom around your click.

Translate Tool

Use the Translate/Magnify tool to translate or magnify data within a frame or the paper 

within the workspace.

Use the center mouse button (or CTRL+ 
right-click) to interactively zoom into or out 
of the plot.
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While in Translate/Magnify mode, drag the cursor to move the data with respect to the frame, or 
Shift-drag to move the paper with respect to the workspace.

You can rescale your image by pressing “+” to magnify, “-” to 
shrink. If you are Shift-dragging to move the paper, the rescale 

buttons “+” and “-” will magnify or shrink the paper so long as you have the 
mouse button depressed

Three-Dimensional Rotation
There are six 3D rotation mouse modes:

• Spherical - Drag the mouse horizontally to rotate about the Z-axis; drag 

the mouse vertically to control the tilt of the Z-axis.

• Rollerball - Drag the mouse in the direction to move with respect to the 

current orientation on the screen. In this mode, your mouse acts much like a 
rollerball.

• Twist - Drag the mouse clockwise around the image to rotate the image 

clockwise. Drag the mouse counterclockwise around the image to rotate the 
image counterclockwise.

• X-axis  - Drag the mouse to rotate the image about the X-axis.

• Y-axis - Drag the mouse to rotate the image about the Y-axis.

• Z-axis - Drag the mouse to rotate the image about the Z-axis.

Use the right mouse button to interactively translate objects.
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Once you have selected a rotation mouse mode, you can quickly switch to any of the others using 
the following keyboard shortcuts:

Drag Rotate about the defined rotation origin with your cur-
rent Rotate tool.

Alt-Drag Rotate about the viewer position using your current 
Rotate tool.

Middle-Click/CTRL+right click smooth zoom in and out of the data
Right-click translate the data
C Move rotation origin to probed point, ignoring zones.
O Move rotation origin to probed point of data.
R Switch to Rollerball rotation.
S Switch to Spherical rotation.
T Switch to Twist rotation.
X Switch to X-axis rotation.
Y Switch to Y-axis rotation.
Z Switch to Z-axis rotation.

.

Slice Tool

Use the Slicing tool to control your slice rendering interactively.

The following keyboard/mouse options are available when the slice tool is active:

+ Primary Slices, Start End Slices Active - Turn on intermedi-
ate slices (if not already active) and adds a slice.
Primary Slices active [ONLY] - Turns on Start/End Slices 
and adds a slice
Start/End Slices active [ONLY] - Turns on Start/End Slices 
and adds a slice

- Primary Slices, Start End Slices Active - Removes start and 
end slices
Primary Slices active [ONLY] - removes the primary slice
Start/End Slices active [ONLY] - removes the Start and End 
Slices
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Add Streamtrace

Select the Add Streamtrace tool to add a streamtrace interactively by clicking anywhere in 

your plot. Select the number of streamtraces to include with each click (rake) using 1-9 on the key-
board. 

Streamtrace Termination Line

Select the Add Streamtrace Termination Line tool to add a streamtrace termination line 

interactively. 

To draw a Streamtrace Termination Line:

•  Move the cursor into the data region.

•  Click once at the desired starting point for the line.

Click/Drag Updates the position of the primary slice (if active). If only 
start and end slices are visible, click updates the position of 
the slice closest to the click.

Alt-click/Alt-drag Determine the XYZ-location by ignoring zones and looking 
only at derived volume objects (streamtraces, slices, iso-sur-
faces, slices).

Shift-click Place the start or end slice (whichever is closest to the initial 
click location).   Show Start/End Slices is activated, if neces-
sary.

Shift-drag Move the start or end slice (whichever is closest to the initial 
click location). Show Start/End Slices is activated, if neces-
sary.

I, J, K (ordered zones only) Switch to slicing constant I-, J-, or K-planes respectively.
X, Y, Z Switch to slicing constant X-, Y-, or Z-planes respectively.
1-4 Numbers one through four switch to the corresponding slice 

group.
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•  Click again at each desired break point.

•  When the polyline is complete, double-click on the last point of the polyline, or 
press Esc on your keyboard.

•  The drawn polyline ends any streamtraces that pass through it.

Add Contour Level

Select the Add Contour Level tool to add a contour level by clicking anywhere in the current 

data region. A new contour level, passing through the specified location, is calculated and drawn.

Alt-Click Place a contour line by probing on a streamtrace, slice, or iso-surface.
Click Place a contour line.
CTRL+Click Replace the nearest contour line with a new line.
Drag Move the new contour line.
- Switch to the Delete Contour Level tool.

The following keyboard and mouse shortcuts are related to the Add Contour Level tool.

Delete Contour Level

Select the Delete Contour Level tool to delete a contour level by clicking anywhere in the 

current data region. The contour line nearest the specified location is deleted.

Add Contour Labels

Select the Add Contour Label tool to switch to the Contour Label mode, enabling you to add 

a contour label by clicking anywhere in the current data region.

Use the “+” key to switch to the Add Con-
tour Level tool and the “-” key to switch 
back to the Delete Contour Level tool.
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A contour label is added to the plot at the specified location; its level or value information is taken 
from the nearest contour line. This allows you to place labels at a slight offset from the lines they 
label.

Probe Tool

Select the Probe At Tool to probe for values of the data set's variables at a particular point.

To obtain interpolated values of the data set variables at the specified location, click at any point in 
the data region.

To obtain exact values for the data point nearest the specified location, Ctrl-click at the 
desired location.

Insert Text

Select the Add Text tool to add text to any frame.

Insert Geometries
Use the corresponding geometry buttons in the toolbar to insert geometries into your plot. 

Polylines

Squares

The Contour type must be lines or lines and flood in order for 
this tool to be active. You can set the contour type on the Con-
tour page of the Zone Style dialog.

For XY plots, When you move into the axis grid area, the cur-
sor cross hair is augmented by a vertical or horizontal line, 
depending on whether you are probing along the X-axis or the 
Y-axis. You can change the axis to probe simply by pressing X 

to probe the X-axis or Y to probe the Y-axis.
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Rectangles

Circle

Ellipse

Create New Frame

Select the Create Frame tool to create a new frame. 

To add a frame:

• Click once in the workspace to anchor one corner of the frame.

• Drag the diagonal corner until the frame is the desired size and shape.

Extract Discrete Points

Select the Extract Discrete Points tool to extract selected points to a data file or a new zone.

To select points:

•  Click your left-hand mouse button at each location where you would like to extract 
a point.

•  To end extraction, either double-click on the last point, or press the Esc key.

•  The Extract Data Points dialog appears; use it to specify how many points to extract 
and how to save the data.

If you have data loaded into Tecplot and you create a new 
frame, you can attach the existing data set to the new frame by 
changing the plot type.
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Extract Points along Polyline

Select the Extract Line tool to extract points along a specified polyline to a data file or a new 

zone.

To select points:

•  Click your left-hand mouse button at each location where you would like to extract 
a point.

•  To end extraction, either double-click on the last point, or press Esc.

•  The Extract Data Points dialog appears; use it to specify how many points to extract 
and how to save the data.

Create Rectangular Zone

Select the Create Rectangular Zone tool to add new 2D rectangular zones to the current Tec-

plot data set.

To create a rectangular zone:

•  Click once in the current data region to anchor one corner of the zone.

•  Drag the diagonal corner until the zone is the desired size and shape. The new zone 
created is IJ-ordered.

To specify the maximum I-index and J-index, use the Create Rectangular Zone dialog (accessed via 
Data>Create Zone).

Create Circular Zone

Select the Create Circular Zone tool to add new 2D circular zones to the current Tecplot data 

set.

The current frame must have a data set 
attached to it, in order for this tool to be 
active.
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To create a circular zone:

•  Click once in the current data region to specify the center of the zone.

•  Drag until the zone has the desired radius. The new zone created is IJ-ordered.

To specify the maximum I-index and J-index, use the Create Circular Zone dialog (accessed via 
Data>Create Zone). 

1- 2.4 Status Line
The status line, running along the bottom of the Tecplot window, gives “hover help.” When you 
move the pointer over a tool in the toolbar, a button on the Quick Edit dialog, or a menu item, a 
description of the control appears. It also provides a progress bar and information during long cal-
culations.

1- 2.5 Tecplot Workspace
The workspace is the portion of your screen in which you create sketches and plots. Each sketch or 
plot is created within a subwindow called a frame. The current state of the workspace, including the 
sizing and positioning of frames, the location of the data files used by each frame, and all current 
attributes for all frames, makes up a layout. By default, the workspace displays a representation of 
the paper Tecplot is set up to draw on, as well as a reference grid and rulers. The active frame, in 
which you are currently working, is on top. All modifications are made to the current frame. 

The current frame must have a data set 
attached to it, in order for this tool to be 
active.
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1- 2.6 Quick Edit Dialog
The map and zone layer controls affecting how the individual layers are drawn can be altered using 
controls on the sidebar. You can also control many of these attributes using the Quick Edit dialog.

To use the Quick Edit dialog, select one or more objects in the workspace, then select the appro-
priate button to change the attribute of the selected object(s).

Quick Edit - Mesh
This area controls whether the mesh is displayed for selected zones, 
and if so, using what plot type. The following options are available:

Figure 1-2. The Quick Edit dialog.
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•  Y - Show the mesh for the selected zones. If the Mesh layer is not currently active, 
a dialog appears asking if you wish it activated.

•  N - Turn off the mesh for the selected zones.

•  Wire Frame - Mesh lines are drawn underlying all other field layers (i.e., 
Contour, Vector, Scatter, Shade); hidden lines are not removed. 

•  Overlay - Mesh lines are drawn above all other field plot layers except vectors 

and scatter symbols.

•  Hidden - Like Overlay, except that in the 3D Cartesian plot type hidden lines 
are removed from behind the mesh. In essence, the cells of the mesh are opaque. Sur-
faces and lines that are hidden behind another surface are removed from the plot.

Quick Edit - Contour
This area controls whether contours are displayed for 
selected zones, and if so, using what plot type. The fol-
lowing options are available:

•  Y - Show the contours for the selected zones. If the Contour zone layer is not cur-
rently active, a dialog appears asking if you wish it activated.

•  N - Turn off the contour for the selected zones.

•  Lines - Plots contour lines. If you choose this plot type, you can use the Cont 
Color attribute to specify Multi-Color to make the line color vary with the contour-
variable value.

•  Flood - Flood the area between adjacent contour lines with a color according 
to the value of the contour variable, number of contour levels, and the Color Map. 
With a large number of contour levels, the color flooding appears nearly continuous. 

•  Both Lines and Flood - Contour lines are drawn with color flooding between 
them.

•  Average Cell - Each cell or element is flooded with one solid color based upon 
the average value of the contour variable at the data points of the cell or element.
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•  Primary Value - Each cell or element is flooded with one solid color based 
upon the primary cell value.

Quick Edit - Vector
This area controls whether vectors are displayed for selected zones, and if so, using what plot type. 
The following options are available:

•  Y - Show the vectors for the selected zones. If the Vector zone layer is not currently 
active, a dialog appears asking if you wish it activated.

•  N - Turn off the vectors for the selected zones.

•  Tail at Point - Display regular vectors – a simple stick vector with length pro-

portional to the local magnitude. The tail of the vector is positioned at the data point. 

•  Head at Point - Display regular vectors – a simple stick vector with length pro-
portional to the local velocity magnitude (the square root of the sum of the squares of 
the vector components). The head of the vector is positioned at the data point.

•  Anchor at Midpoint - Display regular vectors – a simple stick vector with 
length proportional to the local velocity magnitude. The midpoint of the vector is 
positioned at the data point.

•  Head Only - Display vectors as heads only, without the vector shaft.

Quick Edit - Scatter
This area controls whether scatter symbols are displayed for selected 
zones, and if so, whether to use plain or filled symbols. The following 
options are available:

•  Y - Show the scatter symbols for the selected zones. If the Scatter zone layer is not 
currently active, a dialog appears asking if you wish it activated.

•  N - Turn off the scatter symbols for the selected zones.

•  Plain - Use un-filled symbols for the scatter plot.

•  Filled - Use filled symbols for the scatter plot.
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Quick Edit - Shade
This area controls whether shading is used for selected zones.This option allows 
you to turn off just the Shade zone layer for specific zones, without completely 
deactivating the zones. The following options are available:

•  Y - Show light-source shading for the selected zones. If the Shade zone layer is not 
currently active, a dialog appears asking if you wish it activated.

•  N - Turn off light-source shading for the selected zones.

Quick Edit - Edge Border
This area controls whether the zone edge border is displayed for selected ordered zones, and if so, 
what edge type. The following options are available:

•  Y - Show edges borders for the selected zones. If the Edge zone layer is not cur-
rently active, a dialog appears asking if you wish it activated.

•  N - Turn off edges for the selected zones.

•  Show Entire Border - Shows border lines on all boundary of the selected 

zone(s)

•  Show Border Line - Shows the edge border line closest to the selected point.

•  Hide Border Line - Hides the edge border line that is closest to the selected 
point.

•  Show Only Nearest Border Line - Shows only the edge border line that is 

closest to the selected point and hides all others.

Quick Edit - Symbols Mapping Layer
This area controls whether symbols are plotted at each data point, and 
whether those symbols are filled or plain. The following options are avail-
able:

•  Y - Show the symbol plots for the selected maps. If the Symbols map layer is not 
currently active, a dialog appears asking if you wish it activated. 

•  N - Turn off the symbol plots for the selected maps.
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•  Plain - Use un-filled symbols for the scatter plot.

•  Filled - Use filled symbols for the scatter plot.

Quick Edit - XY Bars Mapping Layer
This area controls whether bars are plotted to represent each data point, 
and whether those bars are filled or plain.

•  Y - Show the selected maps as bar charts. If the Bars map layer is not currently 
active, a dialog appears asking if you wish it activated. 

•  N - Turn off bar charting for the selected maps.

•  Plain - Use un-filled bars for the bar chart

•  Filled - Use filled bars for the bar chart.

Quick Edit - XY Error Bars Mapping Layer
This area controls whether error bars are displayed for the selected 
mappings, and in which direction the error bars are drawn. The 
options are:

•  Y - Show the error bars for the selected maps. If the Error 
Bars map layer is not currently active, a dialog appears asking if you wish it acti-
vated.

•  N - Turn off the error bars for the selected maps.

•  Top - Error bar extends upward for positive values (and downward for nega-

tive values) of the error-bar variable.

•  Bottom - Error bar extends downward for positive values (and upward for 
negative values) of the error-bar variable.

•  Left - Error bar extends to the left for positive values (and to the right for neg-

ative values) of the error-bar variable.
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•  Right - Error bar extends to the right for positive values (and to the left for 
negative values) of the error-bar variable.

•  Horizontal - Error bar extends both left and right.

•  Vertical - Error bar extends both up and down.

•  Cross - Error bar extends up, down, left and right.

Quick Edit - Color
This area controls color options for filled objects, 
lines, and text. 

•Object-type - Use the fill, line and text radio 
buttons to identify the object-type to modify. 

•  Color - Select the Color button to activate the Select Color dialog. NOTE: Multi
color is not available for line plots.

•  X button - the behavior of the X button depends on the object-type selected.   

• Fill - X turns off the fill color
• Line - X causes the line color to match the fill color. If no fill color is 

specified, the X button has no effect.
• Text - X has no effect

Quick Edit - Symbols
Use this region of the Quick Edit dialog to change the symbol for the 
Scatter Zone layer or Symbols Map layer.

Use the Size button to specify the size of the scatter symbols as a percent-
age of the frame width (in the 2D Cartesian plot type) or of the median-axis length (in the 3D Car-
tesian plot type).
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Quick Edit - Line Pattern
This area controls the line pattern, pattern length, and line thickness for 
all selected objects.

•  Line Pttrn - Choose the line pattern for the selected zones.

•  Pttrn Lngth - Specify the pattern length for the selected line pat-
tern, as a percentage of the frame width.

•  Line Thcknss - Specify the line thickness for the vectors as a 
percentage of the frame width.

Quick Edit - Arrows
This area controls arrowhead placement on polylines.

Quick Edit - Arrowheads
This area controls the type, size, and angle of arrowhead for both selected vec-
tors and selected polylines and vectors. The following options are available:

• Head Style - Choose the vector head style for the selected zones. The 
following options are available:

• Plain - Display arrowheads as lines drawn from the head of 
the vector.

• Filled - Display arrowheads as filled triangles at the end of each vec-
tor.

• Hollow - Display arrowheads as hollow triangles at the end of each 
vector.

• Size - Specify the size of the arrowhead as a percentage of frame height.

• Angle (deg) - Specify the angle between the vector and the arrowhead.

• Enter Value - For both the size and angle buttons, you can choose Enter and 
enter an exact percentage in the Enter Value dialog.



Chapter 1:Introduction

42

Quick Edit - Font
This area controls the font family and size used for 
selected text.

The following options are available:

•  Font - select the font family

•  Size (%) - Specify the height for the text in frame units (that is, as a percentage of 
frame height.)

•  Size (pt) - Specify the height for the text in points.

Quick Edit - Order and Alignment
Use the Order and Alignment buttons to align text within text-
boxes or the alignment between selected geometries/text-
boxes.

•  Left, Center, or Right - Use the Left, Center or 
Right alignment buttons to align text

•  Top, or Bottom - Use the Top or Bottom alignment buttons to align selected geom-
etries and text with respect to one another

•  Push - Use the Push button to push the selected geometries or text to the bottom of 
the view stack

•  Pop - Use the Pop button to pop the selected geometries or text to the top of the 
viewstack

1 - 3 Getting Help
Tecplot features a fully integrated Help system. Quick help on menu items and sidebar controls is 
available from the status line or tool tips.

Detailed help is accessible by:

•  Pressing the F1 key anywhere in the Tecplot window. If the pointer is over the 
sidebar, Quick Edit dialog, or a menu, the F1 key provides context-sensitive help 
on that control or menu. Otherwise, F1 calls up the Contents page of Help via your 
Web browser.

•  Selecting Contents from the Help menu.

Left 

C
enter 
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R
ight 

B
ottom
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•  Selecting Help on any dialog.

The Help dialog supports text search, has many hypertext links, and provides detailed information 
on all menus and dialogs. 

Your answer may be in Technical Support Notes at www.tecplot.com/support.

If you are covered by Tecplot’s Software Maintenance Service, help is also available from 6:30 
A.M. to 5 P.M. Pacific Standard Time from Tecplot Technical Support at 425.653.9393. 

You may also send e-mail to support@tecplot.com with your questions.

mailto:support@tecplot.com
http://www.tecplot.com/support
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Chapter 2 Data Structure

Tecplot accommodates two different types of data: ordered and finite-element. 

2 - 1 Ordered Data
Ordered data is a set of points logically stored in a one-, two-, or three-dimensional array, where I, 
J, and K are the index values within the array. The number of data points is the product of all of the 
dimensions within the array. 

• One-dimensional array (I-ordered, J-ordered or K-ordered) - A single 
dimensional array of data points where one dimension (I,J or K) is greater than 
or equal to one and the other dimensions are equal to one. In a one-dimensional 
array, the total number of data points is equal to the length of the single-ordered 
array. For example, an I-ordered data set with I=5, J=K=1 has 5 data points.

• Two-dimensional array (IJ-ordered, JK-ordered, IK-ordered) - A two-
dimensional array of data points where two of the three dimensions (I,J, K) are 
greater than one and the other dimension is equal to one. The number of data 
points in a two-dimensional ordered data set is the product of the all of the 
dimensions. For example, in an IJ-ordered data set, the number of data points is 
equal to I x J (where K=1).

• IJK-ordered - Three-dimensional array of data points where all three of the I-
, J-, and K-dimensions are greater than one. The number of data points is the 
product of the I-, J-, and K-dimensions.

2- 1.1 One Dimensional-Ordered Data Points (I,J, or K)
Data points for XY Line plots are usually arranged in a one-dimensional array indexed by one 
parameter: I for I-ordered, J for J-ordered, or K for K-ordered, with the two remaining index values 
equal to one. 



Chapter 2:Data Structure

48

For example, in an I-ordered data set (the most common type), the data points are arranged as fol-
lows:

I=1 at the first data point,
I=2 at the second data point, 
I=3 at the third data point, 
... 
I=IMax for the last point. 

At each data point, N variables (V1, V2, ..., VN) are defined. If you arrange the data in a table where 
the values of the variables (N values) at a data point are given in a row, and there is one row for 
each data point, the table would appear something like that shown in Figure 2-1. For example, if 
you wanted to make a simple XY-plot of pressure versus time, V1 would be time and V2 would be 
pressure.

V1 V2 V3 ... VN (Values at data point I = 1.)
V1 V2 V3 ... VN (Values at data point I = 2.)
V1 V2 V3 ... VN (Values at data point I = 3.)
V1 V2 V3 ... VN
V1 V2 V3 ... VN
V1 V2 V3 ... VN
V1 V2 V3 ... VN (Values at data point I = IMax.)

2- 1.2 Two Dimensional-Ordered Data Points (IJ, JK, or IK)
The data points for 2D and 3D surface field plots are usually organized in a two-parameter mesh. 
Each data point is addressable by a set of the two parameters (e.g. I and J for IJ-ordered) and has 
four neighboring data points (except at the edge of the data). The points are located above, below, 
to the left, and to the right as shown in Figure 2-1. 

Table 2-1. Table of values for I-ordered data points (suitable for XY plots).



(I, J)

(I, J+1)

(I+1, J)(I-1, J)

(I, J-1)

Figure 2-1. IJ-ordered data point neighbors. The layout is identical for JK or IK-ordered 

49

Ordered Data

2- 1.3 3 Dimensional-Ordered Data Points (IJK)
The data points for 3D volume field plots are usually organized in a three-dimensional ordered data 
set. Each point is addressable by a set of three indices (I, J, and K) and has six neighboring data 
points (except at the edges of the data set). These neighbors are located above, below, left, right, in 
front of, and behind the data point as shown in Figure 2-2.

At each data point, you define three spatial variables (X, Y, Z) plus (typically) one or more vari-
ables such as pressure, vector components, and vorticity.

(I, J, K)

(I, J+1, K)

(I, J-1, K)

(I+1, J, K)(I-1, J, K)

(I, J, K+1)

(I, J, K-1)

Figure 2-2. IJK-ordered data point neighbors.
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A mesh plot of IJK-ordered data is displayed in Figure 2-3. The directions of the I-, J-, and K-indi-
ces are shown. As you can see, the points that define the mesh can form curved, irregularly spaced, 
and/or nonparallel paths.

IJK-Ordered Data Plotting
In one- or two-dimensional data sets, all data points are typically plotted. However, there are more 
plotting options for IJK-ordered data, especially when creating 2D or 3D plots. The Surfaces page 
of the Zone Style dialog allows you to designate which surfaces of IJK-ordered data will be plotted. 
You may choose to plot just outer surfaces, or you may select combinations of I-, J-, and K-planes 
to be plotted. Refer to Section 6- 1.2, “Surfaces” for in-depth information.
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2- 1.4 I-, J-, and K-Planes
A K-plane is the connected surface of all points with a constant K-index value. The I- and J-indices 
range over their entire domains. Similarly for an I-plane and a J-Plane.   Examples of I-, J-, and K-
planes are shown in Figure 2-3.

A B

C D

Figure 2-3. An illustration of IJK planes of a semi-circular zone (created by extracting a 
subzone from a circular zone). (A) shows all 3 planes (Surfaces to Plot = 
Boundary on the Surfaces page of the Zone Style dialog). (B) Surfaces to Plot 
= I-Planes   (C) Surfaces to Plot = J-Planes and (D) Surfaces to Plot = K-
Planes.
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Note: I-, J- or K-planes are not necessarily two-dimensional in physical space. They are called 
planes because they exist as planes in logical (IJK) space. In real (XYZ) space, the planes may be 
cones, ellipsoids, or arbitrary surfaces.

2- 1.5 Mesh Structure (Ordered Data Only)
A family of I-lines results by connecting all of the points with the same I-index, similarly for J-lines 
and K-lines. For IJ- ordered data, both families of lines are plotted in a two-dimensional coordinate 
system resulting in a 2D mesh. When both the I- and J-lines are plotted in a three-dimensional coor-
dinate system, a 3D surface mesh plot results. An example of both meshes is shown in Figure 2-4
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Figure 2-4. Left, a 2D mesh of IJ-ordered data points. Right, a 3D mesh of IJ-
ordered data points. Note: Ordered axes do not necessarily 
corresponded to physical axes.

.

2 - 2 Finite-Element Data
Finite-element data is arranged in two arrays, a variable array and a connectivity matrix. The vari-
able array is a collection of points in 2D or 3D space that are connected into polygonal or polyhe-
dral units called elements. The connections between the nodes are defined by the connectivity 
matrix.

While finite-element data is usually associated with numerical analysis for modeling complex 
problems in 3D structures, heat transfer, fluid dynamics, and electromagnetics, it also provides an 
effective approach for organizing data points in or around complex geometrical shapes. For exam-
ple, you may not have the same number of data points on different lines, there may be holes in the 
middle of the data set, or the data points may be irregularly (randomly) positioned. For such diffi-
cult cases, you may be able to organize your data as a patchwork of elements. Each element can be 
independent of the other elements, so you can group your elements to fit complex boundaries and 
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leave voids within sets of elements. Figure 2-4 shows how finite-element data can be used to model 
a complex boundary.
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Finite Element Mesh Structure

Figure 2-5. Finite-element data used to model a 
complex boundary.

Finite-element data defines a set of points (nodes) and the connected elements of these points. The 
variables may defined either at the nodes or at the cell (element) center. Finite-element data can be 
divided into three types:

• FE-line- A set of line segments defining a 2D or 3D line.

• FE-surface - A set of triangular or quadrilateral elements defining a 2D field 
or a 3D surface.

• FE-volume - A set of tetrahedral or brick elements defining a 3D volume field.

In Tecplot, each FE data zone must be composed exclusively of one element type. However, you 
may use a different data point structure for each zone within a data set, as long as the number of 
variables defined at each data point is the same. 

2 - 4 “Finite-Element Data” on page 48 of the Data Format Guide  provides detailed information 
about how to format your FE data for Tecplot.

You can simulate zones with mixed element types by repeating 
nodes as necessary. For example, a triangle element can be 
included in a quadrilateral zone by repeating one node in the 
element’s connectivity list, and tetrahedral, pyramidal, and 

prismatic elements can be included in a brick zone by repeating nodes appro-
priately.
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2- 2.1  Finite-Element Line Data.
Unlike I-ordered data, a single finite-element line zone may consist of multiple disconnected sec-
tions. The values of the variables at each data point (node) are entered in the data file similarly to I-
ordered data, where the nodes are numbered with the I-index. This data is followed by another set 
of data defining connections between nodes. This second section is often referred to as the connec-
tivity list. All elements are lines consisting of two nodes, specified in the connectivity list.

2- 2.2 Finite-Element Surface Data
In finite-element surface data, the values of the variables at each node (data point) and the finite-
element connectivity lists are entered in the data file in the same manner as finite-element line data 
(described above). The difference is in the number of nodes per element.

You can choose (by zone) to arrange your data in three point (triangle) or four point (quadrilateral)
elements. The number of points per node and their arrangement are called the element type of the 
zone. You may repeat a node in the quadrilateral element type to create a triangle if a mixture of 
quadrilaterals and triangles is necessary.

2- 2.3 Finite-Element Volume Data
Finite-element volume cells may contain four points (tetrahedron) or eight points (brick). The 
elements in each zone must be either all tetrahedra or all bricks. Figure 2-6 shows the arrangement 
of the nodes for tetrahedral and brick elements.

In the brick format, points may be repeated to achieve 4-, 5-, 6-, or 7-point elements. For example, 
a node list entry of “n1 n1 n1 n1 n5 n6 n7 n8” results in a quadrilateral-based pyramid ele-
ment.

N1

N2

N3

N4

n1 n2

n3n4

n5

n8 n7

n6

Tetrahedral connectivity 
arrangement.

Brick connectivity 
arrangement.

Figure 2-6. Connectivity arrangements for FE-volume data 
sets.
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2- 2.4 Finite-Element Data Limitations
Working with finite-element data has some limitations:

• XY-plots of finite-element data treat the data as I-ordered; that is, the connec-
tivity list is ignored. Only nodes are plotted, not elements, and the nodes are 
plotted in the order in which they appear in the data file.

• Index skipping in vector and scatter plots treats finite-element data as I-
ordered; the connectivity list is ignored. Nodes are skipped according to their 
order in the data file.

2 - 3 Variable Location (Cell-Centered or Nodal)
In ordered or FE-data sets, the value of the variables can be located at either the nodes or the cell-
centered. 

• For finite-element meshes, cell-centers are the centers (centroids) of elements. 

• For I-ordered grids, the cell-centers are at the centers of the lines connecting 
points (I) and (I+1). 

• For IJ-ordered grids, the cell-centers are at the centroids of the quadrilaterals 
defined by points (I,J), (I+1,J), (I,J+1), and (I+1, J+1). 

• For IJK-ordered grids, the cell-centers are at the centroids of the hexahedral-
like elements defined by points (I,J,K), (I+1,J,K), (I,J+1,K), (I+1,J+1,K), 
(I,J,K+1), (I+1,J,K+1), (I,J+1,K+1),and (I+1,J+1,K+1). 

For many types of plots, Tecplot internally interpolates cell-centered values to the nodes.

Refer to for  “Zone Records” on page 11 of the Data Format Guidefor information on specifying 
the variable location in a data file. 

2 - 4 Working with Unorganized Data Sets
Unorganized data sets are loaded into Tecplot as a single I-ordered zone and will be displayed in 
XY Mode, by default. 

To check for irregular data, you can go to the Data>Dataset Info dialog (accessed via the Data
menu). In the lower left quadrant of that dialog Tecplot will show you the values assigned to: IMax, 
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JMax, and KMax. If IMax is greater than 1, and JMax and KMax are equal to 1, then your data is 
irregular. 

It is also simple to tell irregular data from the plot. If you are looking at irregular data with the 
Mesh layer turned on, Tecplot will connect the datapoints using lines and in the order the points 
appear in the dataset.   

 There are 4 ways to organize your data set.

1. Manually order the data file using a text editor. 

2. Use the Data>Triangulate feature. (2D only). See 18 - 11 “Irregular Data Point 
Triangulation” on page 332.

3. Use one of the Data>Interpolation options. See 18 - 10 “Data Interpolation” 
on page 323.

4. Special Cases (use when interpolation results appear skewed):
• Well data - If points are closely positioned along the depth axis and far 

apart in physical space, use the Tetra Grid add-on to create a new zone 
with all points connected into 3D zones. See 29- 3.12 “Tetra-Grid” on 
page 583.

• Fluid Measurements - When measurements are taken of fluid proper-
ties or containments, interpolating to a rectangular zone does not yield 
good results, Use the Prism Grid add-on to create a 3D volume zone. 
See 29- 3.8 “Prism-Grid” on page 573.

An I-ordered zone is irregular if it is 
known to have more than one dependent 
variable. An I-ordered data set with one 
dependent variable (i.e. an XY or polar 

line) is NOT an irregular zone.

Use the Label Points and Cells feature 
from the Plot menu to see if your data 
set can be easily corrected using a text 
editor by correcting the values for I, J 
and/or K.
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2- 4.1 Example - Triangulate a Data Set
One common source of finite-element surface data is Tecplot’s triangulation option. If you have 2D 
data without a mesh structure, it is probably simplest to enter your data points as an I-ordered data 
set, then use Tecplot’s triangulation feature to create a finite-element data set. You can then edit the 
file, and particularly the connectivity list, to obtain the set of elements you want, rather than having 
to create the entire connectivity list by hand. 

We can triangulate a data set as follows:

1. Create a simple ordered data file, as follows:

VARIABLES = "X", "Y", "P", "T" 
0.0 1.0 100.0 1.6 
1.0 1.0 150.0 1.5 
3.0 1.0 300.0 2.0 
0.0 0.0 50.0 1.0 
1.0 0.0 100.0 1.4 
3.0 0.0 200.0 2.2 
4.0 0.0 400.0 3.0 
2.0 2.0 280.0 1.9

2. Save the file, with extension *.dat

3. Read the data file into Tecplot and switch the plot type to 2D Cartesian.

4. From the Data menu, choose Triangulate.

5. Select the simple ordered zone as the source zone, and click Compute.



Chapter 2:Data Structure

58

Figure 2-7 shows a plot of the resulting data. With triangulation, we obtain more elements (seven) 
than when we created the data set by hand (four), and the elements are triangles rather than quadri-
laterals

X

Y

0 1 2 3 4
0

0.5

1

1.5

2

Figure 2-7. Triangulated data 

.

2- 4.2 Example - Unorganized Three-Dimensional Volume 
To use 3D volume irregular data in Tecplot field plots, you must interpolate the data onto a regular, 
IJK-ordered zone. (Tecplot does not have a 3D equivalent for triangulation.) To interpolate your 
data, perform the following steps:

1. Place your 3D volume irregular data into an I-ordered zone in a data file.

2. Read in your data file and create a 3D scatter plot.

3. From the Data menu, choose Create Zone>Rectangular (Circular will also 
work). 

4. In the Create Rectangular Zone dialog, enter the I-, J-, and K-dimensions for 
the new zone; at a minimum, you should enter 10 for each dimension. The 
higher the dimensions, the finer the interpolation grid, but the longer the inter-
polating and plotting time.

5. Enter the minimum and maximum X, Y, and Z values for the new zone. The 
default values are the minimums and maximums of the current (irregular) data 
set.

6. Click Create to create the new zone, and Close to dismiss the dialog.

7. From the Data menu, choose Interpolate>Kriging (Linear or Inverse distance 
Interpolation would also work). 
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8. In the Kriging dialog, choose the irregular data zone as the source zone, and 
the newly created IJK-ordered zone as the destination zone. Set any other krig-
ing parameters as desired (see Section 18- 10.3, “Kriging,”for details).

9. Click Compute to perform the kriging.

Once Tecplot completes the interpolation, you can plot the new IJK-ordered zone as any other 3D 
volume zone. You may plot iso-surfaces, volume streamtraces, and so forth. At this point, you may 
want to deactivate or delete the original irregular zone so as not to conflict with plots of the new 
zone.

Figure 2-8 shows an example of irregular data interpolated into an IJK-ordered zone, with iso-sur-
faces plotted on the resultant zone.
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Figure 2-8. Irregular data interpolated into an IJK-ordered zone.
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Chapter 3 Frames and the Workspace

This chapter discusses global Tecplot commands that are independent of the data structure and plot 
layers in use, including:

•  Data Hierarchy- treatment of data within Tecplot

•  Interface Coordinate Systems- Learn when and where Tecplot uses different coordi-
nate systems

•  Frames- Plots are created in a frame—a boxed area in the workspace acting as a 
sub-window. You control the format of each frame.

•  Workspace Management - Options Menu- Workspace and paper controls determine 
the color and orientation of your paper, as well as the ruler and grid, to precisely size 
and position objects. For in-depth information on Display Performance, please refer 
to Section 28 - 3 “Performance Dialog” on page 547.

•  View Modification- Zoom, translate, and fit plots within frames.

•  Edit Menu- Many plot elements may be cut or copied from the workspace and 
pasted back into other plot elements.

3 - 1 Data Hierarchy
Tecplot structures data in two levels: data sets and zones.   Data sets are contained within frames. 
Each data set is composed of a zone or group of zones, and each zone contains a variable or group 
of variables. All zones in a dataset contain the same set of variables.

3- 1.1  Frames
You can create multiple plots simultaneously in Tecplot using subwindows called “frames”.   By 
default, one frame is open when you launch Tecplot. You can add frames to the workspace using 
the Frame menu. Data sets can be unique to the frame or shared between frames.   Linking data 
between frames allows you generate unique plots of the same data. For more information on work-
ing with frames, please refer to 3 - 3 “Frames” on page 65. 



Chapter 3:Frames and the Workspace

62

3- 1.2 Data Sets
A data set is defined as “all of the information data in a frame”.   Starting with an empty frame, a 
data set is created and assigned to the active frame when you read one or more data files into Tec-
plot, or when you create a zone within Tecplot. 

3- 1.3 Zones
Zones are a subset of data sets. A data set can be composed of a single zone or several zones. Zones 
are either defined in the data file or created directly in Tecplot. The number of zones in a concate-
nated data set is the sum of the number of zones in each of the data files that are loaded. 

Typically, a data file is divided into zones based on its physical coordinates. For example, a data set 
of an airplane many consist of a zone for each wing, each wheel, the nose, etc. Alternatively, zones 
may be defined based on the material. For example, a data set of a fluid tank may have a zone for 
the tank itself and additional zones for each fluid therein.

All zones in a given data set must have the 
same variables defined for each data point.
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3- 1.4 Summary
A chart of the data hierarchy is shown in Figure 3-1.

Figure 3-1. Data Hierarchy in Tecplot. Frames 1 & 2 share Data Set 1, and Data Set 1 
contains 3 zones from 1 data file. Frame 3 contains data set 2, which is composed 
of 5 zones (2 from data file 2 and 3 from data file 3).
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3 - 2 Interface Coordinate Systems
Tecplot incorporates a number of coordinate systems, including the paper, frame, the physical 
coordinate systems for the plot (2D, 3D or Polar). The origins of each coordinate system and how 
their relationship to one another is shown in Figure 3-2. 

The physical coordinate system (2D or 3D) in effect is dependent upon the plot-type of the current 
frame. Two-dimensional physical coordinates are often referred to as grid coordinates.

Figure 3-2. Tecplot Coordinate System. The physical coordinate system(s) 
of the data set (e.g. 3D Cartesian, 2D Cartesian, etc.) are 
encompassed in the Frame Coordinate System.
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In Tecplot 360, the frame coordinate system is fit to the paper coordinate system, by default. 

3 - 3 Frames
All plots and sketches are drawn within frames. By default, the Tecplot workspace contains one 
frame maximized to the paper. You may add additional frames (up to 128), resize and reposition 
frames, modify background color, and specify border and header appearance. Tecplot acts upon 
only one frame—the current frame—at any given time (except when frames are linked).

See “Stylesheets” on page 448 for additional frame options.

3- 3.1 Frame Creation
Create new frames interactively by drawing them in the workspace using the Frame>Create New 

Frame command or  from the toolbar. If printing plots, draw frames within the paper 
displayed in the workspace. The paper view is turned-off by default in Tecplot 360. To view the 
paper coordinate system (for arranging frames for printing), go to Options>Paper Setup and toggle-
on Show Paper on Screen.

See “Create Multiple Frames” on page 567 for information on simultaneously creating multiple 
frames.

3- 3.2 Frame Deletion
Delete the active frame using Frame>Delete Current Frame, the Edit>Clear or hitting the delete 
key.

Tecplot uses the height of the frame for objects scaled by frame 
units, such as font size. When you enter a frame unit value into 
a dialog, or you are setting frame size and position on the 
paper, you may specify a different unit system (inches, points, 

centimeters, or pixels). The values are automatically converted into frame 
units.

The new frame will be the active frame in 
Tecplot.
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To delete a group of frames: select a group of frames and toggle-on frames in the Objects area of the 
Group Select dialog.

3- 3.3 Edit Current Frame
The Edit Current Frame dialog (accessed via the Frame menu) allows you to adjust the following 
features in the active frame:

•  Frame Positioning and Sizing

•  Frame Border and Header Controls

•  Frame Background Color Modification

•  Frame Name Modification

Figure 3-3. Edit Current Frame dialog box (accessed 
via the Frame menu)
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Frame Positioning and Sizing
You can size and position frames using Edit Current Frame from the Frame menu, or by choosing 
Fit all Frames to Paper (also from the Frame menu).

In the Edit Current Frame dialog, you may specify the exact location for the frame’s left and top 
sides, along with width and height. 

• Left Side - start 
of the left side of 
the frame, relative 
to the workspace

• Top Side - start
of the top side of 
the frame, relative 
to the workspace

• Width - width of 
the frame (coordinates are: left side to left side + width)

• Height - height of the frame (coordinates are: top side to top side + height)

The units in the Frame Dimensions region of the dialog box are based on the units set for the Ruler 
Spacing in Options>Ruler/Grid.

You may also use the mouse or the arrow keys to resize and 
position frames. Click anywhere on a frame’s header or border 
to activate resizing handles for the frame. To scale frames pro-
portionally, maintaining the vertical to horizontal aspect ratio, 

select the frames, then press “+” on your keyboard to enlarge or “-” to 
reduce. 
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After selecting frames, you may position them using the arrow keys on your keyboard. You can 
move frames up, down, left or right in one-pixel increments for precise location. 

Frame Border and Header Controls
Use the Edit Current Frame dialog (accessed via the Frame menu) to adjust the frame border or 
header. 

Toggling-off “Show Border” results in an 
invisible frame border. To show a dashed 
line for invisible borders, go to
Options>Show Invisible Frame Borders. Use 
the Thickness window to adjust the line-
thickness of the border. 

The frame header is displayed when the 
both Show Border and Show Header are tog-

gled-on. If you turn off the border by deselecting the Show Border check box, the header turns off as 
well. You can choose any of Tecplot’s colors for the frame header.

The frame header contains user-configurable information which defaults to:

"&(FrameName) | &(date) | &(DataSetTitle)"

where FrameName is the frame’s name, date is the date the frame was created or revised and Data-
SetTitle is the title of the current data set. These defaults can be changed in your configuration file; 
see the $!GLOBALFRAME command in the Tecplot Reference Manual.

To fit the current frame to the paper (por-
trait orientation), set Left Side = 0.0, Top 
Side = 0.0, Width = 8.5 and Height = 11.

Set Width = 11 and Height = 8.5 for land-
scape paper orientation.
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Frame Background Color Modification
Select the Color box in the Edit Current Frame dialog (accessed via the Frame menu) to adjust the 
frame background color. Toggle-off “Show Background” to set the frame background to transpar-
ent.

Frame Name Modification
Enter text in Frame Name region of Edit Current Frame dialog (accessed via the Frame menu) to 
change the name of the active frame. 

3- 3.4 Frame Pushing and Popping
There are times when you want to expose—pop—overlapping or overlaid frames. For partially 
exposed frames, click on the exposed portion (in any mouse mode except Create Frame). For 
completely obscured frames, pop underlying frames by selecting Push Current Frame to Back, or 
by using the Frame menu’s Order Frames option.

Push Current Frame to Back
To push a frame to the back of the plot, select Push Current Frame Back from the Frame menu.

If you have multiple overlaid frames, repeat these steps until the desired frame is on top, or pop a 
specific frame using Order Frames. If part of a frame is visible, pop it to the top by clicking on it.

NOTE: When inverting the background color from black to 
white (or white to black), you will be asked whether to invert 
the colors for other objects as well (i.e. text or gridlines).
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Order Frames

Use the Order Frames dialog (accessed via the Frame menu) to rearrange the viewstack of frames. 
Pop brings a frame to the front. Push brings a frame to the back. You can sort the frame list by name 
or by the order in which the frames were created. 

3- 3.5 Fit all Frames to Paper
Resizes all frames proportionally so that one dimension, either horizontal or vertical, is exactly 
filled. The relative size and position of all frames are preserved.

3- 3.6 Frame Linking
Tecplot's frame linking feature allows you to link specific style attributes either between frames or 
within a frame. Linking between frames allows you to quickly make changes in one frame and 
propagate them through a number of other frames. 

Figure 3-4. Order Frames dialog.
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Attribute Linking Between Frames
Using the Between Frames page of the Set Links for Current Frame dialog (accessed via the Frame
menu) you can link the following attributes (Figure 3-5.):

Figure 3-5. The Between Frames page of the Set Links for Current Frame 
dialog.

• Frame Size and Position - Use this option to overlay transparent frames. (See 
“Frame Background Color Modification” on page 69)

• X-Axis, Y-Axis Range (For XY Line and 2D plots) - links the X-axis or Y-axis 
range and the positioning of the left and right sides of the viewport.

• XY-Axis Position (For XY Line and 2D plots) - Links the positioning of the 
X- and Y-axes between frames, including the method used for positioning the 
axes, such as aligning with an opposing axis value.

• Polar Plot View - Link views for frames using the Polar Line plot type.

• 3D Plot View - Link the 3D axes and 3D view.
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• Slice Positions - Link slice positions and slice planes for active slices (but not 
slice style).

• Iso-Surface Locations - Link iso-surface values (but not iso-surface plot 
style).

• Contour Levels - Link the values and number of contour levels for 2D and 3D 
plots.

• Value Blanking Constraints - Link all value-blanking attributes.

It is not necessary to close and reopen the dialog between frames.   Simply select another frame 
while the dialog is open to change the current frame.

Frame Linking Groups

Frames can be segregated into groups so that changes in the linked attributes are propagated only to 
members of that group. By default, all frames are added to Group 1. Add a frame to a group, by 
selecting the appropriate group number from the Frame is a Member of drop-down menu on the 
Between Frames page. New frames added to a group take on the characteristics of previous mem-
bers of the group.

Group = 2

Group = 1

Group = 1

Group = 1

Group = 2 Frame E

Frame A

Frame B

Frame C

Frame D

Contour Levels

X-Axis Range

X-Axis Range

X-Axis Range

X-Axis Range

X-Axis Range
Contour Levels

Contour Levels

Figure 3-6. Five frames in 2 groups with different linking options.

 

Between Frame Link Attributes Propagation to Other Frames
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Once link attributes are set in a frame group, you must set these same attributes in other frames for 
linking to occur. Each frame may have each of the attributes selected or not linked. If you want all 
or a select group of frames to have the same link attributes select the appropriate Apply Settings to 
All Frames button to quickly propagate the link settings. The alternative is to select each frame 
individually, making the same selections on the Set Links for Current Frame dialog.

Attribute Linking Within A Frame
The Within Frame page of the Set Links for Current Frame dialog is shown in Figure 3-7. It allows 
you to link the following attributes:

Figure 3-7. The Within Frame page of the Set Links for Current 
Frame dialog.

When 2D or XY Line frames have dependent axes and the 
axis ranges are linked, Tecplot makes a “best-fit” attempt to 
match the axis ranges between frames. Misalignments can 
occur when the aspect ratios for the lengths of the axes is not 

the same between two frames with linked X- and Y-axes. Setting the X- 
and Y-axes to be independent allows a precise match.
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• Axis Style - Link activation, colors, line styles, font styles for objects associ-
ated with axes.

• Gridline Style - Link activation, colors, line styles for gridlines.

• Zone/Map Color between Plot Layers - Link the color of meshes, contour 
lines, and other zone layers for Cartesian plots, or link the color of lines, sym-
bols and other map layers for line plots.

• Zone Line Pattern between Plot Layers - Link line pattern style and length 
for meshes, vector and contour lines for Cartesian plots.

Propagation to Other Frames

The Apply Settings buttons quickly propagate link settings from the current frame to other frames. 
The alternative is to visit each frames one by one, making the same selections on the Set Links for 
Current Frame dialog.

3 - 4 Workspace Management - Options Menu
The workspace is the region in which you can create Tecplot frames. The paper layout is a subset of 
the workspace and is correlated to the printer settings.

3- 4.1 Paper Setup
Tecplot’s representation of paper in the workspace allows you to lay out plots precisely the way you 
want them printed. If you place a frame on the paper and print the resulting plot, the frame appears 
in the exact relative location on the printed paper.

Keep in mind, Within-Frame linking only links attributes 
between similar objects within a frame. These attributes are not 
linked to other frames. The Apply Settings buttons turn on 

the same Within-Frame linking properties in other frames.

The paper is turned-off by default in Tec-
plot 360. Select Show Paper on Screen in 
the Paper Setup dialog to include the paper.
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You can control the size, orientation, and color of your paper by going to File>Paper Setup.

Figure 3-8. Paper Setup dialog box (accessed via the File or Options 
menus).

Paper Size Controls
Tecplot offers the following six paper sizes:

•  Letter - Standard U.S. letter size, 8 1/2 by 11 inches.

•  Double - Standard U.S. ledger size, 11 by 17 inches.

•  A4 - Standard European letter size, 21 by 29.7 centimeters.

•  A3 - Standard European size, 29.7 by 42 centimeters.

•  Custom 1 - Default is 8.5 by 14 inches.

•  Custom 2 - Default is 8 by 10 inches.

All paper sizes may be customized using options in configuration or macro files. It is recommended 
that you only change the dimensions of the Custom 1 and Custom 2 paper sizes. To change the Cus-
tom sizes see the $!PAPER command in the Tecplot Reference Manual.
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Paper Orientation Controls
Tecplot layouts can be landscape or portrait plots. In landscape (the default), the long axis of the 
paper is horizontal, while in portrait the long axis is vertical. Portrait orientation uses the width of 
the specified paper for the horizontal dimension, while landscape uses this for the vertical dimen-
sion. You specify the orientation as part of paper set-up.

Screen Paper Controls
If you are creating plots for display on your screen you can toggle-off the screen representation of 
the paper and use the full workspace, by deselecting “Show Paper on Screen”.

Dimensions (display only). 
The units displayed in the Dimensions region of the Paper Setup dialog are determined by the units 
established in Options>Ruler/Grid.

Paper Color Controls
You can set up your paper to show any of Tecplot’s colors as a background color (the “paper fill 
color”) on your screen, as well as use that color when printing to a color printer. When you are 
printing, Tecplot can flood the paper with your specified fill color. (By default, the paper fill color 
is ignored during printing.) To use the paper fill color when printing: select Use Paper Fill Color 
when Printing from the Paper Setup dialog.
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3- 4.2 Grid and Ruler Set-Up
The workspace grid provides a convenient guide for placing objects on your paper. When placing 
text or geometric shapes, you can choose to snap the anchor points of the shapes to the grid. Rulers 
provide a reference length for sizing objects. 

Workspace Grid Controls
Tecplot allows you to select grid spacing from several pre-set sizes in centimeters (cm), inches (in), 
or points (pt) via a drop-down menu. You can also specify not to show the grid by toggling-off 
“Show Grid”. 

Workspace Ruler Controls
Tecplot allows you to select the ruler markings from several pre-set sizes in centimeters (cm), 
inches (in), or points (pt) via a drop-down menu. You can also specify not to show the grid by tog-
gling-off “Show Ruler”. When “Show Ruler” is toggled-on, rulers appear on the bottom and right-
hand sides of the workspace.

3- 4.3 Show Invisible Frame Borders
Select Show Invisible Frame Borders from the Options menu to temporarily turn-on dashed lines at 
all invisible frame borders.

The grid is not shown if “Show Paper on 
Screen” or “Show Grid” are deselected.

Figure 3-9. Ruler/Grid dialog box (accessed via the Options menu)
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3- 4.4 Show Sidebar or Toolbar
You may turn off the Sidebar by going to Options>Sidebar>None. Similarly, you may turn the Side-
bar on, by going to Options>Sidebar>Standard.

You may turn off or on the Toolbar by selecting Options>Toolbar.

3 - 5 View Modification
Use the View menu to adjust the view of the current frame or to adjust the view of the entire work-
space. The View menu are discussed in the following subsections.

3- 5.1 Redraw Frame
When Auto Redraw is toggle-off, go to View>Redraw Frame, select the Redraw Frame button from 
the Sidebar or type CTRL+R to redraw the current frame.

3- 5.2 Redraw All
When Auto Redraw is toggle-off, go to View>Redraw All, select the Redraw All button from the 
Sidebar or type CTRL+D to redraw all frames in the workspace.

3- 5.3 Zoom
There are two zoom modes – axis (data set) zooming and paper zooming. 

Plot Zooming

Activate plot zooming, by selecting View>Zoom or the  button from the toolbar. Drag the 

magnifying glass cursor to draw a box. The region within the view box will be resized to fit into the 
frame according to the longest dimension of the view box. If Snap to Grid is selected (from the 
Sidebar), you cannot make the zoom box larger than the grid area. 

To return to the previous view: Select Last 
(CTRL+L) from the View menu or Undo 
(CTRL+Z) form the Edit menu. 
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Paper Zooming
Shift+drag the magnifying glass cursor to draw a box about the region that you want to magnify. 
The plot is resized such that the longest dimension of the zoom box fits into the workspace. 

Mouse Zoom and Translation
The middle and right mouse buttons allow you to smoothly zoom and translate data. Your middle 
mouse button (CTRL+right click) zooms smoothly, and your right mouse button translates data. 
(Refer to the Quick Reference Guide for additional functionality.)

3- 5.4 Fit to Full Size
 View>Fit to Full Size (CTRL+F) resizes plots so all data points, text, and geometries are included 
in the frame. Use Fit to Full Size to restore the initial view of your data after extensive zooming, 
scaling, or translating. Tecplot performs the Fit to Full Size operation when it first displays your 
data set.   Use View>Data Fit to neglect text and geometry in the resizing.

3- 5.5 Data Fit
View>Data Fit resizes the plot so all data points are included in the frame. Text and geometries are 
not considered. Use View>Fit to Full Size to include text and geometry in the resizing.

3- 5.6 Nice Fit to Full Size
View>Nice Fit to Full Size (CTRL+N) is available for 2D Cartesian, XY Line, and Sketch plot types 
only.    The command sets the axis range to begin and end on major axis increments (If axes are 
dependent Tecplot adjusts the vertical axis length to accommodate a major tick mark)

3- 5.7 Make Current View Nice
View>Make Current View Nice (CTRL+K) is available for 2D Cartesian, XY Line, and Sketch plot 
types only.    The command modifies the range on a specified axis to fit the minimum and maxi-
mum of the variable assigned to that axis, then snaps the major tick marks to the ends of the axis. (If 
axis dependency is not independent this may affect the range on another axis.)

Alternatively, You can fit one or all frames 
to the workspace by using the Fit Selected 
Frames to Workspace or the Fit All Frames 
to Workspace options of the View>Work-
space menu. 
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3- 5.8 Center
Centers the plot within the frame. Only the data is centered; text, geometry and the 3D axes are not 
considered. Neither the axes nor the plot is changed in size.

3- 5.9 Translate/Magnify
The Translate/Magnify dialog (accessed via the View menu), allows you to move and resize your 
plot within a frame (Figure 3-10). Translating from the dialog box moves the image of your data in 
respect to the current frame. You can translate plots in any direction within a frame. 

Figure 3-10. Translate/Magnify dialog 
accessed via the View menu.

The following options are available in the Translate/Magnify dialog-

• Up, Down, Left, Right - Use the arrows to translate the image.

• Magnification Factor - Change magnification using the arrows, or enter a 
value in the text field.
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• Step Size (%) - Control the step size for each arrow using pre-set ranges from 
the drop-down or by entering your own value.

 The Translate/Magnify tool  (located in the toolbar) allows you to translate/magnify the data 

within the frame or the entire workspace. Use the SHIFT key to translate/magnify the workspace 
instead of the data.

When the Translate/Magnify tool is active, type +/- on your keyboard to increase/decrease the scale 
of the image.

3- 5.10 Last
 View>Last (CTRL+L) restores the previous view. The Last command allows you to step backward 
through the resizings and repositionings of plots. Any time you change the view of a frame, either 
by zooming, centering, translating, or fitting the plot, the previous view is placed in a view stack. 
Each frame is allotted four view stacks, one for each plot type. Each view stack stores the last six-
teen views for that plot type. 

3- 5.11 Rotate
(3D Cartesian plot type only): Calls up the Rotate dialog for image rotation. For further informa-
tion, see “Three-Dimensional Rotation” on page 27

3- 5.12 3D View Options
(3D Cartesian plot type only): Calls up the 3D View Details dialog for setting the view position and 
angle of 3D images. For further information see “Three-Dimensional Rotation” on page 27.

3- 5.13 Copy View 
Use the View>Copy View menu option to copy the current frame view to the frame view buffer, 
where it can then be pasted to other frames having the same plot type. The copied view includes all 
the attributes of the view that are affected by View menu – the amount of zoom, translation and 
scale, and, in 3D Cartesian plot type, the amount of rotation and perspective projection.

To use the Magnify tool on the workspace, hold the SHIFT 
key and click on the workspace. Then, use the + or - keys on 
the keyboard to change the magnification of the workspace. 
Single-click on the data to change the mode back to data set 

magnification.
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3- 5.14 Paste View
View>Paste View (CTRL+A), pastes a copied view onto the current frame When you are working 
with multiple frames attached to the same data set, it is often useful to make your view changes to 
one frame, and then propagate those changes to the other frames.

3- 5.15 View>Workspace Options

• Fit Selected Frames to Workspace (CTRL+SHIFT+S) - Resizes all frames 
proportionally so that the selected frame(s) fill(s) the workspace either verti-
cally or horizontally.

• Fit All Frames to Workspace (CTRL+SHIFT+F) - Resizes all frames propor-
tionally so that all frames fill the workspace either vertically or horizontally.

• Fit Paper to Workspace (CTRL+SHIFT+P) - Resizes paper to fill the work-
space

• Last Workspace View (CTRL+SHIFT+L) - Restores the workspace to the pre-
vious view. The command undoes the last: 

• Shift-Magnify
• Fit Selected Frames to Workspace
• and/or
• Fit All Frames to Workspace

• Maximize Workspace (CTRL+SHIFT+M) - Maximizes the work area view 
by suppressing the Tecplot menu bar, status bar, and sidebar. To restore the nor-
mal view, click anywhere in the maximized workspace

3 - 6 Edit Menu
Duplicate frames, text, and geometries with the copy and paste options of the Edit menu (or their 
keyboard equivalents). You can also cut objects from one location and paste them into another, or 
throw them away completely. 

3- 6.1 Undo
Tecplot can undo all plot and mapping style modifications. In addition, Tecplot allows you to undo 
a variety of other plot alterations. As a rule, Tecplot allows undo for reversible operations that can 
be restored without significant impact on the operation’s performance. To undo an operation, select
Undo from the Edit menu, or press CTRL+Z in the workspace.
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Specifically, the Undo option is allowed for the following conditions:

•  All zone and map style changes.

•  Some (though not all) frame control operations, push and pop.

•  Creating new frames.

•  Moving and Copying line maps

•  View operations.

•  Some pick operations.

•  Streamtrace actions.

• The following data alterations:

• Deleting zones and variables.
• Renaming data sets and zones.
• Creation of rectangular or circular zones.
• Duplication of zones.
• Equation processing. (Except equations containing derivatives.)

Note: Undo is unavailable for all data operations once an 
Undo operation has been performed on an un-allowed item. 
In addition, once an operation is performed that cannot be 
undone, the entire undo history for that frame is erased
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3- 6.2 Select All
To select all geometries, zones, text or streamtraces in a frame, choose the Select All option from 
the Edit menu. The Select All dialog box allows you to specify whether to select all: frames, zones, 
text, geometries and/or streamtraces.

3- 6.3 Quick Edit
Refer to Section 1- 2.6 “Quick Edit Dialog” on page 35

3- 6.4 Push
Push the selected item to the bottom of the current draw stack. The Tecplot plot is drawn on your 
screen from the bottom of the draw stack to the top; elements lying further down in the stack may 
be partially obscured by elements higher up. The following types of objects may be pushed: text, 
geometries, 2D or X-Y grid areas, frames.

3- 6.5 Pop
Pop the selected item to the top of the current draw stack. The following types of objects may be 
popped: text, geometries, 2D or X-Y grid areas, frames.
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3- 6.6 Cut
Edit>Cut or CTRL+X, removes the selected item from the plot, and the current data set (if applica-
ble), and stores the removed item in the Paste buffer.

3- 6.7 Copy
Edit>Copy or CTRL+C stores the selected item in the Paste buffer. The Paste buffer is specific to 
Tecplot.

3- 6.8 Paste
Use Edit>Paste or CTRL+V to add the contents of the Paste buffer to the current plot. Pasting an 
object into the same frame that it was cut or copied from copies the object to the location it came 
from, that is, the new copy is placed directly on top of the original object. Use the Selector or the 
Adjustor tool to move the copy to different locations in the frame.

Note: Pasting from the Paste buffer is allowed only between compatible frames. Attempting to 
copy an object into a frame that does not hold an appropriate data results in an error message.

3- 6.9 Clear
Remove the selected item from the plot and from the current data set.   Cleared items are not stored 
in the Paste buffer.

In Windows and Macintosh platforms, the Cut, Copy, and 
Paste options work only within Tecplot. However, the Edit 
menu’s Copy Plot to Clipboard, option allows you to copy Tec-
plot frames and paste them into other applications. See Section 

24 - 4, “Clipboard Exporting to Other Applications,” for a discussion of this 
feature.

If you cut or clear the last Tecplot frame, 
Tecplot automatically creates another frame 
to replace it.
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Chapter 4 Creating Plots

The basic steps for creating a plot in Tecplot are:

1. Define your data set using one of the following methods: 
a. This is typically accomplished by using the Load Data File(s) com-

mand from the File menu. Please refer to Appendix E “Data Loaders” 
on page 633 for information on working with a specific data loader.

b. Use the Open Layout command from the File menu to load linked 
layout or layout package files.   (See 22 - 1 “Layout Files, Layout 
Package Files, Stylesheets” on page 448 for more information on lay-
out files). 

c. Use any combination of the options in the Create Zone submenu of 
the Data menu or the Insert menu to create your data sets directly 
within Tecplot. 18 - 6 “Zone Creation” on page 310 and Chapter 21 
“Text, Geometries and Images” on page 419 for more information.

2. Select the Plot Type (3D, 2D, XY Line, Polar Line or Sketch) from the Sidebar

3. Toggle-on any mapping or zone layers from the Sidebar (e.g. contour zone 

layer or symbols mapping layer). Use the details buttons ( ) to customize 
zone layers. 

4. Use the options in the Plot menu (such as Blanking or Axis Details) to custom-
ize how your data is displayed

5. Use the options in the Data menu (such as Equations or Interpolation) to alter 
the data set.
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6. [3D only] toggle-on zone effects (translucency and lighting). Use the Zone 
Style or Mapping Style dialogs to opt zones in and out of plot layers or the 
entire plot. See 

7. [2D or 3D only] add derived objects (slices, streamtraces or iso-surfaces). Use 

the details buttons ( ) to customize any derived objects.

You are not limited to working with only one plot at a time in Tecplot. You can create multiple files 
at one time using frames and frame linking. See 3 - 3 “Frames” on page 65 for more information.

4 - 1 Data Journaling
Data is often loaded into Tecplot from external sources, such as data files. On occasion you may 
modify this data prior to making a final plot. Some (but not all) of the data operations mentioned in 
this chapter modify data. Tecplot simultaneously “journals” the corresponding instructions. If you 
then save a layout file, it can reference the original data and include in the layout the instructions 
necessary to reconstruct the final data used for plotting.

If you perform an operation that Tecplot that it is unable to journal, then you are prompted to save 
the data set to a new file when you save a layout file. This is necessary for the layout to reproduce 
exactly what you have in your plot.

Tecplot journals the following operations:

•Data alteration (except for derivatives).
•Creation of rectangular zones, circular zones, and 1-D zones from within Tecplot.
•Zone duplication.
•Zone deletion.

The Data Journal is displayed on the Journal page of the Data Set Information dialog (accessed via 
the Data menu). See 4- 3.4 “Journal Page” on page 95 for more information.

4 - 2 Data Sharing
In order to conserve computer memory and disk space, Tecplot shares variables between zones 
whenever possible. Variable sharing typically occurs with any of the following scenarios:

•  When a variable is calculated for two or more zones, Tecplot determines if the 
results will be the same in the different zones, and shares the variable where appro-
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priate. See 18- 1.1 “Equation Syntax” on page 294 and  “Variable Sharing Between 
Zones” on page 302.

•  When zones are duplicated, all variables are shared between the source zones and 
their duplicates. See 18- 6.4 “Zone Duplication” on page 315.

•  When mirrored zones are created See 18- 6.5 “Mirror Zone Creation” on page 315.

•  When a data loader supporting data sharing (Tecplot, Plot3D, Fluent, CGNS, etc.) 
loads a variables that is identified for two or more zones. This often occurs with time 
dependent data, where the physical coordinates are the typically the same for all time 
steps.

If a zone is altered (independently of zones it is sharing data with) any variable that is changed will 
no longer be shared.

Variable sharing can also be established in a Tecplot data file, using the VARSHARELIST parame-
ter. See  Variable Sharing between Zones in the Data Format Guide.

The Sharing page of the Data Set Information dialog allows you to determine which variables are 
currently shared in your data set. See 4- 3.3 “Data Sharing Page” on page 94.

4 - 3  Data Set Information
The Data Set Information dialog, accessed from the Data Set Info option on the Data menu, gives 
summary information about the current data set, including the data set title, zone and variable 
names, and the minimum and maximum values of a selected variable. You can modify the data set 
title, zone and variable names of any data set. The dialog has the following pages: Zone/Variable 
Info Page, Data Set Page, Data Sharing Page, Journal Page and Auxiliary Data Page.
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4- 3.1 Zone/Variable Info Page
The following information is provided on the Zone/Variable Info page:

• Zone(s) - Lists all zones by number, with their titles. Select one zone to display 
its name in the Zone Name field, where the zone name can be modified.

• Zone Name - Enter a new name for a selected zone.

• Zone Type (Ordered or FE data) - Displays the type of zone selected in the 
Zone(s) listing. For ordered data, it is followed by the index values for IMax, 
JMax and KMax (shown below). For finite-element data, it is followed by the 
element type, number of points, and number of elements (see below).

• IMax (ordered data) - Displays the IMax value of the zone selected 
in the Zone(s) listing.
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• JMax (ordered data) - Displays the JMax value of the zone selected 
in the Zone(s) listing.

• KMax (ordered data) - Displays the KMax value of the zone selected 
in the Zone(s) listing.

• Pts (finite-element data) - Displays the number of data points in the 
zone selected in the Zone(s) listing.

• Elem (finite-element data) - Displays the number of elements in the 
zone selected in the Zone(s) listing.

• Solution Time (Read-only) -displays the solution time for the selected zone.
(see also 6 - 2 “Time Aware” on page 157).

• Strand-ID (Read-only) - displays the Strand-ID for the selected zone. (see 
also 6 - 2 “Time Aware” on page 157).

• Variable(s) - Lists all variables by number, with their names. Select one vari-
able to display its name in the Variable Name field, where the name can then be 
modified.

• Variable Name - Enter a new name for a selected variable.

• Var Type - Displays the type of data of the selected variable in the Variable(s)
field.

• Var Location - Indicates if variables are located at nodes or cell-centers.

• Var Status - Use the Var Status field in the dialog to determine the status of 
the current variable. The variable status can indicate the variable passivity, lock 
state, and additional system state information.

• Var Range-Selected Zone - Displays the Min and Max values for the selected 
variable in the selected zone.

• Var Range- Active Zone(s) - Displays the Min and Max values for the 
selected variable for all active zones.

• Load Variables - If a variable was not initially loaded into Tecplot, “Not 
Loaded” will be displayed in Var Range portions of the dialog. Use the Load 
Variables button to load any variables from your data set that were not initially 
loaded. See “Load On Demand” on page 552 for more information.
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4- 3.2 Data Set Page
On the Data Set page are:

• Data Set Title - Enter a title for the current data set, or edit an existing title. 
The default is the result of concatenating the titles specified in each Title
record encountered in the data files making up the data set.

• Data File(s) - Lists the names and paths of all external data files making up the 
current data set.

• Num Zones - Number of zones in the data set.

• Num Vars - Number of variables in the data set.

• Total Elements - Total number of elements in the data set.
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• Var Load Mode - Depending on the method used, this displays either By Posi-
tion or By Name.

• Locked By - This field will inform you if the current data set has been locked 
by an add-on. Add-ons can lock a data set which in turn prevents your from 
deleting zones or deleting the last frame associated with the data set.

4- 3.3 Data Sharing Page
On the Sharing page are:

• Zone - Use the drop-down to select the which zone to display its shared vari-
ables.

• Variable - Use the drop-down to select the appropriate variable.
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• Variable is Shared in Zone(s) - This list box displays and allows you to select 
individual shared variables.

• Connectivity Shared with Zone(s) - This list box displays and allows you to 
select specific connectivity lists.

4- 3.4 Journal Page
On the Journal page are:

• Journaled data list box - Lists currently journaled data.

• List Commands - Briefly summarizes actions in Tecplot as they apply to the 
data set.
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• Expand Commands - Displays the commands above in detail, including such 
things as the zone number, variable, and value.

4- 3.5 Auxiliary Data Page
On the Aux Data page are:

• Show Auxiliary Data - Use the drop-down to display auxiliary data for zones, 
data sets, frames or names.

• Data Name/Value - Displays the names and values of any auxiliary data.

See   for more information.
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4 - 4 Select Color
In Tecplot, each attribute of your plot can be set to a different color or color type using the Select 
Color dialog

Figure 4-1. Use the Select Color dialog to apply a basic color, contour variable 
color or RGB color to the selected plot attribute.

. 

There are 3 types of color assignments in Tecplot: 

•  Contour Groups - The Contour Variables (Multi C1, C2, C3, and C4) are 
defined in the Contour Details dialog and the coloring is defined by the Global 
Color Map. The Contour Variables are typically used for coloring mesh, con-
tour, vector, and scatter layers.

• RGB Coloring - Select RGB to use the RGB color map established in 
Plot>RGB Coloring>Variables/Range. RGB coloring is used to illustrate the 
relationship between 2 or 3 variables in your data set, by setting R, G and B to 
each of the variables.

• Basic Color Palette - Use the basic color palette to apply a single, constant 
color to a plot attribute.
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For example, you can create a 3D field plot with a contour layer (with colors defined by a contour 
variable), an edge layer (with colors from the basic color palette) and a vector layer (with colors 
defined by RGB vectors).

4- 4.1 Global Color Map
The colors used to display contour variables are determined by the global color map, controlled in 
the Options menu. By default, Tecplot uses a color map called Small Rainbow, which is a rainbow 
of colors from blue to cyan to green to yellow to red. 

To select a color map, select Color Map from the Options menu. 

You can modify any color map, except the Raw User-Defined color map, using the controls in the 
Color Map dialog. The Color Map dialog (Figure 4-2) has the following options:. 

Figure 4-2. The Color Map dialog.

The color map is used by all frames; if you change the color 
map to modify the look of one frame, all frames with contour 
flooding or any form of multi-colored are modified as well.
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• Link All Color Maps Together - When on, each color map group (1-4) use the 
same settings. When off, each color map group can have different attributes.   If 
Link All Color Maps Together is toggled-on when different color map groups 
are set, all color maps inherit the settings of the current color map displayed in 
the dialog.

• Color Map Number - Color maps can be set for up to four groups. The 
attributes for each group are established by selecting a color map number and 
making changes in the Color Map dialog. The Color Map Number buttons are 
available when Link All Color Maps Together is toggled-off.

• Base Color Map - Select one of the following color maps:

• Small Rainbow - Five point color spectrum from blue to cyan to 
green to yellow to red.

• Large Rainbow - Seven point color spectrum from blue to cyan to 
green to yellow to red to purple to white.

• Modern - Seven point color spectrum; within each color band colors 
change in intensity from dark to light.

• Gray Scale - Color spectrum from black to white.
• Wild - random Color spectrum. Wild is different each time you select 

it.
• Two Color - A two-color spectrum.
• User-Defined - A version of one of the first four options above that 

can be customized by the user. You can add or delete control points, as 
well as change RGB values for each control point. 

• Raw User-Defined - A version of one of the first four options above 
that can be customized by the user. To customize the color map, how-
ever, you must save your Raw User-Defined map to a file using the 
Copy Color Map to File option in the Options menu. Then edit the 
resulting file, which consists of RGB triplets for every color in the 
spectrum. You can modify these RGB triplets as you want, using any 
ASCII text editor. See also“Color Map Files” on page 100.

• Color Spectrum - Altering the position of the control points allows you to alter 
the proportions of colors in the spectrum. Click-and-drag control points to 
adjust the range of the color spectrum. CTRL+click-and-drag the control points 
to adjust the positions of the control points.
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• RGB Values for control point x - In lieu of manually adjusting the control 
points, specify precise RGB values for control point “x” using the RGB sliders. 
Modifying the RGB values of the control points changes the spectrum itself. 

• Right RGB same as Left - Toggle-on to define smoothly varying color maps 
for each two-sided control point (any control point except the first or last). Tog-
gle-off to define sharp demarcations between color bands. 

• Number of Control Points - Available for the User-defined Color Map only, 
use this field to adjust the number of control points.   If you enter a number less 
than the current value, the control points are removed from right to left.

• Color Standard Color Map (user-defined and raw user-defined only) - Use this 
button to reset the color spectrum to either Small Rainbow, Large Rainbow, 
Modern or Grayscale. 

• Redistribute Control Points - Select this button to return the control points to 
their original positions.

• Reset - Select this button to reset the RGB values to their original values (and 
also reposition the control points in their original locations).

Color Map Files
The position of color map control points and their RGB values can be stored in color map files; you 
can then edit the color map files to modify either the position or RGB values of the control points.

To create a color map file, select Copy Color Map to File from the Options menu. The resulting file 
includes the RGB triplet values for each point in the color spectrum and can be edited with any 
ASCII editor.

To use the saved color map in a new plot, choose Paste Color Map from File on the workspace 
menu. The color map file is a Tecplot macro file with a limited set of commands (only $!COLOR-
MAP and $!COLORMAPCONTROL commands are allowed).

4- 4.2 RGB Coloring
RGB coloring occurs when Red, Green, and Blue values are supplied at each vertex. It may be used 
to create special flooding such as for Oil/Water/Gas or vector direction plots. RGB coloring may be 
used for each field plot object in Tecplot: zone layers, the mesh or contour layer for streamtraces or 
iso-surfaces, or any of the layers for slices. This affects multi-coloring for that object as well as any 
contour flooding. With RGB coloring, multi-colored objects such as vectors or scatter symbols 
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have their color determined based on the RGB components of the field variables at their location. 
Multi-colored mesh and contour lines use the average value across the mesh line.

RGB Coloring Options
If your data has only two RGB variables, or if the sum of the variables is not normalized, you can 
adjust the settings using the RGB Coloring Options dialog (accessed via Plot> RGB Coloring>Vari-
ables/Range). The RGB Coloring Options dialog (Figure 4-3) has the following options:

Figure 4-3. The RGB Coloring Options dialog.

• RGB Mode - You can either specify all three variables or specify 2 of the three 
variables and calculate the third. The third variable is calculated using the fol-
lowing formula f(R)+f(G)+f(B)=1.0 (assuming f() is a function that maps 
R,G,B values into [0,1.0]).

• Channel Variables - Assign the variables which supply the values for the 
color components, as specified in the RGB Mode.

Note: Exported Vector-Based Files Limitation in RGB Col-
oring. Vector-based export files such as WMF cannot show 
continuous RGB flooding. Objects that use RGB flooding 
are reduced to contain average cell flooding where each cell 

is flooded a solid color based on the averages of the RGB values at each ver-
tex. The user is warned before such output is generated.
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• Channel Variable Range - By default, it is assumed that the minimum value 
for any of the Channel Variables is zero, the maximum is one, and the sum of 
the three variables is one at every point. If the sum is not normalized, you can 
set a new minimum and maximum. For example, if your variables sum to 100 
at every point, you can enter 100 in the field for Value at Maximum Intensity.

RGB Legend
To create an RGB legend, select RGB Coloring>Legend from the Plot menu. The RGB Legend is 
not available unless RGB coloring is in use. The RGB Legend dialog has the following options:

• Show RGB Coloring Legend - toggle-on to include a RGB legend in your plot.

• X(%), Y(%) - Specify the position of the anchor point as percentages of the 
frame width and height. (You can also move the legend interactively.)

• Height (%) - Specify the height of the legend in frame units.

• Orientation - Select the order of the coloring channels (i.e. RGB, GBR, BGR 
etc.). The first channel listed is shown on the lower left corner, the second on 
the lower right, and the third at the top.

• Anchor - Select the Anchor button to call up the Anchor Alignment dialog and 
specify which part of the legend is anchored to the position specified in X(%)
and Y(%).

• Show Text Labels - toggle-on to include text labels in the legend. Use the 
Color and Font buttons to modify the labels.

• Red, Green and Blue Label - Each channel can be labeled by the name of the 
assigned variable, or by text you enter. To choose a new label for a channel, 
click Specify, and type in the alternate label. When a channel has been calcu-
lated (no variable assigned), no label is shown unless the user enters text.

• Legend Box - Select which kind of box you want drawn around the legend (No 
Box, Filled, or Plain). If you choose Filled or Plain, format the box using the 
following controls:

• Line Thickness - Specify the line thickness as a percentage of frame 
height.

• Box Color - Choose a color for the legend box outline.
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• Fill Color (Filled only) - Choose a color for the legend box fill.
• Margin - Specify the margin between the legend text and legend box 

as a percentage of the text height.

4- 4.3 Basic Color Palette

Figure 4-4. The Basic Color Palette region of the Select Color dialog.

Use the Basic Color Palette to define a constant color to the selected plot attribute(s). You may 
redefine a color in the Basic Color Palette with the Color Preferences Dialog, accessed via 
File>Preferences>Colors.
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Chapter 5 XY and Polar Line Plots

A line plot is the simplest type of graph produced by Tecplot. A line plot includes a dependent vari-
able (typically the vertical axis, for XY plots) and an independent variable (typically the horizontal 
axis, for XY plots). Each line on the line plot represents one series of data points, where each data 
point is defined by its independent and dependent variable values. A series of data points is referred 
to as a mapping (or map, for short).

Tecplot supports two types of line plots, XY plots and Polar plots. XY plots are plotted on Carte-
sian coordinates using X & Y as the independent and dependent variables (See “Axis Range Modi-
fication for Polar Axis” on page 262). XY plots can include line, symbols, bar and/or error bar 
layers. Polar plots are plotted on polar coordinates using Theta and R values. Polar plots can 
include line and/or symbol layers.  

 An example of XY and Polar Line plots is shown in Figure 5-1.
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Figure 5-1. A plot of speed versus angle in Tecplot’s XY Line (left) and 
Polar Line (right) plot types.

Line plots are usually created from one-dimensional, I-ordered data.   The data used for line plots 
must have at least two variables defined at each data point. The same number of variables must be 
defined at each data point. 
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You can also create line plots from two- or three-dimensional data in the IJ- or IJK-ordered struc-
ture, or from finite-element data by selecting “XY Line” from the plot type menu in the Sidebar. In 
this case, finite-element data sets will be treated as I-ordered (the connectivity list is ignored), IJ-
ordered data sets will treated as a family of J-sets of I-ordered data, and IJK-ordered data sets will 
be treated as K-planes of J-families of lines. Use the Indices page of the Mapping Style dialog to 
select different ranges and skip intervals for the I-, J-, and K-indices. See Section 5 - 8, “I-, J- and 
K-Indices,”later in this chapter for more information.

When you create a line plot, Tecplot assigns colors, symbol types, and line patterns to each map-
ping. These and other line plot attributes can be changed using the pages of the Mapping Style
dialog. To bring up the Mapping Style dialog, go to the Plot menu and select Mapping Style, or 
select the Mapping Style button on the sidebar.

5 - 1 Map Creation
Line plots are composed of the graphs of one or more pairs of variables (XY pairs in XY Line plots 
or Theta-R pairs in Polar Line plots). These pairs and their dependency relations are referred to as 
mappings in Tecplot. Mappings are defined for each frame; the same data set can have a different 
set of mappings in each frame it is attached to.

Mappings can include any combination of the following mapping layers:

• Lines - Can be drawn as linear segments or curve that fit the data points.

• Symbols - Each data point is represented by a symbol.

• Bars (XY only) - Each data point is represented by a vertical or horizontal bar

• Error Bars (XY only) - Error bars are drawn for each data point. The error bar 
value is determined by a third variable.

XY Line plots can have up to five x-axes and five y-axes simultaneously. Polar Line plots can have 
only one Theta-axis and only one R-axis.
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To define a new mapping, select the Create Map button in Mapping Style dialog. The Create Map-
pings dialog for each line plot type is shown in Figure 5-2.

Figure 5-2.  Create Mappings dialogs for XY Line plots (left) and for Polar Line plots (right).

In XY Line plots, you have the following options:

• X-Axis Var versus Y-Axis Var for One Zone (default) - Add a single 
mapping with one X- and one Y-variable for one zone. 

• X-Axis Var versus Y-Axis Var for All Zones - Define one map for each zone, 
with the specified X-axis and Y-axis variables. If you choose this option, you 
specify only the X-axis and Y-axis variables.

• X-Axis Var versus All Other Variables - Create a new set of mappings using 
one variable as the X-variable and each of the other variables as Y-variables.

• Y-Axis Var versus All Other Variables - Create a new set of mappings using 
one variable as the Y-variable and each of the other variables as X-variables. 

The options for polar line plots are with respect the theta-axis and r-axis variables.

Once you have selected a mapping option, you have the option to specify a mapping name and the 
axis variables.
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• Mapping Name - Enter a name for the mapping in the Mapping Name text 
field. The default name is “Map n,” where n is the number of the mapping to be 
created.

When you first read an ordered data set, Tecplot defines some mappings for you. If your data set 
has more than two variables, Tecplot creates mappings that associate the first variable with each of 
the other variables for the first zone only. 

5 - 2 Mapping Style
Use the Mapping Style dialog to set attributes for lines, symbols, and in XY Line plots, bar charts 
and error bars. You can also make many of these changes using the Quick Edit dialog (accessible 
from the Edit menu or the sidebar). You can set the style of any mapping independently of all other 
mappings, and regardless of whether that mapping is activated or deactivated. 

The options in the first three columns (Map Num, Map Name and Map Show) are globally applied 
to the active frame and independent of the page of the dialog box.

• Map Num - Use the Map Num button to select one or more maps according to 
their map number(s).

• Map Show - Each mapping can be opted in and out of a plot using one of the 
following options:

• Activate - Turns selected mappings on (denoted with “Yes” in the 
Map Show column). 

• Deactivate - Turns selected mappings off (denoted with “No” in the 
Map Show column).

• Show Selected Only - Turns on selected mappings, and turns off all 
other mappings.

• Invert - Switches the current activation settings for the selected 
map(s).

• Map Name - Use the Map Name button to access on of the following options:

• Select by Name - use the Enter Text String dialog to select mapping(s) 
by name. You may use wildcards (*) and partial names to select a 
grouping of mappings at once.

• Edit Name - use the Enter Mapping Name dialog to change the name 
of the selected mapping.
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Enter Mapping Name
Tecplot assigns each mapping a name. The nature of the name varies with the type of data used to 
create the mapping. If your data has only one dependent variable, the default is to use the zone 
name for the mapping. If your data has multiple dependent variables, then the default is to use the 
dependent variable name for the mapping. You can modify any mapping’s name using the Enter 
Mapping Name dialog. This dialog is accessible from the Mapping Style dialog by selecting “Edit 
Name” from the Map Name drop-down. The Enter Mapping Name dialog is shown in Figure 5-3.

Enter a new name for the selected mappings, or construct a new name from text you enter and/or 
one or more of the pre-defined options:

• Zone Name - Adds the string “&ZN&” to the Map Name field, which is then 
replaced with the actual name of the zone assigned to that mapping.

• Zone Number - Adds the string “&Z#&” to the Map Name field, which is then 
replaced with the actual number of the zone assigned to the mapping.

• Independent Var - Adds the string “&IV&” to the Map Name field, which is 
then replaced with the actual name of the independent variable assigned to that 
mapping.

Figure 5-3. Enter Mapping Name dialog, accessed via the Map Name 
button in the Mapping Style dialog.
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• Independent Var Number - Adds the string “&I#&” to the Map Name field, 
which is then replaced with the actual number of the independent variable 
assigned to the mapping.

• Dependent Var - Adds the string “&DV&” to the Map Name field, which is 
then replaced with the actual name of the dependent variable assigned to that 
mapping.

• Dependent Var Number - Adds the string “&D#&” to the Map Name field, 
which is then replaced with the actual number of the dependent variable 
assigned to the mapping.

• Map Number - Adds the string “&M#&” to the Map Name field, which is then 
replaced with the actual number of the mapping.

• X-Axis Num - Adds the string “&X#&” to the Map Name field, which is then 
replaced with the actual number of the X-axis assigned to that mapping for XY 
Line plots. For Polar Line plots, this option is not available.

• Y-Axis Num - Adds the string “&Y#&” to the Map Name field, which is then 
replaced with the actual number of the Y-axis assigned to that mapping for XY 
Line plots. For Polar Line plots, this option is not available.

In addition to the above items, any 
dynamic text item can be added to the Map 
Name field. See 21- 1.4 “Dynamic Text” 
on page 426 for more information on 
Dynamic Text.
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5- 2.1 Mapping Definitions
Existing mappings are edited with the Plot menu’s Mapping Style dialog. From the Definitions
page of the Mapping Style dialog, you can perform the following tasks: modify names; activate 
and deactivate mappings; assign axis variables; assign zones; sort data points in a mapping; control 
the mappings appearance in the line plot legend; and for XY Line plots, assign particular X- and Y-
axes.

In general, select mappings you want to change, and then select the appropriate button above the 
list of mappings. Some buttons call up drop-downs; others call up dialogs. You may change map-
pings whether they are shown on the plot or not (activated or deactivated).

• A - Axis Variable (where A = X,Y, Theta or R) - The choice of variables is the 
heart of the mapping. Each mapping is defined by two variables: X and Y in 
XY Line plots and Theta and R in Polar Line plots. You may change the vari-
ables assigned to a mapping using the Mapping Style dialog.

• Zone Selection - Each mapping uses variable values from a specified zone. If 
your data set has multiple zones, specify the zone for each mapping using the 
Zone button.

• Data Point Sorting - By default, mappings are sorted by the order they occur 
in the data file. You can change this order with the Sort option on the Defini-
tions page of the Mapping Style dialog. The Sort options are:

• None - Default behavior of sorting by the order in the data file.
• By Independent Variable - Points are sorted in ascending order of the 

values of the independent variable.
• By Dependent Variable - Points are sorted in ascending order of the 

values of the dependent variable.
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• By Specify Variable - Select a variable from the Select Variable dia-
log. The points of the selected mappings are sorted in ascending of the 
values of this variable.

• XY Line Plot Axis Assignment - XY Line plots support five X-axes (X1-X5) 
and five Y-axes (Y1-Y5). Newly created mapping use the X1- and Y1-axes. 
You can change these assignments, using the Which X-Axis and Which Y-Axis
fields on the Mapping Style dialog.

The ranges and scales for each axis are defined in the Axis Details dialog 
(accessed via the Plot menu).

By default, Tecplot places axis X1 at the bottom of your axis grid area, and sub-
sequent X axes at the top. Similarly, it places axis Y1 at the left of your axis grid 
area and subsequent Y-axes at the right. Thus, in Figure 5-4, the Seattle rainfall 
observations are shown along axis Y1 at the left of the axis grid area, while the 
error observations are shown along Y2 at the right.

Only Line Segment and ParaSpline are affected by the Sort 
options. Splines are always sorted by the independent variable. 
See Section 5 - 4, “Curve Types,”for more information on 
curve types.
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Figure 5-4. An XY Line plot using two Y-axes.
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You can also use multiple axes to cycle through mappings with different ranges 
or axis settings. You may find it convenient to assign different mappings to dif-
ferent axes so that you can set axis ranges, axis positions, or other axis attributes 
independently for each mapping.

• Show in Legend - By default, all active mappings appear in the line legend. 
However, the legend only lists mappings with identical entries once. (See Sec-
tion 5 - 9, “Line Legend,” for details on the Line Plot Legend.) The Show in 
Legend button has three options:

• Always - The mapping appears in the legend even if the mapping is 
turned off (deactivated) or its entry in the table looks exactly like 
another mapping’s entry.

• Never - The mapping never appears in the legend.
• Auto - The mapping appears in the legend only when the mapping is 

turned on. If two mappings would result in the same entry in the leg-
end, only one entry is shown.

Select Mapping Zone
Each mapping uses variable values from a specified zone. If your data set has multiple zones, 
specify the zone for each mapping using the Zone button.

5 - 3 Line Map Layer
The Line map layer is available for both XY and polar line plots. Activate the layer, by toggling-on 
Lines in the Sidebar. When the Lines map layer is on, the data set is represented by a connected line 
for each mapping, which may be either a simple collection of line segments connecting all the data 
points, or a curve fitted to the original data.
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Line Attributes
The Lines page of the Mapping Style dialog (accessed via the Sidebar or Plot>Mapping Style) is 
shown in Figure 5-5. 

The first two columns, Map Num and Map Name, list the mapping number and name. The Map 
Show field lists which mappings are currently active. The remaining columns of the Lines page of 
the Mapping Style dialog contain specific line attributes.

• Line Show - This option allows you to turn off lines for selected mappings, 
while keeping both the selected mappings and the Lines map layer active over-
all.

• Line Color - Set line color for line plots

• Line Pattern - Set line patterns for line plots

• Pattern Length - Set the pattern length for patterned lines. Pattern length is 
measured as a percentage of the frame height for one complete cycle of the pat-
tern.

• Line Thickness - Set the thickness of lines

In order for the changes made in on the Lines 
page to be visible in your plot, the Lines 
mapping layer must be toggled-on in the 
Sidebar.

Figure 5-5. The Lines page of the Mapping Style dialog.
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5 - 4 Curve Types
Tecplot offers a variety of curve-fits and spline fits. By specifying the curve type, you control 
whether Tecplot simply connects the data points or performs a more sophisticated analysis. Set the 
type of curve plotted for a mapping using the Curve Type drop-down on the Curves page of the 
Mapping Style dialog, or by using the corresponding Line button on the Quick Edit dialog.

Tecplot offers the following curve types (the names are as shown under the Curve Type drop-down; 
the buttons as shown in the Quick Edit dialog):

• Line Segments (No Curve-Fit) : A series of linear segments connect adja-
cent data points. In XY Line plots, these will be line segments. See Section 5 - 
10, “Polar Drawing Options,”for a discussion of Line Segments in Polar Line 
plots.

• Linear Fits: A linear function is fit to the data points. In XY Line plots, this 
will be a straight line. (Linear fit is not available on Quick Edit dialog.)

• Polynomial Curve-Fits : A polynomial of order N is fit to the data points 
(where 1 <= N <= 10, for N=1 a Linear Fit is done).

• Exponential Curve-Fits : An exponential curve fit that finds the best 

curve of the form Y=eb*X+c (equivalent to Y=a*eb*X, where a = ec). To use this 
curve type, Y-values for this variable must be all positive or all negative. If the 
function dependency is set to X=f(Y) all X-values must be all positive or all 
negative.

Figure 5-6. The Curves page of the Mapping Style dialog.
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• Power Curve-Fits : A power curve fit that finds the best curve of the form 

Y=eb * ln X + c (equivalent to Y=a*Xb, where a = ec). To use this curve type, Y-
values for this variable must be all positive or all negative; X-values must be all 
positive. If the function dependency is set to X=f(Y), X-values must be all posi-
tive or all negative, and the Y-values must all be positive.

• Splines : A smooth curve is generated that goes through every point. The 
spline is drawn through the data points after sorting the points into increasing 
values of the independent variable, resulting in a single-valued function of the 
independent variable. The spline may be clamped or free. With a clamped 
spline, you supply the derivative of the function at each end point; with a non-
clamped (natural or free) spline, these derivatives are determined for you. In 
XY Line plots, specifying the derivative give you control over the initial and 
final slopes of the curve.

• Parametric Splines : Creates a smooth curve as with a spline, except the 
assumption is that both variables are functions of the index of the data points. 
(For example in XY Line plot, ParaSpline fits x=f(i) and y=g(i) where f() and 
g() are both smooth.) No addition sorting of the points is performed; the sorting 
specified on the Definitions page of the Zone Style dialog is used for the order of 
the data points. This spline may result in a multi-valued function (of either or 
both axis variables).

• Extended Curve-Fit : Uses a curve-fit supplied by an add-on. These 
curve-fits may be provided by Tecplot, a third party, or written by users. The 
functionality of each extended curve-fit is defined by its creator. If you wish to 
write an extended curve fit add-on, see the Add-On Developer’s Kit User’s 
Manual for more information.
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Linear Fit, Polynomial Fit, Exponential Fit, and Power Fit are all determined by using a least 
squares algorithm. Examples of each of Tecplot’s curve-fit types are shown in Figure 5-7.
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Figure 5-7. Tecplot’s curve-fit types.

The Curves page also contains fields for controlling the following attributes:

• Dependent Variable - The Dependent Variable drop-down controls how Tec-
plot interprets curve fits and splines. Dependent Variable has no effect on map-
pings of the Line Segment curve type.

• Curve Points - Controls the number of points used to draw curve fits and 
splines. Raising the number of points increases the accuracy of curve but also 
increases plotting time and the size of print files.

• Curve Settings - Control options specific to the curve type. For example, 
weighting for curve fits, or starting derivatives for splines.

The coefficients used to draw curve fits and splines may be output to a file, as can the actual points 
used to draw curve fits and splines.

Linear Fits
Tecplot fits the data to a linear function using the standard least-squares algorithm. It calculates the 
function for which the sum of the squared differences from the data points is a minimum. For the 
XY Line plot type, the linear function is a straight line.
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To fit a linear function to your data:, select “Linear Fit” from the Curve Type drop-down on the 
Curves page of the Mapping Style dialog.

Use the Curve Fit Settings dialog (accessed via the Curve Settings button) to specify different set-
tings. The dialog is shown in Figure 5-8

Figure 5-8.  The Curve Fit Settings dialog.

.

• Polynomial Order is shown on the dialog, but should always be one for a linear 
fit. If you change this away from one, Tecplot changes the curve type to Poly-
nomial Curve-Fits.

• To limit the points used in the mapping(s): select Use Only Points Within 
Range, and enter minimum and maximum values.

• To assign a curve weighting variable, select Use Weighting Variable, and 
select the variable from the drop-down. For more information on curve weight-
ing, see Curve-Fit Weighting Variables

Polynomial Curve-Fits
Tecplot uses a standard least-squares algorithm to fit data to a polynomial function. You specify the 
order of the polynomial (from one to ten), and Tecplot calculates the polynomial for which the sum 
of the squared differences from the data points is a minimum.
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To fit a polynomial function to your data:, select “Polynomial Fit” from the Curve Type drop-down 
on the Curves page of the Mapping Style dialog.

By default, this option fits a cubic polynomial, using all the points in the mapping and weighting 
them equally. Use the Curve Fit Settings dialog (accessed via the Curves page of the Mapping Style
dialog), shown in Figure 5-8, to specify different settings. 

• Polynomial Order drop-down. Select the desired polynomial order (one to ten). 
An order of two is a quadratic polynomial, an order of three is a cubic polyno-
mial, etc. If you select one, the curve type is set to Linear Fit as a polynomial of 
order one is a linear function. (See Linear Fits)

• To limit the points used in the mapping(s): select Use Only Points Within 
Range, and enter minimum and maximum values.

• To assign a curve weighting variable, select Use Weighting Variable, and 
select the variable from the drop-down. For more information on curve weight-
ing, see Curve-Fit Weighting Variables

Exponential Curve-Fits
Tecplot can fit the data to an exponential function using the standard least-squares algorithm. 

For XY plots (where X is the independent variable): Tecplot finds the best curve of the form

 Y=eb*X+c (equivalent to Y=a*eb*X where a=ec). 
Similarly, when Y is the independent variable.

For Polar plots (where Theta is the independent variable): Tecplot finds the best curve of the 
form:

  or , 

Similarly when R is the independent variable.

The dependent-variable values must be either 
all positive or all negative. 

R e bθ c+( )±= R aebθ±=
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To fit a exponential function to your data:, select “Exponential Fit” from the Curve Type drop-down 
on the Curves page of the Mapping Style dialog.

By default, this option uses all the data points in the mapping, weighting them equally. Use the 
Exponential Fit Settings dialog (accessed via the Curve Settings button on the Curves page of the 
Mapping Style dialog) to specify different settings. The dialog is shown in Figure 5-9.

Figure 5-9. The Exponential Fit Settings dialog.

To specify different settings:

• To limit the points used in the mapping(s): select Use Only Points Within 
Range, and enter minimum and maximum values.

• To assign a curve weighting variable, select Use Weighting Variable, and 
select the variable from the drop-down. For more information on curve weight-
ing, see Curve-Fit Weighting Variables.

Power Curve-Fits
Tecplot can fit a power function to data using the standard least-squares algorithm. The dependent-
variable values must be either all positive or all negative, and the independent values should be all 
positive. Tecplot will ignore data points with zero or negative independent values. 

For XY plots (where X is the independent variable): Tecplot finds the best curve of the form

 Y=eb*lnX+c (equivalent to Y=a*Xb where a=ec). 
Similarly, when Y is the independent variable.
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For Polar plots (where Theta is the independent variable): Tecplot finds the best curve of the 
form:

  or , 

Similarly, when R is the independent variable.

To fit a power-curve function to your data:, select “Power Curve” from the Curve Type drop-down 
on the Curves page of the Mapping Style dialog.

By default, this option uses all the data points in the mapping, weighting them equally. Use the 
Power Fit Settings dialog (accessed via the Curve Settings button) to specify different settings. The 
dialog is shown in Figure 5-10.

Figure 5-10. The Power Fit Settings dialog.

• To limit the points used in the mapping(s): select Use Only Points Within 
Range, and enter minimum and maximum values.

• To assign a curve weighting variable, select Use Weighting Variable, and 
select the variable from the drop-down. For more information on curve weight-
ing, see Curve-Fit Weighting Variables.

R ebln θ( ) c+±= R aθb±=
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Splines
A spline is a mathematical function defined to link a specified set of points with a function that is 
continuous and smooth (differentiable) at every point. The most common type of spline, the cubic 
spline, is defined using a set of cubic polynomials, one for each interval between the data points.

Splines can be natural or clamped; natural splines are twice-differentiable at the end points and the 
second derivative is zero at those points, while clamped splines need have known first-derivatives 
at the boundary points. Before plotting the spline, Tecplot sorts the data points in increasing value 
along the independent axis. 

To fit a spline function to your data:, select “Spline” from the Curve Type drop-down on the Curves
page of the Mapping Style dialog.

By default, this option fits a natural cubic spline. To specify a clamped spline: 

1. Select the Curve Settings button on the Curves page of the Mapping Style
dialog.

2. In the Spline Settings dialog (shown in Figure 5-11.), select Clamp the Spline, 
and enter values for the derivative at the start and end of the spline.

Figure 5-11. The Spline Settings dialog.

Parametric Splines
Tecplot’s cubic spline fit assumes that the spline function is a single-valued function of the 
independent variable. 

The Sort option of the Definitions page of the 
Mapping Style dialog has no effect on splines.
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Sometimes, however, you have data that curves back upon itself, but you would still like to have a 
spline-like curve fit to it. Parametric splines solve this problem by presuming that both variables 
(X&Y or Theta&R) are functions of the data-point index. The spline is then defined by two single-
valued functions of the data-point index.

Unlike cubic splines, parametric splines are plotted in the order set in the Sort option of the Defini-
tions page of the Mapping Style dialog. By default, the points are unsorted, and thus the spline is 
drawn in order the data points appear in the data file. See 5- 2.1, “Mapping Definitions,” for a dis-
cussion of sorting.

To fit a paraspline function to your data:, select “ParaSpline” from the Curve Type drop-down on 
the Curves page of the Mapping Style dialog.

By default, this option fits two natural cubic splines to the data point index. To specify a clamped 
spline:

1. Select the appropriate mappings in the Mapping Style dialog and select 
Curve Settings. 

2. In the Parametric Spline Settings dialog (shown in Figure 5-12.), select Clamp 
the Spline, and enter values for the derivative at the start and end of the spline.

Figure 5-12. The Parametric Spline Settings dialog.

For the XY Line plot type, the derivatives are either dy/dx or dx/dy depending on the Function 
Dependency for the mapping. Tecplot calculates dx/ds and dy/ds from these values (where s is the 
parametric variable). For the Polar Line plot type, the derivatives are either dR/dTheta or dTheta/dR
(depending on the Function Dependency for the mapping), and Tecplot calculates dR/ds and 
dTheta/ds from these values (where s is the parametric variable). See “Dependent and Independent 
Variables” on page 127 for a full description of the Function Dependency option.
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Extended Curve-Fit
Tecplot add-ons can provide new curve-fit types. These curve types are called extended curve-fits. 
These curve-fits may be provided by Tecplot, a third party, or written by users. The functionality of 
each extended curve-fit is defined by its creator. (If you wish to write an extended curve-fit add-on, 
see the Add-On Developer’s Kit User’s Manual for more information.)

To fit an extended curve to your data:

1. 1. Use the Curves page of the Mapping Style dialog to select the mappings for 
which you want to apply an extended curve-fit.

2. 2. Select Curve Type, and select “Extended” from the drop-down.

3. 3. Select the desired curve fit from the Choose Extended Curve Fit dialog (Fig-
ure 5-13). 

Figure 5-13. The Choose Extended Curve-Fit dialog.

Three extended curve fit add-ons are supplied with Tecplot:

• Akima - The Akima spline is an alternative that exhibits less dramatic over-
shoots and undershoots than the classical spline. The slopes at the end of each 
segment are computed using a nonlinear average of the segment slopes1. The 
Akima spline is always unclamped. There are currently no options available for 
the Akima spline.

• Extended Curve Fit - General

1. For details, see Lancaster, Peter and Salkauskas, Kestutis “Curve and Surface Fitting, An Introduction”, 1986, 
Academic Press. 
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• Extended Curve Fit - Stineman

Extended Curve Fit - General
The General Curve Fit add-on fits an equation composed of a linear combination of user-specified 
sub-functions to the data in the specified map. The optional parameters can be accessed by select-
ing the Curve Settings option on the Curves page of the Mapping Style dialog.

The curve fit computes (least squares) the optimal curve fit coefficients multiplying these sub-func-
tions.

The following options are available:

• Number of Coefficients - Specify the number of coefficients (and number of 
sub-functions) for the desired curve fit. The default is three. You must specify a 
sub-function for each coefficient in the text fields labeled f1(x) through fn(x), 
where n is the number of coefficients. 
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• f1(x) through f8(x) - Enter the sub-functions for the curve fit using the syntax 
described in 18 - 1 “Data Alteration through Equations” on page 291. 

• Normalize X - Causes the curve to be fit using a normalized independent vari-
able. In particular, the independent variable will be translated and scaled to 
vary from zero at the smallest value of the independent variable to one at the 
largest value of the independent variable. For most curves other than polynomi-
als, this option will alter the shape of the curve fit. It is useful when you get the 
“Rank reduced for at least one curve fit” warning message, but otherwise not 
recommended. 

• Normalize Y - Causes the curve to be fit using a normalized dependent variable. 
In particular, the dependent variable will be translated and scaled to vary from 
zero at the smallest value of the dependent variable to one at the largest value of 
the dependent variable. For most curves other than polynomials, this option 
will alter the shape of the curve fit. It is useful when you get the “Rank reduced 
for at least one curve fit” warning message, but otherwise not recommended.

Extended Curve Fit - Stineman
This method of interpolation generates a curve that will never have more inflection points than are 
clearly required by the given set of data points. The interpolating curve passes through the data 
points and exactly matches the computed slopes at those points1.

In these equations use the variable x as the 
independent variable, even if x is specified as 
the dependent variable in the Curves Fit 

Attributes dialog. 

1. For more information see Russell W. Stineman’s “A Consistent Well-Behaved Method of Interpolation” in the 
July, 1980, issue of Creative Computing.
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The optional parameters can be accessed by selecting the Curve Settings option on the Curves page 
of the Mapping Style dialog. Figure 5-14

Figure 5-14. Stineman Interpolation curve-fit 
options.

.

Line Segments (No Curve-Fit)
By default, Tecplot draws a series of linear segments between each set of points for the XY Line 
plot type. (See 5 - 10, “Polar Drawing Options,” for a discussion of Line Segments in Polar Line 
plots). 

To turn off curve fits for your data and use linear segments between points:

1. From the Curves page of the Mapping Style dialog, select the mappings you 
want to show as linear segments.

2. Select Curve Type. Select “Line Segments” from the drop-down.

Line Segments are plotted in the order set in the Sort option of the Definitions page of the Mapping 
Style dialog. By default, the points are unsorted, and lines segments are drawn in order the data 
points appear in the data file. See Section 5- 2.1, “Mapping Definitions,” for a discussion of sort-
ing.

Dependent and Independent Variables
Every mapping has a dependent variable and an independent variable. The dependency relationship 
determines the shape of your plot for most curve types. This dependency has no effect on line 
segment curve types, and for parametric splines, the dependency is only used to determine starting 
derivatives for clamped parametric splines. Extended curve-fits are free to use or not use this 
dependency depending on the type of curve-fit supplied.

You specify the dependency relationship between your axis variables using the Dependent Variable 
drop-down on the Curves page of the Mapping Style dialog.
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For the XY Line plot type, the default setting is y=f(x) (you may change the value to x=f(y)). With 
y=f(x), the X-axis variable is the independent variable and the Y-axis variable is the dependent vari-
able. With x=f(y), the Y-axis variable is the independent variable and the X-axis variable as the 
dependent variable. Two polynomial curve-fits of the same data using different dependency set-
tings are shown in Figure 5-15. 
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Figure 5-15. An XY Line plot type dependencies.

Similarly for Polar Line plots, the default setting is R=f(Theta) (you may change the value to 
Theta=f(R)). With R=f(Theta), the Theta-axis variable is the independent variable and the R-axis 
variable is the dependent variable. With Theta=f(R), the R-axis variable is the independent variable 
and the Theta-axis variable is the dependent variable.

To change the dependency setting:

1. From the Curves page of the Mapping Style dialog, select the mappings to 
change.

2. Select Dependent Variable and choose the appropriate option.

For the XY Line plot type, the dependency setting deter-
mines the direction of bar charts. To create a vertical bar 
chart set the dependency to y=f(x); to create a horizontal bar 
chart set the dependency to x=f(y). See Section 5 - 7, “XY 
Line Bar Charts,” for information on bar charts.
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Curve-Fit Weighting Variables
Linear, polynomial, exponential, and power fits allow you to specify a weighting variable. By 
default each data point is weighted equally. With the weighting variable, individual points can be 
given more or less weight. Relatively larger numbers in the curve weighting variable mean more 
significance for a given point. If the curve-weighting variable is zero at a data point, that data 
point has no effect upon the resulting curve. 

The weighting coefficients must be integers in the range of zero to 9,999. Tecplot truncates weight-
ing coefficients defined as floating-point numbers (that is, a weighting coefficient of 1.99 is trun-
cated to 1.0).

For example, consider the distance-temperature data in the example data file simpxy.dat (found 
in the examples/dat directory in your Tecplot home directory). There is a small cluster of 
points centered about Distance=0.1 and Temperature=550. If we add the following weighting vari-
able to the original data file sympxy.dat, we can omit this cluster from our analysis:

1 1 0 0 0 0 0 0 1 1 1 1 1 1 1 1 1 1 1 1

The data file sympxy2.dat (also found in the examples/dat directory in your Tecplot home 
directory) contains this additional variable as variable 6, Weight4.

The left side of Figure 5-16 shows an XY Line plot with weighted linear fit with the cluster of 
points omitted. For comparison, the original data points and the un-weighted least-squares fit are 
also plotted. The right side shows the same data in a Polar Line plot.
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Figure 5-16. Weighted linear fits.



Chapter 5:XY and Polar Line Plots

130

Curve Information
You can view information about curve-fits and 
splines using the Curve Information dialog 
(accessed via the Data menu) (Figure 5-17)The 
information presented in the Curve Details
section and in the coefficient file is dependent 
on the curve type selected. For example, the 
dialog shown in Figure 5-17, shows the 
information for a linear fit. For extended curve-
fits, the documentation for the extended curve-
fit add-on supplies any necessary information 
on the format used.

In general, the Curve Information dialog pro-
vides the following:

•Mapping - Select from the drop-down the 
map for which you want information, or 
from which you want to extract coeffi-
cients or data points.

•X-Axis Var - Number and name of the X-
axis variable for the chosen map.

• Y-Axis Var - Number and name of 
the Y-axis variable for the chosen 
map.

• Zone - Number and name of the zone for the chosen map.

• Curve Details - Detailed list of coefficients used in the equation to draw the 
line.

• Goodness of Fit - measurement of the success of the curve-fit in modeling the 
variation of the data (where 1 is a perfect fit and zero is no fit). 

• Goodness of Fit (residual degrees of freedom adjustment) same as above with 
degrees of freedom taken into consideration.

• Write Curve Details to File

Figure 5-17. The Curve Information dialog.
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• Write Data Points to File

Goodness of Fit

R2 is displayed in Curve Details region of the Curve Info dialog for linear, polynomial, exponential 
and power curve fits. It is statistical calculation that measures the success of the curve-fit in model-
ing the variation of the data. R2 is defined as the ratio of the sum of the squares of the regression 
(SSR) and the total sum of the squares (SST).

SSR Wi ycurvefiti
ymean–( )2

i 1=

n

∑=

SST Wi yi ymean–( )2

i 1=

n

∑=

R2 SSR
SST
----------=

where:

SSR = sum of the squares of the regression
SST = total sum of the squares
Wi = the value of the weight variable at index i 
yi = the value of the dependent variable at index i
ymean=   the mean value of the dependent variable y
ycurvefit_i =   is the value computed using the curve-fit at the i-index value of the independent 
variable (xi).
i = current index number



Chapter 5:XY and Polar Line Plots

132

n = total number of data points

A fundamental error term in least-squares curve fits is the sum of the squares residual (SSE), 
defined by

SSE Wi ycurvefiti
yi–( )2

i 1=

n

∑=

This is the number that is minimized when computing the curve-fit coefficients. Using the equation 
SST = SSE + SSR, R2 can be related to SSE:

R2 1 SSE
SST
----------–=

Using this form to compute R2, it is easier to see that an R2 closer to one (SSE=0) indicates a better 
curve-fit. 

Goodness of Fit (residual degrees of freedom adjustment)

One problem with R2 is that it will always indicate a good curve-fit when the number of data 
points, n, equals the number of degrees-of-freedom, m. (for example, a quadratic curve-fit through 
three data points). In this case, the curve passes through all data points so SSE=0 and r-square=1. 
However, there are no other data points so, in reality, no estimate can be made on the quality of the 
curve fit away from the specified data points. In general, any time m (degrees-of-freedom) is close 

R-square can take any value between zero 
and one, with a value closer to one indicat-
ing a better fit.
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to n (number of data points), r-square will overstate the quality of the curve fit. For these reason, we 
include the second goodness-of-fit parameter: degrees-of-freedom adjusted R2:

R2
dof 1 SSE n 1–( )

SST m n–( )
----------------------------–=

Like the standard R2, R2
dof will vary from zero to one with values closer to one indicating a better 

curve fit. R2
dof will be less than R2 when the degrees-of-freedom are close to the number of data 

points, but will be nearly equal to R2 when the number of data points is significantly greater than 
the degrees-of-freedom.

Write Curve Details to File
Using the Curve Information dialog (accessed via the Data menu), you can save the coefficients for 
each curve fit or spline for further analysis in later sessions. 

To create an ASCII data file of the coefficients of the curve fits or splines:

1. From the Data menu, select Curve Info.

2. From the Curve Information dialog, select a mapping from the Mapping drop-
down.

3. Select Write Curve Info to File.

Write Data Points to File
Using the Curve Information dialog (accessed via the Data menu), you can save the calculated data 
points along the curve for further analysis in later sessions. 

To create an ASCII data file of the points of the curve fits:

1. From the Data menu, select Curve Info.

2. From the Curve Information dialog, select a mapping from the Mapping drop-
down.

3. Select Write Data Points to File.
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The data file contains one zone for each line in the mapping. For mappings made from I-ordered 
zones, there is one zone. See Section 5 - 8, “I-, J- and K-Indices,” for details on mappings using IJ- 
and IJK-ordered data.

Each zone in the data file is I-ordered with the number of points equal to the active curve points set-
ting (set via the Curve Points option on the Curves page of the Mapping Style dialog). The data 
file has two variables: one for the independent variable and one for the dependent variable. The 
resulting file is a valid Tecplot ASCII data file that can be read into another frame.

5 - 5 Symbols Map Layer
The Symbols map layer is available for both XY and polar line plots. Activate the layer, by tog-
gling-on Symbols in the Sidebar. When the Symbols map layer is on, each data point is represented 
by a symbol on the plot. For each mapping, you may choose the plotting symbol used, and whether 
to use filled or plain symbols.

Symbol Attributes
Use the Symbols page of the Mapping Style dialog (Figure 5-18) to modify the attributes of the 
Symbols layer.

The first two columns list the mapping number and name. The Map Show field lists currently active 
mappings. The remaining columns of the Symbols page of the Mapping Style dialog contain spe-

Figure 5-18. The Symbols page of the Mapping Style dialog.
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cific attributes: Symb Show; Symb Shape; Outline Color; Fill Mode; Fill Color; Symb Size; Line 
Thck; Symb Spacing. Each of these attributes can also be modified using the Quick Edit dialog.

• Symb Show - This option allows you to turn off symbols for selected map-
pings, while keeping both the selected mappings and the Symbols map layer 
active overall. 

• Symbol Shape - select the symbol type for each mapping. In addition to the 
predefined symbols, you use any ASCII character in the following Tecplot 
fonts: Helvetica-Bold, Math, Greek, User-Defined by selecting Other. Enter the 
ASCII character to use as a symbol in the Enter ASCII Character dialog (Fig-
ure 5-19), and select a font from which to display the symbol.

Figure 5-19. The Enter ASCII Character dialog.

• Outline Color - Symbols can be filled or unfilled (default). 

• Fill Mode - The Fill Mode options are:

• None - The symbols are not filled.
• Use Line Color - The symbols are filled with the same color specified 

in Outline Color and appear as a a solid color.
• Use Back Color - The symbols are filled with background color of the 

grid area, and appear hollow, blotting out objects behind the symbol 
(such as grid lines or other mappings).

In order for the changes made in on the Symbols page 
to be visible in your plot, the Symbols mapping layer 
must be toggled-on in the Sidebar.
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• Use Specific Color - The symbols are filled with the color specified in 
Fill Color.

• Fill Color - If the Fill Mode is set to “Use Specific Color”, use the Fill Color
button to set the color.

• Symbol Size - Select the symbol size for your line plotting symbols. Symbol 
size is measured as percentage of the frame height.

• Symbol Line Thickness - specify the thickness of lines used to draw the plot-
ting symbols.

• Symb Spacing - Specify the spacing between symbols. The spacing is speci-
fied either as a percentage of the frame height or as a number of indices to skip. 
You may either enter a value or use one of the following pre-set values:

• Draw All - All symbols are drawn at every data point.
• ISkip=2, 3 or 4 - Symbols are drawn every second, third or fourth data 

point.
• Distance=1, 2 or 3% - Symbols are drawn at the first data point and 

subsequently at data points that are at least one, two or three percent of 
the frame height distant from the previously plotted data point.

• Enter Index - Enter an index skip between symbols (other than 2, 3, 
or 4).

• Enter Distance - Enter a distance between symbols in frame units 
(other than 1%, 2%, or 3%).

5 - 6 XY Line Error Bars
In the XY Line plot type, you can assign one or more variables to be used to compute error bars for 
another variable. Each mapping can be associated with only one error bar variable. If you want to 
assign multiple error bar variables to a mapping, create a copy of the mapping for each error bar 
variable.
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An example plot with error bars is shown in Figure 5-20.
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Figure 5-20. An XY Line plot with symbols and error bars.

You can use any variable in your data set as an error bar variable. However, for them to be mean-
ingful, they should have the same units as the axis along which they are drawn. 

Select Variable
Use the Select Variable dialog to choose:

•  a single variable, as when assigning a variable to the X- or Y-axis in an map-
ping. The text and labels will vary with the particular action being performed, 
but the operation of the dialog is the same in all cases. Select a variable from 
the drop-down of the data set's variables and click OK 

• two variables, as when assigning 2D axis variables or choosing 2D vector 
components. The text and labels will vary with the particular action being per-

If error bar values are not included in your original data set, 
you may create error variables using Tecplot’s data manipu-
lation utilities. For example, if you know that the values of 
some measured variable are accurate only to within ten per-
cent, you may create a new variable to use as the error bar 

variable by multiplying the measured variable by “0.10” via 
Data>Alter>Specify Equations.
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formed, but the operation of the dialog is the same in all cases. For each of the 
two variables required, select a variable from the drop-down of the data set's 
variables.

• three variables, as when assigning 3D axis variables or choosing 3D vector 
components. The text and labels will vary with the particular action being per-
formed, but the operation of the dialog is the same in all cases. For each of the 
three variables required, select a variable from the drop-down of the data set's 
variables 

Error Bar Attributes
You can modify most of the attributes with which error bars are drawn—their color, their thickness, 
their spacing, and the width of the endpoint crossbars. You can make these changes from the Error 
Bars page of the Mapping Style dialog (Figure 5-21), or for some settings you can use the Quick 
Edit dialog.

• EBar Var - Select the error bar variable.

• EBar Type - There are seven types of error bars:

• Top - Extends upward for positive values (and downward for negative 
values) of the error bar variable.

In order for the changes made in on the Error Bars 
page to be visible in your plot, the Error Bars map-
ping layer must be toggled-on in the Sidebar.

Figure 5-21. The Error Bars page of the Mapping style dialog.
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• Bottom - Extends downward for positive values (and upward for neg-
ative values) of the error bar variable.

• Left - Extends to the left for positive values (and to the right for nega-
tive values) of the error bar variable.

• Right - Extends to the right for positive values (and to the left for neg-
ative values) of the error bar variable.

• Horizontal - Extends left and right.
• Vertical - Extends up and down. (This is the default value.)
• Cross - Extends up, down, left, right.

• EBar Color - Specify the error bar line color

• Ebar Size - Specify the size of the crossbar. Crossbar size is measured as a 
percentage of frame height.

• Line Thck - Specify the line thickness of the error bars. The error bar line 
thickness is measured as a percentage of frame height.

• EBar Spacing - Specify the spacing between error bars. The spacing is speci-
fied either as a percentage of the frame height or as a number of indices to skip. 
You may either enter a value or use one of the following pre-set values-

• Draw All - Error bars are drawn at every data point.
• ISkip=2, 3 or 4 - Error bars are drawn every second, third or fourth 

data point.
• Distance=1, 2, or 3% - Error bars are drawn at the first data point and 

subsequently at data points that are at least one, two or three percent of 
the frame height distant from the previously plotted data point.

Although the values are called Left, Right, Up and Down, the 
direction is determined by the direction of positive values in 
your plot. If you reverse the direction of an axis (using the 
Reverse Axis Direction option on the Range page of the Axis 

Details dialog), the error bars point in the opposite direction. 
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5 - 7 XY Line Bar Charts
A bar chart is an XY Line plot that uses vertical or horizontal bars placed along an axis to represent 
data points. You can create bar charts by activating the Bars map layer on the sidebar.

Bar Chart Attributes
The style of the bar chart is controlled on the Bars page of the Mapping Style dialog, shown in 
Figure 5-22.

Figure 5-22. The Bars page of the Mapping Style dialog.

 Use the Bar Dir button to change between vertical or horizontal bars:

Changing the direction of the bars changes the dependent variable attribute used for line curves 
(either y=f(x) or x=f(y)), and vice versa. By default, all mappings use y=f(x) and appear as vertical 
bar charts. If a mapping uses horizontal bars, the mapping will also use x=f(y) for curve fits. Of 
course, this only matters if you plot bars and curve-fits for the same mapping. For more information 
about dependency, see “Dependent and Independent Variables” on page 127.

To modify other attributes (Bars Show, Outline Color, Fill Mode, Fill Color, Bar Size, Line Thck), 
use the Bars page, follow the same procedures used to set Symbol Attributes. 
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5 - 8 I-, J- and K-Indices
Each mapping can show either I-, J-, or K-varying families of lines. By default, Tecplot displays the 
I-varying family of lines. Figure 5-23 shows the family of I-varying lines for Zone 1 of the data.
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Figure 5-23. A family of I-varying lines for the cylinder data.

You can change the family of lines using the Indices page of the Mapping Style dialog as shown in 
Figure 5-24.

Figure 5-24. The Indices page of the Mapping Style dialog.

 

You can also choose which members of the family are drawn (and using which data points), by 
specifying index ranges for each of I, J, and K. The index range for the varying index tells Tecplot 
which points to include in each line, and the index ranges for the other indices tell Tecplot which 
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lines in the family to include. Thus, you may use this option for selecting a subset of an I-ordered 
zone to plot.

• Varying Index - To choose the varying index, and thus specify the family of 
lines to be drawn, select Varying Index on the Indices page of the Mapping 
Style dialog, and choose the desired family (I-, J-, or K-varying). K-varying is 
only available if the mapping is using an IJK-ordered zone.

• Index Ranges - By default, the entire range of points is plotted in your map-
ping. For IJ- and IJK-ordered data, you may want to specify an index range to 
limit the number of lines drawn. Or, for any type of data, you may want to limit 
the points drawn to a select range.

Enter a starting index in the Begin field, an ending index in the End field, and a 
skip factor in the Skip field. A skip of one means “use every point in the range,” 
a skip of two means “use every other point,” and so on.

5 - 9 Line Legend
You can generate a legend that shows the line and symbol attributes of the mappings. In XY Line 
plots, this legend includes the bar chart information. The legend can be positioned anywhere within 
the line plot frame.

The mappings that are shown in the legend are selected on the Definitions page of the Mapping 
Style dialog. By default, all mappings are shown, but Tecplot removes redundant entries.

To include the line plot legend, open that Line Legend dialog (accessed via the Plot menu) and tog-
gle-on Show Line Legend. The Line Legend dialog (Figure 5-25) has the following options:
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•Show Mapping Names - toggle-on or off to 
include mapping names in the legend.

•Text - Format the text for the legend by choosing 
a color, font, text height, and t line spacing 
between entries in the dialog.

•Position - The legend is automatically placed for 
you. You may specify the position of the legend 
by entering values in the X (%) and Y (%) text 
fields. Enter X as a percentage of the frame width 
and Y as a percentage of the frame height.

•Anchor - You may also specify the anchor loca-
tion of the legend using the Anchor Alignment
dialog. By default, the legend is anchored in the 
top right.

•Legend Box - If the legend is Plain or Filled, the 
box attributes may be changed with the following 
controls:

•Line Thickness - Specify the line thickness as a 
percentage of frame height.

•Box Color - Choose a color for the legend box 
outline.

•Fill Color - Choose a color for the legend box 
fill.

• Margin - Specify the margin between the legend text and legend box 
as a percentage of the text height.

5 - 10 Polar Drawing Options
In the Polar Line plot type, a line between two points may be drawn in one of two ways: they may 
be drawn as a straight line between the two points, or they may be drawn as an interpolation of the 
Theta-R values. In the latter case, the connection between the two points is a smooth curve. By 
default, lines are drawn straight. This works for plots where the angular differences between 

Figure 5-25. The Line Legend dialog.
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consecutive points are small. Use the Polar Drawing Options dialog (accessed via the Plot menu) to 
adjust the drawing mode. The Polar Drawing Options dialog has the following options (Figure 
5-26)

• Curved Lines (Theta-R Interpolation) - The connection between two points 
is a curve. This may slow plotting speed for large data set.

Tecplot will stop drawing a line that involves too many revolutions around the 
circle. For example, if adjacent points have angle values of 0 degrees and then 
36000 degrees, the plot would involve 100 complete revolutions around the ori-
gin. If this is the case, Tecplot will draw only ten revolutions. If you need that 
many revolutions, create a new zone that has points interpolated in between the 
two points

• Straight Lines (X-Y Interpolation) - The connection between two points is a 
straight line.

• Angle to Approximate Curved Lines (deg) - All arcs are drawn as a series of 
lines with the maximum angular difference specified in this field. This includes 
the axes, grid lines, and lines drawn in Curved Line mode. 

The settings in the Polar Drawing Options dialog apply to all mappings in the frame.

Figure 5-26. The Polar Drawing Options dialog.
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The difference between the two Polar Line Drawing Modes is shown in Figure 5-27.

0

30

60

90

120

150

180

210

240

270

300

330

0 5 10 15

Curved Lines (Theta-R Interpolation)

0

30

60

90

120

150

180

210

240

270

300

330

0 5 10 15

Straight Lines (X-Y Interpolation)

Figure 5-27. The Polar Drawing Modes: Curved lines are shown on the left 
and straight lines are shown on the right.
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Chapter 6 Field Plots

Field plots are 2D Cartesian or 3D Cartesian plots. The axes in a field plot are all independent 
variables. In Tecplot, field plots can be created using any combination of the following zone layers:

•  Mesh Layer.

•  Contour Layer

•  Vector Layer

•  Scatter Layer

•  Shade Layer.

•  Edge Layer.

By default, 2D and 3D field plots are initially displayed with Mesh and Edge zone layers (Figure 
6-1).
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Figure 6-1. A 2D mesh and edge plot of sample file 
cylinder.plt.

3D field plots may be enhanced with lighting effects and translucency (see Chapter 15 “Translu-
cency and Lighting” on page 251).
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Field plots may also contain any combination of the following objects (which are derived from the 
values in the data set):

•  Iso-Surfaces (3D ONLY)

•  Slices (3D ONLY)

•  Streamtraces

This chapter discusses the plot attributes that are common to all of the plot layers.

6 - 1 Field Plot Modification - Zone Style dialog
Once you have read in your data, you can modify your field plot attributes using the Zone Style dia-
log or the Quick Edit dialog.

The following attributes in the Zone Style dialog are independent of the active plot layer:

• Zone Num - Use the Zone Num button to select a zone or group of zone(s) 
according to zone number. Strands are indicated by an “*” after their Zone 
Num.

Field plots containing transient data are modi-
fied slightly differently in the Zone Style dialog 
than static data sets. See 6 - 2 “Time Aware” 

on page 157 for more information on working with 
transient data sets.
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• Zone Name - Use the Enter Text String dialog to select a zone or group of 
zone(s) according to zone name. Strands are indicated by an “*” after their 
Zone Name.

• Zone Grp - Use the Zone Grp button to select a zone or group of zone(s) 
according by their group number. By default, all zones are assigned to group 1. 
You can change the group number by selecting “Edit Group Number” from the 
Zone Grp menu. 

• Zone Show - By default, all zones are displayed. Turn zones or groups of 
zones on or off by selecting: Activate, Deactivate, Show Selected Only or Invert
from the Zone Show menu.

The remaining columns in the Zone Style dialog are dependent upon the active page are discussed 
in their corresponding sections.

Pages of the Zone Style dialog
The following pages are available in the Zone Style dialog:

•  Mesh - See Chapter 7 “Mesh Layer and Edge Layer” on page 171

•  Contour. - See Chapter 8 “Contour Layer” on page 177

•  Vector. - See Chapter 9 “Vector Layer” on page 195

For transient data, the first zone of the 
strand applicable to the current time step 
is displayed in the Zone Name and Zone 
Number columns. 

If none of the zones in the active strand 
are displayed at the current time step, the 
entire line is grayed-out.

See also 6 - 2 “Time Aware” on page 157.

Each page of the Zone Style dialog is divided into 2 regions 
(separated by a thick vertical line). Options located in the col-
umns in the left-hand region apply universally to all active lay-
ers in the plot. Options located in the right-hand region of any 

page are specific to the corresponding plot layer.
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•  Scatter -  See Chapter 10 “Scatter Layer” on page 205

•  Shade -  See Chapter 11 “Shade Layer” on page 213.

•  Edge - See Chapter 7 “Mesh Layer and Edge Layer” on page 171

•  Points

•  Surfaces

•  Volume (3D only)

•  Effects Attributes - See Chapter 15 “Translucency and Lighting” on page 251
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6- 1.1 Points
You may select the source for the data points used to plot vectors and scatter symbols from the 
Points page of the Zone Style dialog (Figure 6-2). A plot where zone 1 is plotting scatter symbols 
only on one plane (J=5) and zone 2 is plotting all symbols is shown in Figure 6-3 

Figure 6-2. The Points page of the Zone Style dialog.

X
Y

Z

Zone 1

Zone 2

Figure 6-3. A plot showing two zones set to show only J-
planes equal to five, with scatter symbols plotted 
on the surface in zone 1 and all symbols in zone 2.

• Points to Plot - Select how the points are plotted

• Nodes on Surfaces - Draws only the nodes that are on the surface of 
the zone.

• All Nodes - Draws all nodes in the zone.
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• All Connected - Draws all the nodes that are connected by the node 
map. Nodes without any connectivity are not drawn.

• Cell Centers Near Surfaces - Draws points at the cell centers which 
are on or near the surface of the zone.

• All Cell Centers - Draws points at all cell centers in the zone.

• Index Skip -specify the skip intervals for the I-, J-, and K-indices. The menu 
options are as follows:

• No Skip - Set the I-, J-, and K-skip intervals to one; plot all vectors.
• Enter Skip - Specify I-, J-, and K-skip intervals on the Enter Index 

Skipping dialog.

6- 1.2 Surfaces
There are many ways to divide volume data for plotting. One way to view volume data is to select 
surfaces from part of the data. In Tecplot you may choose which surfaces to plot for volume zones 
from the Surfaces page of the Zone Style dialog (accessed by double-clicking on a zone, via the 
Sidebar or via Plot>Zone Style.

Figure 6-4. The Surfaces page of the Zone Style dialog.

The Surfaces to Plot option allows you to choose one of the following:

• Boundary Cell Faces - Plots all surfaces on the outside of the volume zone. 

For irregular and finite-element data, only 
the I-Skip has an effect. I-skip will allow you 
to skip through nodes in the order they are 
listed in the data file. 
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• IJK-ordered data - the minimum and maximum I-, J-, and K-planes 
are plotted. 

• Finite-element volume data -all faces that do not have a neighbor cell 
(according to the connectivity list) are plotted.
 If blanking is turned on, the boundary cells in the blanked region will 
not be drawn and you will be able to see the interior of the volume 
zone. Figure 6-5 shows plots of a volume zone with Surface to Plot set 
to “Boundary Cell Faces”: without blanking, with value blanking, and 
with IJK-blanking. See Chapter 17 “Blanking” on page 280 for infor-
mation on working with Blanking.

• Exposed Cell Faces (default) - This setting is similar to the “Boundary Cell 
Faces” setting, unless value blanking is active. When value blanking is used the 
outer cells faces between blanked and non-blanked cells are drawn, in addition 
to the outer surfaces of the data. Figure 6-6 shows a plot of a volume zone with 
Surfaces to Plot set to “Exposed Cell Faces” with and without value blanking. 

X

Y

Z

Without blanking

X

Y

Z

With Value blanking

X

Y

Z

With IJK blanking

Figure 6-5. Boundary Cell Face plotting without 
blanking, with value-blanking, and with IJK-
blanking.
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See Chapter 17 “Blanking” on page 280 for information on working with 
Blanking

X

Y

Z

With Value blanking

X

Y

Z

Without blanking

Figure 6-6. Examples of plots where Surfaces to Plot has been set 
to Exposed Cell Faces with (left) and without 
(right) value-blanking.

.

• Planes Settings (I-, J-, K-, IJ-, JK-, IK-, and IJK-planes) - Plots the appro-
priate combination of I-, J-, and or K-planes. The planes are determined by the 
Range for columns to the right of the dialog. These settings are available only 
for IJK-ordered data. Figure 6-7 shows a number of examples of plotting I-, 
J-, and K-planes.

X

Y

Z

I and J planes

X

Y

Z

I planes only

X Y

Z

I planes only

X Y

Z

J and K planes

Figure 6-7. Examples of plotting I-, J-, and K-planes.
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• Every Surface (Exhaustive) - This setting will plot every face of every cell in 
volume data. It is not recommended for large data sets. Unless the surfaces are 
translucent, the plot will appear the same as for the Exposed Cell Faces setting.

6- 1.3 Derived Volume Object Plotting
The Volume page of the Zone Style dialog allows you to specify whether or not to show 
streamtraces, iso-surfaces or slices for the selected zone(s).   Figure 6-8 shows a plot with two 
zones where streamribbons and an iso-surface have been excluded from zone 2.

Figure 6-8. A plot where streamribbons and an iso-
surface have been excluded from zone 2.

6 - 2 Time Aware
For transient data sets, you can use the Tecplot interface to display your data at a given time or to 
animate your data over time. The zones loaded into Tecplot can be linked to a specific solution time 
and the active solution time is used to determine which zones are displayed.

For the following definitions, consider the following fictitious data set:

Zone Time StrandID
1 n/a n/a

Table 6-1. Sample Time Aware Data Set
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• Transient zones - Zones associated with time. The transient zone(s) displayed 
in the current frame are dependent upon the current solution time.   Zones 2-15 
in Table 6-1 are transient zones.

• Static zones - Zones not associated with time. They are displayed regardless of 
the current solution time. Zones 1 and 14 from Table 6-1 are static.

• Current Solution Time - The value which determines which transient zones 
are displayed in the current frame. The value of Current Solution Time is spec-
ified on the Settings page of the Time Details dialog (see 6- 2.1 “Time Details 
dialog - Settings page” on page 160).

• Strand - A series of transient zones of that represent the same part of a data set 
at different times. Zones 2, 5, 8, and 11 in Table 6-1 are all have the same Stran-
dID and therefore the are part of the same strand.

2 0.0 2
3 0.18 3
4 0.22 1
5 0.25 2
6 0.28 1
7 0.32 3
8 0.38 2
9 0.42 1

10 0.52 1
11 0.57 2
12 0.58 3
13 0.62 1
14 n/a n/a

Table 6-1. Sample Time Aware Data Set
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• StrandID - An integer value defined for each transient zone. The StrandID of 
a given zone is determined by the data loader.

• Relevant Zone - Only “relevant zones” are plotted at a given solution time. A 
relevant zone is defined as a zone for a given strand used for a certain solution 
time.   If the strand exists at solution time n, the relevant zone is either the tran-
sient zone on that strand defined explicitly at solution time n, or the zone imme-
diately defined immediately prior to solution time n. If the strand does not exist 
at solution time n, there are no relevant zones for that strand at that time. Static 
zones are always considered relevant. Refer to Figure 6-9.

Figure 6-9. An illustration of how relevant zones are determined (based on the data 
in Table 6-1). For a given solution time, the relevant zones ONLY are 
displayed in the plot. NOTE static zones are always considered as relevant 
zones. 

t = .2 s - the red-colored transient zones and both static zones are plotted. 
NOTE: no zones from the first strand are represented because the strand is not 
defined at that time.

t = .4s - the green-colored transient zones and both static zones are plotted.

t = .6s - the blue-colored transient zones and both static zones are plotted. 
NOTE: no zones from the second and third strands are represented because the 
strands are not defined at that time.

Changes made in the Zone Style dialog to any 
zone in a with a given StrandID are propa-
gated to all zones with that StrandID. See also 

6 - 1 “Field Plot Modification - Zone Style dialog” on 
page 150.
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6- 2.1 Time Details dialog - Settings page
Use the Settings page of the Time Details dialog to change the Current Solution Time of the plot. 

The Time Details dialog can be accessed via the Plot menu or by selecting the  button next to 
“Time” in the Sidebar. The page has the following options:

• Solution Time - Use the slider or spin control to interactively change the Cur-
rent Solution Time

• Min - Displays the minimum solution time in the data

• Max - Displays the maximum solution time in the data

6- 2.2 Time Details dialog - Animate page
See 27- 1.1 “Time Animation” on page 516.
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6 - 3 Data Point and Cell Labels
You can label all or some of the data points, or nodes, in your field plots with either the index 
value(s) of the data point or the value of some specified variable at each point. You can also label 
each cell, or element, of the data, with its index (which for finite-element data is its element 
number).

You can label all or some of the data points, or nodes, in your line plots with either the index of the 
data point, the value of the dependent variable at the point, or the both the values (X&Y or Theta 
& R) for the data point. For example, Figure 6-10 shows an XY Line plot with each data point 
labeled with its X-Y value pair.
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Figure 6-10. An XY Line plot with data labels.

To add data labels to your plot, open the Label Points and Cells dialog (accessed via the Plot menu). 
The Label Points and Cells dialog has the following options:
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•Show Node Labels - toggle-on to 
show node labels. Select either 
Index Value or Variable Value.

•Show Cell Labels - toggle-on to 
show cell labels. Select either 
Index Value or Variable Value.

•Index Skip - if labelling by index 
values, select an index skip.

•Color Text by Zone/Map - for 
line plots, the color is set on the 
Symbols page of the Mapping Style
dialog. for field plots, the color is 
set on the Scatter page of the Zone 
Style dialog.

• Include Text box

6- 3.1 Two-Dimensional Plot-
ting Order
In 2D plots, by default, each zone layer 

is drawn for all zones before the next layer is drawn. To plot the data zone-by-zone instead of layer-
by-layer (default), toggle-on By Zone in the 2D Draw Order dialog box (accessed via the Plot
menu).

6 - 4 Three-Dimensional Plot Control
You can view any type of data as a 3D plot by selecting 3D cartesian from the plot type menu in the 
Sidebar. By default, only IJK-ordered data and finite-element volume data are displayed in 3D. 

Three-dimensional plots can be manipulated with the following controls:

•  Reset 3D Axes - Reset the 3D axis sizes and the 3D origin of rotation.

•  Three-Dimensional Axis Limits - Control the data and axis aspect ratios for 3D 
plotting.

•  Three-Dimensional Orientation Axis - Control the optional 3D orientation axis, 
which displays the current orientation of the three axes in the workspace.

Figure 6-11. The Label Points and Cells dialog.
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•  Light Source - Control the light source position, as well as the intensity of the light, 
the background light, and the surface color contrast. See Section 15 - 3, “Three-
Dimensional Light Source,” for more details.

•  Advanced 3D Control - Specify the default lift fraction for 3D lines, symbols, and 
tangent vectors, as well as the 3D sorting algorithm for the plot.

•  The Rotate Dialog - Control the 3D orientation of the plot.

•  Three-Dimensional View Details - Set the specifications for parameters affecting 
the 3D display of your plot, including the perspective, field of view, angular orienta-
tion of the plot, and view distance.

6- 4.1 Reset 3D Axes
By default, the 3D axes are calculated to fit the data. If you alter your data to expand or contract the 
overall data size, the axes do not automatically adjust to the new size. Use the Reset 3D Axes option 
(accessed via the Plot menu) to reset the axes to fit the data.

6- 4.2 Three-Dimensional Axis Limits
In a 3D plot, whenever you read a data file or manipulate the values of variables assigned to axes or 
change variables assigned to the axes, Tecplot examines the data and determines how to plot it. The 
data may require scaling in one or more axis directions, a change of the axis dependency, an adjust-
ment of the space between the data and the axis box, and/or an adjustment of the shape of the axis 
box.

Because there are many valid forms in which the data could be plotted, Tecplot requires some user 
input to determine how to automatically configure the plot the way you want using the 3D Axis 
Limits dialog.

The Reset 3D Axes option also resets the 3D origin.   If you have 
modified your 3D origin using the 3D Rotate dialog (see 
Section 6- 4.5 “The Rotate Dialog” on page 165 for details), the 

Reset 3D Axes option will reset it to approximately the centroid of the 
data.
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•Aspect Ratio- ratio of the range of the 
variable assigned to one axis (multiplied by 
the axis size factor) and the range of the 
variable assigned to another axis (multiplied 
by the axis size factor).

•Data Aspect Ratio Limit - When the data 
aspect ratio of any two axes exceeds the
Data Aspect Ratio Limit, Tecplot automati-
cally rescales the longer axis so that the new 
data aspect ratio is equal to the Data Aspect 
Ratio Reset value.

If your plots are usually unscaled, such 
as plots of real physical objects, you should set the data aspect ratio maximum to 
a large number like 30. Use a smaller number for evenly scaled axes. 

• Axes Aspect Ratio Limit - works similarly to the Data Aspect Ratio Limit, 
except it deals with the shape and size of the axes box.

6- 4.3 Three-Dimensional Orientation Axis
The 3D orientation axis is a representation of your axes that shows you the orientation immediately. 
By default, all 3D plots show the 3D orientation axis in the upper right of the frame. Using the 3D 
Orientation Axis dialog under the Plot menu, you can control whether the 3D orientation axis is 
shown in your plot, and if so, its color, size, line thickness, and the position of the axis origin. You 
can also position the 3D orientation axis simply by clicking on it and dragging it to the desired loca-
tion in the frame.
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6- 4.4 Advanced 3D Control

•Lift Fractions - The lift fraction is the frac-
tion of the distance from the 3D origin of the 
object to your eye. If you specify lift fractions 
for 3D lines, tangent vectors, or scatter sym-
bols, plotted objects of the appropriate type 
are lifted slightly towards you so that they lie 
on top of surface elements.

•Perform Extra 3D Sorting - for some 3D 
plots (i.e. plots with translucency), Tecplot 
uses a painter’s algorithm. A quick sorting 
algorithm is used by default. The data objects 
are divided into smaller objects. The smallest 
object is usually a cell, finite-element, vector, 
or scatter symbol. These objects are sorted 

based upon the distance from viewer, starting with the objects farthest from the viewer and 
working forward. This does not detect problems such as intersecting objects.   If the Perform 
Extra 3D Sorting check box is selected, a slower, more accurate approach is used to detect 
problems for you. 

There are instances when Tecplot cannot sort correctly. For example, consider 
elements A, B, and C, where element A overlaps part of element B which over-
laps part of element C which overlaps part of element A. Since Tecplot draws 
only whole elements, one of these elements will be drawn last and each will 
cover (incorrectly) a portion of another element. If this occurs while printing or 
exporting, choosing an image format will often resolve the problem 

6- 4.5 The Rotate Dialog
You may rotate your plots using the 3D Rotate dialog under the View menu. The 3D rotation tools 
from the toolbar are discussed in  “Three-Dimensional Rotation” on page 27. 

Note: All of the settings in the Advanced 3D 
Control dialog are specific to the current 
frame.
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The Rotate dialog has the following options:

Figure 6-12. The 3D Rotate dialog.

• Rotation Mode

•XYZ-Axis - Rotation about one of the 
three axes – X, Y, or Z. To move about 
any of these axes, using the controls in 
this dialog. Click and hold on the “+” (up) 
or “-” (down) arrows on either side of the 
axis that you want to rotate the plot 
around.

•Spherical - Spherical rotation about the 
Z axis. There are four arrows in a cross- 
“+” (up) and “-” (down) are the vertical, 
top and bottom arrows of the cross; Right 
and Left are the horizontal, right and left, 
arrows of the cross. There are also two 
twist arrows, diagonal to the cross that 
twist about the Eye/Origin ray- one that 
does a twist up to left and one that does a 
twist over to right.

To tilt the plot in a vertical spherical man-
ner around the Z-axis click and hold on 
the vertical “+” (up/top) or “-” (down/bot-
tom) arrows. To rotate the plot in a hori-
zontal spherical manner around the Z-axis 
click and hold on the horizontal “+” 
(Right) or “-” (Left) arrows. To twist the 
plot about the Eye/Origin ray click and 
hold on the twist up to left or twist over 
right diagonal arrows.

• RollerBall - Rotation like a roller 
ball, that is, horizontal movements are right and left from the current 
position; vertical movements rotate up or down from the current posi-
tion; and twist is about the current screen Eye/Origin ray.
To tilt the plot in a vertical manner in respect to current screen orienta-
tion click and hold on the vertical “+” (up/top) or “-” (down/bottom) 
arrows. To rotate the plot in a horizontal manner in respect to current 
screen orientation click and hold on the horizontal “+” (right) or “-” 
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(left) arrows. To twist the plot about the current screen Eye/Origin ray 
click and hold on the twist up to left or twist over right diagonal 
arrows.

• Rotation Step Size (deg) - Determines the amount of rotation per 
click on rotation buttons. To change the step size either enter a new 
value between 0.001 and 180 in the text field, or select one of the fol-
lowing default values from the drop-down: 1, 5, 15. These default val-
ues are set and modified in the Step Size column in the Size 
Preferences dialog.

• Center of Rotation

• X - Rotation of the eye/origin ray about the X-axis. Enter a value in the 
text field, or use the increase or decrease arrows at the right to specify 
a value.

• Y - Rotation of the eye/origin ray about the Y-axis. Enter a value in the 
text field, or use the increase or decrease arrows at the right to specify 
a value.

• Z - Rotation of the eye/origin ray about the Z-axis. Enter a value in the 
text field, or use the increase or decrease arrows at the right to specify 
a value.

• Reset Center of Rotation - Use this drop-down to set the center of 
rotation to be the Center of Data (the center of the bounding box of the 
data), Center of View (the point hit by a probe at frame coordinates 
50%, 50%), or to Viewer Position.

• Plot Orientation - Eye origin view. The angular orientation of the plot is 
defined by three spherical rotation angles:

• y (Psi) - Tilt of eye origin ray away from Z-axis.(Range –1440 to 
1440.)

• q (Theta) - Rotation of the eye origin ray about the Z-axis.(Range –
1440 to 1440.)

• a (Alpha) - Twist about the eye origin ray. (Range –1440 to 1440.)

Note: Center of View can result in an error if 
there is no data in the center of the frame. If 
this is the case, the center of rotation will not 
move.



Chapter 6:Field Plots

168

The eye origin ray is a line from the origin of the 3D object to your eye. The eye 
origin ray is perpendicular to the plane of the computer screen. These angles 
define a unique view. These angles are shown in Figure 6-13

• Preset Views - Specify one of three pre-defined orientations, the XY-Plane, 
the YZ-Plane, the XZ-Plane, or a default with Psi=60, Theta=225, and 
Alpha=0).

Rotate About the Viewer Position. In addition to the rotation capabilities described above, 
you may use the Alt key and mouse to rotate about the viewer (instead of rotating the object). 
Although you may use this feature while in orthographic projection, it is best suited for when per-
spective projection is being used. The Alt key and your middle mouse button may be used to simu-
late fly-through type motion. You may move closer to the object using the Alt key and middle 
mouse button (or CTRL+Alt-right mouse button), then turn your head using the Alt key and left 
mouse button.

6- 4.6 Three-Dimensional View Details
Use the 3D View Details dialog (accessed via the View menu) to control a variety of parameters 
affecting the display of 3D plots.
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Figure 6-13. The 3D angles and 3D projection.
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•Use Perspective - Sets Tecplot’s pro-
jection type. If selected, Tecplot draws 
the current frame with perspective pro-
jection. If not selected, Tecplot draws 
the current frame with orthographic1

projection. (Range is 0.1 to 179.9.)

•Field of View (deg) - Sets the amount 
of the plot (in terms of spherical arc) in 
front of the viewer which may be seen. 
Zooming in or out of a 3D perspective 
plot changes this number and the 
viewer’s position.

•Maintain Object Size During Field 
of View Changes - If selected, Field of 
View changes result in the viewer’s 
position being moved so that approxi-
mately the same amount of the plane is 
visible after the change.

 If not selected, Field of View
changes do not change the 

viewer’s position and result in the entire plot appearing to grow or shrink.

• View Width - Sets the amount of the plot (in X-axis units) in front of the 
viewer which may be seen. Zooming in or out of a 3D orthographic plot 
changes this number, but not the viewer’s position.

• Viewer Position - Change the viewer’s relation to the image by resetting the 
X-, Y, or Z-location, or by changing the view distance.

6- 4.7 Three-Dimensional Zooming and Translating
Just as in all other plots, you may zoom and translate your plot using the mouse. This may be done 
using either the Zoom or Translate tools. For most tools you may also use your middle and right 
mouse buttons (or CTRL+right mouse button) to zoom and translate.

1. With orthographic projection,- the shape of the objects is independent of distance. This is sometimes an “unrealis-
tic” view, but it is often used for displaying physical objects when preserving the true lengths is important (such as 
drafting).
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When the plot projection is orthographic, zooming with the middle mouse button magnifies the 
plot. When the plot projection is perspective, zooming with the middle mouse button changes the 
viewer angle, making the plot appear larger or smaller. If you want to change the viewer’s position 
by moving closer to or further away from an object hold the Alt key down while using the middle 
mouse button.

Working with very large data sets may result in slow zooming, rotating and translating.

See Section 28 - 3, “Performance Dialog,” for further information on plot approximation if zoom, 
rotate, or translate performance is poor.
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Layer

When working with two or three-dimensional field plots, Tecplot allows you to interactively add or 
subtract any combination of plot layers. These layers can be applied to any set of zones in the active 
data set. This chapter discusses mesh and edge zone plot layers.

7 - 1 Mesh Layer
Toggle-on Mesh in the Sidebar to add a mesh layer to your plot. The mesh plot layer displays the lines 
connecting neighboring data points within a zone. For I-ordered data, the mesh is a single line 
connecting all of the points in order of increasing I-index. For IJ-ordered data, the mesh consists of 
two families of lines connecting adjacent data points of increasing I-index and increasing J-index. 
For IJK-ordered data, the mesh consists of three families of lines, one connecting points of 
increasing I-index, one connecting points of increasing J-index, and one connecting points of 
increasing K-index. For finite-element zones, the mesh is a plot of all edges of all elements which 
are defined by the connectivity list for the node points. See Chapter 2: “Data Structure” for an in-
depth description of ordered (IJK) and finite-element data structures.

7- 1.1 Mesh Layer Modification
Once you have read in your data, you can modify your mesh plot attributes using either the Mesh
page of the Zone Style dialog (accessed via the Sidebar or Plot>Zone Style) or the Quick Edit dialog. 
As discussed in “Pages of the Zone Style dialog” on page 151, the changes made using columns to 
the left of the black line apply to the entire plot, while changes from the columns to the right of the 
divider apply to the active plot layer.

In order for the changes made in on the Mesh 
page to be visible in your plot, the Mesh 
zone layer must be toggled-on in the Sidebar.
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7- 1.2 Mesh Layer Types
Tecplot has three distinct mesh types:

• Wire Frame - Wire frame meshes are drawn below any other zone layers on 
the same zone. In 3D Cartesian plots, no hidden lines are removed. For 3D vol-
ume zones (finite-element volume or IJK-ordered), the full 3D mesh (consist-
ing of all the connecting lines between data points) is not generally drawn 
because the sheer number of lines would make it confusing. The mesh drawn 
will depend upon your choice of Surfaces to Plot on the Surfaces page of the 
Zone Style dialog. See Section 6- 1.2, “Surfaces,” for further details. By default, 
only the mesh on exposed cell faces is shown.

• Overlay - Similar to Wire Frame, mesh lines are drawn over all other zone 
layers except for vectors and scatter symbols. In 3D Cartesian plots, the area 
behind the cells of the plot is still visible (unless another plot type such as con-
tour flooding prevents this). As with Wire Frame, the visibility of the mesh is 
dependent upon your choice of Surfaces to Plot in the Volume page of the 
Zone Style dialog. See Section 6- 1.2, “Surfaces,” for further details. 

• Hidden Line - Similar to Overlay, except hidden lines are removed from 
behind the mesh. In effect, the cells (elements) of the mesh are opaque. Sur-
faces and lines that are hidden behind another surface are removed from the 
plot. For 3D volume zones, using this plot type obscures everything inside the 
zone. If you choose this option for 3D volume zones, then choosing to plot 
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every surface (using the Volume page of the Zone Style dialog) has the same 
effect as plotting only exposed cell faces, but is much slower. 

Figure 7-1 shows the available mesh plot types, along with the effects of choosing Overlay and 
Wire Frame in combination with contour flooding

Hidden Line
None

Zone Boundary
Wire Frame

Overlay

Contour Flooding

(With Flood Cutoff)

Figure 7-1. Mesh plots types.

. 

7 - 2 Edge Layer
An edge plot layer displays the connections of the outer lines (IJ-ordered zones), finite-element 
surface zones, or planes (IJK-ordered zones). The Edge layer allows you to display the edges 
(creases and borders) of your data. Zone edges exist only for ordered zones, or 2D finite-element 
zones. 

Three-dimensional finite-element zones do not have boundaries, although you may use the Extract 
FE Boundary dialog to create a zone that is the outer boundary or surface of a finite-element zone. 
See “Boundary Extraction of Finite-Element Zones” on page 321 for details.

NOTE: The opaque surfaces created by Hidden Line are not 
affected by the Lighting Zone effect (there is no light source 
shading). However, it is affected by translucency.
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7- 2.1 Edge Layer Modification
You can control any of the following attributes from the Edge page of the Zone Style dialog:

•  Show Edges - Whether the edges are visible for each active zone.

•  Edge Type - borders and/or creases. See Section 7- 2.2, “Edge Type,”below.

•  I, J or K-Index Border - Select whether to show the corresponding index border: 
None, Min, Max or Both (Min and Max). 

•  Edge Color - The edge color. 

•  Line Thck - The mesh line thickness. 

7- 2.2 Edge Type
There are two types of edges in Tecplot, creases and borders. An edge border is the boundary of a 
zone. An edge-crease appears when the inside angle between two cells is less-than a user-defined 
limit. The inside angle can range from 0-180 degrees (where 180 degrees indicates coplanar sur-
faces). The default inside angle for determining an edge-crease is 135 degrees. You can change the 
crease angle by going to Plot>Edge Details. 

In order for the changes made in on the Edge 
page to be visible in your plot, the Edge zone 
layer must be toggled-on in the Sidebar.

NOTE: For 2D plots, only edge-borders are 
available, and for FE-Volume zones, only 
edge-creases are available.
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Only edge-borders are displayed, by default. You can change the Edge Type using the Edge 
Type column on the Edge page of the Zone Style dialog.

7- 2.3 Edge Display
For IJ-ordered zones, the available edges are the lines I=1, I=IMax, J=1, and J=JMax. 

When the Surfaces to Plot option is set to “Boundary Cell Faces”, “Exposed Cell Faces”, or 
“Every Surface” for IJK-ordered zones, the edges of the surface areas form a “box” that contains 
the data. Surfaces to Plot can be set on the Surfaces page of the Zone Style dialog. 

When the Surfaces to Plot option is set to one of the planes options, such as I-, J-, or K-planes, 
for IJK-ordered zones the edges are the edges of each plane (I-, J-, or K-plane). By default, all 
available edges are drawn when the Edge layer is active. You can specify which of the available 
edges are plotted using either the Zone Style dialog or the Quick Edit dialog.
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Chapter 8 Contour Layer

Contour plots can be used to show the variation of one variable across the data field. To add a 
contour layer to your plot, toggle-on Contour in the Sidebar. 

Additional options can be set on the Contour Details dialog (accessed via the button in the 
Sidebar or Plot>Contour/Multi-Coloring) and the Contour page of the Zone Style dialog.

Contour plots can only be plotted with organized data, such as 
IJ-ordered, IJK-ordered or FE-data. Refer to 2 - 4 “Working 
with Unorganized Data Sets” on page 55 for information on 

organizing your data set.
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An example of each contour plot type is shown in Figure 8-1

Flood

Both Lines and Flood

Average Cell

Corner Cell

Lines

None

Figure 8-1. Contour plot types.

.

Contour plots for streamtraces, iso-surfaces and slices are 
controlled by their respective details dialogs and are not dis-
cussed here (Refer to 14- 1.3 “Rod/Ribbon Page” on 
page 240, 12 - 3 “Iso-Surface Style” on page 217 and 13- 

1.2 “Contour Page” on page 224, respectively).
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8 - 1 Contour Layer Modification
You can modify the attributes of your contour plot using either the Contour page of the Zone Style
dialog or the Quick Edit dialog. You can control any of the following attributes from the Contour
page of the Zone Style dialog.

Contour Show - Select whether or not to show the contour for the highlighted zone(s)

• Contour Type - Tecplot allows you to create contour plots of five different 
types:

• Lines - Draws lines of constant value of the specified contour variable.
• Flood - Floods regions between contour lines with colors from the 

global color map.
The distribution of colors used for contour flooding may be banded
or continuous. When banded distribution is used for flooding a 
solid color is used between contour levels. If continuous color dis-
tribution is used the flood color will vary linearly in all directions. See 
“Color Distribution Methods” on page 185for details on Tecplot’s 
color distribution methods.

• Both Lines and Flood - Combines the above two options.
• Average Cell - Floods cells or finite-elements with colors from the 

global color map according to the average value of the contour vari-
able over the data points bounding the cell.
If the variables are located at the nodes, the values at the nodes are 
averaged.

In order for the changes made in on the Contours page 
to be visible in your plot, the Contour zone layer must 
be toggled-on in the Sidebar.



Chapter 8:Contour Layer

180

If the variables are cell-centered, the cell-centered values are aver-
aged to the nodes and the nodes are then averaged. 

• Primary Value - Floods cells or finite-elements with colors from the 
global color map according to the primary value of the contour vari-
able for each cell. If the variable is cell centered, the primary value is 
the value assigned to the cell. If the variable is node located, the pri-
mary value comes from the lowest index node in the cell.
If the variables are located at the nodes, the value of the lowest 
indexed node is the cell is used. When plotting IJK-ordered, FE-brick 
or -tetra cells, each face is considered independently of the other faces. 
You may get different colors on the different faces of the same cell.

If the variables are cell-centered, the cell-centered value is used 
directly. When plotting I-, J-, or K-planes in 3D, the cell on the posi-
tive side of the plane supplies the value, except in the case of the last 
plane, where the cell on the negative side supplies the value.
Go to Data> Data Set Info to determine whether the variables are 
nodal or cell-centered.

• Flood By - Select either a contour group (C1, C2, C3, or C4) or assign vari-
ables to the RGB color map. See “Contour Groups” on page 181 and Section 4- 
4.2 “RGB Coloring” on page 100 for more information.

• Lines By - Select which contour group identifies the contour lines (applicable 
only when the contour type is 'lines' or 'both lines and flood')

• Use Lighting (3D only) - Turn on or off the lighting effects

Options such as contour labels, contour legends and special settings for contour bands or contour 
lines are set by the selected contour group. See “Contour Groups” on page 181 The color map is set 
globally. See Section 4- 4.1, “Global Color Map”

8 - 2 Contour Details dialog
Use the Contour Details dialog to specify:

•  Contour Groups

•  Contour Levels

•  Contour Coloring

•  Contour Bands
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•  Contour Lines

•  Contour Labels

•  Contour Legend

Contour Groups
The Contour Details dialog in its condensed form is shown in Figure 8-2. 

• C1, C2, C3, C4 - Use the C1,C2, C3 and C4 buttons to specify attributes for a 
specific contour group. Each contour group has its own settings for the contour 
attributes established in the Contour Details dialog. 

• Var - Assign a variable from your data set to the active Contour Group (C1, 
C2, C3 or C4)

The Contour Group Variables (C1-C4) can be used to color contour, mesh, scatter or vector zone 
layers, as specified in the Select Color dialog and the Flood By and Lines By buttons on the Con-
tour page of the Zone Style dialog.

Figure 8-2. The Contour Details dialog in its condensed form.
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8- 2.1 Contour Levels
A contour level is a value at which contour lines are drawn, or for banded contour flooding, the 
border between different colors of flooding. Adjust contour levels using the Levels page of the 
Contour Details dialog (accessed via the Sidebar or the Plot menu). From the Levels page of the 
dialog, you can add, subtract and rearrange contour levels.

Contour Level Addition
You can add new levels in any of three ways:

• Add a new range of contour levels to the existing set by clicking Add Levels
on the Levels page of the Contour Details dialog, then using the Enter Contour 
Level Range dialog as described in “New Contour Level Specification” on 
page 183.
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• Enter a value in the Level To Add text field in the Levels page of the Contour 
Details dialog and then selecting Add Level.

• Choose  from the toolbar, then click at any location in the contour plot 
where you would like a new contour level. Tecplot adds a new contour level 
that goes through the specified point. By holding down the mouse button you 
can drag and interactively position the new contour level until you release the 
button.

Contour Level Removal
You can remove contour levels by:

• Selecting one or more contour levels on the Levels page of the Contour 
Details dialog, then selecting Remove Selected Levels.

• Selecting  from the toolbar, then click on any contour line in your con-
tour plot. Tecplot deletes the specified contour level, or the nearest contour 
level to the specified point.

Contour Level Adjustment

You can interactively adjust a contour level with the  tool from the toolbar. Hold down the 
CTRL key; then click and drag the contour level you want to adjust. Move the contour to the 
desired location and release the mouse button. The new value of the contour level can be viewed on 
the Levels page of the Contour Details dialog.

New Contour Level Specification

You may specify a new set of contour levels via the Reset Levels or New Levels options on Levels
page of the Contour Details dialog. The Reset Levels dialog asks you to supply an 
approximate number of levels to use, and Tecplot will estimate a starting point, an end point and the 
spacing between contour levels.
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If you want more control over the exact values generated for contour levels, click New Levels. 
This calls up the Enter Contour Level Range dialog.

You can specify the range and number of levels in any of three ways:

• Min, Max, and Number of Levels (default) - Enter a minimum and maxi-
mum level value, together with the number of levels to be distributed equally 
through the range. 

• Min, Max, and Delta - Enter a minimum and maximum level value, 
together with a delta (step-size between levels). 

• Exponential Distribution - Enter a minimum and maximum level value, 
together with the number of levels to be distributed exponentially through the 
range.
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8- 2.2 Contour Coloring
Although the color map is global (affecting all frames) there are some adjustments you can make 
that apply only a contour group in the current frame by using the Coloring page of the Contour 
Details dialog.

Use Color Map - Select the color map group to use for contour coloring.   The option is sensitive 
when Link All Color Maps Together is inactive in the Color Map dialog (accessed via Options>Color 

Map or the  button to the right of the Use Color Map drop-down menu).   See 4- 4.1 “Global 
Color Map” on page 98 for more information on color map groups.

• Color Distribution Methods

• Banded - A solid color is assigned for all values within the band 
between two levels. (See 8- 2.3 “Contour Bands” on page 187).

• Continuous - The color distribution assigns linearly varying colors to 
all multi-colored objects or contour flooded regions. You can vary the 
default assignment of colors by entering a “Min” or “Max” value for 
Color Map Endpoints.
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• Use Approximate Continuous Flooding - causes each cell to be 
flooded using interpolation between the RGB values at each node. 
When the transition from a color at one node to another node crosses 
over the boundary between control points in the color spectrum, 
approximate flooding may produce colors not in the spectrum. Leav-
ing this option unchecked is slower but more accurate.

• Color Cutoff - lets you specify a range within which contour flooding and 
multi-colored objects, such as scatter symbols, are displayed. 

• Color Map Adjustments

• Reversed Color Map - You can reverse the color map by toggling on 
Reverse. Two plots, one with the color map going in the default 
direction, and one with the color map reversed, are shown in Figure 
8-3.

• Color Map Cycles - You may choose to cycle the color map. This is 
useful if you have data where there is a great deal of activity in multi-
ple ranges of the contour variable and you want to cycle through all 
colors in each region. A plot with the color map cycled twice is shown 
in Figure 8-4.

A B

Figure 8-3. Sample contour plots created using demo file cylinder.plt. A) Flooded contour plot 
with default settings. B) Flooded contour plot with a reversed colormap.

A B

Figure 8-4. Sample contour plots created using demo file cylinder.plt. A) Flooded contour plot with 
default settings. B) Flooded contour plot with the color map cycled two times.
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8- 2.3 Contour Bands
When Coloring Distribution for a group is set to “Banded” (via the Colors page of the Contour 
Details dialog), you may customize the color bands on the Bands page of the dialog.

The Bands page of the Contour Details dialog has the following options:

• Include Zebra Shading - This effect colors every other band with a specific 
color (or no color at all). 

• Override Band Colors - Specific contour bands can be assigned a unique 
basic color. This is useful for forcing a particular region to use blue, for exam-
ple, to designate an area of water. You can define up to 16 color overrides.
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8- 2.4 Contour Lines
The contour line settings determine how contour lines are drawn for all zones in the current frame’s 
data set. The settings are established on the Lines page of the Contour Details dialog.

• Use Zone Line Pattern - For each zone, draw the contour lines using the line 
pattern and pattern length specified in the Contour page of the Zone Style dia-
log.

• Skip to Solid - Draw n dashed lines between each pair of solid lines, where n
is an integer you enter in the text field Number of Dashed Lines to Draw 
between Solid Lines.

• Dashed Negative Lines - Draw lines of positive contour variable value as 
solid lines and lines of negative contour variable value as dashed lines.
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8- 2.5 Contour Labels
Contour labels are labels that identify particular contour levels either by number or by value. You 
can place contour labels interactively, or have Tecplot create them for you automatically. You can 
also have Tecplot create a set of contour labels automatically, then interactively add contour labels 
to this saved set. 

Customize contour labels with the Labels page of the Contour Details dialog (accessed via the Plot 
menu or the Sidebar), and with the Add Contour Label mouse mode tool from the toolbar.

To add contour labels to your plot, you can use the Add Contour Label tool (see  “Add Contour 
Labels” on page 30) or the Labels page of the Contour Details dialog.

You can modify the following options using the Labels page of the Contour Details dialog.

The contour plot type must be: lines, or lines 
and flood in order to use Contour labels.
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• Show Labels - toggle-on Show Labels to include contour labels in your plot. 
You can label the contour levels by selecting either:

• Use Contour Number
• Use Contour Value

• Number Format - use the Number Format button to specify the number for-
matting of the Contour labels.

• Label Format - use the center section of the dialog to customize label color, 
font and fill settings.

• Generate Automatic Labels (with each Redraw) - At each Redraw, Tecplot 
creates a new set of contour labels. At any time, you can deselect the Generate 
Automatic Labels (with each Redraw) check box, and Tecplot retains the last set 
of labels generated. 

• Align Labels with Contour Line - Use the Spacing field to specify the spac-
ing of the contour labels along the contour line, as a percentage of the 
frame.Use the Level Skip field to specify a the skip value between contour lev-
els to be labeled.

• Align Next User-Positioned Label - If the Align Next User-Positioned 
Label is selected, the next label placed is aligned with the contour line. Other-
wise, the label is written with normal, upright text

• Clear All Contour Labels - When Generate Automatic Labels is dese-
lected, you can click Clear All Contour Labels to erase the current set of 
contour labels.
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8- 2.6 Contour Legend
To include a contour legend, select the Legend page of the Contour Details dialog for the 
appropriate contour group.

The following options are available:

• Show Contour Legend.

• Show Header - includes the name of the contour variable.

• Separate Color Bands - Select this check box to separate the color bands in 
the legend with black lines. Use this option to visually separate similar colors. 
If this box is not selected, similar adjacent colors may tend to blur together.

• Alignment - select Vertical or Horizontal.

• Position - X (%) and Y (%) as percentages of the frame width and height. (You 
can also move the legend interactively.)
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• Anchor - Specify which part of the legend is anchored in the selected position 
using the Anchor Alignment dialog.

• Label Placement - If you have selected Continuous Color Distribution
on the Coloring page of the Contour Details dialog, you have three options 
for placement of labels on the legend:

• Label at Contour Levels - This option places one label for each con-
tour level. See Section 8- 2.1, “Contour Levels”

• Label at Specified Increment - Enter a value in the Increment text 
field when selected.

• Label at Color map Divisions - Places one label for each control 
point on the global color map. See Section 4- 4.1, “Global Color 
Map”.

• Resize Automatically - automatically skip some levels to create a reasonably 
sized legend.

• Include Cutoff Levels - Color bands and labels for levels affected by Color 
Cutoff are shown in the legend. 

• Level Skip - Enter the number of levels between numbers on the legend. This 
also affects the number of levels between contour labels on the plot. Skipping 
levels on the contour legend compresses the color bar (if one appears); it does 
not change the spacing between text entries on the legend. 

• Line Spacing - Enter the spacing between contour legend numbers. This does 
not change the number of entries in the legend, so a large value here creates a 
large legend. Use Level Skip to reduce the number of entries in the legend.

• Header Format - adjust the font and height for the legend header or the leg-
end labels.

• Color - Affects all text in the legend.

• Number Format - The available options are the same as for axis tick mark 
labels; see Section 16.5.3 Tick Mark Label Formats.

• Legend Box (No Box, Filled, Plain) - If you choose Filled or Plain, format the 
box using the following controls-
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• Line Thickness - Specify the line thickness as a percentage of frame 
height.

• Box Color - Choose a color for the legend box outline.
• Fill Color (Filled only) - Choose a color for the legend box fill.
• Margin - Specify the margin between the legend text and legend box 

as a percentage of the text height.

Anchor Alignment
Available through the Legend page of the Contour Details dialog, the Anchor Alignment dialog
allows you to specify the anchor point, or fixed point, of the object. As the box grows or shrinks, 
the anchor location is fixed, while the rest of the box adjusts to accommodate the new size. There 
are nine possible anchor points, corresponding to the left, right, and center positions on the head-
line, midline, and baseline of the box.

8 - 3 Extract Contour Lines
Go to Data>Extract>Contour Lines to extract plotted contour lines as zones. Your data will be 
altered by the creation and naming of new zones.
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Using the Extract Contour Lines dialog, you have the following options:

• Create a separate zone for each contour level - A new zone will be created 
for each contour line plotted. The number of new zones will equal the number 
of contour levels.

• Create a separate zone for each independent line segment in each zone - 
With this option you may create many more zones than there are contour levels. 
New zones are created in each source zone for each topologically independent 
contour line.

The created zones are FE-line segment type zones. After generating the zones, it is recommended 
that you plot them as meshes.
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Chapter 9 Vector Layer

You can create vector plots by activating the Vector layer in the Tecplot sidebar, and specifying the 
vector component variables.
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Figure 9-1. A vector plot of the cylinder data (with the edge layer also active).

Vector plot attributes can be modified using the Vector page of the Zone Style dialog.
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9 - 1 Vector Variables
When you activate the Vector zone layer (via the Sidebar), Tecplot checks to see whether vector 
components have been assigned for the current data set in the current plot type. If you have not 
assigned vector components, the Select Variables dialog will be launched (Figure 9-1).

Choose variables by selecting the desired U-, V-, and, W (3D only) -variables from their respective 
drop-downs. You may select any of the current data set’s variables as any component. You can 
change the component variables at any time by choosing Vector Variables from the Vector submenu 
of the Plot menu.

Once you have selected the Vector check box and have chosen your vector components your vector 

plot will appear. If vectors are not visible, see 9 - 4, “Vector Length”

Figure 9-1. Select Variables dialog for the 3D Cartesian 
plot type. The dialog box for 2D Cartesian 
vector variables does not include W. 
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9 - 2 Vector Plot Modification
You can modify your vector plot attributes using either the Vector page of the Zone Style dialog or 
the Quick Edit dialog. You can control any of the following attributes from the Vector page of the 
Zone Style dialog.

• Vector Show - select whether or not to show the vector for the highlighted 
zone(s)

• Vector Type - Select from the following options:

• Tail at Point (default) - draws the tail of the vector at the data point
• Head at Point - draws the head of the vector at the data point
• Anchor at Midpoint - positions the midpoint of the vector at the data 

point
• Head Only - draws the head of the vector at the data point and does 

not draw a tail. 

In order for the changes made in on the Vector page to 
be visible in your plot, the Vector zone layer must be 
toggled-on in the Sidebar.
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Figure 9-2 shows examples of each of the vector plot types. 

• Head Style - Figure 9-3 displays the available arrowhead styles.

• Plain (default) - Line segments drawn from the head of the vector.
• Filled - Filled isosceles triangles with apex at the head of the vector.
• Hollow - Hollow isosceles triangles with apex at the head of the vec-

tor.

• Line Color - The vector color.

Anchor at Midpoint

Tail at Point

Head at Point

Head Only

Figure 9-2. The Vector plot types: tail at point, 
head at point, anchor at midpoint and 
head only.
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Plain Filled Hollow

Figure 9-3. Arrowhead types for vector plots 
(plain, filled and hollow).
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• Vect Tang - Select whether to display the vectors are 3D vectors with both the 
normal and tangent components or just the tangents components.   Tangent vec-
tors are drawn on 3D surfaces only where it is possible to determine a vector 
normal to the surface. A plot where multiple surfaces intersect each other using 
common nodes is a case where tangent vectors are not drawn because there is 
more than one normal to choose from. An example of this would be a volume 
IJK-ordered zone where both the I- and J-planes are plotted. If tangent vectors 
cannot be drawn then regular vectors are plotted instead

Figure 9-4. Comparison of the Vect Tang options. A) vectors are drawn 
with both the normal and tangent components. B) vectors are 
drawn with only the tangent components.

.

• Line Pttrn - The vector line pattern. 

• Pttrn Lngth - The vector line pattern length. 

• Line Thck - The vector line thickness

The following attributes are assigned on a frame-by-frame basis, rather than zone-by-zone:

• Vector lengths. See Section 9 - 4, “Vector Length”

• Arrowhead angle and size. See Section 9 - 3, “Vector Arrowheads”
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• The reference vector. See Section 9 - 5, “Reference Vectors”

9 - 3 Vector Arrowheads
You can specify arrowhead sizes as either a fraction of the vector length or in frame units (that is, as 
a percentage of the frame height). Arrowhead size is a global attribute; it applies to all arrowheads 
in all zones in the current frame. By default, Tecplot specifies size as a fraction of the vector length.

To modify the arrowhead size select Arrowheads from the Vector sub-menu of the Plot menu. 

The Vector Arrowheads dialog has the following options:

• Angle (deg) - The arrowhead angle is the angle that one side of the arrowhead 
makes with the vector, i.e. the apex angle is twice the arrowhead angle. To 
specify the arrowhead angle. Enter a value from 1 to 90, or choose a value from 
the drop-down, indicated by the down-arrow button.

• Set Size Based On:

• Fraction of Length - enter a decimal value from zero to one 
• Frame Units (%) - enter a percentage value from zero to 100

If your data consists of a dense mesh of points, a vector plot 
may be too crowded to be of much use. You can “thin” the 
plot by plotting only a certain subset of the data points with 
the Index Skip attribute from the Points page of the Zone 
Style dialog.
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9 - 4 Vector Length
Vector length is a global attribute — it applies to all zones in the current frame. To specify the 
vector length, select Length from the Vector sub-menu of the Plot menu. 

The Vector Length dialog has the following options:

• Relative (Grid Units/Magnitude) - specify the vector length as the number of 
grid units per unit of vector magnitude.

• Relative (Cm/Magnitude) - specify the vector length as the number of centi-
meters per unit of vector magnitude.

• Uniform (%) - specify the vector length as a percentage of frame height.

• Recalculate Length - The default vector length is based on the size of the 
longest vector. Select Recalculate Length to change the vector length to a rela-
tive vector length with the scale factor expressed in grid units per unit of vector 
magnitude.

 For either of the “Relative” options, the value you specify is a scale factor which is multiplied by 
the vector magnitude to determine the length of the vector.

NOTE: Since 3D vectors are plotted in the plane of the 
screen, a 3D vector’s length will depend on both the vector 
length settings and the orientation of the vector. The length 
may be distorted even further if the vector length setting is 

Relative and the 3D projection is Perspective.
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9 - 5 Reference Vectors
A reference vector is a vector of specified magnitude placed on the plot as a measure against all 
other vectors. To display a reference vector, select Reference Vector from Vector sub-menu of the
Plot menu.

.The Reference Vector dialog has the following options: 

•Show Reference Vector - toggle-on to include a 
reference vector in your plot

•Origin (%) - Enter the coordinates of the starting 
point of the reference vector, as a percentage of the 
frame width (X) and frame height (Y).

•Color - Choose a color from the Select Color dia-
log. Multi-color and RGB coloring are not avail-
able.

•Angle (deg) - Enter the orientation of the vector in 
degrees from horizontal, or choose a value from the 
drop-down.

•Line Thickness (%) - Enter the desired line thick-
ness or choose a value from the drop-down.

• Magnitude - Enter the magnitude of the ref-
erence vector. The units correspond to those of 
the vector components.

• Include Magnitude Label - toggle-on to include the magnitude of the refer-
ence vector in the label. Select the and modify any of the following options-

• Text Color - Choose a color from the Select Color dialog. Multi-
color and RGB coloring are not available.

• Font - Click the button to choose the font typeface and size from the
Select Font dialog, or click the up and down arrows to adjust the size 
alone.

• Number Format - Click the button to specify how the number will be 
formatted.Offset - Choose the spacing between the label and the refer-
ence vector as a percentage of frame height.
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Reference Vectors

Figure 9-5 shows a plot with a reference vector

Figure 9-5. An example of a vector plot with a reference vector 
included. NOTE: the label for the reference vector was 
included using Insert>Text.



Chapter 9:Vector Layer

204



205

Chapter 10 Scatter Layer

Scatter plots are plots of symbols at the data points in a field. The symbols may be sized according 
to the values of a specified variable, colored by the values of the contour variable, or may be 
uniformly sized or colored. Unlike contour plots, scatter plots do not require any mesh structure 
connecting the points, allowing you to make scatter plots of irregular data.

To add a scatter layer to your plot, activate the Scatter toggle in the Sidebar. You can modify your 
Scatter plot using the Scatter page of the Zone Style dialog and the Scatter submenu of the Plot 
menu.

10 - 1 Scatter Plot Modification
Once you have read in your data, you can modify your scatter plot attributes using either the Scatter
page of the Zone Style dialog or the Quick Edit dialog. You can control any of the following 
attributes for a zone or group of zones from the Scatter page of the Zone Style dialog.

In order for the changes made in on the Scatter page 
to be visible in your plot, the Scatter zone layer must 
be toggled-on in the Sidebar.
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• Scat Show - select whether or not to show the scatter layer for the highlighted 
zone(s)

• Symbol Shape - select one of the following symbols shapes:

•  Square (default)

•  Delta

•  Gradient

•  Right Triangle

•  Left Triangle

•  Diamond

•  Circle

• Point

• Cube (rendered as a square in 2D)

• Sphere (rendered as a circle in 2D)

• Octahedron (rendered as a diamond in 2D)

•  Other - Plot with a specified ASCII character. (as specified in the 
Enter ASCII character dialog.)   In the dialog, enter a character to use 
as a symbol, and then specify the Tecplot character set from which to 
obtain the symbol: Base (English Font), Greek, Math, or User 
Defined.   See also: Figure 21-2 on page 435.

• Outline Color - select from either the color palette or one of the contour 
groups.

• Multi-Color -each plotting symbol is colored according to the value 
of the selected contour variable at that data point. 
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Scatter Plot Modification

• RGB coloring - each plotting symbol is colored according to the val-
ues at that data point for the variables assigned to RGB. 

• Fill Mode - The 3D symbol shapes, Cube, Sphere, and Octahedron, are filled 
with the line color, but the other shapes have several optional fill modes:

• None (default)
• Use Line Color - matches to outline color
• Use Back Color - matches to frame color
• Use Specified Color

• Fill Color - select from either the color palette or one of the contour groups

• Scat Size - scale the symbol size by either a percentage of the frame height or 
a variable in the data set. (See Section 10 - 2 “Scatter Size/Font” on page 208
for complete instructions for sizing scatter symbols by variable.) 

• Line Thck - select the thickness of the scatter outlines for each highlighted 
zone(s).

NOTE: Spheres, Cubes, and Octahedrons are always light-
source shaded. Spheres are Gouraud shaded, and Cubes and 
Octahedrons are Panel shaded. Cube edges are aligned with X-
, Y-, and Z-axes. Octahedrons are oriented so one vertex points 

in the Z-direction and one vertex points in the X-direction. For best appear-
ance of 3D shapes, adjust the Light Source and use Specular Highlighting.

Scat Size and Line Thck are not available for the point symbol.   Points are 
always one pixel in size.

If your data consists of a dense mesh of points, a scatter plot 
may be too crowded to be of much use. You can “thin” the 
scatter plot by plotting only a certain subset of the data points 
with the Index Skip attribute from the Points page of the 
Zone Style dialog.

The Point scatter symbol allows for quick viewing and panning in 3D 
plots. It is also a useful tool for identifying features in volume zones.
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10 - 2 Scatter Size/Font
Use the Scatter Size/Fonts dialog (accessed via Plot>Scatter>Size/Font) to control the base font 
used for ASCII character symbols and the scatter-size variable that can be used to scale scatter 
symbols. The Scatter Size/Font dialog is shown in Figure 10-1.

Figure 10-1. The Scatter Size/Font dialog.

The following options are available:

• Base Font for ASCII Symbols - Select a font from the drop-down. 

• Scatter-Size Variable - Select a variable from the drop-down of the data set's 
variables. If the Scat Size field is set to “Size by Variable” on the Scatter page 
of the Zone Style dialog, this variable is used to calculate the scatter symbol size 
at each data point. The actual size of each symbol is determined by multiplying 
the value of the variable at each point by the Size Multiplier. If the Scat 
Size field is not set to “Size by Variable”, this field has no effect.

• Size Multiplier - Enter the scale factor that multiplies the values of the Scat-
ter-Size Variable to size the scatter symbols. If the Scat Size field on the 
Zone Style dialog is not set to 'Size by Variable', this field has no effect. The 
Size Multiplier multiplied by the scatter variable value gives the size of the 

scatter symbol at a point, in units specified by the following option buttons:
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Reference Scatter Symbols

• Grid Units/Magnitude - Select this to express the Size Multiplier
in terms of grid units per unit of variable magnitude.

• Cm/Magnitude - Select this to express the Size Multiplier in terms 
of screen centimeters per unit of variable magnitude.

• Recalculate Size - Select to reset the Size Multiplier to Tecplot's initial 
value.

10 - 3 Reference Scatter Symbols
If you are using a scatter-size variable, it is sometimes useful to create a reference scatter symbol 
that shows the size at which a data point of a given magnitude will be represented. Figure 10-1
shows a scatter plot with a reference scatter symbol.

 You create the reference scatter symbol using the Reference Scatter Symbol dialog (accessed via 
Plot>Scatter). The dialog will open only if a scatter size variable is defined; if you have not yet cre-
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Figure 10-1. Scatter plot with reference scatter symbol. NOTE: the 
text label was added using Insert>Text.
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ated one, select one by choosing Scatter Font/Size from the Plot menu, then choosing a Scatter Size 
Variable from the drop-down. The Reference Scatter Symbol dialog is shown in Figure 10-2.

Figure 10-2. The Reference Scatter 
Symbol dialog.

• Show Reference Scatter Symbol - toggle-on to include a reference symbol in 
your plot

• Origin - choose the position of the reference symbol

• Magnitude - specify the size of the reference symbol

• Formatting - modify the color, fill mode, line thickness and shape, as desired.

10 - 4 Scatter Legends
To include the scatter legend, select Scatter Legend from the Scatter sub-menu of the Plot menu. 
Select the following options in the Scatter Legend dialog.

• Show Scatter Legend - toggle-on to include a scatter legend in the plot

• Show Zone Names - toggle-on to include zone names in the legend.
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Scatter Legends

• Text - Format the text for the legend by choosing a color and font, and specify-
ing the text height as a percentage of the frame height or in units of points. 
Enter the desired line spacing in the Line Spacing text field.

• Position - Specify the location of the anchor point of the legend by entering 
values in the X (%) and Y (%) text fields. Enter X as a percentage of the frame 
width and Y as a percentage of the frame height.

• Legend Box - Select the type of box to draw around the legend (No Box, 
Filled, or Plain). If you choose Filled or Plain, format the box using the 
following controls-

• Line Thickness - Specify the line thickness as a percentage of frame 
height.

• Box Color - Choose a color for the legend box outline.
• Fill Color - (Filled only) Choose a color for the legend box fill.
• Margin - Specify the margin between the legend text and legend box 

as a percentage of the text height.
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Chapter 11 Shade Layer

Although most commonly used with 3D surfaces, shade plots can also be used to flood 2D plots 
with solid colors, or light source shade the exterior of 3D volume plots. In 3D plots, zone effects 
(translucency and lighting) cause color variation (shading) throughout the zone(s). Shading can 
also help you discern the shape of the plot.

Toggle-on Shade in the Sidebar to add shading to your plot. Use the Shade page of the Zone Style
dialog to customize shading. Refer to Chapter 15, “Translucency and Lighting,” for information on 
translucency and lighting zone effects.

11 - 1 Shade Layer Modification
You can modify your shading attributes using either the Shade page of the Zone Style dialog 
(accessed via the Sidebar or Plot>Zone Style).

Shade plots require IJ- or IJK-ordered, or 
finite-element data. I-ordered, or irregular 
data, cannot be used to create shade plots.
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You can control any of the following attributes from the Shade page of the Zone Style dialog.:

• Shade Show - Whether the shade layer is visible for each active zone. 

• Shade Color - The shade color. In 2D Cartesian plots, only solid zone flooding 
is available (i.e. no lighting effects).

• Use Lighting - (3D only) turns the lighting zone effect off or on. When “no” is 
selected, the shade color is used to uniformly color the zone. Refer to Chapter 
15, “Translucency and Lighting,”for information on translucency and lighting 

zone effects.

In order for the changes made in on the Shade page to 
be visible in your plot, the Shade zone effect must be 
toggled-on in the Sidebar.
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Chapter 12 Iso-Surfaces

An iso-surface is a surface having a constant value for the contour variable. Iso-surfaces require 
that your data contains volume zones (IJK-ordered, finite-element brick, or finite-element 
tetrahedral zones). In Tecplot you can modify iso-surfaces from the Iso-Surface Details dialog 

accessed via the Plot menu or the  button to next to Iso-surfaces in the Sidebar.

12 - 1 Iso-Surface Groups
You can work with up to four different iso-surface groups in Tecplot. Zone layers or other objects 
that reference the same group for an attribute show the same plot style for that attribute. Each iso-
surface group has its own settings for the attributes set in the Iso-surface Details dialog.   Refer 
to the following sections for details on each attribute. For each group, toggle-on Show Iso-surfaces 
from Group η to include the corresponding iso-surface group in your plot (where η can be valued at 
one through four).

In order for the changes made in on the Iso-surface 
Details dialog to be visible in your plot, the Iso-sur-
faces must be toggled-on in the Sidebar.
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12 - 2 Iso-Surface Definition
Use the Definition page of the Iso-Surface Details to control Tecplot’s rendering of iso-surfaces.The 
attributes set on this (and every page of the dialog) are applied to the Iso-Surface group selected 
(specified on the top of the page).

The following options are available

• Show Iso-Surfaces from Group 1 - Select this check box to display iso-sur-
faces from Group 1. 

• Define Iso-Surfaces Using - Use the drop-down to select the appropriate con-
tour group.

•  - Use this button to bring up the Contour Details dialog.

• Draw Iso-Surfaces at - Use this drop-down to have Tecplot draw iso-surfaces 
at-

• Contour Group Levels - go to the Contour Details dialog 

(accessed via the  button) to alter the Contour Levels. See 8- 2.1 
“Contour Levels” on page 182.
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Iso-Surface Style

• At Specified Value(s) - specify up to three values of the contour vari-
able at which to draw iso-surfaces.

• Contour Variable Min - Indicates the minimum value of the contour variable.

• Contour Variable Max - Indicates the maximum value of the contour vari-
able.

12 - 3 Iso-Surface Style
Style settings for all iso-surfaces are handled through the Style page of the Iso-Surface Details
dialog. (These are independent of the style assigned to zones by the Zone Style dialog.) The 
attributes set on this (and every page of the dialog) are applied to the Iso-Surface group selected 
(specified on the top of the page).

The following options are available:

• Show Mesh - Select this check box to display the mesh on iso-surfaces.

• Mesh Color - Select a mesh color from the color palette.
• Mesh Line Thickness - Select a mesh line thickness from the drop-

down, or enter your own number in the text field.

• Show Contour - Select this check box to display contours on iso-surfaces.
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• Contour Type - Select the contour display type.
• Flood by - If you chose contour flooding, select the contour group by 

which to flood the contours, or select RGB flooding.

•  - Use this button to bring up the Contour Details dialog

• Contour Lines by - If you chose contour lines, select the contour 
group by which to draw lines.

•  - Use this button to bring up the Contour Details dialog

• Contour Line Color - If you chose contour lines, click this button to 
display the Select Color dialog and choose the line color.

• Line Thickness - If you chose contour lines, select a contour line 
thickness from the drop-down, or enter your own number in the text 
field.

• Show Shade - Select this check box to display shading on iso-surfaces.

• Shade Color - Select a shade color from the drop-down, or choose a 
custom color.

• Use Lighting Effect - Select this check box to enable the lighting 
effect drop-down where you may choose Paneled or Gouraud
shading.

• Use Surface Translucency - Select this check box to enable the sur-
face translucency text field, where you may set the surface translu-
cency from one (opaque) to 99 (translucent).

• Obey Source Blanking - When active iso-surfaces are generated for non-
blanked regions only. When inactive, iso-surfaces are generated for blanked 
and unblanked regions.

12 - 4 Iso-Surface Animation
Refer to 27- 1.4 “Iso-Surfaces Animation” on page 521.
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Iso-Surface Extraction

12 - 5 Iso-Surface Extraction
Iso-surfaces are derived from the data set and do not append the data set. To extract existing iso-
surfaces to Tecplot zones and retain these surfaces after making changes to the contour variable, 
select Extract>Iso-Surfaces from the Data menu.

In the Extract Iso-Surfaces dialog, select the Extract button to create the new iso-surface zones, one 
zone for each plotted iso-surface. All of the variables in the data set are interpolated from the 3D 
volume zones to the data points of the iso-surfaces.

Iso-surface zones are FE-surface quadrilateral element-type zones, regardless of the original 3D 
volume zone types. The mesh of the iso-surfaces is derived from the mesh of the original zones, so 
that in regions where the original mesh was coarse, the iso-surface mesh is coarse, and where the 
original mesh was fine, the iso-surface mesh is fine.

After creating the new iso-surface zones, it is often a good 
idea to turn off or reconfigure the current settings for iso-sur-
faces because the new zones will occupy the same physical 
space as the original iso-surfaces.
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Chapter 13 Slices

You can add slices to your plot in order to view X, Y or Z Planes within your data. With IJK-
ordered data, slices can also be placed on I, J, or K planes.   Slices can include lighting effects, con-
tours, meshes and more. Slices attributes can be customized using the Slice Details dialog (accessed 
via the Sidebar or the Plot menu).

There are two types of slices:

1. Slices that are derived from the data set -   These slices are created by tog-

gling-on Slices in the Sidebar and using either the Slice tool , or the
Position page of the Slices Details dialog (accessed via the Plot menu) to define 
the location of the slice. The Slice Details dialog is discussed in the following 
section.  Refer to “Slice Tool” on page 28 for information on working with the 
Slice tool.

Slices that are derived from the data set are defined by a constant X-, Y-, or Z-
location, or constant I-, J-, or K-index for IJK-ordered zones. This type of slice 
is part of the style of your plot and does not add to the data set unless you 
extract it to a zone (using Data>Extract>Current Slices).

2. Slices that are extracted directly to zones - These slices are created using the 
Slice from Plane option (accessed via Data>Extract). This option allows you to 
slice through 3D surface as well as 3D volume zones.

These operations are separate and each has unique advantages.   The resulting slices are always 3D 
surfaces.
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13 - 1 Slice Details dialog
Use the slice details dialog to customize slices derived from your data set. The Slice Details dialog 
includes the following pages: Position Page, Contour Page, Vector Page, Other Page, and Anima-
tion Page.

Slice Groups
Up to four different slice groups can be set. Each slice group can use different slice planes, or dif-
ferent ranges for the same slice plane. Changing the settings in the Slice Details dialog allow you to 
make the appearance of each slice group unique. The slice group is specified using the numbers at 
the top of the Slice Details dialog.

13- 1.1 Position Page
Use the Slice Details dialog to customize the position of the active slice group (accessed via the 
Sidebar or Plot>Slices). 

Use the Position page of the Slice Details dialog to specify slice location. Use the slider to move the 
start slice, or you may type in the slice position. Activate the end slice and move it with the end 

In order for the changes made in on the Slice 
Details dialog to be visible in your plot, 
Slices must be toggled-on in the Sidebar.

You must toggle-on “Show Slice from 
Group n” (where n = 1-4) in order to 
include the Slice group in your plot.

You can also place slices interactively 

using the Slice Tool .
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Slice Details dialog

slice slider. You may also activate intermediate slices. Intermediate slices are distributed evenly 
between the start and end slices.

The following options are available:

• Slice Location - Select which plane the slice is drawn on (X,Y,Z, I,J or K)

• Show Primary Slice - Toggle-on to include the primary slice (first slice 
placed) in your plot. Use the slider or the text field to specify the position of the 
primary slice.

• Show Start/End Slices - Toggle-on to include start and end slices in your plot. 
Use the corresponding sliders or text fields to position the slices.

• Show Intermediate Slices - Toggle-on to show intermediate slices between 
the first and second slices.

• Num Slices - Enter the number of intermediate slicing planes in the 
text field. (Range 1-100.)

• Range for all Sliders - Limit the range for the slides.

• Min, Step Size, Max - specify the start, end and step for the slider 
range



Chapter 13:Slices

224

• Reset Slider Range- sets the slider range based on the range of the 
Slice Plane Location variable in the active zones.

• Show Full Slice While Dragging - Toggle-on to include a full image of the 
slice as you drag it to a new position.   When Show Full Slice While Dragging is 
toggled-off, a solid-colored slice is shown during the dragging of slices or slid-
ers. NOTE: Show Full Slice While Dragging is a global setting and is not spe-
cific to a Slice Group..

13- 1.2 Contour Page
Use the Contour page to control the contour attributes of the active slice group (determined by the 
number buttons on the top of the page).

The following options are available:

• Show Contours - Select this check box to show contours.

This option is not available if the slice plane is 
I, J or K.
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• Contour Type - Select the contour type of the flood from the drop-down. 
Lines, Flood, Lines and Flood, Average Cell Flood, and Primary 
Value Flood are available.

• Flood by - If you chose contour flooding, select the contour group by which to 
flood, or RGB flooding.

•  - Use this button to bring up the Contour Details dialog

• Contour Lines by - If you chose contour lines or lines and flood, select the 
contour group by which to draw the lines.

•  - Use this button to bring up the Contour Details dialog

• Line Color - Choose the line color from the Select Color dialog. 
Multi-Color will color the slice contour lines based on the contour 
group variable.

• Line Thickness - Specify the line thickness as a percentage of the 
frame width. You may enter a value in the text field, or choose one of 
the values in the drop-down.

• Use Lighting Effect - Select this check box to enable the lighting effect drop-
down where you may choose Paneled or Gouraud shading.

• Use Surface Translucency - Select this check box to enable the surface trans-
lucency text field, where you may set the surface translucency from one 
(opaque) to 99 (translucent).
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13- 1.3 Vector Page
Use the Vector page to control the vector attributes of the active slice group (determined by the 
number buttons on the top of the page). 

The following options are available:

• Show Vectors - Select this check box to show vectors.

• Tangent Vectors - Select to use tangent vectors for your slices. See 9 - 2 “Vec-
tor Plot Modification” on page 197 for more information.

• Line Color - Choose the line color from the Select Color dialog. Multi-Color 
will color vectors based on the contour group variable. If no contour variable is 
set for the selected contour group, the Contour Details dialog will appear.

• Line Thickness - Specify line thickness as a percentage of the frame width. 
You may enter a value in the text field, or choose one of the values in the drop-
down.

• Vector Type - Use this drop-down to set the vector type for your slices. 
Choose from Tail at Point, Head at Point, Anchor at Midpoint, and Head Only.
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Slice Details dialog

• Vector Head Style - Use this drop-down to set the vector head style for your 
slices. Choose from Plain, Filled, and Hollow.

13- 1.4 Other Page
Use this page to control the mesh, shade, and edge attributes of the active slice group (determined 
by the number buttons on the top of the page).

The following options are available:

• Show Mesh - Select this check box to show mesh lines.

• Color - Choose the line color from the Select Color dialog. Multi-
Color will color meshes based on the contour group variable. If no 
contour variable is set for the selected group when selecting Multi-
Color, the Contour Details dialog will appear.

• Line Thickness - Specify the mesh line thickness as a percentage of 
the frame width. You may enter a value in the text field, or choose one 
of the values in the drop-down.

• Show Shade - Select this check box to show shading on the slice when Show 
Contour has not been selected or is set to Lines.
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• Color - Choose the shade color from the Select Color dialog. Multi-
Color and RGB coloring are not available—use flooded contours for 
multi-color or RGB flooding.

• Use Lighting Effect - Select this check box to enable the lighting 
effect drop-down where you may choose Paneled or Gouraud shading.

• Use Surface Translucency - Select this check box to enable the sur-
face translucency text field, where you may set the surface translu-
cency from one (opaque) to 99 (translucent).

• Show Edge - Select this check box to show selected edge lines on all slices.

• Color - Choose the edge color from the drop-down of Tecplot’s basic 
colors. Multi-Color and RGB coloring are not available.

• Line Thickness - Specify the edge thickness as a percentage of the 
frame width. You may enter a value in the text field, or choose one of 
the values in the drop-down.

• Obey Source Blanking - When active slices are subject to any blanking used 
in for the data. When inactive, slices are generated for blanked and unblanked 
regions. See also Chapter 17 “Blanking” on page 280.

13- 1.5 Animation Page
See 27- 1.6 “Slice Animation” on page 525.

13 - 2 Slice Extraction
In most cases it is not necessary to extract slices to zones. Most existing slice features allow you to 
set almost any style. There are cases where you may need to display multiple sets of slices in vari-
ous directions, so it is necessary to extract at least some of the slices to zones. It is also possible to 
generate arbitrarily oriented slices when extracting to a zone.

13- 2.1 Pre-Defined Slice Extraction
To extract slices that you have pre-defined with the Slice tool or the Slice Details dialog choose the 
Current Slices option from the Extract sub-menu of the Data menu. This option will create a sepa-
rate zone for each slice plane. The created zones are FE quadrilateral, regardless of the source zone 
types.
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Slice Extraction

13- 2.2 Arbitrary Slice Extraction
To extract a slice at an arbitrary orientation, or to slice a 3D surface instead of a volume, use the 
Slice from Plane option from the Extract sub-menu of the Data menu.

Specify any of four different types of cutting planes, as follows: 

• Arbitrary - An arbitrary cutting plane. You may specify the position and ori-
entation of the cutting plane using three points or an origin and a normal vector, 
or you can interactively place and rotate the cutting plane using the controls in 
the Extract Slice dialog. If you choose Arbitrary as your cutting plane, you can 
either use the Position sliders and Rotate About buttons to position the cut-
ting plane, or choose one of the following buttons:

• Three Points - Calls up  Enter Three Points, in which you specify the 
cutting plane by entering the X-, Y-, and Z-coordinates of three points 
on the cutting plane. These points must form a triangle; they cannot be 
coincident or collinear.

• Origin and Normal - Calls up Enter Slice Origin and Normal in 
which you specify the cutting plane by entering the coordinates of a 
point and the components of a normal vector. Using this option, you 
enter six numbers to specify the cutting plane- the X-, Y-, and Z-coor-
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dinates of a point on the cutting plane (called the slice origin), and the 
X-, Y-, and Z-components of a vector normal to the cutting plane 
(called the slice normal).

• Constant X, Y or Z - A cutting plane of constant value. You may specify the 
value either by entering a value, or using a position slider.

• Position - enter the exact coordinate for the X, Y and Z-coordinate of the ori-
gin of the cutting plane or use the slider to specify each coordinate as a percent-
age of their respective axes range.

• Rotate About (Arbitrary ONLY) - use the increase button to rotate the cut-
ting plane clockwise about the respective axes. Use the decrease button to 
rotate counter-clockwise.

• Show Trace - To see a “trace” of the current slice, toggle-on Show Trace.

 If Show Trace is selected, Tecplot draws an approximation of the intersection of 
the slicing plane with the active 3D zones. For finite-element zones, the trace in 
fact draws all line segments of the intersections of the slicing plane with the 
cells in the zone. For IJK-ordered data, the trace is simply the line resulting from 
the intersection of the slicing plane and the outer surface of the zone. 

If Show Trace is not selected, Tecplot simply draws the intersection of the slicing 
plane with the axis box.

• Create Slice From - Choose to create slices from volume zones, surface zones, 
or surfaces of a volume zone. A slice from a volume zone will create a plane. A 
slice from a surface zone, or the surface of a volume zone, will be a line or 
curve.

Once you have created the slice zone, you may plot it, write it out to a data file, 
delete it, etc. It is the same as any zone that was read into Tecplot. If you slice 
volume zones, the resulting slice zones are finite-element surface, quadrilateral 
element-types. If you slice surface zones, the resulting zones are finite-element 
line segment element types.
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See Figure 13-1 for an example of a zone created by a slice
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Figure 13-1. Zone extracted by slicing 3D 
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Chapter 14 Streamtraces

A streamtrace is the path traced by a massless particle placed at an arbitrary location in a steady-
state vector field. Streamtraces may be used to illustrate the nature of the vector field flow in a 
particular region of the plot. See 19 - 9 “Calculating Particle Paths and Streaklines” on page 376 for 
information on adding streaklines and particle paths to your plot.

Because streamtraces are dependent upon a vector field, you must define vector components before 
creating streamtraces in Tecplot. However, it is not necessary to activate the Vector zone layer to 
use streamtraces. 

To add streamtraces to your plot, toggle-on Streamtraces in the Sidebar and use either the Add 

Streamtrace tool or the Create Stream(s) button on the Position page of the Streamtrace 
Details dialog (accessed via the Plot menu) to specify the location of the streamtrace(s).

There are two main categories of streamtraces:

• Surface line streamtraces (or streamlines) - Surface streamtraces are con-
fined to the surface on which they are placed. They can only be placed in zones 
displayed as a 2D or 3D surface. If you try to place streamlines in a zone dis-
played as a 3D volume, an error dialog appears, and no streamlines are drawn. 
See 14- 1.2 “Line Page” on page 238. When surface streamtraces are placed on 
a no-slip boundary surface, they will propagate according to the flow field very 
near the surface (see 14 - 3 “Surface streamtraces on no-slip boundaries” on 
page 248 for more information).

Use the 3D placement plane (available in 
the Sidebar) when positioning volume 
streamtraces ( “Placement Plane” on 
page 20).
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• Volume streamtraces -Volume streamtraces can be created in 3D volume 
zones only (IJK-ordered or FE-volume zones). See 14- 1.3 “Rod/Ribbon Page” 
on page 240. Volume streamtraces are subdivided into three categories:

• Volume Lines, or volume streamlines.
• Volume Ribbons, or streamribbons.

• Volume Rods, or streamrods.

14 - 1 Streamtrace Details dialog
You can control the style of your streamtraces using the Streamtrace Details dialog (accessed 

via the Plot menu or the button to the right of Streamtraces in the Sidebar). These style 
attributes affect all streamtraces in the current frame, including those already placed. They do not 
affect extracted streamtrace zones, discussed in Section 14 - 4, “Streamtrace Extraction as Zones,”
because these are now ordinary ordered zones, not streamtraces at all.

In order for the changes made in on the 
Streamtrace Details dialog to be visible in 
your plot, Streamtraces must be toggled-on 
in the Sidebar.
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14- 1.1 Position Page
Use the Position page of the Streamtrace Details dialog (accessed via the Sidebar or 
Plot>Streamtraces) to control the next streamtrace, or streamtrace rake, to be placed.

The following options are available:

• Format - Choose the format for the next streamtrace from the drop-down. The 
options are as follows:

• Surface Line - Two-dimensional and 3D surface streamlines. Surface 
lines are confined to the surface upon which they are placed. If placed 
in a 3D volume zone, these streamtraces are not plotted.

Alternatively, you can add streamtraces 

using the Add Streamtrace tool . See 
also- “Add Streamtrace” on page 29
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• Volume Line - Three-dimensional-volume streamline plotted through 
3D space. The streamline path is integrated in three dimensions within 
the 3D volume field.

• Volume Ribbon - Three-dimensional-volume streamtrace with a 
defined thickness that twists in accordance with the local stream-wise 
vorticity of the vector field; a streamribbon. When you select this 
option, you should also check the ribbon width on the Rod/Ribbon
page of the Streamtrace Details dialog. The width affects all 
streamtraces, including those already placed. The default width is 
often too large, but it is automatically calculated based upon the extent 
of your data. The center of the streamribbon is a 3D volume stream-
line. The streamribbon rotates about this streamline in accordance 
with the local vector field. Streamribbons have an orientation at each 
step.

• Volume Rod - Three-dimensional-volume streamtrace with a defined 
thickness and a polygonal cross-section; a streamrod. The cross-sec-
tion of a streamrod rotates around a volume streamline in accordance 
with the local stream-wise vorticity. The center of the streamrod is a 
regular 3D volume streamline. Streamrods have an orientation at each 
step. As with streamribbons, you should check the rod width on the 
Rod/Ribbon page of the Streamtrace Details dialog, as well as the num-
ber of rod points (three, by default). The number of points indicates 
the cross-sectional shape of the rod. Three is an equilateral triangle; 
four, a square; five, a regular pentagon; and so forth. Like the width 
parameter, the number of points applies to all streamrods, including 
those already placed.

• Direction - Select the stream integration direction from the following options-

• Forward - Select for forward integration from the starting point.
• Backward - Select for backward integration from the starting point. 

When the streamlines are calculated backwards, the arrowheads still 
point in the forward direction.

• Both - Select for both forward and backward integration from the 
starting point. (For streamribbons and streamrods, you should avoid 
this option.)

• Enter IJK Positions - Select to specify the streamtrace starting point (and 
rake ending positions, if applicable) using the mesh indices I, J, and K.
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• Enter XYZ Positions - Select to specify the streamtrace starting point (and 
rake ending positions, if applicable) using the spatial coordinates X, Y, and Z. 

• Zone (only if Enter IJK Positions is selected) - Select from the drop-down the 
zone for which the I, J, (and K) indices are being specified.

• Create Rake - Select to identify the starting position as the start of a rake, and 
to activate the Rake Ending Position fields. A rake is a group of streamtraces.

• Streamtrace Start Position - Specify the starting position for a single 
streamtrace, or (if Enter Rake Positions is selected) the beginning of a rake of 
streamtraces. There are two or three fields, labeled either X, Y (and Z) or I, J 
(and K). Enter the desired value in each field, or use the up and down arrows to 
increase or decrease the values.

• Rake End Position (only if Create Rake is selected) - Specify the end position 
for a rake of streamtraces. There are two or three fields, labeled either X, Y 
(and Z) or I, J (and K). Enter the desired value in each field, or use the up and 
down arrows to increase or decrease the values.

• Create Streamtrace - Click to place the streamtrace or rake of streamtraces.

• Streamtraces per Rake - Enter an integer in the text field to specify the num-
ber of streamtraces on each rake, where a rake is a group of streamtraces.

• Number of Streamtraces (Information only) - The number of streamtraces 
currently placed.

• Delete All - Click to delete all streamtraces in the current plot.
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• Delete Last - Click to delete the last streamtrace placed.

D - Switches to streamrods.
R - Switches to streamribbons.

S - Switches to surface lines.
V - Switches to volume lines.
1, 2, 3, 4, 5, 6, 7, 8, 9 - Changes the number of 
streamtraces to add when placing a rake of 
streamtraces.

14- 1.2 Line Page
Surface streamtraces or streamlines are confined to the surface on which they are placed. They can 
only be placed in zones displayed as a 2D or 3D surface. If you try to place streamlines in a zone 
displayed as a 3D volume, an error dialog appears, and no streamlines are drawn. The following 
attributes may be set with the Line page of the Streamtrace Details dialog.

• Show Streamtraces - toggle-on to include streamtraces in your plot.

Special Keyboard Commands:
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• Line Color - Enter the color for all streamtraces. You may set the color to 
Multi-Color to color the streamtraces by the chosen contour group variable in 
the same manner as color flooding. (If the contour variable is not currently 
defined, the Contour Variable dialog appears so that you can define it.) You can 
use the Multi-Color option, for example, to color the streamtraces by the local 
temperature or by the velocity magnitude. You can also specify RGB coloring.

The following attributes affect surface and volume streamlines only:

• Line Thickness - Either enter a value for the streamline thickness (as a per-
centage of the frame height for 2D lines and as a percentage of the median axis 
length for 3D surface lines and volume lines), or choose a pre-set value from 
the drop-down.

• Arrows - Select the Show Arrowheads on Lines check box to display arrow-
heads along all streamlines (surface and volume) in the current frame. Arrows 
are not shown on volume ribbons or volume rods. You can also control the fol-
lowing attributes of the displayed arrows-

• Arrowhead Size - Either enter a value for the arrowhead size (as a 
percentage of the frame height), or choose a pre-set value from the 
drop-down.

• Arrowhead Spacing - Enter the distance between arrowheads in 
terms of Y-frame units. A value of ten percent will space arrowheads 
approximately ten percent of the frame height apart from each other 
along each streamline.
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14- 1.3 Rod/Ribbon Page
The following attributes may be set with the Rod/Ribbon page of the Streamtrace Details dialog. 
They affect volume ribbons and volume rods only.

• Rod/Ribbon Width - Enter a width for the volume ribbons and volume rods. 
The width is expressed in grid units. If you want two sets of streamtraces with 
different widths, you must create one set and then extract them as zones, then 
configure a new set of streamtraces with the second width.

• Rod Points - Volume rods have a polygonal cross-section; this parameter tells 
Tecplot what that cross-section should be. Three is an equilateral triangle; four 
is a square; five, a regular pentagon; and so on. If you want two sets of volume 
rods with different cross-sections, you must create one set and then extract 
them as zones, then configure a new set of streamtraces with the second cross-
section.

• Show Mesh - Select this check box to display a mesh.

• Mesh Color - Select a mesh color from the drop-down, or choose a 
custom color or multi-color.

• Mesh Line Thickness - Select a line thickness from the drop-down, or 
enter your own number in the text field.
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• Show Contour Flood - Select this check box to display contour flooding. 

• Flood by - Select the contour group by which to flood.

•  - Use this button to bring up the Contour Details dialog

• Show Shade - Select this check box to display shading.

• Shade Color - Select a shade color from the Select Color dialog. 
Multi-Color and RGB coloring are not available—use contour flood-
ing instead.

• Use Lighting Effect - Select this check box to enable the lighting 
effect drop-down where you may choose Paneled or Gouraud
shading.

• Use Surface Translucency - Select this check box to enable the sur-
face translucency text field, where you may set the surface translu-
cency from one (opaque) to 99 (translucent).

14- 1.4 Timing Page
Use the Timing page of the Streamtrace Details dialog (accessed via the Sidebar or 
Plot>Streamtraces) to control timed markers for streamlines, and timed dashes for all types of 
streamtraces. Stream markers are drawn at time locations along streamlines. The spacing between 
stream markers is proportional to the magnitude of the local vector field. 
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Stream markers are symbols plotted along streamtrace paths to identify the positions of particles at 
certain times. Figure 14-1 shows a plot with both streamtrace markers and dashes.

The spacing between stream markers is proportional to the magnitude of the local vector field. You 
can adjust the spacing between stream markers by specifying the time interval, or delta, between 
stream markers. Increasing the delta time will increase the space between stream markers and vice 
versa. The actual spacing is the product of the local vector magnitude and the specified delta.

You may also select the shape of your stream marker using the pre-set list under the Shape drop-
down menu on the Timing page of the Streamtrace Details dialog. Selecting “Other” from the list 
activates the Enter ASCII Character option, where you may enter an ASCII character to be used as 
your stream marker.

-3 0 3 6 9 12 15

-3

0

3

StartTime = 0.0

TimeDelta = 0.01

-3 0 3 6 9 12 15

-3

0

3

StartTime = 0.01

TimeDelta = 0.01

-3 0 3 6 9 12 15

-3

0

3

StartTime = 0.0

TimeDelta = 0.01

Figure 14-1. Streamtrace markers (top), dashes (bottom), and 
both (middle).
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To place stream markers or dashes along your streamtraces, open the Timing page of the 
Streamtrace Details dialog (accessed via the Sidebar or the Plot menu).

The Timing page has the following options:

• Show Markers [default = spheres (3D) /circles (2D)] - toggle-on to include 
stream markers. Stream markers are available only for streamlines (surface and 
volume). Specify the size, color, and shape of the markers in the fields pro-
vided.

• Show Dashes - toggle-on to include stream dashes. The lengths of the dashes 
and the spaces between them are controlled by the value of Delta. Enter the 
dash skip factor, which controls the number of time deltas used for the “off” 
sections of the streamtraces

• Time Start - Enter the time at which the first marker is drawn. A start time of 
zero means that the first marker is drawn at the starting point. A start time of 
2.5 means that the first stream marker is drawn 2.5 time units downstream of 
the starting point.

• Time End - Enter the time after which no more stream markers are drawn.
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• Time Delta - Enter the time interval which measures the time between stream 
markers. The actual distance between markers is the product of this number and 
the local vector magnitude.

• Time Anchor - Enter the time at which a dash is guaranteed to start provided 
the start and end time surround the dash.

14- 1.5 Termination Line Page
A streamtrace termination line is a polyline that terminates any streamtraces that cross it. The ter-
mination line is useful for stopping streamtraces before they spiral or stall. Figure 14-2 shows the 
cylinder data with some streamtraces terminated with a 2D streamtrace termination line.
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Figure 14-2. A streamtrace termination line drawn through surface streamlines (created with 
demo file cylinder.plt).

Streamtraces are also terminated whenever any of the following occur:

•  The maximum number of integration steps is reached.

•  Any point in the streamtrace passes outside the available data.

•  The streamtrace reaches a point where the velocity magnitude is zero.

In 2D Cartesian plots, the termination line is drawn in the grid coordinate system and moves with 
the data as you zoom and translate. In 3D Cartesian plots, the termination line is drawn in the eye 
coordinate system. This coordinate system moves with the data as you zoom and translate. If you 
rotate a 3D data set after drawing a streamtrace termination line, streamtraces previously termi-
nated by the termination line may be terminated at different places, or not terminated at all if the 
rotated streamtrace no longer intersects the termination line. Figure 14-2 shows a 3D volume plot 
with streamribbons and a streamtrace termination line, and how the termination points vary as the 
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plot is rotated. Notice that the termination line itself remains in place on the screen as the plot is 
rotated.
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Figure 14-3. Volume streamtraces with a termination line.

You control the streamtrace termination line from the Term Line page of the Streamtrace Details
dialog.

From the Term Line page, you can control the following attributes of the termination line:
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• Active Termination Line - If this check box is selected, the termination line is 
active, and any streamtraces that cross it are terminated. You can deselect the 
check box and redraw the plot to view the unterminated streamtraces.

• Show Termination Line - If this check box is selected, the termination line is 
displayed. You can deselect the check box and redraw the plot so that only the 
terminated streamtraces are displayed, not the termination line.

You can select a termination line with the Selector or Adjustor tool. This allows you to interactively 
move the line (with the Selector), modify the line (with the Adjustor), or delete the line (with either 
tool).

14- 1.6 Integration Page
Tecplot uses an adaptive step-size, trapezoidal integration algorithm to calculate streamtraces. The 
basic idea is to create the streamtrace by moving in a series of small steps from the starting point in 
the direction of, or in opposition to, the local vector field. Each step is only a fraction of a cell or 
element. Tecplot automatically adjusts the step size based on the local cell shape and vector field 
variation.

Only one termination line can exist at any 
one time in a given frame. If you draw a 
second termination line, the first is auto-
matically deleted.
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You can control the streamtrace integration by modifying the following parameters in the Integra-
tion page of the Streamtrace Details dialog:

• Step Size - Enter the initial and maximum step size Tecplot uses while inte-
grating through the vector field, as a decimal fraction of the local cell or ele-
ment width. A typical value (and the default) is 0.25, which results in four 
integration steps through each cell or element. The value for Step Size affects 
the accuracy of the integration. Setting Step Size too small can result in round-
off errors, while setting it too large can result in truncation errors and missed 
cells.

• Max Steps - Enter the maximum number of steps before the streamtrace is ter-
minated. This prevents streamtraces from spinning forever in a vortex, or from 
wandering aimlessly in a region where the vector components are very small, 
very random, or both. If you choose a small Step Size, you should enter a 
larger Max Steps.

• Minimum Step Size - The smallest step size for Tecplot to use. Setting this too 
small results in integration problems. Setting this greater than or equal to the 
Step Size results in a constant step size.



Chapter 14:Streamtraces

248

• Obey Source Blanking - When active, streamtraces are generated for non-
blanked regions only. When inactive, streamtraces are generated for blanked 
and unblanked regions.

During the integration, a streamtrace is terminated if any of the following conditions occur:

• The maximum number of integration steps (Max Steps) have been taken.

• Any point in the streamtrace passes outside the available data.

• The streamtrace reaches a point where the velocity magnitude is zero.

• The streamtrace crosses the stream termination line.

Streamtraces may terminate at a zone boundary even if there is an adjacent zone into which the 
streamtraces should proceed. This can happen if there is a small gap between the zones. Specifying 
face neighbors in the data file to connect the zones can alleviate this problem. increasing the mini-
mum integration step size can also eliminate this problem.

14 - 2 Streamtrace Animation
See 27- 1.7 “Streamtrace Animation” on page 528.

14 - 3 Surface streamtraces on no-slip boundaries
When surface streamtraces are placed on a no-slip boundary surface, they will propagate according 
to the normal gradient of tangential velocity (proportional to shear stress) near the surface. This 
velocity gradient is computed from the data in the 3D volume parent zone, as identified by the 
ParentZone parameter.   The ParentZone value identifies the volume zone to which the surface zone 
is bound (i.e. from which velocity data will be taken) and is read from the data file itself. Refer to
“Summary of Data File Records” on page 27 of the Data Format Guide Summary of Data File 
Records in the Data Format Guide for information on specifying the ParentZone in ASCII data 
files. In addition, the wall boundary surfaces must be identified by the following auxiliary data 
variables:

Common.IsBoundaryZone = TRUE
Common.BoundaryCondition = Wall.

The parent zone must be volume and be 
coincident with the no-slip boundary zone 
for this feature to work.
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14 - 4 Streamtrace Extraction as Zones
To extract your streamtraces as zones select Extract>Streamtraces from the Data menu. 

If you want all streamtraces of a given format extracted to a single zone, select the check box 
labeled Concatenate Common Streamtraces into One Zone in the Extract Streamtraces dialog. If you 
select this check box, Tecplot extracts all surface lines into one zone, all volume lines into another, 
all volume ribbons into a third, and all volume rods into a fourth. Tecplot uses value-blanking to 
blank out the intervals between streamtraces (and between stream dashes). If you do not select the 
check box, each streamtrace is extracted into its own zone.

After you have extracted your streamtraces, you will still see the original streamtraces, which may 
obscure the plotted streamtrace zones. Once you have extracted the zones, you can delete the origi-
nal streamtraces by clicking Delete All Streamtraces in Position page the Streamtrace 
Details dialog. If timed dashes are active, all extracted streamtraces will be finite-element zones. 
Otherwise, all extracted streamline zones are I-ordered, and extracted volume ribbon and volume 
rod zones are IJ-ordered.

14 - 5 Streamtrace Errors
Streamtraces will not appear under the following conditions:

•  unorganized data (I-ordered zones)

•  zero-valued vectors

•  the streamtrace was placed outside of the data

•  inappropriate integration step size
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Chapter 15 Translucency and Lighting

For 3D plots, shade and contour zone layers can be enhanced using Translucency and Lighting 
Effects (referred to collectively as the “3D zone effects”). The 3D effects for streamtraces, slices 
and iso-surfaces can be activated via their respective blocks in the Sidebar. The Effects page of the
Zone Style dialog is shown below.

15 - 1 Translucency
Turn-on the translucency zone effect, by toggling-on “translucency” in the Zone Effects region 
of the Sidebar. When a zone is translucent, you may view objects inside or beyond the zone. You 
control the translucency of a zone using the Surface Translucency attribute in the Effects page 
of the Zone Style dialog. The level of translucency may be set to a value between one (nearly solid) 
and 99 (nearly invisible). There are nine pre-set percentages ranging from ten to 90. You may also 

In order for the changes made in on the Effects page to be visi-
ble in your plot, the corresponding zone effect (lighting or 
translucency) must be toggled-on in the Sidebar.
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use the Enter option to define a percentage of your own. An example of a translucent plot is shown 
in Figure 15-1.

Figure 15-1. An example of a plot using translucency.

All surfaces in 3D Cartesian plots may be made translucent. A different translucency may be 
assigned to individual zones, and may also be assigned to derived objects such as slices, 
streamtrace ribbons or rods, and iso-surfaces. Use the Effects page of the Zone Style dialog to 
change translucency settings for zones.

15 - 2 Lighting Effects
There are two types of lighting effects, Paneled and Gouraud.

• Paneled - Within each cell the color assigned to each area by shading or con-
tour flooding is tinted by a shade constant across the cell. This shade is based 
on the orientation of the cell relative to your 3D light source.

• Gouraud - This plot type offers a more continuous and much smoother shad-
ing than Paneled shading, but also results in slower plotting and larger print 

Translucency will only appear on your screen, 
or in exported bitmap images. Translucency 
will appear opaque in print-outs. See Appen-

dix G, “Limits of Tecplot 360,”for more details.
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files. Gouraud shading is not continuous across zone boundaries, unless face 
neighbors are specified. Gouraud shading is not available for finite-element 
volume zones when blanking is included. A finite-element volume zone set to 
use Gouraud shading will revert to Paneled shading when blanking is included.

IJK-ordered data with Surfaces to Plot set to Exposed Cell Faces, faces exposed 
by blanking will revert to Paneled shading.

Figure 15-2 shows two shade plots. The one on the left uses a Paneled lighting effect and the one on 
the right a Gouraud lighting effect.

GouraudPaneled
Figure 15-2. A comparison of the paneled (left) and Gouraud (right) lighting effects.
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15 - 3 Three-Dimensional Light Source
The light source is a point of light, infinitely far from the drawing area. You can open the Light 

Source dialog (Figure 15-3) by selecting the  next to Lighting Zone effect toggle on the sidebar, 
or by selecting Light Source from the Plot menu.

The Light Source dialog has the following options:

• Light Source Position - The 3D light source position is indicated by a dot 
over the origin of the 3D orientation axes in the Light Source Position region of 
the dialog. The 3D light source is a point of light infinitely far from the 
drawing area. The 3D light source applies to all objects within a frame and 
may be different among frames in the workspace. 

You can specify its location by clicking-and-dragging the point with your mouse 
in the Light Source Position region on the Light Source dialog. When the light 
source position moves away from the eye-origin ray, its representation change 
from a point to an arrow. The length of the arrow indicates the distance between 
the eye-origin ray and the light source position. 

Figure 15-3. The Light Source dialog.
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• Intensity (%) - Controls the amount of lighting effect produced by the direc-
tional light source. An intensity of 100 produces the maximum contrast 
between lit and unlit areas, and fully lit areas use the full surface color. Lesser 
values produce less contrast between lit and unlit areas, and fully lit areas use 
darker colors. An intensity of zero means the light source produces no contrast 
between lit and unlit areas, and all areas are black.

• Background Light (%) - Controls the amount of lighting effect applied to all 
objects regardless of the light source position. A background light of zero 
means that areas unlit by the directional light source receive no lighting at all 
and are entirely black, while areas lit by the directional light source get only the 
effect of that light. Larger values produce more lighting effect in areas not lit by 
the directional light source, making these areas show some of the surface color. 
A background light of 100 means that all areas are lit by the maximum amount, 
and areas unlit by the directional light source use the full surface color.

• Surface Color Contrast (%) -Controls the contrast of the color of light source 
shaded surfaces before applying lighting effects. A surface color contrast of 
100 means that light source shaded surfaces use the full surface color for apply-
ing lighting effects. Lesser values mean that the surface color is blended with 
progressively more white, making light source shaded surface colors lighter. A 
surface color contrast of zero means that colors are pure white before applying 
lighting effects; the plot will only be shades of gray.

• Include Specular Highlighting - Turns on/off specular highlight for all light-
source shaded objects in the plot. Specular Highlighting adds the semblance of 
reflected light to 3D shaded or flooded objects.

• Intensity (%) - Controls intensity of specular highlights (that is, the 
amount of reflected light, which controls the amount of whiteness at 
the peak of the highlight).

• Shininess - Controls shininess of specular highlight (that is, roughly 
the size and spread of specular highlight).

Note: Intensity and Background Light are 
cumulative; they can add up to more than 
100 and result in colors lightened beyond the 
base surface color. For example, reds will 

become pink and grays will become white.
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• Lighting Optimizations - Some combinations of lighting type and plot style 
may result in very slow redrawing of plots. Tecplot provides lighting optimiza-
tions to avoid such conditions and instead draws a similar, but less intensive 
plot. These optimizations are on by default. Turn them off if you need to see the 
exact effects you have specified. You may want to turn off the graphics cache 
before turning off those optimizations for plots with large amounts of data. (See 
“Graphics Cache” on page 549 for information on the graphics cache.)
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Tecplot creates axes automatically for 2D, XY and Polar plot types. For these automatically created 
axes, Tecplot determines good tick mark position and spacing, and creates reasonable tick mark and 
axis labels. You can modify your Tecplot configuration file to change the default behavior, and you 
can use the Axis Details dialog (accessed via the Plot menu) to modify your axes.

Tecplot maintains five distinct sets of axes, one for each plot type. Each page of the Axis Details
dialog controls a different aspect of the axis, and each page is repeated for each axis. 

16 - 1 Axis Display
Use the Show Axis toggle switch in the Axis Details dialog to turn-on an axis display. By default, 
displaying an axis, shows the axis line, tick marks, tick mark labels, and title for the axis. It is 
possible to disable any of these components separately, including the axis line. But if you choose 
not to show an axis, none of the plot components associated with that axis (line, tick marks, tick 
mark labels, title, or grid lines) is displayed. 

You can control whether an axis is shown from any page (except Area) of the Axis Details dia-
log, using the Show a-Axis check box, where a is Theta or R for Polar Line plots, X or Y for 2D 
Cartesian and Sketch plots, X1 – X5 or Y1 – Y5 for XY Line plots and X, Y, or Z for 3D Cartesian 
plots.

To edit an axis from the Axis Details dialog, use 
buttons at the top of the dialog that indicate which 
axis you are working with. To edit a different axis, 
select a different axis button.
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16 - 2 Axis Variable Assignment
For 2D axes, Tecplot initially assigns the first and second variables in the data set to the X- and Y-
axes, respectively. For 3D axes, Tecplot initially assigns the first three variables in the data set to 
the X-, Y-, and Z-axes respectively.

To change variable assignments for 2D and 3D axes, select Assign XY or Assign XYZ, respectively, 
from the Plot menu. 

For line plots, assigning axis variables is part of defining the mappings. See Chapter 5, “XY and 
Polar Line Plots,” for more information.

16 - 3 Axis Range Modification
When working with axes ranges, please keep the following definitions in mind:

Axis Range - specifies the minimum and maximum data values displayed along the axis.
Axis Length - physical length of the axis on the screen or paper. 
Axis Scale - ratio of the axis length to the axis range.

The range for an axis fits the value of the first variable assigned 
to that axis. If you deactivate the current layer and activate 
another, it may be necessary to reset the axis range.
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To change the axis range, open the Range page of the Axis Details dialog (accessed via the Plot
menu)(Figure 16-1.).

Figure 16-1. The Range page of the Axis Details dialog for a 3D plot.

The Range page has the following options:

•  Min - enter the minimum value of the range

•  Max - enter the maximum value of the range

• Preserve Length when Changing Range - maintain axis length while allow-
ing other changes to the axis

If you receive an error message stating 
“Axis extends beyond edge of frame”, tog-
gle-on Preserve Length when Changing 
Range and try your changes again.
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• Reverse Axis Direction (XY, Polar and 2D plots only) - toggle-on to reverse 
the axis direction. 

• Use Log Axes - The X- and Y-axes of XY Lines plot types and the R-axis of 
Polar Line plot types can have a linear scale (default) or a logarithmic scale. 
When “Auto Spacing” is selected with logarithmic scale, large numbers are dis-
played in scientific notation (i.e., 3.48x105). It is strongly recommended that 
you use “Auto Spacing” with log axes. On the Ticks or Labels page of the dia-
log, confirm Auto Spacing is selected.

• Reset Range - override Max and Min settings by selecting one of three 
options:

• Reset to Nice Values - Sets the range to slightly larger than the range 
of the axis variable in order to begin and end the axis at major axis 
increments.

• Reset to Var Min/Max - Sets the range to slightly larger than the 
range of the axis variable.

• Make Current Values Nice - Moves the axis range to the nearest 
major axis increments.

• Dependency - not available for polar plots

• for XY Line or 2D cartesian: select Independent or Dependent.
• for 3D cartesian:

•Independent - All axes are independent.
•XY Dependent - The X- and Y-axes are dependent upon each 
other. The Z-axis is independent

•XYZ Dependent - Changing the scale on any axis results in a 
proportional change in scale on the other two axes, so that the 
specified X to Y Ratio and X to Z Ratio are preserved

• Ratios (for field plots only)

To reverse the axes for 3D plots, use nega-
tive size factors and/or negative X-to-Y
and X-to-Z ratios. 
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• for 2D Plots, if Dependent is selected, enter the X to Y Ratio
• for 3D Plot, if XY Dependent is selected, enter the X to Y Ratio
• for 3D Plots, if XYZ Dependent is selected, enter the X to Y Ratio

and the X to Z Ratio

• Size Factors (for field plots) - If the axes are XY-dependent, changing the X or 
Y-size factor changes the other. If the axes are XYZ-dependent, changing one 
size factor changes the other two.

Figure 16-2.depicts the effect of toggling-on or off the Preserve Length when Changing Range 
option.
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Figure 16-2. Preserving length versus preserving scale while changing range (left); 
preserving length versus preserving scale while changing range in a Polar 
Line plot (right).

If Preserve Length when Changing Range is selected and your 
axes are Independent, changes to the X to Y Ratio will 
effect the axes range, but not scale. Deselect Preserve Length 
when Changing Range to change both the axis range and axis 
scale simultaneously.
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Axis Range Modification for Polar Axis
Polar axes are different than any other axis type due to their cyclical nature. Polar axes are 
composed of the Theta- and R-axis. Each axis has very different settings, unlike XY- or XYZ- axes. 
For the Theta-axis you can change the Theta Mode, Theta Period, and orientation; for the R-axis you 
can change the origin; and for both axes you can clip the data to the axes. Each of these features are 
discussed below.

Clip Data to Axes. For Polar Line plots, it is possible to have data that extends beyond the 
edges of the axes. Use this feature to eliminate data drawn outside of the range of the axes. Clipping 
data can be set independently for the axes. To activate or deactivate clipping, use the Clip Data 
to Axis toggle on the Range page of the Axis Details dialog. This feature is illustrated in Figure 
16-3.
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Figure 16-3. An example of clipping polar data to an axis.

Theta Mode. By default the Theta-axis is in degrees mode with a range of zero to 360. For the 
Theta axis you can plot the angles in units of: Radians, Degrees and Arbitrary (where arbitrary sets 
the Theta range the maximum and minimum values of the variable). The options for the Theta 
Mode are 0 - 360 degrees, -180 – 180 degrees, 0 – 2 Pi radians, Pi-Pi radians, and Fit to Var Min/
Max. Selecting any of these options changes the Theta Mode, resets the Theta-axis range, and 
resets the Theta Period.

When the Theta Mode is radians, Tecplot attempts to draw theta labels as fractional units of Pi. 

Theta Period. The Theta Period specifies the theta range that is required to create a complete 
circle. If your Theta Mode is “Degrees”, the Theta Period is forced to 360; for “Radians” the 
period is 2 Pi. For “Arbitrary” you can set the period to any value.
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Theta Value on Circle Right. The Theta Value on Circle Right setting changes the 
orientation of the Theta-axis. By default this value is zero, which means that the value zero (or 
equivalent value, 360 degrees, 720 degrees, and so forth) is displayed on the right hand side of the 
circle. You can change this value to change the orientation of the axis.

R-Origin. The R-Origin can be changed on the Range page of the Axis Details dialog. This 
setting specifies what value of R is represented at the center of the axis. The effect of changing the
R-origin from a range of 0.3 to 0.6 is displayed in Figure 16-4.
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Figure 16-4. An example of changing the R-origin on a polar plot
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16 - 4 Axis Grids
You control the gridlines and precise dot grid from the Grid page of the Axis Details dialog, as 
shown in Figure 16-5. The spacing of gridlines is controlled by the tick mark spacing; see Section 
16 - 5, “Tick Marks,” for more information.

Figure 16-5. The Grid page of the Axis Details dialog for a Polar Line plot.

The Grid page of the Axis Details dialog has the following options:

• Gridlines - toggle-on Show to display major gridlines on your plot. You can 
customize the line pattern, pattern length, line thickness and line color.

• Minor Gridlines - toggle-on Show to include minor gridlines on your plot. 
You can customize the line pattern, pattern length, line thickness and line color.

In a Polar Line plot the abundance of grid-
lines at the center may obscure data. You 
can specify a gridline cutoff along the R-
axis of polar plots on the Grid page of the 
Axis Details dialog for the Theta-axis. 



265

Tick Marks

• Gridline Cut-off (R%) [Polar only] - The point along the R-axis where you 
want to stop drawing Theta-lines.

• Gridline Draw Order - For all axes except 3D, you may specify a gridline 
draw order. Gridlines may be drawn either first, before any of the other plotting 
layers, or last, so they overlay any plotting layers. You can also specify the 
gridline draw order by “pushing” or “popping” the axis grid area from the Edit 
menu. First select the axis grid area by clicking on a gridline, then choose Push 
from the Edit menu to plot the gridlines first, or choose Pop to plot the gridlines 
last.

• Show Precise Dot Grid - The precise dot grid is a set of small dots drawn at 
the intersection of every minor gridline. In line plots, the axis assignments for 
the first active mapping govern the precise dot grid. The precise dot grid 
option is disabled for the 3D Cartesian plot type, and line plots when either 
axis for the first active line mapping uses a log scale. 

16 - 5 Tick Marks
Each axis can be marked with tick marks, and those tick marks may or may not be labeled, either 
with numbers or with custom text strings. You control tick marks and their placement using the 

NOTE: Drawing an object “Last” brings it to 
the front of your plot and drawing and object 
“First” puts it at the back of your plot.
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Ticks page of the Axis Details dialog (Figure 16-6.). You control the tick mark labels using the 
Label page of the Axis Details dialog.

Figure 16-6. The Ticks page of the Axis Details dialog for polar line plots.

The Ticks page of the Axis Details dialog has the following options:

• Show Tick Mark On - For each plot type, you can display tick marks at dif-
ferent sections of the axis. (This description also applies to Labels and Titles).

• Sketch, XY Line, and 2D Cartesian axes allow tick marks to be dis-
played in the following areas:

•Axis Line - the line that represents the specified axis

•Grid Border Left (Grid Border Bottom) - By default the 
axis line and grid border left/bottom are in the same position. 
Grid Border Left is the left most position of the grid as 
defined by the viewport settings on the Area page of the Axis 
Details dialog

•Grid Border Right (Grid Border Top).
• Polar R-axis allows tick marks to be displayed in the following areas:

•Axis Line - the line that represents the R-axis
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•All R-axes - only available if the Draw Axis in Both 
Directions toggle or Draw Perpendicular Axis toggle 
is checked for the R-axis The All R-axes setting will draw 
tick marks on the additional axes that are drawn.

•Grid Border Start - start point of the polar grid area.

•Grid Border End - endpoint of the polar grid area. 

• Polar Theta-axis allows tick marks to be displayed in the following 
areas:

•Axis Line - the line that represents the Theta-axis

•Inner Circle - only available if the minimum value on the 
R-axis is greater than the R-Origin value; when this is the 
case, the center of the polar plot is a circle rather than a single 
point, therefore ticks can be drawn on the inner circle

•Outer Circle - the outer edge of the polar grid area.
• Three-dimensional axes allow tick marks to be displayed in the fol-

lowing areas:
•Axis Line - the line that represents the specified axis
•Opposite Edge - the complimentary line that is opposite the 
axis line

• Tick Mark Length and Thickness - Tick mark length and thickness can be set 
independently for tick marks and minor tick marks using the Length and 
Thickness fields on the Ticks page of the Axis Details dialog.

• Number of Minor Tick Marks - Toggle-off Auto Spacing toggle at the bot-
tom of the page, to specify the number of minor tick marks to display The num-

Grid Border Start and Grid Border End are only 
available if the polar plot does not form a complete 
circle. If the data forms a complete circle, there is no 
start or end point on which to draw the ticks.
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ber of minor tick marks can be set in the Number of Minor Ticks text field 
on the Ticks page of the Axis Details dialog.

• Tick Mark Direction - The following options are available to specify direc-
tion in which the tick marks are drawn:

• In - Tick marks and minor tick marks are drawn from the axis toward 
the center of the plotting region.

• Out - Tick marks and minor tick marks are drawn from the axis away 
from the center of the plotting region. 

• Center - Tick marks and minor tick marks are centered on the axis 
line.

• Tick Mark and Label Spacing - You can control tick mark and tick mark 
label spacing directly, or use Auto Spacing (the default), to calculate an opti-
mal spacing for tick marks and tick mark labels. As you change views, particu-
larly in zooming, Tecplot recalculates the spacing. With Auto Spacing
selected, Tecplot also calculates the number of minor tick marks for you.

Spacing values are shared between the tick marks and tick labels. You can 
change the spacing by adjusting the Auto Spacing, Spacing and Anchor
controls at the bottom of the Ticks or Label pages of the Axis Details dialog.

16 - 6 Tick Mark Labels
From the Labels page of the Axis Details dialog, you can specify attributes for tick mark labels 
for each axis.

The following options are available:

• Show Labels On - Select the appropriate check boxes for label display. The 
available options are dependent upon plot type.

• Number Format - You can choose several numeric formats for your tick mark 
labels, or specify a set of text strings to use as custom labels. The following 
numeric formats are available:

Note: There is not a separate control for showing 
minor tick marks. To hide minor tick marks, enter 
zero in the Number of Minor Ticks text field.
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• Integer - Tick marks are labeled in integer format (for example, 12). If 
this format is selected, tick mark labels with a decimal part are trun-
cated.

• Float - Tick marks are labeled with floating-point numbers (for exam-
ple, 10.2).

• Exponent - Tick marks are labeled using numbers in exponential for-
mat (for example, 1.02E-03).

• Best Float - Tecplot selects the best floating-point representation of 
the tick mark labels.

• Range Best Float - Tecplot selects the best floating-point representa-
tion of the tick mark labels, taking into account the range of values on 
the axis.

• Superscript - Tick marks are labeled with numbers in scientific nota-
tion (for example, 1.2x10-3).

• Custom - Uses the specified custom label set to label the axes.
Custom labels are text strings defined in your data file that allow you 
to print meaningful labels for variables that do not contain numeric 
data. Custom labels are defined using the CUSTOMLABELS record; 
each CUSTOMLABELS record corresponds to one custom set. When 
you choose custom labels for an axis, you also choose which custom 
set should be used for that axis.
An example of using custom formatting is can be found at the end of 
this section. 

• Offset from Line (%) - Enter the offset of the tick mark labels from the axis.

• Orient Labels - Select from the following additional options for label display:

• At Angle - labels oriented at the angle specified in the Angle drop-
down menu

• Parallel to Axis - labels are parallel to the axis
• Perpendicular to Axis - labels are perpendicular to the axis

• Angle (deg) - If Orient Labels is set to “At Angle”, specify the orientation of 
the tick mark labels relative to the axis. The angle is measured in degrees 
counter-clockwise from the axis.

• Show Label as Axis Intersection [2D, XY and Polar Only] - Toggle-on to 
draw a label at the point where two axes intersect. Use this toggle if you have 
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axis labels that are colliding, or stacked on top of one another at the intersection 
of two axes.

• Erase Behind Labels - Toggle-on to include a rectangle (with the color of the 
frame background) behind the label to increase the visibility of the labels.

• Label Skip - specify the interval between tick mark labels.

• Tick Mark and Label Spacing - You can control tick mark and tick mark 
label spacing directly, or use Auto Spacing (the default), to calculate an opti-
mal spacing for tick marks and tick mark labels. As you change views, particu-
larly in zooming, Tecplot recalculates the spacing. With Auto Spacing
selected, Tecplot also calculates the number of minor tick marks for you.

Spacing values are shared between the tick marks and tick labels. You can 
change the spacing by adjusting the Auto Spacing, Spacing and Anchor
controls at the bottom of the Ticks or Label pages of the Axis Details dialog.

Using Custom Labels
As a simple example of using custom labels, consider the following data file, containing data about 
attendance at two schools:

The numbers 1 and 2 represent the school number, and the CUSTOMLABELS record defines Cleve-
land as school one and Garfield as school two. Once you assign custom labels in Tecplot, the 
School axis is labeled with Cleveland and Garfield rather than 1 and 2.

To create a plot with custom labels:

1. Create a data file with one or more CUSTOMLABELS records, and one or more 
variables with ordered integer values 1, 2, 3, and so forth. The first string in 

VARIABLES= "SCHOOL", "ATTENDANCE"
CUSTOMLABELS "Cleveland", "Garfield"

ZONE T="1991"
1 950
2 640
ZONE T="1992"
1 1010
2 820
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the CUSTOMLABELS record corresponds to a value of 1, the second string to 
2, and so on. Read the data file into Tecplot.

2. Create a plot. XY Line plots are the most likely to use custom labels, but you 
can use them anywhere.

3. From the Plot menu, choose Axis, and select the Label page of the Axis 
Details dialog.

4. Choose the axis for which you want to assign custom labels, click Number 
Format, and select “Custom” from the Format drop-down. Choose a set of 
custom labels for the axis from among all the CUSTOMLABELS records in the 
data file. For this example, edit the X-axis and choose custom set 1.

5. Go to the Ticks page of the Axis Details dialog. Deselect Auto Spacing, 
then set the spacing to one. (You may also want to set the number of minor 
ticks to zero.)

6. Go to the Range page of the Axis Details dialog. Set the Min and Max 
value to 0.5 and 2.5 respectively.

7. Close the Axis Details dialog, then go to the sidebar. From the plot layers, 
select the Bars, deselect the Lines check box.
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The attendance data are plotted in Figure 16-7.
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Figure 16-7. Bar charts with custom labels.

As another example, consider the following data file containing temperature and rainfall data:

VARIABLES= "MONTH", "TEMPERATURE", "RAINFALL" 
CUSTOMLABELS "Jan", "Feb", "Mar", "Apr", "May", "Jun", "Jul", "Aug", 
"Sep", "Oct", "Nov", "Dec" 
CUSTOMLABELS "Cold", "Cool", "Warm", "Hot" 
CUSTOMLABELS "Dry", "Average", "Wet" 
1 1 1 
2 1 2 
3 2 3 
4 2 3 
5 3 3 
6 3 2 
7 4 1 
8 4 1
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This weather data file is plotted in Figure 16-8.
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Figure 16-8. A 3D plot with custom labels on each axis.

Custom labels are used cyclically. That is, if the variable assigned to the axis using custom labels 
goes over the number of custom labels, Tecplot starts with the first label again. This is useful for 
days of the week, months of the year, or other cyclical data. In the weather data set above, a value 
of 13 for the MONTH variable yields a tick mark label of "Jan". Similarly, a value of five for TEM-
PERATURE yields a tick mark label of "Cold".
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16 - 7 Axis Titles
An axis title is a text label that identifies the axis. By default, Tecplot labels each axis with the 
name of the variable assigned to that axis.

From the Title page of the Axis Details dialog, you can specify the following attributes for 
each axis title (Figure 16-9).

• Show Title On - For any plot type, you can specify to show the axis title 
directly on the corresponding axis. The remaining available options are depen-
dent upon plot type.

• for 3D ONLY - Opposite Edge
• for 2D, XY Line or Sketch - Grid Border Bottom or Grid Border Top
• for Polar Line plots - Inner Circle or Outer Circle

• Offset from Line - prevents Tecplot from printing your axis title directly on 
top of the axis. You may specify a positive or negative offset from one side or 
the other of the axis. An offset of zero offset prints the edge of the axis title on 

Figure 16-9. The Title page of the Axis Details dialog for the 3D plot type.
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the axis. [OPTIONAL] You may also adjust the axis title offset using the Adjus-

tor  tool from the toolbar.

•  Position along Line - specify a the start position of the axis title, as a percent-
age of axis length.

• Title

• Use Variable Name - use the axis variable name as the title.
• Use Text - enter the desired axis title in the appropriate text field.

16 - 8 Axis Lines
The actual axis line is shown by default whenever the axis is shown. However, you can hide the 
axis line without turning off the axis as a whole.

To show or hide the axis line, select the Lines page of Axis Details dialog appears (accessed via 
the Plot menu) Figure 16-10.

Figure 16-10. The Line page of the Axis Details dialog for 3D plots.

The Lines page for Sketch, XY Line, Polar Line and 2D Cartesian axes has the following options:
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• Show Axis Line - toggle-on to display on axis line.

• Align Axis with -

• Options for Sketch and 2D - Y Value, Bottom, Top or Viewport

• Options for XY Line - Y1 Value, Bottom, Top or Viewport

• Options for Polar - Theta-axis- R Value, Inner Circle, or Outer 
Circle. When aligning with an R-value you may enter an R-axis 
value to specify the position of the axis line. When aligning with the 
inner or outer circle, specify an offset. With a zero offset, the axis line 
is on the inner or outer circle, a positive offset moves the axis line out-
side the grid area. A negative offset moves the axis line within the grid 
area.

• Options for Polar - R-axis - R Value, Inner Circle, or Outer 
Circle. When aligning with an R-value you may enter an R-axis 
value to specify the position of the axis line. When aligning with the 
inner or outer circle, specify an offset. With a zero offset, the axis line 
is on the inner or outer circle, a positive offset moves the axis line out-
side the grid area. A negative offset moves the axis line within the grid 
area.

•Theta Value - Align the R-axis with a specific Theta-value. 
The axis is limited to the grid area.

•Grid Border Start - Align the R-axis with the start of the grid 
border. The axis is limited to the grid area.

•Grid Border End - Align the R-axis with the end of the grid 
border. The axis is limited to the grid area.

•Specific Angle - Align the R-axis with a specific screen angle. 
The axis is limited to the grid area.

•Top of Grid Area - Align the R-axis with the top of the grid 
area. The axis may be drawn outside the grid area.

•Bottom of Grid Area - Align the R-axis with the bottom of 
the grid area. The axis may be drawn outside the grid area.

•Left of Grid Area - Align the R-axis with the left side of the 
grid area. The axis may be drawn outside the grid area.

•Right of Grid Area - Align the R-axis with the right side of 
the grid area. The axis may be drawn outside the grid area.
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In addition to setting the alignment of the R-axis, you may choose to 
extend the R-axis by drawing an axis line perpendicular or parallel to 
the existing axis line. When the Draw Axis in Both Directions toggle is 
selected, Tecplot extends the axis line so it spans the width of the grid 
area. If the Draw Perpendicular Axis toggle is selected, Tecplot draws 
an axis line perpendicular to the main axis line.

• Offset (%) - enter the offset of the line from the axis

• Show Grid Border [2D, XY and Sketch plots Only] - A line is drawn around 
the grid, when this is toggled-on.

• Show Viewport Border (polar line plots only) - toggle-on to show the view-
port border (defined in the Area page of the Axis Details dialog).

The Lines page for 3D Cartesian axes has the following options:

• Show Line on Opposite Edge

• Show Axis Box - All edges of all axes are displayed with this is toggled-on.

• Auto 3D Edge Assignment - If toggled-on, Tecplot automatically places the 
three axis lines so they will not interfere with the drawing of the plot. If tog-
gled-off, you have the option to place the line at: Y-Min & Z-Min, Y-Max & 
Z-Min, Y-Min & Z-Max, or Y-Max & Z-Max, 

16 - 9 Grid Area
The grid area of your plot is the area defined by the axes. For Sketch, XY Line, and 2D Cartesian 
plots you can alter the size of the grid area by changing the extents of the viewport. (For these plot 
types the viewport and grid area are synonymous.) For Polar Line and 3D Cartesian plots, the grid 
area is altered by changes to the axis ranges. For 3D axes, you can also specify an axis box padding, 
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the minimum distance from the data to the axis box, and whether to light-source shade the axis 
planes. From the Area page of Axis Details, you control whether the grid area or viewport are 
color-filled. The Area page is shown in Figure 16-11.

Figure 16-11. The Area page of the Axis Details dialog.
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Manipulation
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Chapter 17 Blanking

Blanking allows you to exclude specific portions of zones from being plotted (in other words, 
selectively display certain cells or data points). In 3D, the result is analogous to a cutaway view.

In general, all types of blanking affect all field layers, zones and all other plot attributes with the 
following exceptions:

Value Blanking Edge Layer
IJK Blanking Derived Objects

a. Derived Objects can opt in or out of blanking. (See  “Blanking Settings for Derived 
Objects” on page 281)

a (slices, streamtraces or iso-sur-
faces)
FE zones
Unstructured/Unorganized zones

Depth Blanking Derived Objectsa (slices, streamtraces or iso-sur-
faces)

Blanking settings are only applied to the current frame. Value blanking settings for multiple frames 
may be synchronized using frame linking. Refer to 3- 3.6 “Frame Linking” on page 70 for more 
information on linking.

Blanking results for volume zones depend upon the Surfaces to Plot setting on the Surfaces page of 
the Zone Style dialog (See Section 6- 1.2, “Surfaces,” for more details).

Type of Blanking Attribute Not Blanked

Table 17-1. Plot attributes not affected by blanking
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Value Blanking

In the following discussions, the term “cell” is used. In I-ordered data sets, a cell is the connection 
between two adjacent points. In IJ-ordered data sets, a cell is the quadrilateral area bounded by four 
neighboring data points. In IJK-ordered data sets, a cell is the six-faced (hexahedral) volume 
bounded by eight neighboring data points. For finite-element data sets, a cell is equivalent to an 
element.

The forms of blanking are as follows:

• Value Blanking - Cells (or portions of cells) of selected zones or line plot map-
pings are excluded based on the value of the value-blanking variable at the data 
point of each cell or at the point where each cell intersects with a constraint 
boundary.

• IJK-Blanking - Cells of one IJK-ordered zone are included or excluded based 
on the index values. (IJK-ordered zones ONLY)

• Depth-Blanking - Cells in a 3D plot are visually excluded based on their dis-
tance from the viewer plane. (3D zones ONLY)

All types of blanking may be used in a single plot. They are cumulative: cells blanked from any of 
the options do not appear. Value-blanking and Depth-blanking affect selected zones of all types, 
while IJK-blanking affects a single IJK-ordered zone.

Blanking Settings for Derived Objects
You can opt to turn blanking on or off for derived objects (iso-surfaces, streamtraces, or slices) in 
their respective Details dialogs. 

• Iso-surfaces - The option is located on the Style page of the Iso-surface Details
dialog.

• Streamtraces - the option is located on the Integration page of the Streamtrace 
Details dialog.

• Slices - the option is located on the Other page of the Slice Details dialog.

17 - 1 Value Blanking
Value-blanking allows you to selectively eliminate or trim cells (2D only) and elements from Line, 
2D, and 3D field plots. For each active constraint you specify a value-blanking variable, a constant 
value or another variable, and a conditional statement telling Tecplot that region to blank in relation 
to the specified variable or constant. 
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Value Blanking for Field Plots
To include value blanking in your plot, go to the Plot menu and select Blanking>Value-Blanking.   

The Value-Blanking dialog (Figure 17-1) has the 
following options:

Figure 17-1. The Value-Blanking dialog when 
plot type is 2D or 3D Cartesian

•Include Value-Blanking - toggle-on to 
include value-blanking

•Blank entire cell when - Select one of the 
following blanking styles:

•Trim cells along constraint boundary

•Blank entire cells when. 

•All corners are blanked - Cells are 
removed from the plot if all of their data 
points satisfy one or more of the active 
blanking constraints.

•Any corner is blanked - Cells are removed 
from the plot if any of their data points sat-
isfy one or more of the active blanking con-
straints.

•Primary value is blanked - Cells are 
removed from the plot based on the primary 
value for a cell. The primary value for the 
cell is dependent upon the zone type and the 
variable value location, as outlined in Table 
17-2.



Ordered Cell Centered Cell value
Finite Element Cell Centered Cell value
Ordered Nodal Lowest indexed corner in the cell
Finite Element Nodal First node in the connectivity list for 

the cell
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Value Blanking

• Constraint - you can establish up to eight value-blanking constraints

• Active - toggle-on to activate a constraint by selecting.

• Blank When - for each constraint, set the following parameters

• Select the variable to use for value-blanking. 

• Specify one of the following operations to describe how the blanking 
variable will be compared to the constant or variable following it.

• Show Constraint Boundary (2D ONLY) - toggle-on to display the line which 
separates the region of your data which is blanked from the region which is not 
blanked

Zone Type Value Location Source of Primary Value

Table 17-2. Primary Cell Value Criteria

It is often convenient to create a new variable for 
use as the value-blanking variable. This allows you 
to manipulate its values without changing any other 
part of the plot. 

If a value-blanking variable is not available, you can create 
one using the Specify Equations dialog (accessed via 
Data>Alter). See Section 18- 1.1, “Equation Syntax”

Value-blanking has no effect on edges of an ordered 
zone. If the edge is turned on, the edge of the entire 
zone (without value-blanking) is plotted.
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For finite-element data, value-blanking can affect the view of previously extracted boundaries, 
because each extracted boundary is a zone (see “Boundary Extraction of Finite-Element Zones” on 
page 321).
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Figure 17-2. The effects of the different value-blanking options in 2D field plots for a 
constraint where a variable is less than or equal to zero. The dark shading 
indicates the areas which are not blanked. A) Blank cell when primary value is 
blanked. B) Blank cell when all corners are blanked. C) Blank cell when any 
corner is blanked. D) Trim cells along mathematical constraint boundary.

Figure 17-2 illustrates the various value-blanking modes for 2D plots.

Blanking Settings for Individual Zones
Using the Effects page of the Zone Style dialog (accessed via the Plot menu or the Sidebar), you can 
turn value blanking on and off for individual zones. Simply, highlight the zone(s) and select “Yes” 
or “No” from the Use Value Blanking column.
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Line Plot Blanking
For line plots, blanking excludes data points from consideration in the resulting plot. On a global 
scale, only value-blanking is available. To plot specific index ranges you can use the Indices page 
of the Mapping Style dialog to limit index ranges per mapping. The Curves page can provide 
another form of blanking, by allowing you to limit the range for the independent variable for indi-
vidual mappings.

Figure 17-3 shows two plots. The original data for the plots contain some “bad” data points. The 
bad data points were identified as those with a Y-value greater than 0.6. The plot on the left uses all 
data points, including the bad data points, to draw a curve. The plot on the right has filtered out the 
bad data points by using value-blanking where all points are removed if Y > 0.6. Blanking does not 
necessarily have to be on the independent or dependent variable.

Figure 17-3. XY Line plots showing the effect of value-blanking.

17 - 2 IJK-Blanking 
IJK-blanking is available only for 3D volume zones. IJK-blanking removes a selected portion of 
one IJK-ordered zone from the plot. This allows you to create cutaway plots, plots showing the 
exterior of some data set with a section “cut away” to show the interior, such as the plot shown in 
Figure 17-4.  

To use IJK-blanking, you must have an IJK-ordered 
zone, and the current plot type must be 2D or 3D Car-
tesian. Unlike value-blanking, which operates on all 
zones within a single frame, IJK-blanking can only be 

used on a single zone within a frame.



Z

X

Y

Figure 17-4. A cutaway plot created with 
IJK-blanking.
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To use IJK-blanking, select Blanking>IJK-Blanking from the Plot menu.

The IJK-Blanking dialog has the following options.
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• Include IJK-Blanking - toggle-on to include IJK-blanking in your plot.

• Domain - Specify the domain of the IJK-blanking by choosing one of the fol-
lowing options:

• Interior - Cells within the specified index ranges are blanked. Those 
outside are plotted. This creates a “hole” in the zone. The left side of 
Figure 17-5 shows an ordered zone with IJK-blanking with Interior 
domain.

• Exterior - Cells outside the specified index ranges are blanked. Those 
inside are plotted. This plots a sub-zone of the zone. The right side of 
Figure 17-5 shows an ordered zone with IJK-blanking with Exterior 
domain.

• Zone - Select the zone to apply IJK-blanking to. The zone must be IJK-
ordered. You may select only one zone at a time. 

• IJK - Ranges - Specify the format in which you will specify the index ranges 
by selecting one of the following option buttons:

• Select IJK-Ranges Using Index Values - Specify the I-, J-, and 
K-index ranges using absolute index values.
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IJK-Blanking

Exterior Domain

Figure 17-5. IJK-blanking with Interior domain (left) and Exterior domain 
(right).
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• Select IJK-Ranges Using% of Max - Specify the I-, J-, and K-index 
ranges as start and end percentages of the maximum index. For exam-
ple, you could blank the middle third of a data set by setting the start 
percentage to 33.3 and the end percentage to 66.6. 

17 - 3 Depth-Blanking
Depth-blanking removes cells in a 3D plot based upon how close or far they appear from the 
screen. Turn on Depth Blanking by selecting Blanking>Depth Blanking from the Plot menu.

Activate depth blanking with the following options:

• Include Depth Blanking - Select this check box to toggle depth-blanking on 
and off.

• Blank from Front (%) - Blank cells appearing closer to the viewer than this 
plane. The value entered is the plane position in percentage of depth from the 
closest corner of the bounding box of the data to the furthest corner of the 
bounding box.

At the default of zero, the plane is at the depth of the closest corner of the 
bounding box. No cells on the front of the plot are blanked. At 50, the front half 
of the plot will be blanked. In particular, cells closer to the viewer than the front 
of the blanking plan, and cells further from the viewer than the blanking plane, 
may be blanked.

When you save a layout, macro, or stylesheet, the 
IJK-blanking index ranges are stored as the percent-
age of the maximum index regardless of how you 
chose to enter them. This way, one file can be used for 

different zone sizes.
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Depth-Blanking

• Blank from Back (%) - Blank cells appearing farther from the viewer than 
this plane. The value entered is the plane position in percentage of depth from 
the furthest corner of the bounding box of the data to the closest corner of the 
bounding box.

At the default of zero, this plane is at the depth of the furthest corner of the 
bounding box. No cells on the back of the plot will be blanked. At 50, the back 
half of the plot will be blanked.
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Chapter 18 Data Operations

Plots in Tecplot rely on the data sets attached to each frame. You can modify, create, transform, 
interpolate, duplicate, and delete the data in the current data set using the Data menu. You can also 
use the data operation capabilities of Tecplot to create plots of analytical functions. By using 
Tecplot’s layout files, macro capabilities and/or equation files, you can create complex data 
operations that can be repeated on different data sets.

Changes to the data set within Tecplot do not affect the original data file(s). You can save the mod-
ified data to a data file by selecting Write Data File from the File menu. When you save a layout 
file, a journal of data operations is saved and those operations are repeated when the layout file is 
read at a later time. If the data in the file has changed, or the data file is overridden with a different 
file, the operations are applied to the new data. Alternatively, any data sets that have been modified 
are also saved to data files (see Section 22 - 1, “Layout Files, Layout Package Files, 
Stylesheets,”for details).

18 - 1 Data Alteration through Equations
Use the Specify Equations dialog to alter data in existing zones. The dialog allows you to change 
the values of entire variables or specific data points. You can also use the dialog to create new vari-
ables.

NOTE: Changes made to the data set in the Specify Equations 
dialog are not made to the original data file. You can save the 
changes by saving a layout file or writing the new data to a file. 
Saving a layout file will keep your data file in its original state, 

but use journaled commands to reapply the equations
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To modify your data set, go to the Data menu and select Alter>Specify Equations.

 The Specify Equations dialog has the following options and fields:

• Equations - Enter the equation(s) using the syntax described in 18- 1.1 “Equa-
tion Syntax”

• Zones to Alter - Select whether to alter: all zones, all active zones, a range of 
zones or no zones.

• Index Ranges - Select the index ranges to alter in the selected zones. You 
may skip this step if you want to apply the equation to all points of the selected 
zones. Use the special value 0 or Mx to specify the maximum index. You can 
also use the values Mx-1 (to specify the index one less than the maximum 
index), Mx-2, and so forth. 

The index ranges are applied to all ordered zones that are selected using the 
Zones to Alter area. Index ranges are ignored for finite-element zones.

If you are creating a new variable, all zones must be 
selected since all zones in a data set must have the 
same variables defined at each data point.
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If you are creating a new variable, the new variable’s value is set to zero at any 
index value that is skipped.

• New Var Data Type (if applicable) - Select the data type of the new variable. 
The following data types are available:

• Auto - Tecplot assigns the data type based upon the variables used in 
the right-hand side of the equation.

• Single - Four-byte floating point values.
• Double - Eight-byte floating point values.
• Long Int - Four-byte integer values.
• Short Int - Two-byte integer values.
• Byte - One-byte integer values (zero to 255).
• Bit - Either zero or one.

• New Var Location (if applicable) Select the location of the new variable. The 
options are:

• Auto (default) - “Auto” is set to node unless all variables in the equa-
tion are located at the cell center.

• Node
• Cell-Center

• Data Set Info - launches the Data Set Info dialog. See 4 - 3 “Data Set Informa-
tion” on page 90 for more information.

• Remove <>’s - remove restrictions from all equations. See 18- 1.2 “Equation 
Restriction” on page 302 for more information. 

• Save Equations - save all equations in the Equation(s) field to a file.

• Load Equations - load an equation file.

• Compute - select the Compute button to alter the data. 
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If an error occurs during the alteration (because of division by zero, overflow, 
underflow, and so forth), an error message is displayed, and all of the zones are 
restored to the state they were in before the bad equation was processed. For 
example, if you have three equations A, B, and C, and B contains an error, the 
final state is the result of processing equation A.

18- 1.1 Equation Syntax
You can enter multiple equations in the Equation(s) text field of the Specify Equations dialog. Each 
equation occupies one line of the text field, and each equation is applied to all specified zones and 
data points before subsequent equations are computed.

Tecplot equations have the following form:

LValue = F(RValue1, RValue2, RValue3,...)
Where:   F() - a mathematical expression. 
 LValue - an existing or new variable.
 RValueN - a value (such as a constant, variable value, or index value).

If LValue already exists in the data set of the active frame, the equation is used to modify that vari-
able. If the variable does not already exist, the equation is used to create a new variable as a func-
tion of existing variables.

There may be any number of spaces within the equation. However, there cannot be any spaces 
between the letters of intrinsic-function names nor for variables referred to by name. (See “Equa-
tion Operators and Functions” on page 296)

Equation Variables and Values
A variable is specified in one of following ways:

•  its order in the data file

A variable may be referenced according to its order in the data file, where V1 is 
the first variable in the data file, V2 is the second, and so forth. 

Every time you hit the Compute button, the equations 
are calculated. Be sure to remove previously computed 
equations before computing new ones.
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To create a new variable using this specification, you must specify the number 
of the next available variable, i.e. if there are 5 variables in the data set, the new 
variable must be called V6. You will receive an error message is you attempt to 
assign an invalid variable number.

• by its name

A variable may be referenced by its name by enclosing the name with curly 
braces (“{” and “}”). For example, to set V3 equal to the value of the variable 
named R/RFR, you can type:

V3 = {R/RFR}

Variable names are case insensitive. Leading and trailing spaces are also not 
considered.   However, spaces within the variable name are significant.

If two or more variables have the same name, Tecplot uses the first variable 
when the variable is referred to by name. So, if both V5 and V9 are named R/
rfr, V5 is used.

The curly braces can also be used on the left-hand side of the equation. In this 
case, if a variable with that name does not exist, a new variable is created with 
that name. 

• by a letter code - Variables and index values may be referenced by the follow-
ing letter codes:

• I - The I-index value at the data point.
• J - The J-index value at the data point (1 for finite-element zones).
• K - The K-index value at the data point (1 for finite-element zones).
• X - The variable assigned to the X-axis (in XY-plots, all active map-

pings must have the same X variable in order for this variable name to 
be valid).

• Y - The variable assigned to the Y-axis (in XY-plots, all active map-
pings must have the same Y variable in order for this variable name to 
be valid).

You can confirm the number and order of variables in 
the data file by selecting the Data Set Info button in 
the Specify Equations dialog and going to the Zones/

Var page of the Data Set Info dialog. The variables in the data set are 
listed on the right-hand side of the page.
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• Z - The variable assigned to the Z-axis (if in 3D).
• A - The variable assigned to the Theta-axis for Polar plots. For this 

variable to be valid, the plot type must be set to Polar Line. In addi-
tion, all active mappings must have the same Theta-variable.

• R - The variable assigned to the R-axis for Polar plots. The plot type 
must be Polar Line, and all active mappings must have the same R-
variable for this variable name to be valid.

• U - The X-component of vectors (if defined in the vector variable dia-
log).

• V - The Y-component of vectors (if defined in the vector variable dia-
log).

• W - The Z-component of vectors (if defined in the vector variable dia-
log).

• B - The value-blanking variable for the first active constraint (if appli-
cable).

• C - The contour variable for contour group 1 (if defined in the Contour 
Details dialog).

• S - The scatter-sizing variable (if defined in the Scatter Size/Font dia-
log).

Letter codes may be used anywhere on the right-hand side of the equation. Do 
not enclose them in curly braces. 

Those letter codes representing variables (all letter codes except I, J, and K) 
may be used on the left-hand side of the equation, as well.

The variables referenced by the letter codes are for the current frame.

Equation Operators and Functions
In an equation, the valid binary operators are as follows:

+ Addition.
- Subtraction.
* Multiplication.
/ Division.
** Exponentiation.
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Binary operators have the following precedence:

** Highest precedence.
*,/ 
+,- Lowest precedence.

Operators are evaluated from left to right within a precedence level.

The following functions are available (except where noted, all take a single argument):

SIN Sine (angle must be specified in radians).
COS Cosine (angle must be specified in radians).
TAN Tangent (angle must be specified in radians).
ABS Absolute value.
ASIN Arcsine (result is given in radians).
ACOS Arccosine (result is given in radians).
ATAN Arctangent (result is given in radians).
ATAN2(A,B) Arctangent of A/B (result is given in radians).
SQRT Returns the positive square root.
LOG, ALOG Natural logarithm (base e).
LOG10, ALOG10 Logarithm base 10.
EXP Exponentiation (base e); EXP(V1)=e**(V1).
MIN(A,B) Minimum of A or B.
MAX(A,B) Maximum of A or B.
SIGN Returns -1 if argument is negative, +1 otherwise.
ROUND Round off to the nearest integer.
TRUNC Remove fraction part of a value.

LOG and ALOG are equivalent functions, as are LOG10 and ALOG10.

Variables input into trigonometric function must be in units of radians.



Chapter 18:Data Operations

298

First- and second-derivative and difference functions are also available. See “Derivative and Dif-
ference Functions” on page 298.

To call an intrinsic function, place its argument within parentheses, i.e. to set V4 to the arctangent 
of V1, use:

V4 = ATAN(V1)

Derivative and Difference Functions
The derivative functions can be called in the same manner as described above for intrinsic func-
tions. Derivative and difference functions can be calculated with respect to the following variables: 

Variable Definition Restricted to:
x, y, z axis variables XY Line, 2D or 3D
a theta-axis variable Polar Line
r radial-axis variable Polar Line
i, j, k index range Ordered Zones

The complete set of first- and second-derivative and difference functions are listed below:

Type Function 
Call

Applicable Variables

First Order dd = x, y, z, a, or r
Second Order d2d 2 = x, y, z, a or r
Second-Order
(cross derivatives)

d2d = xy, yz, xz, az, ar, or 
rz

Table 18-1. Derivative and Difference Function Variables
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The derivative function ddx is used to calculate x∂
∂ ; d2dx2 calculates 

x2

2

∂
∂ ; d2dxy calculates 

x y∂

2

∂
∂ .

Type Function 
Call

Applicable Variables

First Order dd = i, j, or k
Second Order d2d 2 = i, j, or k
Second-Order
(cross derivatives)

d2d = ij, jk, or ik

The difference functions ddi, d2di2, and so forth, calculate centered differences of their argu-
ment with respect to the indices I, J, and K based on the indices of the point. For example:

ddi V( )
Vi 1+ Vi 1––

2
-----------------------------=

 

BOUNDARY VALUES

Boundary values for first-derivative and difference functions (ddx, ddy, ddz, ddi, ddj, and 
ddk) of ordered zones are evaluated in one of two methods: simple (default) or complex1. 

For simple boundary conditions, the boundary derivative is determined by the one-sided first deriv-
ative at the boundary. This is the same as assuming that the first derivative is constant across the 
boundary (i.e. the second derivative equal to zero).

Table 18-2. Difference Functions

NOTE: Difference functions cannot be used 
for finite-element zones.
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For complex boundary conditions, the boundary derivative is extrapolated linearly from the deriva-
tives at neighboring interior points. This is the same as assuming that the second derivative is con-
stant across the boundary (i.e. the first derivative varies linearly across the boundary).

For second-derivatives and differences (d2dx2, d2dy2, d2dz2, d2dxy, d2dyz, d2dxz, 
d2di2, d2dj2, d2dij, d2dk2, d2djk, and d2dik), these boundary conditions are ignored. 
The boundary derivative is set equal to the derivative one index in from the boundary. This is the 
same as assuming that the second derivative is constant across the boundary.

The use of derivative and difference functions is restricted as follows:

• Derivatives and differences for IJK-ordered zones are calculated for the full 
3D volume. The IJK-mode for such zones is not considered.

• If the derivative cannot be defined at every data point in all the selected zones, 
the operation is not performed for any data point.

• Derivative functions are calculated using the current frame’s axis assignments. 
Be careful if you have multiple frames with different variable assignments for 
the same data set.

• Derivatives at the boundary of two zones may differ since Tecplot operates on 
only one zone at a time while generating derivatives.

1. The $!INTERFACE parameter in the configuration file tecplot.cfg selects the method to 
use:

$!INTERFACE 
 DATA {DERIVATIVEBOUNDARY=SIMPLE}
Change the parameter SIMPLE to COMPLEX to use the complex boundary condition.

You can create your own derivative bound-
ary conditions by using the index range 
and the indices options discussed previ-
ously.
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Integration
Use the Analyze menu to calculate integrals with Tecplot. See 19 - 7 “Performing Integrations” on 
page 361 for information.

Auxiliary Data
You may use auxiliary data containing numerical constants in equations. The syntax for using aux-
iliary data in equations is:

AUXZONE[nnz]:Name
AUXDATASET:Name
AUXFRAME:Name
AUXVAR[nnv]:Name
AUXLINEMAP[nnm]:Name

where nnz = the zone number(s)

nnv = the variable number(s)

nnm = the line map number(s)

Name = name of the auxiliary data

For example, a data set auxiliary data constant called Pref would be referenced using AUX-
DataSet:Pref. Equations using this auxiliary data might appear as:

{P} = {P_NonDim} * AUXDataSet:Pref.

Zone Number Specification
By following a variable reference with square brackets (“[” and “]”), you can specify a specific 
zone from which to get the variable value. 

The zone number must be a positive integer constant less than or equal to the number of zones. The 
zone specified must have the same structure (I-, IJ-, or IJK-ordered or finite-element) and dimen-
sions (IMax, number of nodes) as the zone(s) the equation(s) will be applied to. 

NOTE: If you do not specify a zone, the 
zone modified by the left-hand side of the 
equation is used.
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Zone specification works only on the right-hand side of the equation.

Index Specification
By following a variable reference with parentheses, you can specify indices, for ordered data only. 
Indices can be absolute or an offset from the current index.

Index offsets are specified by using the appropriate index “i”, “j” or “k” followed by a “+” or “-” 
and then an integer constant. Any integer offsets may be used. If the offset moves beyond the end of 
the zone, the boundary value is used. For example, V3(i+2) uses the value V3(IMAX) when 
I=IMax-1 and I=IMax. V3(I-2) uses the value of V3(1) when I=1 or I=2. 

Absolute indices are specified by using a positive integer constant only. For example, V3(2) refer-
ences V3 at index 2, regardless of the current i index.

If the indices are not specified, the current index values are used.

Variable Sharing Between Zones
For zones with the same structure and index ranges, you can set a variable to be shared by specify-
ing that the variable for those zones have the values from one zone. For example, if zones 3 and 4 
have the same structure and you compute V3=V3[3] for zones 3 and 4, V3 will be shared. 

18- 1.2 Equation Restriction
The zone and index restrictions specified in the equation dialog can be overridden on an equation 
by equation basis. To specify restrictions for a single equation add the colon character (:) at the end 
of the equation followed by one or more of the following:

Subsequent alteration of the variables may 
result in loss of sharing.

Equation Restrictor Comments
<Z=<set>> Restrict the zones.
<I=start[,end[,skip]]> Restrict the I-range.
<J=start[,end[,skip]]> Restrict the J-range.
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For example, to add one to X in zones 1, 3, 4, and 5:

X=X+1:<Z=[1,3-5]>

The following example adds one to X for every other I-index. Note that zero represents the maxi-
mum index.

X=X+1:<I=1,0,2>

The next example creates a new variable of type Byte:

{NewV}=X-Y:<D=Byte>

Select the Remove <>’s button to remove Equation restrictions.

18- 1.3 Macros and Equations
Tecplot allows you to put your equations in macros. In fact, we sometimes refer to a macro with 
just equations as an equation file. An equation in a macro file is specified using the $!ALTER-
DATA macro command. Equation files may also include comment lines and must start with the 
comment #!MC 1100, like other macro files. If you are performing complex operations on your 
data, and/or the operations are repeated frequently, equation files can be very helpful.

You can create equation files from scratch using an ASCII text editor, or you can create your equa-
tions interactively using the Specify Equations dialog, and then save the resulting equations. The 
standard file name extension for equation files is .eqn.

For example, you might define an equation to compute the magnitude of a 3D vector. In the Specify 
Equations dialog, it would have the following form:

{Mag} = sqrt(U*U + V*V + W*W)

In a macro file, it would have the following form:

<K=start[,end[,skip]]> Restrict the K-range.
<D=datatype> Set the data type for the variable on the left 

hand side. This only applies if a new vari-
able is being created.

Equation Restrictor Comments
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#!MC 1100 
$!ALTERDATA 
 EQUATION = "{Mag} = sqrt(U*U + V*V + W*W)"

The interactive form of the equation must be enclosed in double quotes and supplied as a value to 
the EQUATION parameter of the $!ALTERDATA macro command.

To read an equation file, select Load Equations on the Specify Equations dialog. In the Load 
Equation File dialog, select an equation file that contains a set of equations to apply to the selected 
zones of your data. The equations in the equation file will added to the list of equations in the dia-
log. All equations are applied to your data when you click Compute.

Equations in equation files may be calculated somewhat differently depending on whether the com-
putation is done from within the Specify Equations dialog or by running the equation file as a 
macro. When loaded into the Specify Equations dialog, equations that do not contain zone or 
index restrictions use the current zone and index restrictions shown in the dialog. When processed 
as a macro file, the equations apply to all zones and data points. To include zone and index restric-
tions, you must include them in the equation file as part of the $!ALTERDATA command. Refer to 
the Tecplot Reference Manual for more information on working with the $!ALTERDATA com-
mand.

ecify Equations dialog. The default file extension is .eqn.

18 - 2 Data Smoothing
You can smooth the values of a variable of any zone (in either 2D or 3D) to reduce “noise” and 
lessen discontinuities in data. Smoothing can also be used after inverse-distance interpolation to 
reduce the artificial peaks and plateaus. Each pass of smoothing shifts the value of a variable at a 
data point towards an average of the values at its neighboring data points.

To smooth data in Tecplot, select Alter>Smooth from the Data menu. 
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Data Smoothing

The Smooth dialog has the following options:

• Zone - Specify the zone to smooth from the Zone drop-down. The zone should 
not intersect itself.

• Variable - Select the variable to smooth. For the XY Line plot type, the vari-
able must be a dependent variable for one active mapping for that zone.

• Number of Passes [OPTIONAL] - Specify the number of smoothing passes to 
perform. The default is 1. A greater number of passes results in greater smooth-
ing, but takes more time.

• Coefficient [OPTIONAL] - Specify the relaxation factor for each pass of 
smoothing. Enter a number between zero and one (exclusively). Large numbers 
flatten peaks and noise quickly. Small numbers smooth less each pass, rounding 
out peaks and valleys rather than eliminating them.

• Boundary [OPTIONAL] - Select the boundary conditions by which to smooth 
from the Boundary drop-down.

• Fixed - The points at the boundary are not changed in value. For 
finite-element data, only fixed boundary conditions may be used.

• First Order - The points at the boundary are smoothed based on the 
assumption that the first derivative normal to the boundary is constant. 
This will tend to cause contour lines of the smoothed variable to be 
perpendicular to the boundary.

• Second Order - The points at the boundary are smoothed based on the 
assumption that the second derivative normal to the boundary is con-
stant. This option may overextrapolate derivatives at the boundary. 

• Compute - select the Compute button to perform the smoothing. While the 
smoothing is underway, a working dialog appears showing the progress of the 
smoothing. This dialog has a Cancel button allowing you to interrupt the 
smoothing.

If you click Cancel during the smoothing process, you will interrupt the smooth-
ing, and Tecplot will report back the number of passes completed. 



Chapter 18:Data Operations

306

Limitations to smoothing:

• Finite-element zones cannot be smoothed with anything other than Fixed 
boundary conditions.

• Tecplot uses the current frame’s axis assignments to determine the variables to 
use for the coordinates in the smoothing, and also to determine whether the 
smoothing should be done with XY Line, 2-, or 3D Cartesian plot types. Be 
careful if you have multiple frames with different variable assignments for the 
same data set.

• Any axis scaling is ignored by Tecplot while smoothing.

• For I-ordered or finite-element line segment zones, the current frame can be in 
the XY Line, 2D or 3D Cartesian plot types. In XY Line, the variable must be 
the dependent variable of one active mapping for that zone.

• For IJ-ordered, finite-element triangle, or finite-element quadrilateral zones, 
the current frame can be a 2D or 3D Cartesian plot type, but you cannot smooth 
the variables assigned to the X- and Y-axes in 2D Cartesian.

• For IJK-ordered, finite-element tetrahedral, or finite-element brick zones, the 
plot type must be 3D Cartesian, and you cannot smooth the variables assigned 
to the X-, Y-, and Z-axes. The IJK-mode is ignored. The zone is smoothed with 
respect to the entire 3D volume.

• Smoothing does not extend across zone boundaries. If you use a boundary con-
dition option other than Fixed (such that values along the zone boundary 
change), contour lines can be discontinuous at the zone boundaries.

• Smoothing is performed on all nodes of a zone, and disregards value-blanking.

18 - 3 Coordinate Transformation
By default, all 2D and 3D Tecplot plots use a Cartesian coordinate system with X, Y, and Z axes. If 
you data is in polar coordinates or spherical coordinates, you will probably want to compute the 
corresponding Cartesian (X,Y and Z) coordinates before visualizing your data.

To transform your data from one coordinate system to another, select Alter>Transform Coordinates
from the Data menu.
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The Transform Coordinates dialog has the following options and fields:

• Transformation - Select the type of transformation for changing all points in 
one or more zones from one coordinate system to another. The options are:

• Polar to Rectangular - Tecplot assumes the current X-variable represents the 
radius r, and the current Y-variable represents the angle θ.

• Spherical to Rectangular - Tecplot assumes the current Y-variable represents 
the radius r, the current X-variable the angle θ (in radians), and the current Z-
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variable the angle ψ. Figure 18-6 shows r, θ, and ψ in the spherical coordinate 
system.

Figure 18-6. Three-dimensional angles of rotation.

• Rectangular to Polar
• Rectangular to Spherical

• Source Variables - Specify the source variables for each coordinate

• New Variables

• Create New Variables - This option results in new variables. Tecplot 
names them so the data set integrity is maintained (no two variables 
with same names).

• Put Results in Existing Variables - Results are put into variables in 
the current data set.

• Angles in - Specify whether to calculate using values in Theta and Psi variable 
as radians or degrees.

• Select Zones to Transform - Selects zones to alter

• Compute - Select the Compute button to perform the transformation.
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Two-Dimensional Data Rotation

18 - 4 Two-Dimensional Data Rotation
Use the 2D Rotate dialog to rotate 2D field data about a user specified XY-origin

To rotate data in 2D, select Alter>2D Rotate from the Data menu.

 The 2D Rotate dialog has the following options:

• Angle (deg) - Specify the angle of rotation, in degrees.

• X-Origin and Y-Origin - Specify the coordinates of the origin of rotation.

• Select the zones to rotate.

• Compute - you must select the Compute. button for rotation to occur.

18 - 5 Shift Pseudo-Cell Centered Data
Use the Shift Pseudo Cell-Centered Data dialog (accessed via Data>Alter) to shift the values of 
variables of cell-centered data to your grid points. Linear interpolation is used.

The following options are available:

Unlike interactive 3D rotation, change made 
via the 2D Rotate dialog modify the data.
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• Zone(s) - Select zones to be shifted.

• Variable(s) - Select variables for shifting the data.

The final result is a node-centered data set with interpolated observations at each node

18 - 6 Zone Creation
The Create Zone submenu of the Data menu allows you to add data to your plot. The menu has the 
following options: One-Dimensional Line Creation, Rectangular Zone Creation, Circular or Cylin-
drical Zone Creation, Zone Duplication, Mirror Zone Creation, FE Surface Zone Creation (from 
Polylines), and Zone Creation by Entering Values.

18- 6.1 One-Dimensional Line Creation
A 1D-line zone is an I-ordered set of points along a line

To create the 1-D line zone, select Create Zone>1-D Line from the Data menu. 

The   Create 1-D Line Zone dialog has the following options and fields:

Use this option ONLY if you have legacy 
data that does not make use of the newer 
ability to supply cell-centered data directly

You can create a 1-D line zone as the first 
step in plotting an analytic function by 
modifying the Y-variable of the new zone 
using the Specify Equations dialog.
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• Number of Points - enter the number of data points you want in the zone.

• Coordinates - enter the start and end points in the text fields labeled XMin
and XMax.

• Create - Select the Create button to create the zone.

Tecplot uniformly distributes the points along the X-axis between XMin and XMax. Y, and any 
other variables, are set to zero.

18- 6.2 Rectangular Zone Creation
Creating a rectangular zone is often the first step in interpolating irregular data into an ordered grid 
(see Section 2- 4.2, “Example - Unorganized Three-Dimensional Volume,”) 

Tecplot allows you to create a new ordered rectangular zone with the dimensions in the I-, J- and K-
directions you specify. This is done either with the Create Rectangular Zone tool (2D only) or the 
Create Rectangular Zone dialog. The zone that you create has the same number of variables as 
other zones in the data set. 

To create a rectangular zone, select Create Zone>Rectangular from the Data menu.

The Create Rectangular Zone dialog, has the following options:

• Dimensions - enter the number of data points in the I, J and K-directions

• To create an I-ordered zone, enter one for both the J- and K-dimen-
sions.

• To create an IJ-ordered zone, enter one for the K-dimension. The z-
axis variable will equal ZMin throughout the created zone.
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• To create an IJK-ordered zone, enter a K-dimension greater than one.

• Coordinates - enter the start and end points of the physical coordinates (X,Y 
and Z)

• Create - Select the Create button to create the zone.

Tecplot uniformly distributes the data points in the I, J and K directions. Any variable not assigned 
to an axis is set to zero.

Using Alter option under the Data menu, you can modify the X-, Y-, and Z-coordinates, and the 
values of the other variables as well, by using equations or Equation files. See Section 18 - 1, “Data 
Alteration through Equations”

18- 6.3  Circular or Cylindrical Zone Creation
Tecplot allows you to create a new ordered circular or cylindrical zone with the dimensions in the I-
, J-, and K-directions you specify. The I-dimension determines the number of points on each radius 
of the zones. The J-dimension determines the number of points around the circumference. The K-
dimension determines the number of layers in the zone, creating a cylinder. 

You create a circular or cylindrical zone with the Create Circular Zone dialog, or with the Create 
Circular Zone tool (2D only). The zone that you create has the same number of variables as other 
zones in the data set. 

If you have no current data set, Tecplot creates one with two or three variables, depending on the K-
dimension. If you specify K=1 (the default), the data set is created as IJ-ordered, and has two vari-
ables. If you specify K>1, the data set is created as IJK-ordered, and has three variables.



313

Zone Creation

To create a circular zone select Create Zone>Circular from the Data menu.

The Create Circular Zone dialog has the following options:

• Dimensions - enter the number of points:

• in the radial direction (I)
• in the circumferential direction (J)
• for the height of the cylinder (K). Set K equal to one to create a 2D cir-

cular zone)

• Coordinates

• Radius - enter the length of the radius.
•  X-Origin and Y-Origin - enter the coordinates for the zone center
• ZMin and ZMax -enter the minimum and maximum Z-coordinates. 

For a circular zone (where K=1), the Z variable is set to ZMin for all 
points.

• Create - Select the Create button to create the zone.
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For 2D (IJ-ordered), Tecplot creates a zone in which I-circles are connected by J-radial lines, as 
shown in Figure 18-7 (A). For 3D (K>1), Tecplot creates a K-layered cylindrical zone having I-cir-
cles connected by J-radial planes as shown in Figure 18-7 (B). All other variables are set to zero.
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Figure 18-7. (A) A 2D circular zone (B) A 3D circular zone.

BA

Using the Alter option from the Data menu, you can modify the X-, Y-, and Z-coordinates, and the 
values of the other variables as well, by using equations or equation files. See Section 18 - 1, “Data 
Alteration through Equations”
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18- 6.4 Zone Duplication
To create a full duplicate of one or more existing zones, select Create Zone>Duplicate from the 
Data menu. In the Create Duplicate Zone dialog, select the source zone(s). Each duplicate zone has 
the same name as its source zone.

18- 6.5 Mirror Zone Creation
To create a duplicate zone that is the mirror image of an existing zone, select Create Zone>Mirror 
from the Data menu.

After a zone is duplicated, all variables in the 
newly created zone(s) will be shard with 
their corresponding source zone(s).

You can only create mirrored zones along 
one of the standard axes (2D) or the plane 
determined by any two axes (3D).
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The Create Mirror Zone dialog, has the following options:

• Select the Sources Zone(s)

• Specify the axis (2D) or axis plane (3D) to mirror about.

• Create - Select the Create button to create the zone.

Each mirror zone has a name of the form “Mirror of zone sourcezone”, where sourcezone is the 
number of the zone from which the mirrored zone was created.

18- 6.6 FE Surface Zone Creation (from Polylines)
To create a finite-element surface zone from two or more I-ordered zones, select Create Zone> 
From Polylines from the Data menu. 

The variables in the newly created zone(s) are shared with their 
corresponding source zone(s), except for the coordinate and 
velocity normal to the symmetry plane

The data must be arranged in non-intersecting 
polylines, where each polyline can have any 
number of points.
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The Create Zone from Polylines dialog has the following options:

• Source Zone(s) - Select two or more zones to create your new zone from. The 
field displays only I-Ordered zones (the polylines). 

• Connect Polyline Start and End Points - toggle-on this option to connect the 
start and end points for each supplied polyline. This is especially useful when 
creating 3D surfaces. 

• Create - Select the Create button to create the zone.

Data Examples where Create Zone from Polylines is useful:

• Data is collected on the surface of an irregularly shaped object

• measurements were taken at various depths and distances within a fluid

18- 6.7  Zone Creation by Entering Values
To create an I-ordered zone for XY-plots from manually entered values, select Create Zone>Enter 
Values from the Data menu.   In the Enter XY-Values to Create a Zone dialog, enter X- and Y-value 
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pairs, one per line; first X, then Y. Use the drop-down labeled Destination Data Type to specify a 
data type for the new zone (long or short integer, float, double, byte, bit).

18 - 7 Data Extraction from an Existing Zone
You may create new zones by extracting (or interpolating) data from existing zones in a number of 
ways. Derived objects, such as contour lines, FE-boundaries, iso-surfaces, slices, or streamtraces 
may be extracted to be independent zones. You may also extract data using a specified slice plane, 
discrete points, points from a polyline, or points from a geometry. 

The procedures for extracting derived objects are discussed in the chapters related to those objects. 
For details see Chapter 8, “Contour Layer,”, 12 - 5, “Iso-Surface Extraction,”and Section 14 - 4, 
“Streamtrace Extraction as Zones”. Extracting slices, both derived and arbitrarily defined, is 
described in Section 13 - 2, “Slice Extraction”

18- 7.1 Sub-Zone Extraction
To create a sub-zone of an existing zone, select Extract>Sub-Zone from the Data menu. 

SubZone extraction is available for ordered 
zones only.
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Data Extraction from an Existing Zone

The Extract SubZone dialog, has the following options:

• Source Zone - select the source zone (ordered zones only).

• Index Range from Source Zone - Specify the desired sub-zone as a range of 
I-, J-, and K-indices. You may use the special value 0 or Mx to indicate the 
maximum of that index, and the values Mx-1 to represent one index less than 
the maximum, Mx-2 for two less than the maximum, and so forth.

• Create - Select the Create button to create the zone. Each sub-zone is given the 
name “SubZone.”

18- 7.2 Data Point Extraction
You may create an I-ordered zone by extracting data points from the current data set using any of 
three methods:

• Discrete Point Extraction.

• Point Extraction from a Polyline

• Point Extraction from a Geometry

Note: To extract points from a geometry or 
polyline, it must lie within the edges of a 
zone with connectivity.
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Discrete Point Extraction
To extract a discrete set of points with the mouse:

1. From the Data menu, choose Extract>Discrete Points. 

2. Click at each location from which you want to extract a point.

3. Double-click on the last data point or press Esc to end. 

4. Use the Extract Data Points to File dialog to specify how to save the data.

Point Extraction from a Polyline
To extract points from a polyline:

1. From the Data menu, choose Extract>Points from Polyline. 

2. Click at the desired beginning of the line, and at all desired breakpoints.

3. Double-click on the last data point or press Esc to end. 

4. Use the Extract Data Points to File dialog to specify how to save the data.

Point Extraction from a Geometry
To extract points from a polyline geometry:

1. In the workspace, select the polyline geometry from which you want to extract 
data points.

2. From the Data menu, choose Extract>Points from Geometry. 

3. Use the Extract Data Points to File dialog to specify how to save the data.

Data Point Extraction Controls
Use the Extract Data Points dialog to control how data points are extracted. The dialog has the 
following options:

• Extract Data to:

• File - Select this option to extract the data points to an ASCII Tecplot 
data file.
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Data Extraction from an Existing Zone

• Zone - Select this check box if you want the data points extracted to a 
zone in the current data set.

• Include distance variable - Toggle-on for the extracted data file to contain an 
additional variable, DISTANCE. The variable contains the accumulated dis-
tance from the first point to the last point.

• Number of points to extract - Enter the number of points to extract. This field 
is sensitive only if you are extracting data points from a polyline or geometry. It 
is insensitive if you are extracting discrete points. If you are extracting from a 
geometry, you must also select the check box labeled “Extract regular points 
along a geometry.”

• Extract regular points along geometry - Select this check box if you want to 
extract the specified number of points distributed uniformly along the geome-
try.

• Extract only points which define geometry - Select this check box if you 
want to extract only the endpoints of the segments in the geometry.

Boundary Extraction of Finite-Element Zones
To extract the boundary of a finite-element zone, select Extract>FE-Boundary from the Data menu. 
The Extract FE-Boundary dialog has the following options:

• Source Zone - Select the source zone for the FE-Boundary.

• Retain boundaries between blanked and unblanked cells - If blanking is on, 
toggle-on to include the boundary between blanked and un-blanked cells in the 
zone boundary. 
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Edge-border lines for finite-element data are similar to edge-border lines in ordered data, with a 
few exceptions. For triangular and quadrilateral meshes, a line is drawn along the edges of elements 
that have no neighboring element. 

In cases where each element is independent of all other elements (i.e. the elements have no com-
mon nodes), a border line will be drawn around each element.

Border lines will not be produced for finite-element volume data (tetrahedral and brick element- 
types). However, some plot styles will draw on the outer surface of these zones, in effect drawing 
on the boundary. Extracting the boundary of these zones extracts the outer surface.

18 - 8 Zone Deletion
In any data set with more than one zone, you can delete any unwanted zones. To delete a zone, 
select   Delete>Zone from the Data menu. You cannot delete all zones; if you attempt to delete all 
zones, the lowest numbered zone is not deleted.

If you are extracting the boundary from a 3D surface zone, 
make sure the plot type is set to 3D Cartesian. If you create the 
boundary zone in a 2D Cartesian plot, the Z-coordinate is not 
taken into account, and points that are not coincident in 3D 

Cartesian plots may become coincident in 2D plots. 
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18 - 9 Variable Deletion
To delete a variable, select   Delete>Variable from the Data menu. The Delete Variable dialog is 
shown below.

18 - 10 Data Interpolation
In Tecplot, interpolation, refers to assigning new values for the variables at data points in a zone 
based on the data point values in another zone (or set of zones).

For example, you may have a set of data points in an I-ordered zone that are distributed randomly 
in the XY-plane. This type of data is sometimes referred to as unordered, ungridded, or random 
data. In Tecplot, it is referred to as irregular data. Using data in this form, you can create mesh plots 
and scatter plots, but you cannot create contour plots, light-source shading, or streamtraces.

 In Tecplot, you can interpolate the irregular I-ordered data onto an IJ-ordered mesh, and then cre-
ate contour plots and other types of field plots with the interpolated data. You can also interpolate 
your 3D, I-ordered irregular data into an IJK-ordered zone and create 3D volume plots from the 
IJK-ordered zone. You can even interpolate to a finite-element zone.

Deleting a variable removes it from all zones.

You cannot delete a variable that a Calculate-
on-demand variable is a function of. See  “Cal-
culate-on-Demand Variables” on page 358.
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The accuracy of the interpolation will depend on your data, the density of the destination grid, how 
well the grid fits the area of your unorganized zone and the settings used for interpolation.

There are three types of interpolation available:

• Linear Interpolation - Interpolate using linear interpolation from a set of finite-
element, IJ-ordered, or IJK-ordered zones to one zone.

• Inverse-Distance Interpolation- Interpolate using an inverse-distance weight-
ing from a set of zones to one zone.

• Kriging- Interpolate using kriging from a set of zones to one zone.

18- 10.1 Linear Interpolation
Use the Linear Interpolation dialog to interpolate data from one or more ordered or finite-element 
zones onto a destination zone. Irregular I-ordered data cannot be used for the source zones in linear 
interpolation. (For 2D data, you may be able to first create a finite-element zone from an irregular, 
I-ordered zone by using triangulation. See Section 18 - 11, “Irregular Data Point Triangulation”)

Linear interpolation finds the values in the destination zone based on their location within the cells 
of the source zones. The value is linearly interpolated to the destination data points using only the 
data points at the vertices of the cell (or element) in the source zone(s).

To perform linear interpolation:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the desti-
nation zone).
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3. From the Data menu, choose Interpolate>Linear.

4. From the Linear Interpolation dialog, select the zones to be interpolated from 
those listed in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s)
scrolled list.

6. Select the destination zone into which to interpolate. Existing values in the 
destination zone will be overwritten.

7. [OPTIONAL] Outside Points - Select how to treat points that lie outside the 
source-zone data field. You have two options: 

• Constant - sets all points outside the data field to a constant value that 
you specify.

• Do Not Change - preserves the values of points outside the data field. 
Do Not Change is appropriate in cases where you are using one inter-
polation algorithm inside the data field, and another outside.

8. Select the Compute button to perform the interpolation. 
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9. While the interpolation is proceeding, a working dialog appears showing the 
progress of the interpolation.

18- 10.2 Inverse-Distance Interpolation
Inverse-distance interpolation averages the values at the data points from one set of zones (the 
source zones) to the data points in another zone (the destination zone). The average is weighted by 
a function of the distance between each source data point to the destination data point. The closer a 
source data point is to the destination data point, the greater its value is weighted.

In many cases, the source zone is an irregular data set—an I-ordered set of data points without any 
mesh structure (a list of points). Inverse-distance interpolation may be used to create 2D or 3D sur-
face, or a 3D volume field plots of irregular data. The destination zone can, for example, be a circu-
lar or rectangular zone created within Tecplot. 

To perform inverse-distance interpolation in Tecplot, use the following steps:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the desti-
nation zone).

If you click Cancel during the interpolation process, the interpo-
lation is terminated prematurely. The destination zone will be 
left in an indeterminate state, and you should redo the interpo-

lation.
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3. From the Data menu, choose Interpolate>Inverse Distance.

4. From the Inverse-Distance Interpolation dialog, select the zones to be interpo-
lated from those listed in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s) 
scrolled list.

6. Select the Destination Zone into which to interpolate. Existing values in the 
destination zone will be overwritten.

7. [OPTIONAL] Enter the minimum distance used for the inverse-distance 
weighting in the Minimum Distance text field. Source data points which are 
closer to a destination data point than this minimum distance are weighted as if 
they were at the minimum distance. This tends to reduce the peaking and pla-
teauing of the interpolated data near the source data points.

8. [OPTIONAL] Enter the exponent for the inverse-distance weighting in the 
Exponent text field. 

The exponent should be set between 2 and 5. The 
algorithm is speed-optimized for an exponent of 4, 
although in many cases, the interpolation looks better 
with an exponent of 3.5.
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9. [OPTIONAL] Select the method used for determining which source points to 
consider for each destination point from the Point Selection drop-down. There 
are three available methods, as follows: 

• Nearest N - For each point in the destination zone, consider only the 
closest n points to the destination point. These n points can come from 
any of the source zones. This option may speed up processing if n is 
significantly smaller than the entire number of source points.

• Octant - Like Nearest N above, except the n points are selected by 
coordinate-system octants. The n points are selected so they are dis-
tributed as evenly as possible throughout the eight octants. This 
reduces the chances of using source points which are all on one side of 
the destination point.

• All - Consider all points in the source zone(s) for each point in the des-
tination zone. 

10. Click Compute to perform the interpolation. While the interpolation is pro-
ceeding, a working dialog appears showing the progress of the interpolation. 

Inverse-distance interpolation ignores the IJK-mode of IJK-ordered zones. All data points in both 
the source and destination zones are used in the interpolation.

The Inverse-Distance Algorithm
The algorithm used for inverse-distance interpolation is simple. The value of a variable at a data 
point in the destination zone is calculated as a function of the selected data points in the source zone 
(as defined in the Point Selection drop-down).

The value at each source zone data point is weighted by the inverse of the distance between the 
source data point and the destination data point (raised to a power) as shown below:

If you click Cancel during the interpolation process, the interpo-
lation is terminated prematurely. The destination zone will be 
left in an indeterminate state, and you should redo the interpo-

lation.

Note: Tecplot uses the current frame’s axis assignments to 
determine the variables to use for coordinates in interpolation. 
However, axis scaling is ignored.
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 (summed over the selected points in the source zone)

where ϕd and ϕs are the values of the variables at the destination point and the source point, respec-
tively, and ws is the weighting function defined as:

ws D E–=

D in the equation above is the distance between the source point and the destination point or the 
minimum distance specified in the dialog, whichever is greater. E is the exponent specified in the
Exponent text field.

Smoothing may improve the data created by inverse-distance interpolation. Smoothing adjusts the 
values at data points toward the average of the values at neighboring data points, removing peaks, 
plateaus, and noise from the data. See Section 18 - 2, “Data Smoothing,” for information on 
smoothing.

18- 10.3 Kriging
Kriging is a more complex form of interpolation than inverse-distance. It generally produces supe-
rior results to the inverse-distance algorithm but requires more computer memory and time.

To perform kriging in Tecplot, perform the following steps:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the desti-
nation zone).

Kriging and Inverse Distance Interpolation Improvements: 
For better results with 3D data, try changing the range of your 
Z-variable to one similar to the X-range the Y-range. Also, set 
Zero Value to 0.05



Chapter 18:Data Operations

330

3. From the Data menu, choose Interpolate>Kriging

4. From the Kriging dialog, select the zones to be interpolated from those listed 
in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s)
scrolled list.

6. Select the destination zone into which to interpolate. Existing values in the 
destination zone will be overwritten.

7. [OPTIONAL] In the Range text field, enter the distance beyond which source 
points become insignificant for the kriging. The value is stated as the fraction 

Note: Tecplot uses the current frame’s axis assign-
ments to determine the variables to use for coordi-
nates in kriging. However, it ignores any axis scaling. 
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of the length of the diagonal of the box which contains the data points. A range 
of zero means that any point not coincident with the destination point is statis-
tically insignificant; a range of one means that every point in the data set is sta-
tistically significant for each point. In general, values between 0.2 and 0.5 
should be used.

8. [OPTIONAL] In the Zero Value text field, enter the semi-variance at each source 
data point on a normalized scale from zero to one. Semi-variance is the cer-
tainty of the value at a data point. A value of zero means that the values at the 
source points are exact. Greater values mean the values at the source points 
have some uncertainty or noise. Zero is usually a good number for the zero 
value, and it causes the interpolated data to fit closely to all the source data 
points. Increasing the zero value results in smoother interpolated values that fit 
increasingly more to the average of the source data.

9. [OPTIONAL] Select the overall trend for the data in the Drift drop-down. This 
can be No Drift, Linear, or Quadratic.

10. [OPTIONAL] Select the method used for determining which source points to 
consider for each destination point from the Point Selection drop-down. There 
are three available methods, as follows:

• Nearest N - For each point in the destination zone, consider only the 
closest n points to the destination point. These n points can come from 
any of the source zones. 

• Octant - Like Nearest N above, except the n points are selected by 
coordinate-system octants. The n points are selected so they are dis-
tributed as evenly as possible throughout the eight octants. This 
reduces the chances of using source points which are all on one side of 
the destination point.

Also, if the Drift is set to Linear or Quadratic, Tecplot 
requires that the points selected be non-collinear 
(non-coplanar in 3D). To avoid this limitation, set the 
Drift to None. Alternatively, you can eliminate coinci-

dent points by triangulation before you interpolate.
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• All - Consider all points in the source zone(s) for each point in the des-
tination zone..

11.Click Compute to perform the kriging. While the kriging is proceeding, a 
working dialog appears showing its progress.

The Kriging Algorithm
For a detailed discussion of the kriging algorithm see:

Davis, J. C., Statistics and Data Analysis in Geology, Second Edition, John Wiley & Sons, 
New York, 1973, 1986.

18 - 11 Irregular Data Point Triangulation
Triangulation is a process that connects data points to form triangles. You can use triangulation to 
convert irregular, I-ordered data sets into a finite-element surface zone. Triangulation is one of the 
two options for creating 2D field plots from irregular data. The other is interpolation, discussed in 
Section 18 - 10, “Data Interpolation” Triangulation preserves the accuracy of the data by creating 
an finite-element surface zone with the source data points as nodes and a set of triangle elements.

The Point Selection option is very important for kriging, since 
kriging involves the computationally expensive inversion and 
multiplication of matrices. The computational time and mem-
ory requirements increase rapidly as the number of selected 

source data points increases. In general, you should not use the All option 
unless you have very few source points.

If you click Cancel during the kriging process, the kriging is ter-
minated prematurely. The destination zone is left in an indeter-
minate state, and you should redo the kriging.

Kriging and Inverse Distance Interpolation Improvements: 
For better results with 3D data, try changing the range of your 
Z-variable to one similar to the X-range the Y-range. Also, set 
Zero Value to 0.05
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Triangulation works best for 2D data. However, you can triangulate 3D surface data, provided the 
Z-coordinate is single-valued (the surface does not wrap around on itself). When you triangulate 
3D surface data, the Z-coordinate of the data is ignored, causing a less-than-optimal triangulation in 
some cases.

To triangulate your data. select Triangulate from the Data menu. The Triangulate dialog has the fol-
lowing options:

• Source Zone(s) - Select the zone or zones to triangulate from the list.

• Use Boundary Zone(s) - Toggle-on to specify a boundary zone for the trian-
gulation. Select the boundary zone or zones from the list. The boundary zones 
define the boundaries in the triangulation region.   if you do not include bound-
ary zones, Tecplot assumes the data points lie within a convex polygon and that 
all points in the interior can be connected.

• Include Boundary Points - Toggle-on to include the points in the 
boundary zones in the triangulated zone.

• Triangle Keep Factor [OPTIONAL] - This factor is used to define “bad” trian-
gles on the outside of the triangulated zone. 

At the completion of triangulation, Tecplot attempts to remove bad triangles 
from the outside of the triangulation. The definition of a bad triangle is stored is 
a number between zero (three collinear points) and 1.0 (an equilateral triangle). 



Chapter 18:Data Operations

334

Typical settings are values between 0.1 and 0.3; settings above 0.5 are not 
allowed. Bad triangles will not be removed if removing the triangle strands a 
data point.

• Compute - Select the Compute button to perform the triangulation.

After triangulating your data, you can use the resulting finite-element surface zone to create plots. 
Generally, you turn off the original zone(s) and plot the new zone only, but you can, for example, 
plot a scatter plot of the original zone(s) along with the contours of the new zone.

18 - 12 Data Spreadsheet
All ordered and finite-element data can be viewed using Tecplot’s data spreadsheet (accessed via 
Data>Spreadsheet.). The data may be modified within the spreadsheet in order to change the plots 
Tecplot produces. .

Changes to the spreadsheet do not automatically alter the origi-
nal data file. However, saving the plot of altered data as a lay-
out file will save the changes in the data journal. You also have 
the option of overwriting your original data file, or creating a 

new file with the altered data.
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The spreadsheet displays Tecplot's data differently depending on the type of zone being examined. 
An example of the Data Spreadsheet dialog for an IJK-ordered zone is shown in Figure 18-8.

Figure 18-8. The Data Spreadsheet for an IJK-ordered 
zone. The first several values of X variable 
at the first index of the K plane are 
displayed.

I-ordered and finite element data sets are displayed with each zone's variable displayed in a col-
umn. IJ-ordered data sets are displayed in the spreadsheet with I along the rows and J along the col-
umns. IJK-ordered data sets are displayed one plane at a time: selecting the K-plane displays I 
along the rows and J along the columns, selecting the J-plane displays I along the rows and K along 
the columns, and selecting the I-plane displays J along the rows and K along the columns. With 
IJK-ordered data the slice of interest can be selected by entering a specific index or using the up 
and down arrows provided.

Load Variables
If a variable was not initially loaded into Tecplot, “Not Loaded” will be displayed in every cell of 
the spreadsheet when that variable is selected.  Use the Load Variables button to load any vari-
ables from your data set that were not initially loaded. See “Load On Demand” on page 552 for 
more information.
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Spreadsheet Format
You can change the format of data in a spreadsheet without changing the appearance of your plot. 
To change the data spreadsheet's display format, select the Format button on the Data Spreadsheet
dialog.   The Data Format dialog has the following options:

Figure 18-9. The Data Format dialog used to 
format the data displayed in the 
Data Spreadsheet.

• Format - select a number format from the option menu that best represents the 
data of interest.

• Precision [for Float and Exponent only] - specify the number of places to the 
right of the decimal

• Column Width - specify the width of the columns in number of characters

Spreadsheet Data Editing
You can change your data set within Tecplot without changing your original data file. You do this 
by editing values in the cells of the spreadsheet. To modify data:

1. From the Data Spreadsheet dialog select a desired zone and variable to modify.

2. If the variable is shared with another zone or zones, the Alter in all Shared 
Zones toggle will be enabled. Select this toggle to keep the variable shared as 
you modify data, propagating changes to the other zones that share the vari-
able. If this toggle is not selected, the variable will be changed in the selected 
location and no longer shared. See also: 4 - 2 “Data Sharing” on page 89.

3. Select the value of interest from the spreadsheet. This will highlight and 
expand the value to its full precision.



337

Data Spreadsheet

4. To replace the highlighted value simply enter the new value. Anything high-
lighted is instantly replaced with new digits entered.

5. To slightly modify a highlighted value select the value a second time. This will 
un-highlight the value and place the edit cursor at the desired position. Make 
desired modifications to the existing value.

6. To undo a modification of a given cell press Esc. To commit to a modifica-
tion press the Enter, Tab, or Shift-Tab keys, or click on another cell.
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Chapter 19 Data Analysis

Tecplot helps you analyze computational fluid dynamics and similar solutions. Data analysis 
capabilities are available via the Analyze menu, and include:

• Function calculations, including grid quality functions (such as skewness) and 
flow variable functions (such as vorticity). Many of these duplicate functions 
that are available in NASA’s PLOT3D and FAST plotting programs.

• Integration of input or calculated data, including scalar, vector-dot-normal and 
vector-dot-tangential integrands, as well as a special forces and moments 
option for calculating lift, drag and moments.

• Turbulence variable calculations.

• Particle path and streakline calculations, including particles with mass.

• Error analysis using Richardson extrapolation.

• Flow feature detection, including vortex cores, separation and attachment 
lines, and shock surfaces.

Units (Dimensions)
Analysis may be performed with data representing any system of units or dimensions, including 
non-dimensional data. All data set variables and other parameters must, however, be in the same set 
of units. Unit conversions are not available. UNIX users may wish to use the units utility for unit 
conversions. Analysis results will be in the same units as the data.
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19 - 1 Specifying Fluid Properties
Fluid properties, such as viscosity, describe the fluid model used to create the data set. These 
properties are required for many calculations performed by other dialogs. They are set via the Fluid 
Properties dialog. Values entered must be dimensionally consistent with each other and with your 
data set. If you imported your data using the PLOT3D data loader, you can probably use the default 
fluid properties.

For a layout with multiple data sets, a separate set of fluid properties is maintained for each data set. 
You can copy the settings from one data set to another using the Copy Settings to File and Paste Set-
tings from File options in the Analyze menu. These actions also transfer the settings made in the 
Reference Values, Field Variables, Geometry and Boundaries, and Unsteady Flow Options dialogs.

The Fluid Properties dialog is accessed by selecting Fluid Properties from the Analyze menu.

It allows you to specify properties for a compressible or incompressible fluid. For incompressible 
(uniform density) fluids, you specify density, specific heat, viscosity and conductivity. For 
compressible (variable density) fluids, you specify the gas constant, gamma (the ratio of specific 
heats), viscosity and conductivity.

By default, each fluid property is a constant. However, each property can be overridden by a field 
(data set) variable (with the exception of density). When a field variable is assigned, the local value 
of that variable is used for field calculations using that property, and the constant value is used only 
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for global calculations, such as the calculation of reference (free-stream) quantities. To assign a 
field variable for a particular property, set the Use Field Variable toggle and click Select to choose a 
variable from the current data set from the Select Variable dialog.

• Incompressible - Toggle-on to indicate the fluid is incompressible. For incom-
pressible fluids, you must specify density, specific heat, viscosity and conduc-
tivity. For compressible fluids, you must specify gas constant, gamma, 
viscosity and conductivity.

• Density (for incompressible fluids only) - density represents the mass of fluid 
occupied by a unit volume. Its dimensions are [Mass]/[Length]**3.

• Specific Heat (for incompressible fluids only) - specific heat is the amount of 
energy required to raise a unit mass of the fluid one degree in temperature. 
Dimensions are [Length]**2/[Time]**2[Temperature].

• Gas Constant (for compressible fluids only) - the specific gas constant has 
dimensions of [Length]**2/[Time]**2[Temperature].

• Gamma (for compressible fluids only) - gamma represents the ratio of the spe-
cific heat at constant pressure to the specific heat at constant volume, a non-
dimensional quantity.

• Viscosity - The dynamic viscosity's dimensions are [Mass] / [Length] [Time].

• Conductivity - The thermal conductivity's dimensions are [Mass] [Length] / 
[Time]**3[Temperature].

19- 1.1 Specifying Incompressible Fluid Properties
When the Incompressible check box is selected, the density of the fluid and its specific heat (Cv), 
viscosity (μ), and conductivity (k) must be entered. Gamma (γ), the ratio of specific heats at 
constant volume and pressure, is unity for incompressible fluids, so the Gamma section is inactive. 
Gas Constant (R) is also inactive. The thermal and caloric equations of state for incompressible 
fluids are shown below. ρ is density, and e represents the internal energy per unit mass:

Since the density entered in this dialog represents the density of the fluid throughout the physical 
domain, you are not allowed to enter a reference value for density in the Reference Values dialog, or 

ρ const=
e CvT=
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choose a density field variable on the Field Variables dialog (see Section  “Identifying State Vari-
ables” on page 347).

Specific heat (Cv) is the amount of energy required to raise a unit mass of the fluid one degree. It 
has dimensions of: 

Length2

Time2 Temperature×
-------------------------------------------------------- Energy

Mass Temperature×
------------------------------------------------------=

Viscosity (μ) represents the dynamic viscosity coefficient, in units of 

Mass
Length Time×
-------------------------------------

Conductivity (k) is the thermal conductivity of the fluid, in units of 

(EQ 1)

19- 1.2 Specifying Compressible Fluid Properties
When the Incompressible check box is not selected, the specific gas constant, gamma, viscosity and 
conductivity must be entered. Since density is not a constant property of compressible fluids, the 
Density text field is inactive, as is the Specific Heat section of the dialog. The thermal and caloric 
equations of state for compressible fluids are shown below. p is pressure, and e is internal energy 
per unit mass:

Mass Length×

Time3 Temperature×
--------------------------------------------------------
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(EQ 2)

The gas constant is the universal gas constant divided by the molecular weight of the fluid:

(EQ 3)

giving units of

(EQ 4)

Gamma is the ratio of the gas specific heats and is non-dimensional:

(EQ 5)

Note: the caloric equation of state assumes constant specific 
heats for the fluid. In situations where this assumption is not 
valid (such as high-temperature flows) Tecplot will calculate 
inaccurate values of temperature. For these cases, it is best 

to have your solver output temperature, and then input it into Tecplot for 
other calculations (see Section  “Identifying State Variables” on page 347). If 
your solution represents a chemically reacting flow, your solver should also 
output R and γ as field variables, which you can identify as discussed earlier 
in this chapter.

p ρRT=
e CvT=

R R̂
M
-----=

Length2

Time2 Temperature×
--------------------------------------------------------

γ
Cp

Cv
------=
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19- 1.3 Working with Non-Dimensional Data
Consider a case where temperature is non-dimensionalized by dividing it by free-stream tempera-
ture:

(EQ 6)

and pressure is non-dimensionalized with gamma (the ratio of specific heats) and free-stream pres-
sure:

(EQ 7)

We wish to know what to enter for the gas constant in the Fluid Properties dialog. We plug what we 
know into the thermal equation of state (where ρ is density and R is the gas constant):

(EQ 8)

Since the equation of state must hold for the free-stream conditions, we know

(EQ 9)

From this, we see that the product of (1) and (2) in (EQ 8) must equal γρ∞R∞.

(EQ 10)

This doesn’t entirely answer our question, however, and in the absence of additional information, 
we simply need to decide how ρ and R are each individually non-dimensionalized. The requirement 

T T
T∞
------⇒

p p
γp∞
---------⇒

p ρRT= p
γp∞
---------⇒ ρ

1( )
------- R

2( )
-------× T

T∞
------×=

p∞ ρ∞R∞T∞=

ρR ρR
γρ∞R∞
----------------⇒
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we just determined is that the product of the two must be non-dimensionalized by γρ∞R∞. So we 
may decide to non-dimensionalize density by free-stream density,ρ∞, which leaves the gas constant 

non-dimensionalized (that is, divided) by γR∞. In the Fluid Properties dialog, we enter 1
γ
---  

for Gas Constant. If we chose to leave Gas Constant at unity, density would be non-dimensional-
ized by gamma and free-stream density, γρ∞.

19 - 2 Specifying Reference Values
Certain calculations, such as Pressure Coefficient (see 19 - 6, “Calculating Variables,”) require 
reference, or free-stream values. If you loaded your data with the PLOT3D loader, this information 
has probably been loaded along with the data. Otherwise, you may supply this information using 
the Reference Values dialog.

For a layout with multiple data sets, separate settings are maintained for each data set. You can 
copy the settings from one data set to another using the Copy Settings to File and Paste Settings 
from File options in the Analyze menu. These actions also transfer the settings made in the Fluid 
Properties, Geometry and Boundaries, Field Variables, and Unsteady Flow Options dialogs.

There must be data in the current frame for the Reference Values dialog to be displayed. The Refer-
ence Values dialog is shown in Figure 19-1

Figure 19-1. The Reference Values dialog.

The dialog options are as follows:

• Velocity - In the first two text fields you may specify free-stream velocity as 
either U-Velocity and V-Velocity, or as Mach Number and Angle of Attack. Z-
velocity is assumed to be zero. Angle of attack must be specified in degrees; 
flow proceeding in the +X- and +Y-direction has a positive angle of attack. For 
incompressible flow (see Section 19- 1.1, “Specifying Incompressible Fluid 
Properties,”) only U- and V-velocities may be specified.
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• Pressure/Density - The third text field allows you to specify either Density
or Pressure. Select the corresponding option in the drop-down. For incom-
pressible flow, you must specify Pressure, because density is specified in the 
Fluid Properties dialog.

• Temperature/Sound Speed - The final text field allows you to specify Tem-
perature or Sound Speed. Temperature must be in absolute units, such as Kelvin 
or Rankine. For incompressible flow you must specify temperature. For incom-
pressible fluids the speed of sound is undefined and the density of the fluid is 
constant. 

19 - 3 Identifying Field Variables
Data analysis is performed on data in the current frame. Many of these calculations require 
information about what the data represents. For example, if you wish to calculate pressure from 
your data you must identify two other thermodynamic state variables with which Tecplot can 
perform the calculation using the thermal equation of state. X, Y, and Z are taken from the axis 
assignments for the 2- or 3-D plot in the current frame. The FLUENT and PLOT3D data loaders 
supply most or all of the remaining information to Tecplot. You may also supply this information 
using the Field Variables dialog.

For a layout with multiple data sets, separate settings are maintained for each data set. You can 
copy the settings from one data set to another using the Copy Settings to File and Paste Settings 
from File options in the Analyze menu. These actions also transfer the settings made in the Fluid 
Properties, Geometry and Boundaries, Reference Values, and Unsteady Flow Options dialogs.

There must be data in the current frame for the Field Variables dialog to be displayed. The Field 
Variables dialog is shown in Figure 19-2.

Figure 19-2. The Field Variables dialog.
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The top section of the dialog allows you to specify a vector of convective variables, either velocity 
or momentum (velocity multiplied by density). The bottom section of the dialog contains two drop-
down menus and associated text fields for identifying two thermodynamic variables in your data 
set.

Choosing the Convective Variables
Select the convective variables in your data set by clicking the Select button in the top section of the 
Field Variables dialog. Choose one of the two options on the Field Variables dialog to indicate 
whether these variables represent pure velocity or momentum.

Identifying State Variables
The State Variables region of the dialog allows you to identify up to two variables, such as pressure 
and temperature, in your data. From the two drop-downs, select any two choices from Pressure/
Temperature/Density/Stagnation Energy/Mach Number/Not Used. Then click Select, and 
choose the corresponding variable(s) from your data. If you have only one thermodynamic 
variable, select Not Used in one of the drop-downs. For incompressible flow see Section 19- 1.1, 
“Specifying Incompressible Fluid Properties,”)you may specify Pressure for one variable, and you 
may specify Temperature or Stagnation Energy (per unit volume) for the other.

The Select button launches the Select Variables dialog which allows you to select variables in your 
data set. The selections in the drop-down menus mentioned above determine whether these vari-
ables represent pressure, temperature, density, stagnation energy or Mach number.

19 - 4 Setting Geometry and Boundary Options
For certain calculations, you will need to specify information about your data that Tecplot may not 
automatically detect. For example, a 2D solution may actually represent a 3D axisymmetric 
solution, affecting any integrations you perform. Adjacent zones may be connected, affecting other 
calculations such as grid stretch factors, gradients, and flow features such as vortex cores. Certain 

The convective variables used in data analysis 
are not the same variables that are used to cre-
ate vector plots for your solution data, though 

their initial values may be set the same.

Temperature must be in absolute units, such as 
Kelvin or Rankin. 
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zones or zone surface regions may represent wall boundaries in your solution, on which separation 
and attachment lines may be calculated. The FLUENT data loader identifies most of these 
characteristics for you when you import FLUENT case and data files. You may also specify them 
with the Geometry and Boundaries dialog.

For a layout with multiple data sets, separate settings are maintained for each data set. You can 
copy the settings from one data set to another using the Copy Settings to File and Paste Settings 
from File options in the Analyze menu. These actions also transfer the settings made in the Fluid 
Properties, Reference Values, Field Variables, and Unsteady Flow Options dialogs.

For the Geometry and Boundaries dialog to be launched there must be data in the current frame. 
The dialog, shown in Figure 19-3, may then be displayed by selecting Geometry and Boundaries in 
the Analyze menu.

• Specifying an Axisymmetric Solution - Selecting Axisymmetric About Vari-
able enables the Variable and associated Value drop-down menus. Select X or Y 
from the Variable drop-down, and enter the constant value of this variable that 
defines the axis of symmetry. If you choose the axisymmetric option, all inte-
grations will be performed as 3D axisymmetric integrations by multiplying the 
integrand by 2πr , where r is the distance from the specified axis of symmetry. 
Integrations are described in 19 - 7, “Performing Integrations”.

Figure 19-3. The Geometry and Boundaries dialog.
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• Connecting Adjacent Zones - Tecplot can calculate whether nodes on the 
boundaries of adjacent zones (or the same zone) overlap. It uses this informa-
tion in calculating the Stretch Ratio grid quality function (see Section F- 2.2, “I-
, J-, or K-Stretch Ratio,”), calculating gradients, and extracting fluid flow fea-
tures (see 19 - 11, “Extracting Fluid Flow Features”) Connections between 
zones are calculated cell face by cell face. The two cells are considered con-
nected wherever all nodes of a particular boundary cell face overlap all nodes 
of an adjacent boundary cell face. 

For unsteady flows (see 19 - 5 “Unsteady Flow” on page 353), only zones 
within the same time level are examined for connections. To enable this option, 
select the Connect Adjacent Zones option and enter the maximum distance at 
which two nodes will be considered to overlap in the Nodal Proximity text field. 
Note that this text field value is also used for zone-type boundaries, discussed 
below.

The zone connection feature is overridden, cell-by-cell, by any face neighbors 
contained in a data set. Both connection mechanisms are overridden by any 
boundary conditions set on a particular face. That is, if you specify a boundary 
condition in the Geometry and Boundaries dialog that covers a specific cell face, 
that face will not be connected to an adjacent cell, irrespective of any face neigh-
bors or overlapping nodes present.

19- 4.1 Performance Considerations
Establishing connections across zone boundaries allows Tecplot to calculate better gradient quanti-
ties at these locations. There may be a substantial performance penalty for ordered-zone calcula-
tions, however, because at these boundary locations, Tecplot uses the finite-element least-squares 
formulation for calculating the gradients. Refer to Section 19- 6.1 “Gradient Calculations” on 
page 359 for a discussion of gradient calculations.

19- 4.2 Specifying Boundaries and Boundary Conditions
You may associate cell boundary faces (cell faces on the exterior of a zone) with a boundary condi-
tion. There are two reasons why you might want to do this:

• To ensure that boundary faces are not connected to adjacent cells (see the 
above discussion on connections).

• To identify wall boundaries in 3D solutions for feature extraction (see 19 - 11 
“Extracting Fluid Flow Features” on page 393).

If you set a boundary condition on a particular cell boundary face, that face will not be considered 
connected to any other cells by the gradient calculation routines. This may be advantageous, for 
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example, in solutions containing a thin flat plate, where nodes on either side of the flat plate overlap 
and would otherwise be connected by the connection mechanism.

For three-dimensional flow solutions, you can use the Extract Flow Features dialog to extract sepa-
ration and attachment lines. These lines are only calculated on boundaries you have identified as 
wall boundaries. While other boundary conditions may be specified, this information is not cur-
rently used, aside from inhibiting connections.

Specifying the Default Boundary Condition
Tecplot keeps track of all unconnected boundary cell faces (see Section 19 - 4, “Setting Geometry 
and Boundary Options”) It applies the default boundary condition to any unconnected faces to 
which you do not specifically apply a boundary as described below. Choose the desired boundary 
condition from the Default Boundary Condition drop-down. The default boundary condition is at the 
bottom of the boundary ‘pecking order.’ If a cell boundary face is not covered by any other bound-
ary condition, and is not connected to any other cells by either Geometry and Boundaries connec-
tion settings or Tecplot face neighbors, then the default boundary condition is applied to it.

Identifying Zone Boundaries
Regions on the boundaries of zones may be explicitly identified and associated with particular 
boundary conditions. For ordered zones only, you may identify a boundary region by zone bound-
ary (that is, the I=1 boundary) and index range on that boundary. For all zone types, you may iden-
tify a boundary region by selecting one or more boundary zones. 

Boundary zones are zones of dimension one less than the current plot type. They are surfaces in 3D 
Cartesian plots, or lines in 2D Cartesian plots. Boundaries are considered to exist wherever the 
nodes of these boundary zones coincide with nodes on the boundaries of volume zones in 3D Car-
tesian plots, or surfaces in 2D Cartesian plots. For example, you can identify boundary regions on a 
tetrahedral (3D) zone using triangular zones that lie on the surface of the tetrahedral zone. The 
boundary is applied wherever the nodes of the triangular zone overlap boundary nodes of the tetra-
hedral zone. As with connecting adjacent zones, the matching is done cell face by cell face using 
the Nodal Proximity setting of the Geometry and Boundaries dialog to determine how close to each 
other nodes must be to be considered overlapping. 

It is easy to create boundary zones by extracting sub-zones from ordered zones in your data set. For 
finite-element zones, it may be possible to extract the desired boundary region using blanking and 
FE-Boundary extraction. In general, however, finite-element boundary zones must come from your 
grid generator or flow solver.

New boundaries are created by clicking New on the Geometry and Boundaries dialog. This displays 
The Edit Boundary dialog, shown in Figure 19-4.



351

Setting Geometry and Boundary Options

Displaying Boundaries
The current settings of the Geometry and Boundaries dialog may be displayed by clicking the Dis-
play Boundaries button. This creates a new frame and plots all zone boundaries. For each zone in 
your solution data, one zone will be created in the new frame for each boundary condition applied 
to the boundary faces of that zone. The names of these zones indicate their zone of origin in your 
solution data and the applied boundary condition.

For each boundary face in your solution, Tecplot applies some simple rules to determine that face’s 
boundary condition. First, all faces covered by the boundary definitions in the Boundaries list have 
the boundary conditions prescribed in the list applied to them. If a particular face is covered by 
more than one of these boundaries, the boundary lowest in the list takes precedence. If you have 
selected the Connect Adjacent Zones option, any faces not covered by the listed boundaries are then 
checked to see if they overlap faces of neighboring zones. Overlapping faces are assigned the 
boundary condition ‘Interzone Boundary.’ Finally, any boundary faces not assigned any other 
boundary condition will be assigned the default boundary condition you have chosen.

Since the Geometry and Boundaries dialog is modeless, you can explore the boundary definitions in 
this new frame prior to applying your settings. This is a convenient way to make sure you are 
applying the desired boundary settings.

Clicking the Display Boundaries button records a DISPLAYBOUNDARIES macro command if you 
are recording a macro file.

Since this feature creates a new frame, it cannot be saved in the data journal, and the current data 
journal is invalidated. If you subsequently save a layout file, you will be prompted to save a new 
data file.

Saving Geometry and Boundary Settings
Once you are satisfied with your geometry and boundary settings, you can save them by clicking 
the Apply button. When you apply your settings, a SETGEOMETRYANDBOUNDARIES macro 
is recorded (if you are recording a macro file).
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19- 4.3 The Edit Boundary dialog
The Edit Boundary dialog is displayed by clicking New on the Geometry and Boundaries dialog, or 
by selecting an existing boundary and clicking Edit.

Figure 19-4. The Edit Boundary dialog.

It allows you to identify a boundary of one or more zones, either by entering the zone number(s), 
face and index range on that face, or by entering the zone numbers of boundary zones, as discussed 
in Section 19 - 4 “Setting Geometry and Boundary Options” Enter the desired options and click OK 
to add the boundary to the Geometry and Boundaries dialog.

Using Index Range-Type Boundaries
For ordered zones, you may identify boundary regions by choosing a zone boundary, or face, and 
index ranges to specify a region on the face. To create an index range-type boundary, click Zone, 
Face and Index Range, and choose the desired boundary condition from the Boundary Condition 
drop-down. Select the zones to which this boundary will apply by entering their zone numbers in 
the Zone Numbers text field, or clicking Select and choosing the zones from the resulting dialog. 
(See Section 19 - 7, “Performing Integrations,” for a description of the Select Zones dialog.) If you 
have selected zones by clicking in the work space, you may enter these zone numbers by clicking
Use Selected. Choose a face from the Zone Face drop-down and enter the index ranges in the 
remaining text fields. When you click OK, the new boundary will appear in the Boundaries list in 
the following format:

<bc>,<set>,<face>,INDEX1MIN,INDEX1MAX,INDEX2MIN,INDEX2
MAX
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<bc> is the boundary condition, one of Inflow, Outflow, Wall, Slipwall, Symmetry, and 
Extrapolated. <set> is the set of zone numbers to which the boundary applies, enclosed in 
square brackets. <face> is one of I=1, I=IMAX, J=1, J=JMAX, K=1, and K=KMAX and the 
remaining parameters are the minimum and maximum indices on the face, with zero indicating the 
maximum index value, and negative numbers indicating offsets from the maximum index value. 
For example, the following line would indicate a wall boundary condition set on the J = 1 face of 
zones 2, 4, 5, and 6 from I = 1 to IMax and K = 3 to KMax - 2:

Wall,[2,4-6],J=1,1,0,3,-2

Using Boundary Zone-Type Boundaries
For all zone types, you may identify boundary zones, as discussed in Section 19 - 4 “Setting Geom-
etry and Boundary Options”. Click Specify Boundary Zones and choose the desired boundary con-
dition from the Boundary Condition drop-down. Then enter the zone numbers of the boundary 
zones, or click Select and choose them from the resulting dialog. The boundary will be applied to 
any volume (3D) or surface (2D) zones in the data set. The boundary appears in the Boundaries list 
in the following format:

<bc>,<set>

where <bc> is as described above, and <set> is the set of boundary zones that define the bound-
ary.

19 - 5 Unsteady Flow
Tecplot can perform particle path and streakline calculations for unsteady flow solutions. To enable 
this feature, it must know which zones correspond to which solution time levels in your unsteady 
solution. Each solution time level may be comprised of one or more zones, which may be ordered, 
finite-element, or both. Many data loaders supply this information. You may also enter it in the 
Unsteady Flow Options dialog.

For a layout with multiple data sets, separate settings are maintained for each data set. You can 
copy the settings from one data set to another using the Copy Settings to File and Paste Settings 
from File options in the Analyze menu. These actions also transfer the settings made in the Fluid 
Properties, Reference Values, Field Variables, and Geometry and Boundaries dialogs.
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The Unsteady Flow Options dialog, Figure 19-5, is displayed by selecting Unsteady Flow Options in 
the Analyze menu.

It contains an option allowing you to specify that your solution is steady-state, a list to display 
unsteady time levels you enter, as well as controls for entering new time levels.

Specifying a Steady-State Solution
To direct Tecplot to treat your data set as representing a steady-state solution, select the Flow Solu-
tion is Steady-State option. This setting disables the remainder of the dialog. 

To direct Tecplot to treat your data set as an unsteady solution, toggle-off: Flow Solution is Steady-
State. This enables the remainder of the dialog, where you can identify your solution time levels.

An unsteady flow solution consists of a sequence of zones that represent successive solution times. 
Each time level may be represented by one or more zones. Identify solution time levels by entering 
the zone number(s) for a particular solution time level in the Zones text field and the time they rep-
resent in the Time text field, then clicking Add. The zones and associated time appear in the Solu-
tion Time Levels list. You may edit an existing time level by selecting it in the list. Its time and zones 
appear in the text fields, where you may edit them. Clicking Replace updates the currently selected 
list time level with the modified one.

By manually entering each time and associated zones in the text fields, you may identify all solu-
tion time levels in the current data set. For large numbers of zones two additional methods of enter-
ing time levels are provided. If your solution, or some portion of it, was calculated with a constant 

Figure 19-5. The Unsteady Flow Options dialog.
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time step, you may use the Group Zones by Time Step dialog to enter all of these time levels at 
once. Alternatively, if your zone names contain the solution time each zone represents, you may 
enter all of your time levels by parsing the zone names for their corresponding solution time. These 
options are discussed below.

19- 5.1 Group Zones by Time Step dialog
The Group Zones by Time Step dialog allows you to enter a sequence of solution time levels into 
the Unsteady Flow dialog more easily than manually entering each time level

• Starting Zone - Enter the first zone of your solution data you wish to be 
included in the grouping operation.

• Ending Zone - Enter the final zone of your solution data you wish to be 
included in the grouping operation.

• # Zones per Level - Enter how many zones represent each solution time level.

• Starting Time - Enter the solution time which will be assigned to the first zone 
or group of zones identified in this operation.

• Time Step - Enter the time step of your solution. The solution time of each 
time level will be calculated by adding this time step to the previous time 
level's solution time.

• Add to List - Click to add all time levels identified by this operation to any 
time levels which already exist. If the time calculated for any of the new levels 
already exists in the list, this will generate an error.
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• Replace List - Click to replace any time levels in the list with the time levels 
identified in this operation.

19- 5.2 Parsing Zone Names for Solution Time
If the names of your solution zones contain the solution time they represent, you may automatically 
enter all time levels by parsing the zone names for these times. Zones of the same solution time will 
be grouped together. The times must be preceded in the zone name by some identifiable text, such 
as “Time=.” Enter this text (without quotes) in the text field, then click Parse.

Note: This action will first delete all existing time levels, and then attempt to parse the zone names 
for new time levels. You may wish to view your zone names before attempting this action. You may 
view and edit zone names with the Data Set Information dialog (accessed via the Data menu).

19 - 6 Calculating Variables
THe PLOT3D functions create data set variables which are derived from CFD grids and solution 
data. This group of functions initially appeared in NASA’s PLOT3D program and were expanded in 
PLOT3D’s successor, FAST. The functions include grid quality measures, as well as scalar and 
vector flow variables. For a complete list of functions, refer to Appendix F, “PLOT3D Function 
Reference”. The functions are calculated with the Calculate dialog.

Many of these calculations are affected by settings in the Fluid Properties dialog (see 19 - 1, “Spec-
ifying Fluid Properties,”) the Reference Values dialog (See 19 - 2, “Specifying Reference Values,”) 
and the Field Variables dialog. (See 19 - 3, “Identifying Field Variables”)

For the Calculate dialog to be displayed, the active frame must contain a data set. The Calculate
dialog, shown below, may then be displayed by selecting Calculate Variables in the Analyze menu.

• Name - This text field indicates which function will be used for the calcula-
tion. Type in the name of the desired function, or click Select to choose from a 
list of all available functions (see the Selecting a Function dialog). Alterna-
tively, you may enter the equivalent PLOT3D function number, as shown in the 
Appendix F “PLOT3D Function Reference” on page 699. 
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• Normalizing a Function - A function may be normalized in one of two ways:

• Maximum Magnitude - divides the function value at each grid point 
by the maximum value in magnitude, such that the absolute value of 
the function is never greater than one. For vector functions, each vec-
tor component is divided by the maximum vector length

• Reference Values - divides the function value at each grid point by the 
same function calculated with the reference values (the values entered 
in the Reference Values section of the dialog). This is the type of nor-
malization performed by PLOT3D in its normalized functions. This 
option is not available for grid quality functions, since no meaningful 
reference values exist for these functions. It is also not available for 
functions whose reference value is zero, such as pressure coefficient.

• No Normalization - Select to disable normalization

• New Var Location - You may select the location (nodal or cell-centered) of 
new variables created during a calculation with the New Var Location drop-
down. Variables that already exist in the data set keep their existing locations.

• Calculate on Demand - This option adds the selected variable to the data set, 
but delays the actual calculation until it is needed. This is discussed in more 
detail below.

• Calculating the Function - Clicking Calculate performs the calculation for 
each zone in the active frame. If this is the first time the selected function has 
been calculated, a new variable is added to the data set with the name of the 
function. Otherwise, you will be prompted to overwrite the previously calcu-
lated variable with new values. For vector functions, each component of the 
function is added to the data set, with X, Y, and Z prefixed to the variable name, 
and (vector) removed from the name. If the function is normalized, 
(Max-Normalized) or (RV-Normalized) is appended to the variable 
name, depending on the option selected. Upon completion of the calculation, 
you will be informed of the new variable’s minimum and maximum values and 
their locations.

Shared Variables
If variable sharing is enabled, all variables from which the function is calculated are shared 
between multiple zones, and they and the calculated variable are all at the same location (cell-
centered or nodal), the new variable will be shared as well. You can see which variables in a data 
set are shared in the Data Set Info dialog (accessed via the Data menu).
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Calculate-on-Demand Variables
Variables calculated with the Calculate on Demand option are added to the data set, but are not 
calculated until they are needed. This can save a lot of time when working with unsteady solutions 
where only a small number of zones are displayed at any given time. Displaying a contour plot of 
the calculated variable will only result in calculation of the variable for the currently active zones. 
Activating new zones (by, for example, advancing the solution time displayed in Tecplot) will 
result in the calculation being performed only for the newly displayed zones.

A calculate-on-demand variable is a function of other variables in the data set and is calculated 
using the Calculate dialog. Calculate-on-demand variables are recalculated whenever a variable 
that they are a function-of is recalculated. For example, given Pressure = f(Gas Constant), if 
the value of Gas Constant changes, Pressure is recalculated. 

To avoid circular data dependencies, you are prevented from selecting calculate-on-demand vari-
ables in the Fluid Properties or Field Variables dialogs. In addition, you cannot delete any variables 
on which a Calculate-on-demand variable is dependent.

If you plan to make a sequence of changes to your data and analysis settings, you can inhibit these 
automatic recalculations by turning off Tecplot’s Auto-Redraw feature. Recalculation will then take 
place only when you redraw the frame.

Undoing a Calculation
If the data journal is valid, alterations made to the data set with the Calculate dialog may be undone 
by selecting Undo from the Edit menu. This will result in Tecplot re-executing the data journal, 
which may be a lengthy process.

If you wish to force the variable to be cal-
culated for all zones at once, you may re-
do the calculation with the Calculate on 
Demand toggle turned off.

You cannot modify a variable that is calcu-
lated on demand. 
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Selecting a Function
The function name may be typed into the Name text field, or selected from a list which contains all 
available functions. Click Select to display the Select Function dialog.

Selecting a function from this dialog and clicking OK enters that function in the appropriate area. 
Functions in this list which only apply to 3D solution data begin with (3D). Vector functions, 
whose names are appended with (vector), calculate three vector components. Each of the avail-
able functions is described in Appendix F, “PLOT3D Function Reference”

An alternative method of selecting a function is to enter its equivalent PLOT3D function number. 
These numbers may also be found in Appendix F, “PLOT3D Function Reference”. If a valid func-
tion number is entered into the Name text field, Tecplot replaces the number with the name of the 
corresponding function and sets the Normalize drop-down to None or Reference Values as 
appropriate.

19- 6.1 Gradient Calculations
Most of the PLOT3D functions are scalar functions. Gradient calculations are a notable exception 
to this rule, however, and depend on values at neighboring points. Understanding how these 
calculations are performed may help you interpret the results.

Gradients in Ordered Zones
If an ordered zone is connected to neighboring zones, its gradients are calculated using the same 
method as for finite-element zones (see below). Gradients in unconnected ordered zones are 
calculated using standard finite-difference formulae. Pressure gradient, for example, is calculated 
in the following manner.
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(EQ 11)

Where ξ indicates the I-direction, η indicates the J-direction, ζ indicates the K-direction and sub-
scripts indicate partial derivatives. In the zone interior, derivatives are estimated with second-order 
central differences, such as:

(EQ 12)

The left-hand form is used for calculating gradients at nodes, and the right-hand form is used at cell 
centers. For boundary nodes, first-order one-sided differences are used.

Gradients in Finite-Element Zones
The coordinate transformation approach used in unconnected ordered zones is generally not 
possible for finite-element zones. Instead, the variable, say pressure, is assumed to vary linearly in 
all dimensions, giving:

(EQ 13)

where p0 is the pressure at the node or cell center in question. Next a matrix equation is formed 
with the pressure difference for all nodes neighboring the current node (connected to the current 
node by a cell edge).
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(EQ 14)

This equation is generally over-specified and is inverted by least-squares to find the gradient vector.

19 - 7 Performing Integrations
Tecplot provides a flexible integration feature. You can integrate scalar data set variables as well as 
vector variables dotted with grid unit normal or unit tangential vectors. Tecplot also has several pre-
defined integrations, such as mass flux, which simplify the integration process. In ordered zones, 
you can integrate these quantities over cell volumes, face areas, or lines. In finite-element zones, 
you can integrate over cell volumes. In addition, you can calculate lift, drag, side force and 
moments due to pressure and viscous forces acting on a surface or a set of surfaces. The results of 
the integration may be displayed in a text window (and subsequently saved to a text file), or plotted 
in a frame. All of these features are accessed via the Integrate dialog. 

Note: Many of these calculations are affected by settings in the Fluid Properties dialog (see 19 - 1 
“Specifying Fluid Properties” on page 340) the Reference Values and Field Variables dialog (see 19 
- 3 “Identifying Field Variables” on page 346). and the Geometry and Boundaries dialog (see 19 - 4 
“Setting Geometry and Boundary Options” on page 347).
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The Integrate dialog is displayed by selecting Perform Integration from the Analyze menu.

The resulting dialog provides options to specify the zone(s) of integration, the variable to be inte-
grated, the domain of integration and display methods.

• Type of Integration - Tecplot can perform simple, path, surface and volume 
integrals. Refer to Section 19 - 7, “Performing Integrations,” to see how to 
select these using the current plot type. Tecplot defines the following fourteen 
integration types:

• Length/area/volume - The physical size of the integration domain.
• Scalar - The integral of a single variable.
• Average - The area- or volume-weighted average of a single variable 

over the domain.
• Mass weighted scalar - The integral of a single variable multiplied by 

density.
• Mass weighted average - The weighted average of a single variable, 

with density as the weighting function.
• Weighted average - A general weighted average—both the variable 

and the weighting function are specified.
• Scalar flow rate - The convection of a scalar through a surface. It is 

calculated by integrating the dot product of the flow velocity and the 
surface unit normal multiplied by the scalar variable.
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• Mass flow rate - The convection of density through a surface. This is 
calculated by integrating the dot product of the flow velocity and the 
surface unit normal multiplied by the density.

• Mass weighted flow rate - The convection of a scalar multiplied by 
density through a surface. This is calculated by integrating the dot 
product of the flow velocity and the surface unit normal multiplied by 
the scalar variable and density.

• Mass flow weighted average - The weighted average of a scalar vari-
able on a surface. Here the weighting function is the dot product of the 
flow momentum vector (velocity multiplied by density) and the sur-
face unit normal.

• Forces and moments - The integral of pressure and viscous stresses on 
a surface. The Forces and Moments option integrates pressure and 
shear stresses over lines (2D) and planes (3D). Pressure is assumed to 
act in the opposite direction of the unit normals. These are calculated 
by integrating the dot product of the stress tensor and the surface unit 
normal.   This will correctly calculate lift and drag if, for example, you 
have a 2D airfoil defined by the J=1 line and you integrate forces and 
moments over I-lines (or J-planes) for J=1.
Forces and Moments are calculated as six quantities: X-, Y- and Z-
Force and X-, Y- and Z-Moments about the origin. For backward com-
patibility, the forces are also displayed as Lift, Drag and Side force. 
Lift and Drag are the forces rotated in the XY-plane such that Lift is 
normal to the reference flow direction (specified on the Reference Val-
ues dialog) and Drag is parallel to it. Side force is equal to Z-Force.
If an I-ordered zone (in 2D) or a surface zone (in 3D) has been defined 
as a boundary to a surface (2D) or volume (3D) zone, then you can 
perform a Forces and Moments integration over this boundary zone. 
Tecplot takes the shear stress and unit normal direction from the asso-
ciated zone. This allows you, for example, to perform Forces and 
Moments integrations for finite-element solutions, provided you have 
a line or surface zone that defines the surface, and you have identified 
this zone as a boundary zone in the Geometry and Boundaries dialog.

• Vector-dot-normal - The integral over a surface of a vector dotted with 
the surface unit normals. Here the components of the vector are data 
set variables.
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• Vector average - The weighted average of a scalar variable on a sur-
face. The weighting function is the dot product of a vector with the 
surface unit normal. Both the scalar and the vector components are 
data set variables.

• Vector-dot-tangential - The integral on a line of a specified vector dot-
ted with the line unit tangential vector.

• Integrand - Some of the available types of integrations require you to choose 
variables from your data set to be integrated. Where required, fields in the Inte-
grand section of the dialog will be enabled. You may type in the variable 
names, or click Select to choose variables.

For Forces and Moments integrations, pressure and the components of velocity 
are calculated from the field variables identified on the Field Variables dialog.

• Specifying the Domain of Integration - The domain of integration is defined 
by zone numbers and index ranges. For ordered zones, you may choose 
whether to integrate over lines, planes, or volumes. You may also choose to use 
the absolute value of calculated volumes, which can be useful for finite-ele-
ment zones where the node ordering may result in erroneous calculations. 
Finally, you can choose to exclude regions not displayed due to index or value 
blanking. Please refer to Chapter 17 “Blanking” on page 280 for more informa-
tion on blanking.

• Integrate Over - The drop-down menu allows you to specify cell volumes, 
planes of constant I, J, or K, or lines of varying I, J, or K. For tetrahedral and 
brick finite-element zones, only volume integration is allowed. For quadrilat-

Options that involve a unit normal must be inte-
grated over a domain where the unit normal direc-
tion can be determined. Acceptable domains 
include lines in 2D or planes in 3D, as well as trian-

gular or quadrilateral zones in 3D. The vector-dot-tangential options 
can only be integrated over lines. Unit normals are discussed further 
in Section 19 - 7, “Performing Integrations”

If you have selected the 2D Cartesian plot type and have specified 
that the geometry is axisymmetric, an axisymmetric integration will 
be performed. Tecplot multiplies each grid segment’s or cell’s con-
tribution to the integration by , where  is the distance from the 
centroid of the segment or cell to the axis of symmetry.

2πr r
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eral and triangular finite-element zones, only K-planes are allowed (selecting 
Cell Volumes for these zones is equivalent to selecting K-planes, since they are 
logically 2D). For 2D and 3D Cartesian plot types, integrations over lines are 
performed as path integrals and integrals over planes are performed as surface 
integrals. Integrals in XY line plots integrate the chosen variable along the X 
axis to calculate the area between the curve and the X axis. Volume integrations 
should be done in 3D Cartesian plots—volume integrations in 2D Cartesian 
plots will give zero results.

If a vector dot product is to be integrated, then the domain must have an identifi-
able normal or tangential direction. In 3D Cartesian plots, this usually means I-, 
J-, or K-planes will be selected. The normals in these cases will point in the +I-, 
+J-, and +K-directions, respectively, or the reverse for a left-handed grid. I-, J-, 
and K-planes do not have an identifiable tangential direction, so vector-dot-tan-
gential integration over planes generates an error.

If I-, J-, or K-Lines are selected, the tangential vectors point in the positive-
index direction. Vector-dot-normal integration is also available, but may not be 
meaningful—the normal is calculated by taking the cross-product of the tangen-
tial and the +Z-axis.

In 2D Cartesian plots, I-planes are equivalent to J-lines, J-planes is equivalent to 
I-lines, and K-planes is equivalent to cell volumes. (It may be better to ignore 
planes in two dimensions.) Both normal and tangential directions are available 
in all cases. However, the normal to K-planes points in the third dimension; it 
may not be meaningful.

For quadrilateral and triangular finite-element zones, the normal direction is 
found with the right-hand rule—if the fingers of the right hand are curled in the 
direction of a line drawn from cell node 1 to node 2, thence to node 3, then the 
thumb will point in the direction of the normal.

• Zones - The Zones text field allows you to specify which zones the variable 
will be integrated over. You may enter a single zone, a range of zones with a 
hyphen (for example, 3-5), or a combination of these, separated by commas (,). 
For convenience, the All button will set this text field to indicate all data set 
zones. The Active button will list all zones currently active. You may also 
select zones from a list by clicking Select, which calls up the Select Zones dia-
log.

• Specifying Index Ranges - Below the Zone field are I-, J-, and K-index 
ranges. These ranges will be applied to each zone over which the integration is 
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performed. The three comma separated items in each index range indicate the 
starting index, the ending index and the skip factor, respectively. 

For finite-element zones, only the J-index settings have effect. These indicate 
the range of cells over which the integration will be performed. For reasons dis-
cussed below, a skip factor of unity is probably desirable for these cases.

To enter or change an index range, click the button over the desired range’s text 
field. The Enter Range dialog will be displayed.

Enter the starting index in the Begin field, the ending index in the End field, and 
the skip factor in the Skip field.

You have two options for entries into the End field. You can enter a number, in 
which case the maximum allowable value is displayed at the top of this dialog, 
and indicates the smallest size of the given index for all of the zones listed on the 
Integrate dialog. Alternatively, you can enter “Mx” to use the maximum index 
for each individual zone, “Mx - 1” to use one less than the maximum and so on. 
A skip factor of 1 means “use every point in the range,” a skip of two means, 
“use every other point” and so forth.

For linear and planar integration, skip factors are ignored along the line, or 
within the plane, of integration. For example, if you are integrating along I-lines, 
the I-skip factor will be ignored. Minimum and maximum index values are 
always used.

• Use Absolute Values of Volume - takes the absolute value of the volumes of 
3D grid cells used for integration. This is useful if you have a finite-element 
grid with arbitrary node ordering such that the calculated volume of cells may 
be positive or negative. Negative grid cell volumes occur when left-handed 
grids are used in Tecplot. A right-handed ordered zone will have the +J-direc-
tion proceeding to the left of the +I-direction when viewed from the +K-direc-
tion. For finite-element zones, the nodes of each cell will proceed counter-
clockwise when viewed from the direction of the highest-numbered node.

Figure 19-6. The Enter Range dialog.



367

Performing Integrations

• Exclude Blanked Regions - removes from the integration domain portions of 
any zones that are hidden due to value- or index-blanking. (Note that 3D depth 
blanking has no effect.)

Excluding blanked regions can lead to unexpected results, depending on the 
blanking settings. In particular, note that blanking options allow for a cell to be 
blanked when any of its nodes is blanked, when its “primary” (or lowest-num-
bered) index is blanked, or only when all of its nodes are blanked. As a result, 
cells may still be displayed where some nodes have been blanked. Figure 19-7
illustrates this effect. Index-blanking has been used to blank all nodes along the 
J=1 line, but all cells are still displayed. An integration over volumes or K-
planes would include the entire mesh, while integrations over I-lines or J-lines 
would exclude the J=1 line. In general, display the Mesh layer to see the domain 
of integration if you are integrating over volumes in 3D or planes in 2D, and dis-
play the Scatter layer to see the remaining types of integration domain. See 
Chapter 17 “Blanking” on page 280 for more information on blanking.

• Performing the Integration - Clicking Integrate at the bottom of the Integrate
dialog will perform the integration and display the results. Tecplot uses the 
trapezoidal method, a second-order method which averages nodal values to 
cell, face, or edge centers, then sums the products of these values with the cor-
responding cell volumes, areas, or lengths.

Figure 19-7. The effect of blanking on nodes and cells.
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19- 7.1 Specifying Display Options

Displaying Tabulated Results
The results of an integration may be displayed in a text dialog, plotted, or both. These options are 
set at the bottom of the Integrate dialog. If the Show Tabulated Results check box is selected, 
integration results will appear in a text dialog, as shown below.

This dialog presents two additional options. Clicking Save displays a file selection dialog which 
allows you to save the integration results to a text file. Make Text places a text field containing the 
results into the current frame. Make sure the desired frame is your current frame before you click 
this button.

Plotting Results
Setting the Plot Results As check box results in the integration results being plotted in a new frame. 
Each zone used in the integration results in a corresponding zone being created in this frame. For 
Cell Volume integrations, the plot will not be useful, because it will contain only a single point in 
each zone. For plane (in 3D) or line integrations where multiple planes or lines are integrated in 
each zone, plotting can be very useful. In these cases, the results for each plane or line are plotted 
versus the corresponding index or indices.

For all integrations except Forces and Moments, the text field to the right of the Plot Results As 
check box may be used to name the variable used to hold the integration results in the results plot. 
For Forces and Moments, the nine variable names will be Lift, Drag, Side, X-Moment, Y-Moment, 
Z-Moment, X-Force, Y-Force and Z-Force, with Lift initially being the only variable displayed.

Because the plotting feature creates a new frame, it cannot be saved to the data journal, and the cur-
rent data journal is invalidated. If you subsequently save a layout file, you will be prompted to save 
a new data file.
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19- 7.2 Accessing Integration Results in Macros
Macro commands may access the results of the most recent integration through specific 
environment variables. Each of these variables represents the total over all zones (the final number 
shown in the Integration Results dialog). For all integration types except Forces and Moments, the 
single result is stored in the variable INTEGRATION_TOTAL. Table 19-1 shows the variable 
names for forces and moments.

Environment variables are accessed in macros in the same way as regular macro variables, except 
that a $ is prefixed to the variable name. For example, the following macro command would dis-
play the most recent scalar integration:

$!PAUSE “Integration total = |$INTEGRATION_TOTAL|”

19- 7.3 Integration Examples
The following sections demonstrate potential uses of the Integrate dialog.

Integration Types Environment Variables

Forces and 
Moments

INTEGRATION_LIFT
INTEGRATION_DRAG
INTEGRATION_SIDE
INTEGRATION_XMOMENT
INTEGRATION_YMOMENT
INTEGRATION_ZMOMENT
INTEGRATION_XFORCE
INTEGRATION_YFORCE
INTEGRATION_ZFORCE

All other types INTEGRATION_TOTAL
Table 19-1. Environment variables for integration results.
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Calculating the Volume Under a Surface
Figure 19-8 shows a 3D surface. We desire to calculate the volume between that surface and the 
Z=0 plane. To do this, integrate Z over the projection of the surface onto the Z=0 plane. To get this 
projection, switch to 2D Cartesian plot type. Ensure that the same variables used for X and Y in 3D 
are used for X and Y in 2D using the Assign XYZ dialog (available in the Plot menu).

Set up the Integrate dialog to perform the integration. Choose Scalar as the integration type and Z 
as the scalar variable. The remaining controls are left at their default settings. Clicking Integrate 
displays the volume under the surface. The Integrate dialog and the results are shown in Figure 
19-9.

Figure 19-9. The Integration dialog and the integration 
results for calculating the volume under the 
surface shown in Figure 19-8

Figure 19-8. A 3D surface.
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Internal Flow Examples
The next few examples will demonstrate some uses of the Integrate dialog for internal flows, such 
as flow through a jet engine or a pipe. Our data set consists of a single I-J ordered zone. It is shown 
with the mesh and contours of pressure in Figure 19-10.

Calculating Total Mass. To calculate the total mass we must integrate density over volume 
(or area in 2D). If your data set does not contain density, it may be determined using the Calculate
dialog. (See 19 - 6, “Calculating Variables”) Select the Scalar Integral integration type, choose the 
density variable as the scalar, then integrate over Cell Volumes (which is demoted to K-planes for 
our IJ-ordered data). When we click Integrate, the total mass appears as the result of the integration. 
The Integrate dialog and the results are shown in Figure 19-11.

Figure 19-11. The Integration dialog and the 
integration results for calculating the 
volume under the surface shown in 
Figure 19-10

Figure 19-10. An internal flow solution.
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Calculating Mass Flow Rate. We now will calculate the mass flow rate at various stations 
in the streamwise direction. This will give us an indication of how well converged our solution is to 
steady-state. The Integrate dialog makes this easy with the Mass Flow Rate integration type. We 
select this option and specify integration over J-lines (which is equivalent to I-planes in 2D). Note 
that the entire Integrand section of the dialog is disabled. Tecplot calculates the necessary variable 
(momentum) from information entered in the Fluid Properties and the Field Variables dialogs.

We only wish to plot the results, so we select this option at the bottom of the Integrate dialog, spec-
ifying that the result be named “Mass Flow.” When we click Integrate, the mass flow rate is plotted 
versus I-index in a new frame. The Integrate dialog and the plotted results are shown in Figure 
19-12. From the results, we see that our solution was not fully converged. 

Figure 19-12. The Integration dialog and the results 
of calculating the mass flow rate of the 
object in Figure 19-10.

Calculating Mass-Weighted Stagnation Pressure. We now calculate a quantity com-
monly used in engine analysis, the mass-weighted stagnation (or total) pressure. Although it is 
referred to as “mass-weighted,” the weighting function is actually the mass flow rate. Accordingly, 
select Mass Flow-Weighted Average for the integration type, choosing the Stagnation Pressure 
variable from our data set (previously calculated with the Calculate dialog). Since we are only 
interested in this value at the exit plane, we again select J-lines, but now specify an I-range of (Mx, 
Mx, 1) to integrate only the I=IMax plane. We choose only to display the result in a text dialog. 
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Click Integrate to perform the calculation. The Integrate dialog and the result are shown in Figure 
19-13.

Figure 19-13. The Integration dialog and 
results for calculating the mass-flux 
weighted average integral for the 
data in Figure 19-10

Calculating Lift and Drag
Our final example makes use of a three-element airfoil solution, an example of an external flow 
solution. Our data consists of four zones. Three zones are IJ-ordered zones which capture the Edge 
layer about each of the elements. The fourth zone is a triangular finite-element zone that fills the 
remaining airspace about the elements. Pressure contours and streamtraces of this solution are 
shown in Figure 19-14.

Figure 19-14. A three element airfoil solution.
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To calculate lift and drag for this airfoil configuration we use the Forces and Moments integration 
type. As with Mass Flow Rate, the entire Integrand portion of the Integrate dialog is disabled, 
because Tecplot will derive the required values (pressure, velocity gradient, viscosity) from settings 
in other dialogs. We choose integrate over the surface (J=1) line for each of the three Edge layer 
zones, the click Integrate. The Integrate dialog and results appears as in Figure 19-15.

Figure 19-15. The Integration dialog and the 
integration results for calculating 
the lift and drag for the data 
shown in Figure 19-14.

The results of each zone are listed separately. Scrolling to the bottom of the Integration Results dia-
log, we see the total lift and drag, along with other force and moment data.

19 - 8 Calculating Turbulence Functions
Tecplot allows you to calculate and add to your data set any of four turbulence-related quantities 
given any two from your data set. Turbulent kinetic energy, dissipation rate, frequency and 
kinematic viscosity are available via the Turbulence dialog.
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The Turbulence dialog is displayed by selecting Calculate Turbulence Functions from the Analyze
menu. 

It contains two drop-down menus and associated text fields for you to identify the two turbulence-
related variables in your data set, drop-downs for you to select the function you wish to calculate 
and the location of the calculated variable, a toggle to select calculate-on-demand, and a Calculate 
button to perform the calculation.

Identifying Turbulence Variables
The first two drop-down menus on the Turbulence dialog allow you to specify which turbulence 
variables are contained in your data set. The options are Kinetic Energy (κ), Dissipation Rate (ε), 
Turbulent Frequency (ω) and Turbulent Kinematic Viscosity (νt). This last option is the kinematic 
viscosity, which is equal to the dynamic viscosity divided by the density.

Selecting the Variable Location
You may select the location (nodal or cell-centered) of new variables Tecplot creates during a 
calculation with the New Var Location dropdown. This setting only affects new variables added to 
the data set when you click Calculate. Variables that already exist in the data set keep their existing 
locations. If you wish to change the location of an existing variable, you can delete or rename the 
variable and then perform the calculation with the desired setting for New Var Location.

Calculating on Demand
Selecting the Calculate on Demand option results in the calculated variable being added to the 
data set when you click the Calculate button, but the actual calculation is delayed until it is actually 
needed. Please refer to the discussion of calculate-on-demand in Section 19 - 6, “Calculating 
Variables.”
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Performing the Calculation
Once you have identified two turbulence variables in your data set, you may calculate either of the 
other two. Select the desired function from the Function drop-down menu and click Calculate. The 
function is calculated and added to your data set as a variable with the same name as the function 
selected. If your data set variables are k and ε, the following formulae will be used for the 
calculations of ω and νt:

(EQ 15)

(EQ 16)

with Cμ = 0.09. Equations for other input variables are derived from these.

Shared Variables
If both variables from which the turbulence function is calculated are shared between multiple 
zones, and they and the calculated variable are all at the same location (cell-centered or nodal), the 
new variable will be shared as well. This mimics the behavior in the Data>Alter>Specify Equations
dialog.

19 - 9 Calculating Particle Paths and Streaklines
For steady-state solutions, Tecplot allows you to track the paths of massless particles by placing 
streamtraces in the flow. The Particle Paths and Streaklines dialog augments this capability by 
providing two additional visualization methods, particle paths and streaklines, for particles with or 
without mass.

Please note that these calculations, particularly for streaklines, may be very lengthy to perform, 
especially for cases with large grids.

ω ε
Cμk
---------=

νt
Cμk2

ε
------------=
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The Particle Paths and Streaklines dialog is displayed by selecting Calculate Particle Paths and 
Streaklines from the Analyze menu.

It contains a drop-down menu allowing you to choose particle paths or streaklines, as well as 
options pertaining to the path integrations, particles with mass, storage and display of the calculated 
particle paths. In addition, the results of streaklines may be animated.

19- 9.1 Calculating Particle Paths
A particle path is the path that a single particle follows through a solution. In steady flow, particle 
paths are the same as streaklines and streamtraces for massless particles. To calculate particle paths, 
you must:

1. Place streamtraces at the locations where you wish particles to be released, 
then select Particle Paths from the drop-down menu at the top of the dialog. 
(Details on placing streamtraces may be found in the Chapter 14 
“Streamtraces” on page 233.)

2. Specify an integration time step. For steady-state calculations, specify the 
maximum number of time steps to be performed (see 19 - 5, “Unsteady Flow,”
for specifying steady or unsteady flow).

3. Set the Particles Have Mass option for particles with mass. Click Mass 
Options to set mass-related options.

4. Optionally, set the Create Single Ordered Zone From Particle Paths toggle to 
create a single IJ-ordered zone from all particle paths instead of a separate I-
ordered zone from each path.
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5. Click Calculate.

Specifying the Integration Time Step and Maximum Number of Steps
Particle Paths are calculated by integrating the velocity field of your solution using a constant time 
step, which you enter in the Integration Time Step text field. A smaller time step will result in more 
accurate particle paths but will take longer to calculate. For unsteady calculations, the time step is 
set equal to the time interval between your solution time levels by default. If you specify so large a 
time step that a particle passes out of your solution domain in the first integration time step, you 
will get a warning message.

If you have set the Flow Solution is Steady-State option, you must also enter the maximum number 
of integration time steps to be performed (see also 19 - 5 “Unsteady Flow” on page 353).

Specifying Mass-Related Options
For particles with mass, set the Particles Have Mass option. This enables other mass-related 
controls in the dialog. Click Mass Options to display the Particle Mass Options dialog. (See Section 
19- 9.3, “Particles with Mass”) In addition, you have the option of storing the particle’s velocity 
and other particle properties or the local flow properties along the calculated particle path. Select 
Store Particle Velocity, Temperature and Mass to store these values along the particle path. Select 
Store Interpolated Solution Values to store these values instead. Following the calculation, you will 
be informed of which data set variables contain these values.

Performing the Particle Path Calculation
When you click Calculate, a particle is placed at the starting point for each streamtrace you have 
placed. If you did not place any streamtraces, you will get an error message. From these starting 
locations, beginning with the time equal to the time of your first solution time level (or zero for 
steady-state calculations), the particle positions are advanced by performing a second-order Runge-
Kutta integration of the velocity field. For unsteady calculations, linear interpolation is performed 
between solution time levels. Integration for each particle is continued until the final time level is 
reached (unsteady calculations), the specified number of time steps has been performed (steady-
state calculations), or until the particle passes out of your solution domain. The particle paths are 
displayed as new I-ordered zones in your data set, with each integration step represented by a node 
in the new zones, unless you selected the Create Single Zone From Particle Paths option, which 
results in a single IJ-ordered zone.
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Examining the Particle Paths
Each I-ordered zone created by a Particle Path calculation represents a path through space and time. 
The paths’ non-grid variables will hold interpolated values of your solution data that the particle 
“saw” as it passed through your solution, except as discussed in Section  “Specifying Mass-Related 
Options”above. You can visualize this by coloring the particle zones’ mesh plots with one of your 
solution variables. The following steps will accomplish this:

1. Turn on the Mesh plot layer by toggling-on the Mesh in the Sidebar.

2. Call up the Zone Style dialog (accessed via the Plot menu or the Sidebar).

3. Turn off mesh plotting for your solution zones by selecting the solution zones, 
clicking Mesh Show and selecting No.

4. If necessary, turn on mesh plotting for the Particle Path zones by selecting 
them, clicking Mesh Show and selecting Yes.

5. Color the Particle Path zones with a variable by selecting these zones, clicking 
Mesh Color and selecting Multi-Color. If you had not previously chosen a con-
tour variable, the Contour Variable dialog will open to allow you to select it. 
Choose the variable you wish to use to color the particle paths.

6. If Auto Redraw has not been selected, click Redraw to redraw your plot. You 
will see the particle paths displayed and colored with the contour variable.

You may wish to turn on the Scatter plot layer to see the size of these steps. If you do this, you will 
first want to turn off scatter plotting for your solution zones. You can also do this with the Zone 
Style dialog.

19- 9.2 Calculating Streaklines
Streaklines simulate experimental techniques which involve the periodic or continuous release of a 
tracer substance, such as oil drops or smoke. Tecplot produces streaklines by releasing a sequence 
of particles from the release points and integrating the unsteady velocity field to find their positions 
in the flow at the end solution time. The final positions of all particles emitted from a particular 
release point form one streakline. Once streaklines have been calculated, they may be animated on 
screen or to a file.

To calculate Streaklines, perform the following actions:

1. Identify the solution time levels in your data set. (See Section 19 - 5, 
“Unsteady Flow”)
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2. Place streamtraces at the locations where you wish particles to be released.

3. Select Streaklines from the drop-down menu at the top of the Particle Paths 
and Streaklines dialog.

4. Enter the integration time step as with particle path calculations. (See “Speci-
fying the Integration Time Step and Maximum Number of Steps” on page 378)

5. Specify the particle release frequency. (See Section “Specifying the Particle 
Release Frequency” on page 380)

6. For particles with mass, set the Particles Have Mass option. Click Mass 
Options to set mass-related options.

7. Click Calculate.

It is not reasonable to calculate streaklines for steady-state flow, because in steady-state flow, even 
for particles with mass, streaklines are the same as particle paths (just more time consuming to 
compute).

Specifying the Particle Release Frequency
For Streakline calculations, a sequence of particles is released throughout the solution time. Each 
particle’s position is integrated using the specified integration time step. The frequency with which 
particles are released is specified by the controls just above the Calculate button. In the Release text 
field, enter the number of particles to be released in the specified time interval. In the particles per 
drop-down menu, identify this time interval by selecting either Solution Time Level or Unit 
Solution Time.

If you select Solution Time Level, the indicated number of particles will be released, evenly spaced 
in time, between each pair of solution time levels you have identified. If you select Unit Solution 
Time, the particles will be released at regular intervals throughout the time covered by your solu-
tion. In either case, a particle will be released at the final time of your solution, so that the streak-
lines will include the release points themselves. Releasing particles more frequently will produce 
more detailed streaklines (the accuracy is determined by the Integration Time Step), but will take 
longer to calculate.

Performing the Streakline Calculation
When you click Calculate, the streaklines are calculated and added to your data set as new I-
ordered zones. To see them, turn on the Mesh plot layer and disable mesh plotting for your solution 
zones. See Section “Examining the Particle Paths” on page 379.
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Animating Streaklines
Once you have performed a streakline calculation, the animation controls of the Particle Paths and 
Streaklines dialog are enabled. A streakline animation displays each successive step in the 
integration, and can be an effective means of visualizing the unsteadiness of a flow. Toggle-on 
Include Zone Animation in the Particle Paths and Streaklines dialog to animate the zones along with 
the streaklines. 

You may display the animation in the frame in which the streaklines were calculated or save it to a 
raster metafile or an AVI file. Raster metafiles can be played by the Framer utility provided with 
Tecplot, while AVI files can be played by many common software packages. To perform a streak-
line animation, do the following steps:

1. Delete the I-ordered zones of any streaklines you do not wish to be part of the 
animation using the Delete Zone dialog.

2. Select the animation destination from the Animate Streaklines dropdown.

3. Click Animate.

4. If you chose to save the animation to a file, the Animate Options dialog will be 
displayed.Enter your choices for the animation and click OK. Then choose a 
file name in the resulting file selection dialog.

Please note that subsequent particle path 
or streakline calculations will replace the 
current streakline calculation, making it 
unavailable for animation.
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While animating on the screen, the Animate button’s text will change to Cancel, allowing you to 
stop the animation. While animating to a file, a progress dialog will be displayed that allows you to 
cancel the animation.

Deleting Particle Paths and Streaklines
Particle paths and streaklines are saved either as I-ordered zones or as a single IJ-ordered zone. You 
may delete these individually using the Delete Zone dialog. If you wish to delete all previously cal-
culated particle paths and streaklines, you may do so using the Delete All Particle Paths and Streak-
lines button. This deletes all zones whose names begin with ‘Particle Path’ or ‘Streakline.’

Animate Options
The Animation Options dialog allows you to specify options for saving the streakline animation to a 
file. The following options are available:

• Width (pixels) - Enter a value in the text field for your exported image’s 
width. The image region is rendered to the image file to exactly fit a size of 
Width by Height. This text field initially displays the frame’s actual width.

• Height (pixels) - Displays the height of the image based on the value entered 
for Width, preserving the shape of the region to be exported. (Calculated by 
Tecplot.)

• Animation Speed (frames/sec) - Applicable only to AVI files. Enter a value in 
the text field to set your speed in frames per second.

• Use Multiple Color Tables - Selecting this check box will create a color table 
for each frame of the animation. If this check box is not selected, Tecplot will 
scan each frame in your AVI file and create an optimal color table from 256 
colors for the entire animation. (AVI images are always reduced to 256 colors.)

19- 9.3 Particles with Mass
Whereas massless particles always travel with the local fluid velocity, particles with mass travel 
according to a more complicated equation of motion where the fluid creates drag on the particle. In 
addition, particles with mass may have a temperature that is different from the local fluid 
temperature, and they may lose mass due to ablative processes such as vaporization. The Particle 
Mass Options dialog allows you to enter coefficients and particle properties to indicate how these 
mass-related effects are calculated.

The Particle Mass Options dialog is displayed by clicking Mass Options on the Particle Paths and 
Streaklines dialog. It allows you to specify either general or detailed coefficients related to the par-
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ticle trajectory and heat transfer calculations, plus options related to gravity and the initial particle 
velocity. If you choose to calculate the particle temperature, you may choose to terminate the parti-
cle at a specified temperature, or, with the detailed coefficient option, to ablate the particles until 
their mass reaches zero.

Selecting a Coefficient Set
You may enter either general coefficients or detailed coefficients. General coefficients are a 
convenient way of characterizing the particles, but result in less accurate calculations. They should 
only be used when the particle drag coefficient and heat transfer coefficient (if particle temperature 
is being calculated) are essentially constant. Detailed coefficients result in more accurate 
calculations, and should be used whenever the drag coefficient or heat transfer coefficient may not 
be constant, such as when the particle Reynold’s number is less than 1000 (see page 388 for a 
definition of particle Reynold’s number). In addition, if you wish to calculate particle ablation, you 
must specify detailed coefficients. Indicate your choice of coefficients by making the appropriate 
selection in the option box at the top of the Particle Mass Options dialog.

Calculating Particle Temperature
If you wish to calculate each particle’s temperature along its path, set the Calculate Particle 
Temperature option. Particles begin with their temperature equal to the local fluid temperature at 
their insertion point (the beginning of each streamtrace you have placed). If you have chosen to 
enter general coefficients, enter the Temperature Time Constant in the General Coefficients section 
of the dialog. Otherwise, enter the specific heat (per unit mass) and the Nusselt number in the 
Detailed Coefficients section of the dialog. Also, select from the available options in the 
Termination Options section of the dialog. All of these options are discussed below.

Specifying the Effects of Gravity and Buoyancy
If you wish to include the effects of gravity in your calculation, enter the gravitational constant and 
select the axis direction in which gravity acts. 

If you choose the detailed coefficient set and non-zero gravity, the effects of buoyancy will also be 
included. Buoyancy acts in the opposite direction of gravity. It is included by subtracting from the 
particle mass the mass of the fluid it displaces, and multiplying the result by the gravitational con-
stant to calculate the force due to gravity.

Buoyancy effects are not included if you choose the general coefficient set because the particle size 
is not specified. In this case, the gravitational constant is simply added to the particle acceleration 
that is calculated from the general coefficients and local flow conditions.
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Specifying the Initial Particle Velocity
Each particle injected into the flow begins either at the velocity of the flow at the point where the 
particle is injected, or at zero velocity. Select one of these options from the dropdown.

General Coefficients
Figure 19-16 shows the Particle Mass Options dialog with the general coefficients displayed. The 
General Coefficients consist of the Ballistic Coefficient and, if you are calculating particle 
temperature, the Temperature Time Constant.

Ballistic Coefficient. The Ballistic Coefficient is defined by the following:

(EQ 17)

Figure 19-16. The Particle Mass 
Options dialog with general 
coefficients.

B
mp

SCD
----------=
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where B is the Ballistic Coefficient, S is the frontal area of the particle, CD is the particle’s drag 
coefficient and mP is the particle’s mass. Given the Ballistic Coefficient, the acceleration of a parti-
cle due to fluid drag is calculated from

(EQ 18)

where a is particle acceleration, i stands for each spatial dimension, ρf is the local fluid density and 

ufi
 and upi

 are the velocity components of the fluid and the particle. If non-zero grav-

ity has been specified, the acceleration in the specified direction is augmented by the gravitational 
constant. For example, if a gravitational constant, gc, acts in the -Z direction, the acceleration in the 
Z direction becomes:

(EQ 19)

Temperature Time Constant. For the general coefficient option, particle temperature is cal-
culated with a simple relaxation:

(EQ 20)

where T is temperature, and τT is the Temperature Time Constant you enter in this text field.  τT has 
units of time, and indicates the “e-folding” time of this relaxation--the amount of time it takes to 
reduce the difference between the fluid temperature and the particle temperature by a factor of 
about 2.7.

Comparing (EQ 20) with the convective heat transfer equation,

ai
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(EQ 21)

we see that τT may be thought of as a combination of the convective heat transfer coefficient, h and 
the surface area, mass, and specific heat of the particle:

(EQ 22)

Note from (EQ 21) that the Temperature Time Constant is only constant if the heat transfer coeffi-
cient is also constant. In general, however, this coefficient will vary with the particle’s velocity rel-
ative to the fluid, so this approximation should be viewed with skepticism.

Q hA Tw T∞–( ) m– pcp
dTp

dt
---------= =

τT
πrp

2h
mpcp
------------–=
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Detailed Coefficients
Figure 19-17 shows the Particle Mass Options dialog with detailed coefficients displayed. The 
detailed coefficients consist of particle mass radius and drag coefficient. In addition, if particle 
temperature is being calculated, the detailed coefficients consist of particle specific heat and 
Nusselt number.

Mass. Each particle begins with the same mass, entered in this text field. If ablation is being cal-
culated, the particle’s mass may be reduced by the ablative process as it travels through the flow 
field.

Radius. As with Mass, each particle begins with the same radius, entered in this text field and 
may be reduced by ablation.

Specify/Calculate Drag Coefficient. You may elect to specify a constant drag coefficient 
or have Tecplot calculate it. If you specify a constant drag coefficient, enter its value in the corre-
sponding text field. For calculated drag coefficient, Tecplot uses a formula from Multiphase Flow 
and Fluidization: Continuum and Kinetic Theory Descriptions (D. Gidaspow, 1994):

Figure 19-17. The Particle Mass 
Options dialog with detailed 
coefficients.



Chapter 19:Data Analysis

388

(EQ 23)

with the particle Reynold’s number:

(EQ 24)

where dp  is the particle diameter, Up Uf–  is the speed of the particle rel-

ative to the fluid and μf  is the dynamic viscosity of the gas. The acceleration then 

becomes:

 (EQ 25)

If non-zero gravity has been specified, the acceleration in the specified direction is augmented by 
the gravitational constant adjusted for buoyancy. For example, if a gravitational constant, gc, acts in 
the -Z direction, the acceleration in the Z direction becomes:

(EQ 26)
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where ρp is the density of the particle.

Specific Heat. If particle temperature is being calculated, enter the specific heat per unit mass of 
the particles, in units of energy per mass per degree.

Specify/Calculate Nusselt Number. The Nusselt number is a non-dimensional measure of 
heat transfer. The temperature change of the particle is calculated from this number using the fol-
lowing formula:

(EQ 27)

where kf is the conductivity of the fluid.

If you specify a constant Nusselt number, enter its value in the text field. Otherwise, Tecplot will 
calculate it using a formula from An Eulerian-Lagrangian Analysis for Rocket Motor Internal 
Flows (Jayant S. Sabnis, et al., 1989):

(EQ 28)

Termination Options
When solving for particle temperature, you may terminate particles when they reach a specified 
temperature, or calculate particle ablation (mass reduction due to off-gassing or some sort of 
sloughing of material from the particle). 

Terminate/Ablate Particles. If you elect to terminate the particles at a particular tempera-
ture, you must enter the temperature. When the particle reaches this temperature, its path will be 
terminated at that location. If you elect ablation, you must enter the temperature at which ablation 
begins, and the latent heat of the ablative process. If you wish to model boiling of initially solid par-
ticles, enter the latent heat of fusion plus the latent heat of vaporization, as a positive number. Once 
the particle reaches the specified temperature, any additional heat transferred to the particle will 
result in ablation instead of an additional temperature rise. If the particle’s mass reaches zero, it will 
be terminated at that location.
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Temperature. For temperature-based termination, this is the temperature, in absolute units, at 
which the particle will be terminated. For ablation, this is the temperature at which the ablation 
begins.

Latent Heat. This is the combined latent heat of fusion and vaporization for the particle, used 
only for particle ablation. Its units are energy per unit mass.

19 - 10 Analyzing Solution Error
Tecplot allows you to examine a sequence of CFD solutions on successively finer meshes, estimate 
the order of accuracy of the solutions, as well as perform Richardson extrapolation to improve the 
accuracy of the solutions. These features are applicable only to smooth solutions (solutions with no 
discontinuities). They are available via the Error Analysis dialog.

The Error Analysis dialog is displayed by selecting Analyze Error from the Analyze menu.

It contains controls for specifying the solution zones to analyze, the maximum accuracy of your 
CFD solver, some options specific to accuracy calculation, and buttons to perform the analyses.

Calculating Solution Accuracy
The accuracy of a sequence of three solutions is estimated using Richardson extrapolation on a 
particular data set variable you select. The resulting accuracy in both the 1-norm and the Max- 
(infinity-) norm is reported in a text dialog. You also have the options of plotting the overall error 
versus grid spacing, or plotting the calculated accuracy at each grid node.
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Selecting Solution Zones
To calculate solution accuracy, you must identify three zones from your data set. The zones must 
represent coarse, medium and fine grid solutions of the same problem. The order in which you 
enter the zone numbers does not matter. The medium grid must have twice the number of cells in 
each index direction as the coarse grid, or twice, plus one, the number of nodes. The fine grid must 
have four times the number of cells, or four times, plus one, the number of nodes as the coarse grid.

Since finite-element zones do not have identifiable index directions, the requirement for the coarse, 
medium and fine grid sizes is only in terms of the total number of cells. It is assumed that succes-
sively finer grids have been refined equally in all directions. The requirement is that the medium 
grid have eight times as many cells (four in 2D) as the coarse grid and the fine grid have 64 times as 
many cells (sixteen in 2D).

For all zone types, the medium and fine grids must have nodes that overlap the coarse grid nodes.

You may type the zone numbers in the text field, or select them by clicking Select and choosing 
three zones from the resulting list.

Specifying the Solver’s Maximum Accuracy
Under some circumstances, Richardson extrapolation can report an accuracy in excess of the 
solver’s theoretical maximum accuracy. For this reason, Tecplot limits the accuracy used by this 
technique to the value you enter in the Maximum Accuracy text field. Although fractional values 
are allowed in this text field, you should enter the theoretical maximum order of accuracy of your 
solver as an integer. That is, two for a second-order accurate solver.

Selecting the Data Set Variable
For the accuracy calculation, Tecplot performs Richardson extrapolation on one variable in your 
data set. It must not be a grid variable. Enter the name of the variable in the Use Data Set Variable 
text field, or click Select to choose the variable.

Plotting the Solution Accuracy
You can plot the results of the accuracy calculation in either or both of two ways. First, you can plot 
the accuracy at each grid node as a contour plot (XY-plot for 1-D data) by setting the Plot Accuracy 
at All Grid Nodes check box. Second, you can plot the overall error as a log-log XY-plot by setting 
the Plot Overall Accuracy (log-log) check box. If you select either of these options, new frames 
will be created to display the plots when you perform the calculation.

The plot of overall accuracy plots the error in the 1-norm and max- (infinity-) norm versus grid 
spacing for each of the three zones. The grid spacing of the coarse grid zone is taken as unity for 
this plot. The 1-norm is the average absolute value of the difference between the extrapolated solu-
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tion and the solutions of the input zones. The max-norm is the maximum absolute value of this dif-
ference. Figure 19-18 shows an example of this plot. The slopes of the two lines represent the 
accuracy of the solver. A significant difference in the slopes may indicate discontinuities in your 
solution, or other problems with the calculation.

Figure 19-18. A plot of the overall accuracy.

The plot of accuracy at all grid nodes plots the calculated accuracy on the grid from your coarse 
solution. For 2D and 3D grids, it is plotted as a contour plot. For 1-D solutions, it is plotted as an 
XY-plot.

Because this feature creates a new frame, it cannot be saved in the data journal, and the current data 
journal is invalidated. If you subsequently save a layout file, you will be prompted to save a new 
data file.

Performing the Calculation
When you click Calculate Accuracy, the accuracy calculation is performed. The accuracy in the 1-
norm and max-norm is reported in a text dialog. If you selected either of the plot options, the plots 
are created in new frames.
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Extrapolating a Solution
Given three solutions on successively finer grids, Tecplot can perform Richardson extrapolation to 
improve the accuracy of the solution, and report the difference between the extrapolated solution 
and the original, fine grid solution.

To perform this extrapolation, three zones must be identified in the Error Analysis dialog as previ-
ously discussed (see Section  “Selecting Solution Zones”) and the maximum accuracy of the solver 
entered (see Section  “Specifying the Solver’s Maximum Accuracy”). Once these are entered, 
clicking Extrapolate Solution creates two new zones in the solution data set. The first new zone 
contains the extrapolated solution on the coarse grid. The second new zone contains the difference 
between the extrapolated solution and the original fine grid solution.

19 - 11 Extracting Fluid Flow Features
Tecplot can display important features in 3D fluid flow solutions that make analyzing the solutions 
much easier. For trans-sonic flow, it can display shock surfaces. For all flows, including 
incompressible flows, it can display lines indicating the location of vortex cores, as well as 
separation and attachment lines. These calculations make use of MIT’s FX library. For more 
information on this library, please see http://raphael.mit.edu/fx/. These features are accessed 
through the Extract Flow Features dialog.

The Extract Flow Features dialog is displayed by selecting Extract Flow Features from the Analyze
menu.

It contains a drop-down for selecting the desired feature, options for specifying the algorithm to use 
when extracting vortex cores, as well as an Extract button, which performs the desired task.

Flow features are identified using field variables you have identified on the Field Variables dialog. 
(See 19 - 3, “Identifying Field Variables”) and may be affected by settings on the Fluid Properties
dialog. (See 19 - 1, “Specifying Fluid Properties”) The feature extraction may also be affected by 

http://raphael.mit.edu/fx/
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your boundary settings. In particular, separation and attachment lines are only calculated on 
boundaries you have identified as wall boundaries. Refer to Chapter 19 - 4, “Setting Geometry and 
Boundary Options,” for more information on specifying boundary conditions for your data.

Extracting Shock Surfaces
To extract shock surfaces, select Shock Surfaces from the Feature drop-down, then click Extract. 
The remaining controls on the dialog are disabled. After calculation, shock surfaces are then 
displayed as iso-surfaces of a new data set variable named ShockFeature. This variable is similar to 
the Shock variable available on the Calculate dialog.

You may note that the displayed shock surface is obscured by clutter due to the sensitivity of the 
shock function capturing minor oscillations in the solution. A useful technique for displaying only 
the true shock is to use the value blanking feature to eliminate regions where this clutter appears. 
Use Tecplot’s Calculate dialog to calculate the Pressure Gradient Magnitude variable, then use the 
value blanking to blank the plot where this variable is less than some constant. A good value to use 

is 0.1ρ∞c∞
2 , or for PLOT3D non-dimensional data, just 0.1.

Extracting Vortex Cores
To extract vortex cores, select Vortex Cores from the Feature drop-down, choose from the two 
available extraction methods, then click Extract. The cores consist of a group of line segments that 
may not all be connected. As a result, they are displayed using a line segment finite-element zone. 
Display the Mesh or Edge plot layer to see the new zone. If you are using value blanking, you may 
need to interpolate the blanking variable to the new zone. Refer to 18 - 10 “Data Interpolation” on 
page 323 for information on interpolation and 17 - 1 “Value Blanking” on page 281 for information 
on value blanking.

Due to the properties of the algorithm used, vortices that happen to exactly align with grid lines 
may not be properly extracted. This is unlikely to occur in real-world solutions, but is common in 
test data generated by extruding 2D solutions to produce artificial 3D solutions.

Choosing a Vortex Core Extraction Method

Two algorithms for determining the location of the vortex cores are available. These methods are 
represented by the Vorticity Vector and Velocity Gradient Eigenmodes options. The Vorticity 
Vector method determines the location of vortex cores by examining the vorticity vector. The 
Velocity Gradient Eigenmodes method is more sophisticated and a little more expensive, using the 
eigenvalues and eigenvectors of the velocity gradient tensor. The eigenmode method tends to give 
fewer spurious vortex cores.
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Visualizing the Vortex Core Strength

If you have chosen a contour variable for your data set, the vortex strength returned by the FX 
library will be stored in this variable in the new zone. You may visualize this vortex strength by 
turning on the Mesh plot layer and choosing to color the mesh of this zone with the contour 
variable. You may need to modify the contour levels to get an acceptable display of the vortex 
strength. You may also wish to use the value blanking feature using this variable to blank out the 
vortex cores where they are very weak or unrealistically strong (as can happen at a no-slip wall 
boundary).

Extracting Separation and Attachment Lines
Separation and attachment lines show where a fluid flow separates from or reattaches to a no-slip 
wall boundary. These lines can give you an indication of where separation bubbles or recirculation 
regions appear in your data. To calculate them you must first identify one or more Wall boundaries 
using the Geometry and Boundaries dialog. (See 19 - 4, “Setting Geometry and Boundary 
Options”) The separation and attachment lines will be calculated on these boundaries.

Due to the algorithm used by the FX library to detect separation and attachment lines, these lines 
may not be detected for flows that are essentially two-dimensional. (That is, flows which contain 
no variation along one of the three spatial dimensions.)

To calculate separation and attachment lines, select this option in the Feature drop-down and click 
Extract. The lines, if any, will be displayed in new zones, one zone for separations lines and a sepa-
rate zone for attachment lines. As with vortex cores, the lines consist of sets of possibly uncon-
nected line segments, which are displayed using line segment finite-element zones. Display the 
Mesh or Edge layer to see the lines.

Excluding Blanked Regions
For vortex core and separation/attachment line calculations in ordered zones, you may choose to 
exclude blanked regions from the calculation. Select this option by selecting the Exclude Blanked 
Regions from Ordered Zones toggle. This will prevent lines from being calculated in regions of 
ordered zones that are not plotted due to blanking. Note, however, that this will invalidate the data 

journal. If you subsequently save a layout file, you will be prompted to save a new data file as well.
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Chapter 20 Probing

The Probe tool allows you to select a location in your plot and view the values of all 
variables at that location. You can also view information about the data set itself while probing. The 
probe-to-edit feature allows you to modify your data interactively.

With the Probe At dialog, you can specify the location of the probe as set of spatial coordinates X, 
Y, and Z, one of the polar coordinates Theta and R, or as a set of I-, J-, and K-indices. You select 
one or more locations in the data field where information is to be collected, and the resulting infor-
mation is displayed in the Probe dialog.

When you probe with the mouse, you can probe in either of two modes: Interpolate and Nearest 
Point. In Interpolate mode (accessed by a single mouse click) the value returned is the linearly 
interpolated value for the specified locations. In Nearest Point mode, accessed by CTRL+click, 
the value returned is the exact value at the closest data point in the field.

20 - 1 Field Plot Probing with the Mouse

The most direct method of probing is to use the Probe tool . Click at any point to probe in 
Interpolate mode, which calls up a dialog showing the probe information interpolated for that 
point. CTRL+click at any location to probe in Nearest Point mode which will obtain probe 
information for the data point closest to the cross-hair.
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The following table shows the information returned for each type of probe action for field plots. 
(All mouse click operations are using the left mouse button.)

Probe Action Information Returned

Click If the pointer is over a valid cell, the value 
returned is the interpolated field values from all 
nodes in the cell. 
2D Cartesian plots - if multiple cells are candi-
dates, the cell from the highest number zone is 
used.
3D Cartesian plots - the closest cell in a zone, slice, 
iso-surface or streamtrace is selected. If multiple 
cells are candidates, the cell closest to the viewer is 
used, with priority given to surfaces drawn with 
mesh, flooded contours or shading.
Translucent zone surfaces are excluded from prob-
ing priority.

CTRL+Click If the pointer is over a valid cell, the field value 
from the nearest node in the cell is returned. 
If multiple cells are candidates:
2D Cartesian plots - the cell from the highest num-
ber zone is used
3D Cartesian plots - the cell closest to the viewer is 
used. If the pointer is not over any cell, then the 
field values from nearest data point (as measured 
in distance on the screen) are returned.
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Shift-CTRL+Click Return the field values from the nearest point on 
the screen (ignoring surfaces, zone number or 
depth of the point).

This is useful in 3D for probing on data points that 
are on the back side of a closed surface without 
having to rotate the object.

 In 2D this is useful for probing on data points for 
zones that may be underneath other zones because 
of the order in which they were drawn.

Alt-Click
(3D only)

Same as Click except ignore zones while probing. 
(Probe only on streamtraces, iso-surfaces, or 
slices.)

Alt-CTRL+Click Same as CTRL+Click except ignore zones while 
probing. (Probe only on streamtraces, iso-surfaces, 
or slices.)

Alt-CTRL+Shift-
Click

Same as Shift-CTRL+Click except ignore zones 
while probing. (Probe only on streamtraces, iso-
surfaces, or slices.)

Probe Action Information Returned
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The probe results are displayed in the Probe dialog.   

Note: Interpolate mode does not work for I-ordered data dis-
played in a 2D or 3D Cartesian plot; if you probe such data 
you will always get the error message “Point is outside of 
data field,” because Tecplot cannot interpolate without a 

field mesh structure. You can, however, use the Nearest Point mode in such 
situations.
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20 - 2 Field Plot Probing by Specifying Coordinates and Indices
Use the Probe At dialog, for: precise control over your probe location, probing using I-, J-, and K-
indices, or probing inside a 3D volume. You can launch the Probe At dialog from the Data menu, 
from the Var Values page of the Probe dialog, or by clicking Tool Details from the Sidebar while in
Probe mode.

Probe At Position
To probe at a specified location using spatial coordinates (in Interpolate mode), launch the Probe 
At dialog (accessed via the Data menu). 

Figure 20-1. The Position page of the 
Probe At dialog.

The Position page of the Probe At dialog has the following options:

• Enter Coordinates - enter the X-, Y-, and Z-coordinates of the desired probe 
location.

• Probe Within Volume [DEFAULT] - If the zone you are probing is a 3D vol-
ume zone, toggle-on Probe Within Volume to ensure that the probe is performed 
at the indicated point. If you specify a position within a 3D volume zone and 
the Probe Within Volume is not selected, Tecplot probes at the surface of the 
zone nearest to the user.
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• Do Probe - Select the Do Probe button to perform the probe. The Probe dia-
log will appear with interpolated values for the specified location.

Probe at Index

To probe at a specified location using data set indices (in Nearest Point mode), launch the Probe 
At dialog (accessed via the Data menu) and select the Index page (Figure 20-1).

The Index page of the Probe At dialog has the following options:

• Mapping/Zone - Select the desired zone or mapping from the drop-down.

• I, J, K - Enter the I-, J-, and K-indices of the desired probe location. (For 
finite-element and I-ordered data, you can enter only the I-index. For IJ-ordered 
data, you can enter both I- and J-indices. For IJK-ordered data, you can enter I-, 
J-, and K-indices.) 

• Do Probe - Select the Do Probe button to perform the probe. The Probe dia-
log will appear with interpolated values for the specified location.

If you have already probed one point, you can specify 
new indices by increasing or decreasing the displayed 
values using the up and down arrows at the right of 
each index field. Doing this automatically performs 

the probe; you need not click Do Probe again.
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20 - 3 Field Plot Probed Data Viewing
You can view probed data in the Probe dialog. The Probe dialog has four pages:

• Variable Values- Examine values of all variables at any selected location.

• Zone and Cell Information- Report characteristics of any location in a data 
field. The characteristics reported include the indices of the selected cell or 
point, the zone number, the dimensions of the zone, and the type of zone 
(ordered or finite-element).

• Cell Center- Examine values of all variables at the center of the clicked-on 
cell.

• Face Neighbor- Examine neighboring cells of the click-on cell.
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20- 3.1 Variable Values
The Var Values page of the Probe dialog lists every variable in the current data set, together with 
its value at the specified probe point. The Var Values page also displays the zone name and number 
and the current solution timer.

By default, each variable is shown on a single line, which allows display of about the first ten char-
acters of the variable name and seven significant digits of the variable value. To display longer vari-
able names or see more digits of the value, deselect the check box labeled One Line per Variable.

Load Variables
The value (on the Var Values page) and Cell Center Value (on the Cell Center page) will display 
“Not Loaded” for variables from your data set that were not automatically loaded into Tecplot. To 
load these variables into Tecplot, select the Load Variables button (on either the Var Values or 
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Cell Center page of the Probe dialog) and select the variables desired from the Load Variable dialog. 
See “Load On Demand” on page 552 for more information on load on demand.

20- 3.2 Zone and Cell Information
The Zone/Cell Info page of the Probe dialog lists the follow-
ing information about any probed data point, regardless of 
the format of the data:

• The number and name of the probed zone.

• The format of the zone, either ordered or one of 
the finite-element formats (FE-Triangle, FE-Quad, 
FE-Tetra or FE-Brick).

• Time - the Current Solution time of the probed 
point

For ordered zones, the following additional information is 
displayed:

• I-Max - Maximum I-index of the zone.

• J-Max - Maximum J-index of the zone.(J-Max is 
one for I-ordered data.)

• K-Max - Maximum K-index of the zone. (K-Max 
is one for IJ-ordered data).

• Plane - Shows the type of plane.   I, J, or K dis-
plays the index of the point at the principal data 
point of the cell containing the probed point. (If the 
point is probed using Ctrl-click for Nearest 

Point, the label reads “I,J or K-Index.”)

• Face Plane - The I-, J-, or K-plane that is probed.

• Face Indices - The planes that are not mentioned in Face Plane, these are the 
other faces that are showing in 3D, or are the axes in 2D.

For finite-element zones, the following additional information is displayed:

• Total Pts - Total number of points in the zone.
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• Total Elems - Total number of elements (cells) in the zone.

• Node Num - Number of the probed node. This field is filled in only if the point 
is probed using Ctrl-click for Nearest Point.

• Elem Num - Number of the probed element.

• Node 1 - 8 - Number of the node defining Node 1-8 of the cell.

• Node 4 -FE-Quad, FE-Tetra, and FE-Brick only.
• Node 5-8 - FE-Brick only.
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20- 3.3 Cell Center
The Cell Center page of the Probe dialog lists the value of every variable in the current data set at 
the center of the cell that was selected. The Zone name and number and the current solution time 
are also displayed. 

By default, each variable is shown on a single line, with the first ten characters of the variable name 
and first seven significant digits of the variable value.

To display longer variable names or see more digits of the value, deselect the check box labeled 
One Line per Variable. 

See “Load Variables” on page 404 for information on the Load Variable button.
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20- 3.4 Face Neighbor
The Face Neighbor page of the Probe dialog displays cells that neighbor the selected cell. A cell is 

considered a neighbor if one of its faces shares all nodes in common with the selected cell, or if it is 
identified as a neighbor by face neighbor data in the data set. The current solution time is also 
displayed. Refer to  for more information on face neighbor data.

20 - 4 Line Plot Probing with the Mouse
You may probe XY and Polar Line plots in much the same way you probe field plots. You can use 
the probe mouse mode to obtain interpolated variable values at any given location, or obtain exact 
values from a specified (X, Y) or (Theta, R) data point. When you probe an XY Line plot in the 
standard mode, Tecplot displays a vertical or horizontal line, depending on whether you are probing 
along an X- or a Y-axis. When you probe a Polar Line plot, a radial line or a circle is displayed 
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depending on whether you are probing along the Theta- or R-axis. In either case, the probe is per-
formed along the displayed line (or circle). 

To probe in interpolate mode: activate the probe tool and click anywhere on your plot. Axis vari-
able values of all active mappings that lie along the probe line are interpolated and displayed.

To probe in Nearest Point mode: activate the probe tool and CTRL+click anywhere on your plot. 
When you CTRL+click, Tecplot displays the exact X- and Y- or Theta- and R-values of the data 
point closest to the location clicked.

20- 4.1 Line Plot Probing in Interpolate Mode

Interpolate mode is the standard probe mouse mode in line plots just as for field plots. For XY 
Line plots, you can probe along any of Tecplot’s five X-axes, or along any of Tecplot’s five Y-axes. 
By default, probing is performed along the X1 axis. For Polar Line, probing is done along the 
Theta-axis by default.

Note: In Polar Line, many combinations of Theta- and R-values can result in the same point on the 
screen. When using the mouse in Interpolate mode to probe along the Theta-axis, Tecplot uses 
the Theta-value within the current Theta-axis range to determine the corresponding R-values 
reported in the Probe dialog. This behavior may result in no probe information shown for a map-
ping that has Theta-values entirely outside the current Theta-axis range, even though the mapping 
crosses the probe line on the screen. (For example, probing along the Theta-axis in interpolate 
mode misses a mapping representing only Theta-values several cycles outside the current Theta-
axis range.) Similarly, when using the mouse in Interpolate mode to probe along the R-axis, Tecplot 
uses the R-value within the current R-axis range and may miss mappings that are shown on the plot 
but have R-values different from the R-axis range.
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To enter the Probe Interpolate mode, select the Probe tool  from the toolbar and select 
the Tool Details button from the sidebar. The Probe At dialogs for XY and Polar Line plots are 
shown in Figure 20-2 The Probe At dialog has the following options:

Figure 20-2. The Probe At dialog for XY (left) and Polar Line 
(right) plots.

• Select Axis to Probe - Click the button corresponding to the axis you want to 
probe along.

• Do Probe - Select the Do Probe button (or , from the toolbar) to per-
form the probe. The Probe dialog will open, as in Figure 20-3.

Alternatively, you can press the X, Y, T, or R 
keys on the keyboard while moving the 
mouse over the plot to selects the axis to 
probe along. You can also press the 1, 2, 3, 

4, or 5 keys to select different X- or Y-axes for multiple-
axis XY Line plots.
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Figure 20-3. Probe dialog for XY 
line plots.

For interpolated values, the Probe dialog lists every active 
mapping and the interpolated value the opposing axis vari-
able for that mapping. The value along the probed axis is 
listed at the bottom of the dialog. For example, Figure 20-3
shows a probe along the X1 axis and the corresponding Y-
values.

In the Probe dialog, the probe value is dashed (---) if the 
probe is out of range for the mapping. The probe value is 
gray (inactive) if the mapping is not using the specific axis 
which you are probing. For example you probe the X1 axis 
and the mapping uses the X2 axis. This will only happen in 
XY Line plots with multiple X- or Y-axes.

By default, each mapping is shown on a single line, which 
allows display of about the first ten characters of the map-
ping name and seven significant digits of the variable value.

To display longer mapping names or see more digits of the 
value, deselect the check box labeled One Line per Mapping. 
The position of the probe is listed below the list of map-
pings.

• X-Value, Y-value - X, Y-value of the nearest data 
point to the probe position.
• I-, J- or K-Index - I, J or K-index of the nearest 
data point to the probe position.
• Map - Number and name of the nearest map to 
the probe position.
• Zone - Number and name of the nearest zone to 

the probe position.
• I,J or K-Max - Maximum I, J or K-index of the current zone.
• X or Y-Axis - X or Y-axis associated with the current map.

20- 4.2 Line Plot Probing in Nearest Point Mode

Nearest Point probe mode provides the exact X- and Y- or Theta- and R-values of the data point 
closest on the screen to the probed location, together with information on the mapping and the zone 
to which the probed point belongs. If a data point is common to multiple mappings, the probe 
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returns information on the highest numbered mapping. For example, if a data point is plotted as part 
of two mappings, numbered 1 and 2, the probe results are displayed for mapping 2.

To enter the Probe Nearest Point mode select the Probe tool, , from the toolbar and 
CTRL-click at the desired probe location. The nearest point is calculated from the actual location of 
the cross-hair and is independent of the axis you were probing along.

In Nearest Point mode, the Probe dialog appears with the heading Specific Values. The follow-
ing information about the nearest data point is displayed:

• X- or Theta-value.

• Y- or R-value.

• I, J or K-index.

• The number and name of the mapping associated with the data point. 

• The number and name of the zone referenced in the mapping.

• The maximum I, J and K-indices of the zone.

• For XY Line plots, the X-axis and Y-axis associated with the mapping.

20 - 5 Data Editing
Using the Adjustor tool, you can probe and edit specific data points. In Adjustor mode, you can 
actually modify the coordinates of your data with the mouse.

You can edit data points either by moving them with the mouse (in XY Line and 2D Cartesian plots 
only), or by using the Probe/Edit Data dialog to enter new values for any variable in the probed data 
point.

If you modify a shared variable with the Adjustor tool, 
the variable will be branched--a separate copy of the 
variable will be created for the edited zone. If you use 

the Probe/Edit Data dialog, you can inhibit branching by select-
ing the Alter in all Shared Zones toggle.
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20- 5.1 Data Editing with the Mouse
In XY Line and 2D Cartesian plots, you can select and move data points with the Adjustor mouse 
mode. You can select multiple data points and move them as a group. When you move data points 
with the mouse, you will not actually see the changes until you redraw the screen.

See  “Adjustor Tool” on page 23 for more information.

20- 5.2 Data Editing with the Probe/Edit Data Dialog 
To probe to edit using the Probe/Edit Data dialog:

1. On the toolbar, choose the Adjustor tool, indicated by the  button.

2. Move the pointer into the workspace, where it becomes the Adjustor.

3. Double-click on the point you want to edit, or click on the point and then click 
Object Details on the sidebar. 

4. From the Probe/Edit Data dialog (shown in Figure 20-4), enter new values as 
desired.

Note: If you attempt to double-click, but move 
the mouse between clicks, you may find that 
you have moved your data point.
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5.  If the variable you wish to modify is shared by other zones and you want the 
modification to be used by all zones (and the variable to remain shared), select 
the Alter in all Shared Zones toggle

Figure 20-4. Probe/Edit Data dialog 
for field plots (left) and 
XY Line plots (right).

.

Edit Options for Field Plots
The lower half of the Probe/Edit Data dialog is a copy of the Probe At dialog’s Index page. All 
variables in the zone or mapping are listed, along with their values at the probed point. You can use 
this area to specify a new zone or mapping to probe, along with the specific points to probe and 
edit. 
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For 2D and 3D plot types, the Probe/Edit Data dialog has Scroll Up and Scroll 
Down buttons which are active if the data set has more variables than can be 
displayed on one page of the dialog. Thus, you can edit one point, then 
increase or decrease the displayed indices to edit the next point along a map-
ping.

• Variable - Lists all variables in the current data set. If there are more than ten 
variables, the Scroll Up and Scroll Down buttons are active.

• Value - Lists the value of the named variable at the probed point.
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• Scroll Up/Down - Click this to scroll up or down one page of variables. This 
button is active only if there is more than one page of variables.

• Load Variables - See “Load Variables” on page 404.

• Enter Zone/Index to Probe - Specify a grid point by index for editing. There 
are four controls in this region:

• Zone - Select a zone to probe from the drop-down.
• I, J or K - Specify the I, J or K-index of the probed point. You can 

either enter a value, or use the up and down arrows to increase or 
decrease the current value.

Edit Options for XY Plots

• Variable - Display the names of the X- and Y-variables for each of the selected 
map.

• Value - Display the values of the X- and Y-variables for each of the selected 
map.

• Enter Map/Index to Probe - Specify a data point by index for editing. There 
are four controls in this region:

• Zone - Select a map to probe from the drop-down.
• I, J or K - Specify the I, J or K-index of the probed point. You can 

either enter a value, or use the up and down arrows to increase or 
decrease the current value.



417

Data Editing



Chapter 20:Probing

418



419

Chapter 21 Text, Geometries and 
Images

You can enhance any plot, or create a drawing from scratch, using Tecplot’s text and drawing tools. 
Tecplot provides tools for creating polylines, circles, ellipses, squares, rectangles, and text. You can 
also insert BMP, JPEG, or PNG images to enhance your plot. 

Pure sketches are created with the “Sketch” plot type. Figure 21-1 shows a sketch created with Tec-
plot drawing tools.

WEDGE
α

Freestream
Shock Wave

Flat Plate

Free Stream

L S H
XF

XS

Z

Figure 21-1. A sketch created with Tecplot.

21 - 1 Text

To add text to your plot or sketch, either select the Text tool  from the toolbar or Text from 
the Insert menu. Click anywhere in a frame to indicate the location of the text. Use the Text Details
dialog to enter and modify text and its formatting. To create multiple text element click in the Tec-
plot workspace at the desired location of the next text element before closing the dialog.
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21- 1.1 Text Details
The Text Details dialog has the following options:.

•  Enter Text String - Type the desired text.

•  Color - Select a color for the text from the Select Color dialog.

• Font - Select a font for the text from the drop-down of Tecplot's built-in fonts. 
You can embed Greek, Math, and User-Defined characters into English-
font strings by enclosing them with text formatting tags, together with the key-
board characters.

The text formatting tags and their effects are as follows (format tags are not case 
sensitive and may be either upper or lower case):

• <b>...</b> - bold
• <i>...</i> - italics
• <verbatim>...</verbatim> - verbatim
• <sub>...</sub> - subscripts
• <sup>...</sup> - superscripts
• <greek>...</greek> - Greek font.
• <math>...</math> - Math font.
• <userdef>...</userdef> - User-Defined font.
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• <helvetica>...</helvetica> - Helvetica font.
• <times>...</times> - Times font.
• <courier>...</courier> - Courier font.

Embedding and escaping special characters work only in English-font text; they 
have no effect in text created in Greek, Math, or User-Defined fonts.

You can produce subscripts or superscripts by enclosing any characters with 
<sub>...</sub> or <sup>...</sup>, respectively. Tecplot has only 
one level of superscripts and subscripts; expressions requiring additional levels, 

such as , must be created by hand using multiple Tecplot text strings. If you 
alternate subscripts and superscripts, Tecplot positions the superscript directly 
above the subscript. Thus, the string a<sub>b</sub><sup>c</sup> pro-

duces . To produce consecutive superscripts, enclose all superscript charac-
ters in a single pair of tags. The string x<sup>(a+b)</sup> produces 

 in your plot.

To insert a tag into text literally, precede the first angle bracket with a backslash 
(“\”). To insert a backslash in the text, just type two backslashes (“\\”). In ASCII 
input files, the number of backslashes must be doubled (two to precede a special 
character, four to create a backslash) because the Preplot program also requires a 
backslash to escape special characters.

• Angle (deg) - Specify the orientation of the text relative to the axis. The angle 
is measured in degrees counter-clockwise from horizontal. Horizontal text is at 
zero degrees; vertical text is at 90 degrees. You can either enter an angle in 
degrees, or select from one of the preset angles in the drop-down.

• Height - Specify the height for the text. The height can be expressed in any of 
three ways, depending upon the setting of Coordinate System/Character Height. 
The default is in points; you can either enter a value in the text field or choose a 
preset value from the drop-down.

• Coordinate System/Character Height - Select a combination of coordinate 
system and character height units from the following option buttons:

• Frame/Frame - Specify character height as a percentage of frame 
height and place the text in a frame coordinate system.

• Frame/Point - Specify character height in points and place the text 
in a frame coordinate system.

ex2

ab
c

x a b+( )
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• Grid/Grid - Specify character height in grid units, and place the text 
in the grid coordinate system.

• Grid/Frame - Specify character height in frame units and place it in 
the grid coordinate system.

• Origin - Enter the X- and Y-coordinates of the text anchor.

• Clipping - Clipping refers to displaying only that portion of an object that falls 
within a specified clipping region of the plot. If you have specified your text 
position in the Frame coordinate system, the text will be clipped to the frame. 
If you have specified the Grid coordinate system, you can choose to clip your 
text to the frame or the viewport. The size of the viewport depends on the plot 
type as follows:

• 3D Cartesian - The viewport is the same as the frame, so viewport 
clipping is the same as frame clipping.

• 2D Cartesian/XY Line - The viewport is defined by the extents of the 
X and Y axes. You can modify this with the Area page of the Axis 
Details dialog.

• Polar Line/Sketch - By default, the viewport is the same as the frame. 
You can modify this with the Area page of the Axis Details dialog.

• Options - Click Options to add a box around your text, modify the line spacing 
for multi-line text, or set a text anchor location. See 21- 1.2 “Text Options” on 
page 423.



423

Text

21- 1.2 Text Options
Using the Text Options dialog (accessed via the Options button in the Text Details dialog) allows 
you to control boxed text, specify the text anchor position, control line spacing, and specify the 
scope of the text. The following options are available:

• Text Box - Specifies whether and how the text is boxed, as follows:

• No Box - Select this to specify that no box is drawn around the text.
• Filled - Select this to specify a filled box around the text. A filled box 

is opaque; if you place it over another Tecplot object, the underlying 
object cannot be seen.

• Plain - Select this to specify a plain box around the text.
• Line Thickness (%) - Specifies the thickness of the text box as a per-

centage of the frame width. 
• Box Color - Select the box outline color from the Select Color dialog.
• Fill Color - Select the box fill color from the Select Color dialog.
• Margin - Specify the margin as a percentage of the text character 

height.

• Text Anchor Location - Specify the anchor point, or fixed point, for the text 
box. As the text box grows or shrinks, the anchor location is fixed, while the 
rest of the box adjusts to accommodate the new size. There are nine possible 
anchor points, corresponding to the left, right, and center positions on the head-
line, midline, and baseline of the text box. Select the option button correspond-
ing to the desired anchor position.
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• Line Spacing - Specify the line spacing for the entered text. To specify the line 
spacing either enter a value in the text field, or use the up and down arrows to 
increase or decrease the existing value.

• Attach to Zone/Map - Select this check box to attach the text to a particular 
zone or mapping. Text that is attached to an inactive or non-existent zone is not 
displayed. If you select this check box, enter the number of the zone or map-
ping to which you want to attach the text. 

• Show in All “Like” Frames - Select this check box to display the entered text 
in all frames sharing the current frame's data set. 

• Macro Function - In the text field, specify the name of the macro function that 
you wish to link to a particular string of text. See 25- 1.2 “Macro Linking to 
Text and Geometries” on page 501 for more information.

21- 1.3 Special Characters

European Characters
Tecplot supports the ISO-Latin one-character encodings. Characters in the ASCII ordinal range 
from 160-255 are now available, providing support for most of the major European lan-
guages.Table 21-2 shows the characters supported by Tecplot. Note that the two right-hand col-
umns represent the extended European characters. Text formatting tags for Greek, Math, or User-
Defined characters work only with characters in the range 32-126 and is not available for the 
extended European characters.

If your keyboard is configured to produce European characters, then the European characters 
should appear and print automatically with no additional setup.

If your keyboard is not configured to produce a specific European character you can generate it by 
including the sequence \nnn in your text where nnn is from the character index table found in 
Table 21-2. For example, if your keyboard will not generate the é and you want to show the word 
“latté,” enter:

latt\233

 Custom Characters
You can create symbols, characters, and even custom fonts for use in Tecplot 
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Table 21-2. Character Indices in Tecplot.
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 See Section 28 - 6, “Custom Character and Symbol Definition,”for instructions.

21- 1.4 Dynamic Text
You can add special placeholders to text that changes with the data or the display environment. For 
example, you can add a date placeholder that Tecplot will replace with the current date at each 
Redraw. Similarly, you can add a zone name or variable name placeholder.

The complete list of placeholders is as follows:

Variables Notes

&(AUXDATASET:name) The named auxiliary data attached to 
the current frame.

&(AUXFRAME:name) The named auxiliary data attached to 
the data set of the current frame.

&(AUXVAR[nnn]:name) The value of variable nnn.
&(AUXLINEMAP[Q]:name)
where Q = either nnn or ACTIVE-
OFFSET = nnn and nnn = 
linemap number

The name of the linemap. If ACTIVEO-
FFSET= is used, the integer value indi-
cates the first linemap associated with 
the nnnth active field map. 

&(AUXZONE[Q]:name)
where Q = either nnn or ACTIVE-
OFFSET = nnn and nnn = zone 
number

The named auxiliary data attached to 
the data set of the current frame.   nnn = 
zone number. If ACTIVEOFFSET= is 
used, the integer value indicates the 
first zone associated with the nnnth 
active field map. 

&(AXISMAXA) Maximum value of current Theta-axis 
range.

&(AXISMAXR) Maximum value of current R-axis 
range.

&(AXISMAXX) Maximum value of current X-axis 
range.
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&(AXISMAXY) Maximum value of current Y-axis 
range.

&(AXISMAXZ) Maximum value of current Z-axis 
range.

&(AXISMINA) Minimum value of current Theta-axis 
range.

&(AXISMINR) Minimum value of current R-axis 
range.

&(AXISMINX) Minimum value of current X-axis 
range.

&(AXISMINY) Minimum value of current Y-axis 
range.

&(AXISMINZ) Minimum value of current Z-axis 
range.

&(BYTEORDERING) Platform’s byte ordering: “INTEL” or 
“MOTOROLA”

&(COLORMAPDYNAMIC) Returns one if the color map is 
dynamic, zero if static.

&(DATE) Replaced with the current date in the 
format dd Mon yyyy.

&(DATASETFNAME[nnn]) Data set file name of the nth file associ-
ated with the current data set. If n is 
omitted then all data set file names are 
show, separated by new lines.

&(DATASETTITLE) Replaced with the current data set title.
&(ENDSLICEPOS) Replace with the position of the ending 

slice plane. 
&(EXPORTISRECORDING) Returns “YES” if currently recording, 

otherwise returns “NO.”
&(FRAMENAME) Replaced with the current plot.

Variables Notes
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&(INBATCHMODE) A value of one if Tecplot is in batch 
mode, zero if interactive.

&(ISDATASETAVAILABLE) A value of one if a data set exists for the 
current frame, zero if nonexistent.

&(ISOSURFACELEVEL[nnn]) Replace with the value of the contour 
variable on the nnnth iso-surface. 
NOTE: currently, this placeholder 
applies only to iso-surface group 1.

&(LAYOUTFNAME) Replaced with the name of the current 
layout file.

&(LOOP) Innermost loop counter.
&(MACROFILEPATH) Path to the directory containing the 

most recently opened macro file.
&(MAXA) Maximum value for the Theta variable. 

The value is calculated from the zone 
assigned to the lowest numbered active 
line mapping.

&(MAXB) Maximum value for blanking variable 
for the first active constraint. If the plot 
type is 2D or 3D Cartesian, the value is 
calculated from the current set of active 
zones. If the plot type is XY or Polar 
Line, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

Variables Notes
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&(MAXC) Maximum value for contour variable 
for contour group 1. If the plot type is 
2D or 3D Cartesian, the value is calcu-
lated from the current set of active 
zones. If the plot type is XY or Polar 
Line, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

&(MAXI) I-dimension for the lowest numbered 
active zone for 2D and 3D Cartesian 
plot types. For line plots this represents 
the maximum I-value for the zone 
assigned to the lowest numbered active 
line mapping. For finite-element data, 
this represents the number of nodes in 
the lowest numbered active zones.

&(MAXJ) J-dimension for the lowest numbered 
active zone for 2D and 3D Cartesian 
plot types. For line plots this represents 
the maximum J-value for the zone 
assigned to the lowest numbered active 
line mapping. For finite-element data, 
this shows the number of elements in 
the lowest numbered active zone.

&(MAXK) K-dimension for the lowest numbered 
active zone for 2D and 3D Cartesian 
plot types. For line plots this represents 
the maximum K-value for the zone 
assigned to the lowest numbered active 
line mapping. For finite-element data, 
this shows the number of nodes per ele-
ment for the lowest numbered active 
zone.

Variables Notes
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&(MAXR) Maximum value for the R variable. The 
value is calculated from the zone 
assigned to the lowest numbered active 
line mapping.

&(MAXS) Maximum value for scatter sizing vari-
able for the currently active zones.

&(MAXU) Maximum value for variable assigned 
to the X-vector component for the cur-
rently active zones.

&(MAXV) Maximum value for variable assigned 
to the Y-vector component for the cur-
rently active zones.

&(MAXVAR[nnn]) Maximum value of variable nnn.
&(MAXW) Maximum value for variable assigned 

to the Z-vector component for the cur-
rently active zones.

&(MAXX) Maximum value for variable assigned 
to the X-axis. For 2D or 3D Cartesian 
plots, the value is calculated from the 
current set of active zones. For line 
plots, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

&(MAXY) Maximum value for variable assigned 
to the Y-axis. For 2D or 3D Cartesian 
plots, the value is calculated from the 
current set of active zones. For line 
plots, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

Variables Notes
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&(MAXZ) Maximum value for variable assigned 
to the Z-axis for the currently active 
zones.

&(MINA) Minimum value for the Theta variable. 
The value is calculated from the zone 
assigned to the lowest numbered active 
line mapping.

&(MINB) Minimum value for blanking variable 
for the first active constraint. For 2D or 
3D Cartesian plots, the value is calcu-
lated from the current set of active 
zones. For line plots, the value is calcu-
lated from the zone assigned to the low-
est numbered active line mapping.

&(MINC) Minimum value for contour variable 
for contour group 1. For 2D or 3D Car-
tesian plots, the value is calculated from 
the current set of active zones. For line 
plots, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

&(MINR) Minimum value for the R variable. The 
value is calculated from the zone 
assigned to the lowest numbered active 
line mapping.

&(MINS) Minimum value for scatter sizing vari-
able for the currently active zones.

&(MINU) Minimum value for variable assigned to 
the X-vector component for the cur-
rently active zones.

Variables Notes
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&(MINV) Minimum value for variable assigned to 
the Y-vector component for the cur-
rently active zones.

&(MINVAR[nnn]) Minimum value of variable nnn.
&(MINW) Minimum value for variable assigned to 

the Z-vector component for the cur-
rently active zones.

&(MINX) Minimum value for variable assigned to 
the X-axis. For 2D or 3D Cartesian 
plots, the value is calculated from the 
current set of active zones. For line 
plots, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

&(MINY) Minimum value for variable assigned to 
the Y-axis. For 2D or 3D Cartesian 
plots, the value is calculated from the 
current set of active zones. For line 
plots, the value is calculated from the 
zone assigned to the lowest numbered 
active line mapping.

&(MINZ) Minimum value for variable assigned to 
the Z-axis for the currently active 
zones.

&(NUMFRAMES) Number of frames.
&(NUMPLANES) Returns number of graphics bit-planes
&(NUMVARS) Number of variables in current data set.
&(NUMXYMAPS) Number of XY-maps assigned to the 

current frame.
&(NUMZONES) Number of zones in current data set.
&(OPSYS) Returns 1=UNIX, 2=DOS.

Variables Notes



433

Text

&(PAPERHEIGHT) Paper height in inches.
&(PAPERWIDTH) Paper width in inches.
&(PLATFORM) Platform name (such as “SGI” or 

“WINDOWS”).
&(PLOTTYPE) Plot type for the current frame: Zero 

for Sketch, one for XY Line, two for 
Cartesian 2D, three for Cartesian 3D, 
and four for PolarLine.

&(PRIMARYSLICE) Return the primary slice position (Cur-
rently is limited to Slice Group 1).

&(PRINTFNAME) Replaced with the name of the current 
print file.

&(SLICEPLANETYPE) Replace with the type of slice plane (X-, 
Y-, Z-, I-, J- or K-planes).

&(SOLUTIONTIME) Tecplot’s current solution time.
&(SOLUTIONTIME[Q])
where Q = either nnn or ACTIVE-
OFFSET = nnn and nnn = zone 
number

Solution time of zone nnn. If ACTIVE-
OFFSET= is used, the integer value 
indicates the fist zone associated with 
the nnn'th active field map. &(SOLU-
TIONTIME[5]) would retrieve the solu-
tion time of the 5th zone. 
&(SOLUTIONTIME[ACTIVEOFF-
SET=3]) would retrieve the solution 
time of the first zone in the 3rd active 
field map.

&(STARTSLICEPOS) Replace with the position of the starting 
slice plane.

&(STREAMSTARTPOS[nnn]) Starting position (X, Y, Z) of the nnnth 

streamtrace.

Variables Notes
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The placeholders must be typed exactly as shown, except that the nnn in the zone name and vari-
able name placeholders should be replaced by the actual number of the zone or variable, such as 
&(ZONENAME[3]) or &(VARNAME[2]).

You can, of course, embed the dynamic text strings in text records in a Tecplot-format data file, as 
in the following example:

TEXT CS=FRAME HU=POINT T=”&(DATE)”

&(STREAMTYPE[nnn]) Type (Surface Line, Volume Line, Vol-
ume Ribbon, Volume Rod) of the nnnth 
streamtrace.

&($string) Replaced with the value of the system 
environment variable string.

&(TECHOME) Path to the Tecplot home directory.
&(TECPLOTVERSION) Returns Tecplot Version. (Currently 

returns “110.”)
&(TIME) Replaced with the current time in the 

format hh:mm:ss.

&(VARNAME[nnn]) Replaced with the variable name for 
variable nnn.

&(ZONEMESHCOLOR[Q])
where Q = either nnn or ACTIVE-
OFFSET = nnn and nnn = zone 
number

Color of the mesh for the nnnth zone. If 
ACTIVEOFFSET= is used, the integer 
value indicates the nnnth active zone for 
field plots and the zone associated with 
the nnnth active line mapping for line 
plots.

&(ZONENAME[Q])
where Q = either nnn or ACTIVE-
OFFSET = nnn and nnn = zone 
number

Replaced with the zone name for zone 
nnn. If ACTIVEOFFSET= is used, the 
integer value indicates the nnnth active 
zone for field plots and the zone associ-
ated with the nnnth active line mapping 
for line plots.

Variables Notes
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System environment variables can be accessed directly from Tecplot by using the following: 
&($string), where string is the name of your environment variable. Using environment variables 
within Tecplot can add another degree of flexibility by taking advantage of your customized envi-
ronment. If an environment variable is missing, the environment variable name itself will appear on 
the screen.

21 - 2 Geometries
Geometries in Tecplot are simply line drawings. Geometries include polylines (a set of line 
segments), circles, ellipses, rectangles, and squares. Images are also considered geometries, and are 
discussed in Section 21 - 3, “Images”. Figure 21-2 shows some examples of geometries.

21- 2.1 Geometry Creation
Geometries are created by drawing them in a frame using the toolbar or the Insert menu

Polyline

Add a polyline to your plot, using the button from the toolbar or by selecting Insert>Poly-
line. To draw the polyline, move the mouse (without dragging) to the desired end point of the first 
line segment, then click the left mouse button. Move the pointer to the next end point, click, and so 
on. After placing the last segment, double-click on the final end point or press Esc on your key-
board. To draw a horizontal or vertical line segment, press the H or V keys, respectively, while 
drawing the segment. After you place the segment’s end point, the horizontal or vertical restriction 
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Figure 21-2. Sample Geometries
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is lifted. To lift the horizontal or vertical line segment restriction without placing the end point, 
press A on your keyboard. You can draw unconnected line segments in a single polyline; press U 
on your keyboard to “lift the pen.” You can then move the pointer to the start of the next line seg-
ment.

A Allow translation of polyline segments in all directions.
H Restrict translation of current polyline segment to hori-

zontal.
U Pen up, while drawing polyline.
V Restrict translation of current polyline segment to verti-

cal.

Circle

Add a circle to your plot, using the  button from the toolbar or by selecting Insert>Circle. To 
draw the circles, click at the desired center point of the circle; drag the mouse until the circle is the 
desired radius, then release.

Ellipse

Add an ellipse to your plot, using the  button from the toolbar or by selecting Insert>Ellipse. 
To draw the ellipse, click at the desired center point of the ellipse; drag the mouse until the ellipse is 
the desired size and shape, then release.

Square

Add a square to your plot, using the  button from the toolbar or by selecting Insert>Square. 
The anchor point of the square is either the lower left-hand corner or the upper right corner of the 
square. Drag the mouse to the right of the anchor to create a square with the anchor at lower left; 
drag the mouse to the left to create a square with the anchor at upper right. Release when the square 
is the desired size

Table 21-3. Keyboard Shortcuts for Polylines
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Rectangle

Add a rectangle to your plot, using the  button from the toolbar or by selecting Insert>Rect-
angle. To draw the rectangle, drag the mouse until the rectangle is the desired size and shape. In 
contrast to squares, rectangles can propagate in any direction.

21- 2.2  Geometry Details
Use the Geometry Details dialog to specify attributes of polylines, circles, ellipses, squares and rect-
angles. To access the Geometry Details dialog either select a geometry and click on Object Details in 
the Sidebar, or double-click on the geometry object itself.

The following options are available:

• Line Color - Select a color for the geometry from the Select Color dialog.

• Line Pattern - Select the desired pattern (Solid, Dashed, Dotted, LongDash, 
or DashDotDot).

• Pattern Length (%) - Specify the length of the line pattern as a percentage of 
the frame width.

• Line Thickness (%) - Specify the thickness of the line as a percentage of the 
frame width. 

• Fill Color - Toggle-on to fill a circle, ellipse, square, rectangle or line segment 
polygon. Then select a color for the geometry fill from the Select Color dialog.

• Origin - Enter the X- and Y-coordinates of the anchor position of the geometry 
(in frame units if the coordinate system is frame; in grid units if the coordinate 
system is grid).

• Coordinate System - Specify the coordinate system for the geometry (Frame
or Grid). 

• Frame - the geometry is always displayed at constant size when you 
zoom in or out of the plot. 

•  Grid - the geometry resizes with the data grid.
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• Clipping - Clipping refers to displaying only that portion of an object 
that falls within a specified clipping region of the plot. If you have 
specified your geometry position in the Frame coordinate system, the 
geometry will be clipped to the frame—any portion of the geometry 
that falls outside the frame is not displayed. If you have specified the 
Grid coordinate system, you can choose to clip your geometry to the 
frame or the viewport. The size of the viewport depends on the plot 
type as follows:

•3D Cartesian - The viewport is the same as the frame, so viewport clipping 
is the same as frame clipping.

•2D Cartesian/XY Line - The viewport is defined by the extents of the X 
and Y axes. You can modify this with the Area page of the Axis Details dia-
log.

•Polar Line/Sketch - By default, the viewport is the same as the frame. You 
can modify this with the Area page of the Axis Details dialog.

• Draw Order - Geometries can be drawn either before the data, or after the 
data. If a geometry is drawn before the data, the plot layers, such as mesh, con-
tour lines, etc. will be drawn on top of the geometry. If a geometry is drawn 
after the data, the geometry will be drawn last, obscuring the data. 

• Attach to Zone/Map - Toggle-on to attach the geometry to a particular zone 
or mapping by entering the number of the zone or mapping. Geometries that are 
attached to an inactive or non-existent zone are not displayed.

• Show in All “Like” Frames - Select this check box to display the geometry in 
all frames sharing the current frame's data set.

• Macro Function - In the text field, specify the name of the macro function that 
you wish to link to a particular geometry. See 25- 1.2 “Macro Linking to Text 
and Geometries” on page 501 for more information.

You can place text and geometries in any 
order you like. Tecplot draws all geome-
tries first, in the order in which they were 
placed, then all text. Use the Push and Pop
commands from the Edit menu to reorder 

objects in the viewstack.
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The following fields are specific to a single geometry type-

• Polyline Arrowhead - These options control the appearance of an arrowhead 
on a drawn polyline.

• Attachment - Choose the end or ends of the polyline by selecting the 
appropriate check boxes.

• Size(%) - Specify the size of the arrowhead, as a percentage of frame 
height.

• Style

•  Plain arrowhead style.

•  Filled arrowhead style.

•  Hollow arrowhead style.
• Angle - Specify the angle the arrowhead makes with the polyline. You 

can either enter a value (in degrees) in the text field, or choose a preset 
value from the drop-down.

• Circle - Controls the radius and precision of approximation of the circle-

• Radius - Set the radius of the circle (in coordinate system units- 
Frame or Grid).

• Approximated by Number of Sides - Enter the number of polylines 
used to approximate the circle.

• Ellipse - Controls the shape and precision of approximation of the ellipse, as 
follows-

• Horizontal Axis - Set the horizontal axis of the ellipse (in coordinate 
system units- Frame or Grid).

• Vertical Axis - Set the vertical axis of the ellipse (in coordinate system 
units- Frame or Grid).

• Approximated by Number of Sides - Enter the number of polylines 
used to approximate the ellipse.

• Square - Controls the size of the square, as follows-
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• Size - Set the size of the square (in coordinate system units- Frame or 
Grid).

• Rectangle - Controls the size and shape of the rectangle as follows-

• Width - Set the width of the rectangle (in coordinate system units- 
Frame or Grid).

• Height - Set the height of the rectangle (in coordinate system units- 
Frame or Grid).

21- 2.3 Three-Dimensional Line Geometries
Three-dimensional line geometries cannot be created interactively; they must be created in a data 
file or using an add-on. In order to display 3D geometries, you must either include at least one zone 
in the data file with the 3D geometries or read the 3D geometries in, using the Add to Current Data 
Set option, after having first read a data set into the frame

21 - 3 Images
Tecplot can import images from JPEG, BMP, and PNG files. These images can be used as logos or 
as a backdrop to your plot. To add an image to your plot, go to Insert>Image and browse to the 
desired image file.

When you insert an image, the image is initially centered in the frame at a preset size.
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21- 3.1 Modifying Images
The Image Geometry Details dialog (accessed via the Object Details button in the Sidebar) is used 
to modify an image just like it is used to modify other geometries. The dialog also displays the file 
name of the image and its resolution (number of pixels in each direction) for informational 
purposes.

The following options are available:

• Origin - Enter the X- and Y-coordinates of the anchor position of the geometry 
(in frame units if the coordinate system is frame; in grid units if the coordinate 
system is grid).

• Coordinate System - Specify the coordinate system for the geometry (Frame
or Grid). 

• Frame - the geometry is always displayed at constant size when you 
zoom in or out of the plot. 

•  Grid - the geometry resizes with the data grid.
• Clipping - Clipping refers to displaying only that portion of an object 

that falls within a specified clipping region of the plot. If you have 
specified your geometry position in the Frame coordinate system, the 
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geometry will be clipped to the frame—any portion of the geometry 
that falls outside the frame is not displayed. If you have specified the 
Grid coordinate system, you can choose to clip your geometry to the 
frame or the viewport. The size of the viewport depends on the plot 
type as follows-

•3D Cartesian - The viewport is the same as the frame, so viewport clipping 
is the same as frame clipping.

•2D Cartesian/XY Line - The viewport is defined by the extents of the X 
and Y axes. You can modify this with the Area page of the Axis Details dia-
log.

•Polar Line/Sketch - By default, the viewport is the same as the frame. You 
can modify this with the Area page of the Axis Details dialog.

• Height and Width - Enter a new value in one of the text fields labeled Width or 
Height. Units may be specified by typing them after the number. Use “cm” for 
centimeters, “in” for inches, or “pix” for pixels.

• Preserve Aspect Ratio - When the Preserve Aspect Ratio toggle is off, the width 
and height of the image can be set independently. If the Preserve Aspect Ratio is 
then turned back on, the current image aspect ratio is used. To return the image 
to its original shape, press the Reset button.

• Draw Order - Geometries can be drawn either before the data, or after the 
data. If a geometry is drawn before the data, the plot layers, such as mesh, con-
tour lines, etc. will be drawn on top of the geometry. If a geometry is drawn 
after the data, the geometry will be drawn last, obscuring the data. 

• Attach to Zone/Map - Toggle-on to attach the geometry to a particular zone 
or mapping by entering the number of the zone or mapping. Geometries that are 
attached to an inactive or non-existent zone are not displayed.

You can place text and geometries in any 
order you like. Tecplot draws all geome-
tries first, in the order in which they were 
placed, then all text. Use the Push and Pop
commands from the Edit menu to reorder 

objects in the viewstack.
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• Show in All “Like” Frames - Select this check box to display the geometry in 
all frames sharing the current frame's data set.

• Macro Function - In the text field, specify the name of the macro function that 
you wish to link to a particular geometry

• Filter - The Resize filter determines how the image is resized to fit the screen. 
The following filters are available-

• Fast (textures) - default- Tecplot uses OpenGL textures to resize the 
image. This is the fastest option (given sufficient graphics space). 
However, the accuracy of the image may suffer, especially when 
reducing an image to a size much smaller than it was before.

• Pixelated - Choose this option when the image is much larger than its 
original size and you want to see the individual pixels. This option is 
slower than the Fast (textures) for increasing the size of images.

• Smooth - There are seven smooth options, all producing slightly dif-
ferent effects. These options are slower than the Fast (textures), but 
produce better effects for highly reduced images. In general, use the 
Smooth (Lanczos2) option unless you have specific image processing 
needs 

21- 3.2 Images and Tecplot Files
Images cannot be included in data files. When you save a data file, even if you specify to include 
geometries, any images in the plot are not saved.

In layout and style sheet files, the image is referenced from its original location. This reference can 
be a relative reference or an absolute (as with data files). See Section 22 - 1 “Layout Files, Layout 
Package Files, Stylesheets” on page 448 for details.

For layout package files, images are included.

The resize filter has no effect on vector-based output, 
only on the screen and for exported images.

Line Color, Line Pattern, Pattern Length, Line Thick-
ness and Fill Color are not available for images.
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21 - 4 Text and Geometry Alignment
When you have a number of text and geometries, you may want to align them after placing them. 
You can do this using the alignment tools in the Quick Edit dialog.

You can use these tools as follows:

1. On the toolbar, choose the Selector tool by clicking .

2. In the workspace, select a text or geometry with which you want to align other 
objects. 

3. Drag the mouse to draw a rubber band box around the text and geometries you 
want to align. The Group Select dialog appears.

4. Select the Text and Geometries check boxes in the Group Select dialog, then 
click OK. Selection handles appear on the selected text and geometries.

5. On the sidebar, click Quick Edit to call up the Quick Edit dialog, if it is not 
already displayed.

6. Use the alignment buttons to align the selected text and geometries with the 
original select object as follows:

•  Left

•  Center

•  Right

•  Top

•  Bottom

21 - 5 Text and Geometry Links to Macros
Each text or geometry you create can be linked to a macro function. This macro function is called 
whenever the user holds down the control key and clicks the right mouse button on the text or 
geometry.

For example, if you have pieces of text, each representing a different well, CTRL+right-click on 
any piece could run a macro that brings up an XY-plot of that well's data.
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Macro functions are specified with the “Macro Function” field in the Geometry dialog or in the 
Text Options dialog. If desired, the macro function may be listed with one or more parameters. See 
Chapter 25, “Macro Commands,”and the Tecplot Reference Manual, for more detailed information 
on using macros in Tecplot.
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Chapter 22 Output

Tecplot provides a variety of formats for you to output and export your complete plots. This chapter 
discusses: saving your settings using layout files or stylesheets, preparing plots for web publishing 
and writing data files to a file.

For information on exporting or printing your completed plot(s), please refer to: Chapter 24 
“Exporting” on page 473 or Chapter 23 “Printing” on page 463, respectively.

22 - 1 Layout Files, Layout Package Files, Stylesheets
Tecplot has three different types of files for storing plot information: 

• Stylesheets (.sty) - Stylesheets store information about a single frame and do 
not include any information about the data used by the frame.

• Layout Files (.lay) - Layout files store information about all the frames in the 
workspace, including identification of the data used by each frame.

• Layout Package Files (.lpk)- Layout package files are an extension to layout 
files where data and an optional preview image are included.

Layout and layout package files are the preferred method for saving the style of your plot. They 
save a complete picture of the workspace and are quick-and-easy to load and save. Stylesheets con-
tain the style of a single frame in Tecplot. 

22- 1.1 Stylesheets
Stylesheets are useful, when:

•  Pre-processing must be done to a data set prior to attaching a style. You may need to 
load a data set and run some equations or do interpolation or zone extraction before 
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assigning a style. The style may reference objects or variables that do not exist in the 
original data and it is necessary to assign the style after they are created.

•  Switching styles on large data sets. You may want to load a large data set and gener-
ate two full page plots. Each plot has a different style. By using a stylesheet for the 
second plot you avoid having to reload the data set.

•  Copying the style of one frame to another frame in the same layout.

•  Saving just part of a frame’s style, such as just the contour levels.

A stylesheet includes the following attributes (Figure 22-3):

•  Type of plot (a 2D contour plot in 2D or an XY Line plot)

•  Colors used

•  Current view of the data

•  Axes display

•  text, geometry and images

Note: Tecplot’s data journaling capabili-
ties together with layout files eliminate 
this situation in many cases.
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Figure 22-3. Some of the items considered part of the frame style.
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If the frame contains any image geometries (see Section 21 - 3 “Images” on page 440), Tecplot will 
save references to the image files in the stylesheet. If the images came from a layout package file, 
Tecplot will save references to this file in the stylesheet.

22- 1.2  Layout Files
A plot often consists of multiple frames or even multiple data sets. Layout files allow you to cap-
ture all the information on the plot. Layout files include instructions on how to create the data used 
in the plot, the frame layout and data set attachments, axis and plot attributes, the current color map, 
and so forth.

Figure 22-4 shows a layout with four frames. The frame in the upper left-hand corner is attached to 
data set 1. The two frames on the right are both attached to data set 2. The frame in the lower left is 
not attached to a data set.
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Figure 22-4. Layout of four frames using two data sets.

If a frame defined in a layout file requires an attached data set, the data files necessary to build the 
data set are referenced in the layout file. These data files can be referenced using absolute paths or 
relative paths. When using relative paths under Windows, the data files must be on the same drive 
as the layout file.

A layout file may also contain the data journal; a set of macro commands which alter the data or 
create new data. The data journal commands replicate the data modifications made to the original 
data (in files) during prior Tecplot sessions. Not all data operations are supported by the data jour-
nal. For more information, see 4 - 1 “Data Journaling” on page 89.
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In addition to storing the individual style of each frame, layout files record:

•  Page layout information (including the size and orientation of the paper).

•  Color spectrum information, including the global color maps in use.

To include the field data with a layout, use a layout package file. For more information, see Section 
22- 1.3, “Layout Package Files”

22- 1.3  Layout Package Files
Layout package files allow you to transmit raw data, along with style information in a single file. 
With layout package files the view can be changed, different plot types tested, and so forth.

Layout package files are very useful if you are making large documents containing many images, 
or other situations when you need to catalog your images. You can extract contents using the com-
mand line utility lpkview. This utility allows you to look at thumbnail sketches of each image in 
a layout package file without having to load each separately into Tecplot. For more information 
refer to the Quick Reference Guide.

Layout package files have the same properties as standard layout files. (See Section 22- 1.2, “Lay-
out Files”). Layout package files also contain all data associated with frames in the layout, and an 
optional preview image of the Tecplot workspace. An extension of.lpk is used.

22- 1.4 Working with Layout and Layout Package Files

New Layout
File>New Layout creates a new layout in your workspace after removing any existing frames

and resetting the paper setup to the default configuration. Anything not saved before this action will 
be removed.   Use New Layout to reset your workspace.

Layout Saving
Save layout files using the Save Layout (CTRL+S) or Save Layout As (CTRL+W) options under the 
File menu.

The Save Layout dialog has the following options:
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• Save As Type - Choose “Linked Data (*.lay)” or “Packaged Data” (*.lpk) 

• Use Relative Path (Linked Layout ONLY) - By default, Tecplot saves the 
name of the data files used in the layout with their relative file paths. To save 
your layout using absolute file paths, toggle-off Use Relative Path. 

• URL [OPTIONAL] - In Windows, you may specify a URL by selecting the 
URL check box. When selected, you may enter a full URL as the file name. 
The two file types are mutually exclusive. You cannot browse disk files when 
the URL check box is selected, and you cannot enter a URL if the URL check 
box is not selected.

• Include Preview Image [OPTIONAL] -Toggle-on Include Preview Image to 
include a preview image with the file. (Layout Package files ONLY).

After saving the layout file, you will be prompted specify any data set changes. See Data Set 
Changed and Data Set Changed - Create New File and for more information.
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Data Set Changed
In Tecplot, layout files contain references to the data files in use. The data sets are not copied 
directly into the layout file. As such, if you make changes to the data set using Tecplot and wish to 
save the layout, Tecplot will ask you whether to (1) save a set of instructions (journal) to recreate 
your changes or (2) create new data files reflecting the changes made. You do not have the option to 
overwrite the original data set(s). 

The option Use original data set along with journaled instructions is available only if the changes 
made to the data set are supported by journaling (see 4 - 1 “Data Journaling” on page 89 for more 
information).   This option minimizes disk storage. Changes to the original data are reflected in 
later Tecplot sessions. 

Data Set Changed - Create New File
If you choose to save the current data to new files and reference the new files in the layout, or if you 
have modified the data in ways not supported by the data journal, Tecplot prompts you for a file 
name under which to save the changed data. If your layout has multiple data sets, Tecplot prompts 
you for a file name for each modified data set

Layout File Opening
Open layout files using the Open Layout (CTRL+O) option under the File menu.   To combine the 
layout file with the current layout in Tecplot, select the Append check box. 

Layout File Opening with Different Data Files
When you open your layout files in Tecplot, you have the option of overriding the data files that are 
referenced in the layout file. This does not change the saved layout file.

To open a layout file with different data files than those specified in the layout file, select Data 
Override from the Open Layout dialog. In the Override Layout dialog (Figure 22-5), One line is 
listed for each data set in the layout file. Each line contains the data reader name (TECPLOT for 
Tecplot-format data files). If the data set is being loaded by the Tecplot reader, this line shows the 
number of files making up the data set, and a partial list of file names. If a data loader add-on is 
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used, instructions used by the loader are listed here. (This could be a list of file names identical to 
the Tecplot loader’s list.)

Figure 22-5. The Override Layout Data dialog.

To change the data files or instructions making up a data set, double-click on the appropriate line, 
or select the line and select Change. This process includes one or more dialogs allowing you to 
change the list of file names or instructions. Tecplot-format data files include a dialog to select new 
files. If the data loader does not have the capability to override the instructions, an error message 
appears.

Examples for overriding the data sets in the layout file are described in Appendix A, Section 
Table 1-1, “Tecplot Command Line Examples,” on page 592
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22 - 2 Plot Publishing for the Web
Publish allows saving plots directly to an HTML file, from which you may read and write data and 
layout files to ftp:// and http:// sites. A Tecplot HTML file could include a reference to a layout 
package file of your analysis, enabling other Tecplot users browsing your files to review your 
results directly. The Publish Options dialog and a Tecplot HTML file are shown in Figure 22-6.

Publish creates an HTML file referencing the plot images in your Tecplot workspace. Publish also 
creates layout package files with a link from the HTML file to the layout package file.

To create a Tecplot HTML file, select Publish from the File menu. The Publish dialog has the fol-
lowing options:

• Include Reference to Layout Package - Selecting this option creates a layout 
package file, along with a reference to that file in the resulting Publish file.

Figure 22-6. The Publish 
Options dialog 
creates layout 
package files for 
the Web.
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• Make Single Image for Workspace -Creates a single image file of your entire 
Tecplot workspace. A single reference is added to your Publish file for this 
image file.

• Make Separate Images for Each Frame - Creates an image for each frame in 
your Tecplot workspace. A separate reference for each frame is added to your 
Publish file.

• Convert to 256 Colors

22 - 3 Data File Writing
You can write out the data set in the current frame as either an ASCII or binary data file. Tecplot 
asks you to choose which part of the data to write, as well as to specify the format for the saved file.

Keyboard shortcut for Publish = CTRL+U
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To write the data set in the current frame to a file, select Write Data File from the File menu. The 
Write Data File Options dialog has the following options:

• Details to Save - Specify which record types you want to write to the 
saved data file by selecting the appropriate check boxes. By default, all record 
types that are present in the current data set are selected. 

• Text
• Geometries
• Custom Labels
• Field Data - Save the zone data.
• Data 
• Linkage (If Possible) - Save the variable and connectivity sharing 

between zones existing in the data set, reducing its size and loading 
time.
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• Face Neighbor Information Generated by Tecplot - Automatically 
save the face neighbor information generated by Tecplot for finite-ele-
ment zones. This increases the data set size and loading time, but 
speeds performance after loading.

• Save Data Using - Choose whether to save the file as ASCII or Binary.

• Precision [ASCII ONLY] - Specify the precision of your Float and 
Double variables. These variable types are written in exponent format 
and the precision determines the number of digits included past the 
decimal point.

• Zone/Geometry Format - For ASCII, choose to write the file in POINT for-
mat or BLOCK format (BLOCK is required if any variables are cell-centered). 
See Chapter 2 “ASCII Data” on page 9 of the Data Format Guide for a com-
plete description of both formats.)

• Zone(s)/Variable(s) - Select the zones and variables to save.

• Associate Layout with Newly Saved Data File [OPTIONAL] - Tecplot associ-
ates this data file with the layout’s style. If not selected, Tecplot asks you for a 
file name when writing out the file.
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Chapter 23 Printing

Printing your plot is the process of sending the plot image to an output device, print spooler, or a 
file. Typically the output device is a printer, but it may be a plotter, film recorder, file or typesetting 
machine. If you are creating files for use in another program, you should use Tecplot’s Export
option (accessed via the File menu) to create your files—Export includes all the supported print file 
types, as well as several standard graphics formats, including: TIFF, WMF, JPEG, and EPS. See 
Chapter 24, “Exporting,”for complete details.

23 - 1 Plot Printing
To print a plot, select Print from the File menu (Figure 23-1).

Figure 23-1. The Print dialog (for Windows).

Tecplot supports the standard Windows printer drivers. You can also configure Tecplot to use the 
native Tecplot print drivers for the following formats: PostScript.

The Print dialog has the following options:

•  Format - Indicates the current printer for the plot.
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•  Send Output to File - [OPTIONAL] Selecting this check box will send your out-
put to a file instead of a printer.

•  Print Setup - Calls up the Print Setup Dialog dialog.

•  Render Options - Calls up the Print Render Options dialog.

•  Preview - Displays Tecplot’s print preview screen

23 - 2 Setup
You can set various parameters relating to the paper, including paper size and orientation, using the 
Paper Setup dialog or the Print Setup dialog. A change to your paper settings in either the 
Paper Setup dialog or the Print Setup dialog will automatically update the other.

23- 2.1 Printing Setup for Windows

Print Setup Dialog
On Windows platforms, use the Print Setup dialog to set up your paper (Figure 23-2.). The Print 
Setup dialog is accessed via the Print dialog (accessed via the File menu) and has the following 
options: 

Figure 23-2. The Print Setup dialog (Windows).

Ctrl+P is the keyboard shortcut for the 
Print dialog.
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• Printer - Specify the printer and set its properties.

• Paper - Specify the paper size and source tray using the following drop-
downs:

• Size - Select the paper size. The choices are printer-dependent.
• Source - Choose a paper tray from the drop-down.

• Orientation - Specify one of the following options:

• Portrait - The horizontal axis of the plot is aligned with the short side 
of the paper.

• Landscape - The vertical axis of the plot is aligned with the short side 
of the paper.

By default, Tecplot uses the standard Windows print drivers. You can choose to use Tecplot's native 
print drivers, by adding the following line to your tecplot.cfg file:

$!INTERFACE USETECPLOTPRINTDRIVERS=YES

If you use Tecplot’s native print driver, you will use the Print Setup dialog for subsequent printing.

Paper Setup Dialog
To adjust the paper size, orientation, and background color for your plots, select the Paper Setup
option from the File menu. The current settings for these options are reflected in the representation 
of the paper in the workspace. (To view the paper, select the Show Paper on Screen check box in 
either the Paper Setup dialog or the Ruler/Grid dialog (accessed via the Options menu). This check 
box is selected by default.)

The Paper Setup dialog, in contrast with the Print Setup dialog under Windows, offers you only 
six paper sizes. These may not be compatible with the paper sizes your printer supports. You cannot 
select from multiple paper trays with the Paper Setup dialog. You may set screen display options 
and fill colors with the Paper Setup dialog. The following options are available in the Paper 
Setup dialog:

• Size - Choose the size of the paper from the following six selections: 

• Letter (8.5 x 11 inches).
• Double (11 x 17 inches).
• A4 (21x 29.7 cm).
• A3 (29.7 x 42 cm).
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• Custom 1 (8.5 x 14 inches).
• Custom 2 (8 x 10 inches).

Under Windows, paper size Custom 2 is overwritten with the size selected in 
Print Setup if that size does not exist in Tecplot.

You can customize all six paper sizes in the configuration file, as well as their 
hard-clip limits. The hard-clip limits are the lines on the edges of the paper that 
show where your printer cannot print. You can set the hard-clip limits to larger 
values for use as guides in placing your plots on the paper.

• Orientation - Choose the paper orientation. You have two options: Portrait 
and Landscape. In Portrait orientation, the long axis of the paper is aligned with 
the vertical axis of the plot. In Landscape orientation, the long axis of the paper 
is aligned with the horizontal axis of the plot.

• Paper Fill Color - Select a color to use for the paper background. This color is 
used to display the paper in the workspace. You can select the check box Use 
Paper Fill Color when Printing to have Tecplot print this background color on 
the hard-copy as well.

23- 2.2 UNIX Printing
Setting up to print under UNIX includes the following tasks:

• Spool Command - This may include specifying a device-dependent startup 
string to condition the output device for the Tecplot output, or a mopup string to 
reset the output device upon completion of plotting.

Printers on most UNIX systems are accessed via print spoolers that manage the 
print queue. Typically you use either the lp or lpr commands to send files to 
the print spooler. There may be command-line options that need to be set on 
your system, as well, such as a flag to specify a particular printer.

In the Spooler Cmd text field, enter the appropriate spool command for your sys-
tem, using the @ symbol to represent a file name.
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For example, suppose you routinely use the following spool command to print a 
file named myfile.ps: “lpr -m -r myfile.ps.” The appropriate 
spooler command to enter in the Spooler Cmd field is then “lpr -m -r @.” 

• Startup and Mopup Strings - A startup string is an initialization string that 
sets up your output device to accept the plot created by Tecplot. A mopup string 
is a reset signal that tells your output device that the special output has ended. 
For most devices no startup or mopup strings are needed.

Enter the appropriate startup string or mopup string in the appropriate text field. 
Special characters are generated by using Macro Codes (such as “%E” for the 
escape character and “^nnn” for any ASCII character with a decimal ordinal 
value of nnn). Check your printer documentation for the appropriate strings.

• Printing Precision - For PostScript output, you can control the numerical pre-
cision used in your print files. Print files contain numbers that define sizes and 
positions of pieces of the plot on the output paper. These numbers are defined 
as integers between zero and about 8,000. Usually, this provides sufficient reso-
lution for most output devices. Occasionally, you may need more resolution. 
For example, printing to a high-resolution output device like a Linotronic type-
setter may require more precision; making print output with very small cells or 
elements may also require more precision.

To increase the precision of the output, increase the value in the Extra Precision
field of the Print Setup dialog. You specify one Extra Precision value for all 
formats that supports precision control. The precision is defined as the number 
of digits to the right of the decimal. Normally, precision is zero. The disadvan-
tage of setting precision high is that the print files increase in size. The higher 
the Extra Precision setting, the larger your print files, but the more accurate the 
plot.The maximum setting for the precision is eight.

When printing to a spooler, Tecplot creates temporary 
files with names of the form tp??????, where the 
?s are randomly generated characters. Tecplot does 
not delete these temporary files automatically; com-

mands to do so should be included in your spool command. In our 
example, the -r flag says to remove the file when done.
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PostScript (color or monochrome)
PostScript supports all Tecplot fonts (including Greek and Math), color flooding (or gray-scale 
flooding), hidden surface (or line) removal, and overlaid frames (plots).

The following options are available:

• Color - Select this check box to prepare output using Color PostScript; other-
wise, use monochrome output.

• Spooler Cmd - Enter the command to spool print output in this text field. Use 
the @ sign to specify wildcard file names. For example, if you print files using 
the command lpr filename, where filename is the name of the file to be printed, 
you should enter lpr @ in the Spooler Command text field.

• Startup String - Enter any necessary startup string in this text field. For exam-
ple, if your device requires PostScript Level 2, you may need the following set-
pagedevice command:

%!PS-Adobe-3.0^010<</PageSize [792 1224]>> setpagede-
vice^010

• Mopup String - Enter any necessary mopup string in this text field. A mopup 
string is any string required by your printer to understand that the Tecplot print 
job is complete and the printer should now be ready to accept additional jobs.

• Extra Precision - Enter the number of decimal places (0 to 8, inclusive) to 
which plotting calculations are stored. The default is 0, which should be ade-
quate for most situations.
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23 - 3 Print Render Options
Select Print Render Options the Print dialog to set 
the rendering options for your output (shown in 
Figure 23-3.)

Figure 23-3. The Print Render Options 
dialog (Windows).

The Print Render Options dialog offers you the 
following choices:

• Color - Select this check box for color 
output; deselect the check box for mono-
chrome output.

• Render Type:

• Vector - Select this option to create print 
output using the drawing commands of the 
printer. The printer renders the plot, yield-

ing higher resolution, but some plot options, such as translucency, are 
not available.

• Image - Select this option to create print output using an image. Ren-
dering is done by Tecplot at the specified resolution, usually less than 
the printer’s resolution. However, all plot options are available.

• Force Extra Sorting for all 3D Frames - This option is available when the 
Vector option has been selected. Selecting this check box will cause Tecplot to 
use extra sorting in all 3D frames. This overrides the setting in the Advanced 
3D dialog. If this check box is not selected, Tecplot will choose sorting algo-
rithms based on the Advanced 3D dialog options that were chosen for each 
frame. When printing 3D plots in a vector graphics format, Tecplot must sort 
the objects so that it can draw those farthest from the screen first and those 
closest to the screen last. By default, Tecplot uses a quick sorting algorithm. 
This is not always accurate and does not detect problems, such as intersecting 
objects. If Extra Sorting is selected, Tecplot uses a slower, more accurate 
approach that detects problems.

Vector graphics formats do not support trans-
lucency, contour flooding with Gouraud 
shading, or contour flooding using the con-
tinuous color distribution method (which is 

only available with OpenGL). 
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• Resolution (dpi) - Available when the Image option is selected. Enter the res-
olution in terms of dpi in the text field. Larger resolutions may result in an out-
of-memory condition, or produce very large files. Smaller resolutions may 
yield less-attractive output images.

• Minimum Memory Required - indicates the amount of memory your final 
output will require when the selected Render Type is Image.

23 - 4 Print Preview
A preview of your screen image as it will be rendered for the printer may be generated by selecting 
Print Preview from the File menu or by clicking Preview on the Print dialog, which is shown in 
Figure 23-1.

As discussed in Section 23 - 3, “Print Render Options,” the default sorting algorithm used by Tec-
plot may have problems with intersecting objects. This will typically not show up in the OpenGL-
rendered screen image. However, sorting errors may occur for vector print output and will be visi-
ble in the preview. 

The Print Preview option provides access to the Print Render Options dialog, where you may 
improve sorting by selecting Force Extra Sorting for All 3D Frames. If extra sorting does not solve 
the problem, the only option available is to export the plot using an image format, discussed in 
Chapter 24, “Exporting”By increasing the resolution for an image format you can obtain a quality 
comparable to PostScript without the sorting errors.

Limitations of Print Preview:

•  Print Preview will not display translucency. 

•  Gouraud shading for contour flooding will be reduced to Paneled shading. 

•  Continuous color flooding will be reduced to color flooding with average-cell color. 

When you print, warning messages will be displayed to advise you of unsupported plot styles.
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Chapter 24 Exporting

Use the Export dialog under the File menu to create files for export into other applications. Tecplot 
generates three types of export files—vector graphics, image and movie files. 

Tecplot exports the following vector graphics formats:

• EPS Export- Vector or image graphics in a special type of PostScript file 
designed for inclusion in other applications.

• Postscript (PS) Export- Vector or image graphics suitable for direct printing, 
but usually unsuitable for import into other applications. It is recommended 
that you use the Encapsulated PostScript (EPS) format for importing into other 
applications.

•  WMF Export- Vector graphics to import into various Windows applications.

Tecplot exports the following image formats:

• BMP Export- Image in Windows Bitmap format.

• JPEG Export- JPEG files are very small for their resolution and quite com-
mon on the internet, but they do involve some loss of image quality that may 
affect certain plot images.

• PNG Export- Also common on the internet, PNG images have a high image 
quality but larger file size than JPEG.

• Sun Raster (RAS) Export- Image in Sun Microsystems' Sun Raster format.

• TIFF Export- Image in Tagged Image File Format.

• X-Windows Format (XWD) Export- Image in “xwd” (X-Window Raster) 
format.
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Tecplot exports the following movie formats:

• AVI Export- A common Windows movie file format. AVI files may contain 
multiple images for animations.

• Flash Export- Flash is a movie file format commonly used on the Internet. 
Unlike AVI, Flash supports twenty-four-bit “true color,” which may give better 
results for 3D shaded or translucent plots.

• Raster Metafile (RM) Export - Image in NASA’s Raster Metafile format. 
Raster Metafile files may contain multiple images for animations. Used for cre-
ating movies for Framer.

On Windows and Macintosh systems, Tecplot can export directly to the clipboard instead of to a 
file. Windows systems export BMP and WMF directly to the clipboard. Macintosh systems export 
PICT files directly to the clipboard. PICT files are an image format unique to the Macintosh ver-
sion of Tecplot, and are only available when copying directly to the clipboard. See 24 - 4 “Clip-
board Exporting to Other Applications” on page 488 for more information.

Certain images formats support anti-aliasing, a feature that smooths jagged edges on text, lines and 
edges. This feature is discussed at the end of this chapter. See 24 - 5 “Antialiasing Images” on 
page 490.

Performance Tips
If exporting is taking an unusually long time, or you get an error message saying that the image 
cannot be exported, the most likely cause is that the image width you are trying to export is too 
large. Selecting a smaller image width will greatly speed up the export process.

For an image export size of Length x Width, the file size for an uncompressed true color image is 
approximately Length x Width x 3. Memory requirements to export such an image can be up to 
twice this size.

For 256 color images, the maximum file size is approximately Length x Width, but is usually less 
since all 256 color image files are compressed. However, the memory requirements for exporting 
are the same as they are for a true color uncompressed image.

Anti-aliasing can dramatically increase the memory requirements during image generation. This is 
because a larger image is rendered first and then super-sampled to render to the final image. A 
smaller super-sample allows for faster rendering time. See 24 - 5 “Antialiasing Images” on 
page 490.
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24 - 1 Vector Graphics Format
Vector export files have device-independent resolution and thus can be easily resized, but they have 
the same limitations as vector print output. Table 24-1 provides a summary of the advantages and 
disadvantages of using vector graphics file formats.

24- 1.1 EPS Export
Encapsulated PostScript file (EPS) are Postscript files with additional commands that another 
program can use to determine the size of your plot. After you import your EPS file into another 
program, you can position it and usually resize it before printing.

For some applications, if you import an EPS file and print to a non-PostScript printer, only the pre-
view image is printed. On Windows platforms, you must specify that the printer is a PS printer, or 
you will also get a print-out the preview image.

Advantages Disadvantages
Resolution Independent (can be re-sized 
over and over to any size) 

Does not support translucency

Always journal quality Lines can appear different than on screen
Small file sizes for XY and 2-D output 

 

 

 

Very large 3-D output files
Not Web friendly
Can be manipulated in 3rd party programs but 
those programs are usually more expensive
Needs a PostScript printer for PS output

Table 24-1. Advantages and Disadvantages of Vector Graphics format

If you try to send an EPS directly to a printer, it may not be 
positioned correctly on the paper. Use Tecplot’s PS export for-
mat to create files to send directly to a printer.)
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The Export dialog for EPS format has the following 
options:

• Color - Choose between color and gray-
scale EPS output.

• Vector/Image - Choose the Render Type: 
vector PS commands or a PS image in the 
file. Vector commands generally result in a 
smaller file, but a PS image is required to 
accurately represent translucency or smooth 
color gradations.

If you choose Vector Render Type, the 
following options are available:

• Extra Precision - Specify the number of 
decimal places to carry-out the size and posi-
tion parameters in the resulting vector-based 

EPS output. Larger values create more accurate plots, but result in 
larger file sizes.

• Force Extra Sorting for All 3D Frames - Toggle-on to use extra sort-
ing in all 3D frames.This overrides the setting in the Advanced 3D dia-
log. If this check box is not selected, Tecplot chooses sorting 
algorithms based on the Advanced 3D dialog options for a given 
frame.

If you choose Image Render Type, the following options are available:

• Region - Choose to export only the current frame, or the smallest rect-
angle containing all frames, or everything shown in the workspace.

• Resolution - Enter the resolution of the image in dots per inch. Larger 
values create more accurate plots, but result in larger file sizes.

• EPS Preview Type - Tecplot provides the following options for the preview 
image:

• None - No preview image information is include. This is good for 
importing into applications that do not use preview image informa-
tion.
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• TIFF - Include a monochrome or gray-scale TIFF preview image. 
(Color preview images are not available.) This is the most common 
preview image format. You may specify an image depth for the pre-
view image in the Depth drop-down. TIFF image depth options are 
described in Section 24- 2.5, “TIFF Export” (This preview image 
depth is separate from the depth of the actual image for EPS files gen-
erated with Render Type Image. The actual image depth is deter-
mined by Tecplot.) 

• EPSIV2 - Include a monochrome (one bit per pixel) Encapsulated 
PostScript Version 2 preview image. This is also a common preview 
image type in EPS files.

• FrameMaker - Include a monochrome preview image compatible 
with older versions of Adobe FrameMaker. This preview image type 
is rarely necessary.

See also: Chapter 27 - 2, “Movie File Creation Manually” and 27- 5.1 “AVI Files” on page 535.

24- 1.2 Postscript (PS) Export
The Export dialog allows you to export plots in PostScript 
(PS), although this format is usually used for printing directly 
to a printer or print spooler. It is recommended that you use 
the Encapsulated PostScript (EPS) format for importing into 
other applications. See 24- 1.1, “EPS Export,”for details.

If you want to export PostScript file (perhaps for later print-
ing), the process for creating a PostScript export file is very 
similar to printing to a file on a UNIX system (even under 
Windows). See Chapter 23, “Printing,”for details.

24- 1.3 WMF Export
WMF (Windows Metafile) is a vector graphics format and 
thus can be easily resized by the importing application. WMF 
files can be imported into many applications. As a vector for-

When using Render Type Image, these preview image width 
and height values are separate from the size of the actual 
EPS image. The actual EPS image size is determined by the 
Resolution setting.
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mat, WMF cannot accurate represent plots with translucency or smooth color gradations. Selecting 
WMF from the Export Format drop-down displays WMF options (as shown below).

The following options are available:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing all 
frames.

• Color -Toggle-on for color WMF output. Tog-
gle-off for gray-scale.

• Force Extra Sorting for All 3D Frames -
Selecting this check box causes Tecplot to use 
extra sorting in all 3D frames.This overrides the 
setting in the Advanced 3D dialog. If this check 
box is not selected, Tecplot chooses sorting 
algorithms based on the Advanced 3D dialog 
options for a given frame.

24 - 2 Image Format
Image output has the advantage of accurately representing translucency and smooth color 
gradations, but with the disadvantage of generally being larger than vector output, particularly 
when a high image resolution is specified. Image files are sometimes called raster or bit-mapped. 
Table 24-2 provides a summary of the advantages and disadvantages of image file formats.

Advantages Disadvantages
Looks like the screen image, or better Resolution dependent (starts to lose quality if 

stretched)
Adjustable export size For super-high resolution printing, images will be 

very large
Supports translucency  
Relatively small file size  
Easily managed by presentation packages  
Web friendly  

Table 24-2. Advantages and Disadvantages of Image file formats
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24- 2.1 BMP Export
BMP (Bitmap) is an image format, and thus accurately represents plots with translucency and 
smooth color gradations. The BMP export options are shown below.

When you select BMP in the Export dialog, you have 
the following options:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing 
all frames, or everything shown in the work-
space.

• Use Width of Image on Screen - Select 
this option to generate an image file the 
same size as the current plot on the screen. 
This option is required, if you use on-screen 
image rendering in the Display Performance
dialog. See Section 28 - 3, “Performance 
Dialog,”for details.

• Enter Width - Select this option to specify 
a width (in pixels) for the generated image. 

A larger width increases the quality of your image. However, the greater the 
width you specify, the longer it will take to export the image and the larger the 
exported file. This option is not available if you have chosen to use on-screen 
image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.

• Convert to 256 Colors - Select this check box generate an image with only 
256 colors (down from a possible 16 million colors). Tecplot selects the best 

Easily manipulated in inexpensive 3rd 
party programs 

 

Prints on any printer  
Table 24-2. Advantages and Disadvantages of Image file formats
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color match. The image will have a greatly reduced file size, but for plots with 
many colors, the results may be suboptimal. Using this option with transpar-
ency, smooth color gradations, or antialiasing may result in poor image quality.

24- 2.2 JPEG Export
JPEG (Joint Photographic Experts Group) is an image format, and thus accurately represent plots 
with translucency and smooth color gradations. However, JPEG is a highly compressible, “lossy” 
format, and can result in poor image quality for some types of images. The advantage of JPEG is 
very small file sizes and near universal acceptance on the internet. JPEG supports different qualities 
of compression, and Tecplot allows you to control the image quality (and thus, inversely, the file 
size).

When you select JPEG in the Export dialog, you 
have the following options:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing 
all frames, or everything shown in the work-
space.

• Use Width of Image on Screen - Select 
this option to generate an image file the 
same size as the current plot on the screen. 
This option is required, if you use on-screen 
image rendering in the Display Performance
dialog. See Section 28 - 3, “Performance 
Dialog,”for details.

• Enter Width - Select this option to specify 
a width (in pixels) for the generated image. 

A larger width increases the quality of your image. However, the greater the 
width you specify, the longer it will take to export the image and the larger the 
exported file. This option is not available if you have chosen to use on-screen 
image rendering.

• Antialiasing - Select this option to remove “jaggies” from the image. See Sec-
tion 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.
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• Encoding - Choose an encoding method for the JPEG file. 

• Standard - creates a JPEG which downloads one line at a time, start-
ing at the top line. 

• Progressive - creates a JPEG image that can be displayed with a “fade 
in” effect in a browser. This is sometimes useful when viewing the 
JPEG in a browser with a slow connection, since it allows an approxi-
mation of the JPEG to be drawn immediately, and the browser does 
not have to wait for the entire image to download. 

Given the same Quality level, Standard encoded JPEG files look better than 
equivalent Progressive encoded JPEG files. However, although they have a 
larger file size.

• Quality - Select the quality of JPEG image. Higher quality settings produce 
larger files and better looking export images. Lower quality settings produce 
smaller files. For best results, use a quality setting of 75 or higher.

24- 2.3 PNG Export
PNG (Portable Network Graphics) is an image format, and thus accurately represent plots with 
translucency and smooth color gradations.

When you select PNG in the Export dialog, you have 
the following options:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing 
all frames, or everything shown in the work-
space.

• Use Width of Image on Screen - Select 
this option to generate an image file the 
same size as the current plot on the screen. 
This option is required, if you use on-screen 
image rendering in the Display Performance
dialog. See Section 28 - 3, “Performance 
Dialog,”for details.

• Enter Width - Select this option to specify 
a width (in pixels) for the generated image. 

A larger width increases the quality of your image. However, the greater the 
width you specify, the longer it will take to export the image and the larger the 
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exported file. This option is not available if you have chosen to use on-screen 
image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.

• Convert to 256 Colors - Select this check box generate an image with only 
256 colors (down from a possible 16 million colors). Tecplot selects the best 
color match. The image will have a greatly reduced file size, but for plots with 
many colors, the results may be suboptimal. Using this option with transpar-
ency, smooth color gradations, or antialiasing may result in poor image quality.

24- 2.4 Sun Raster (RAS) Export
Sun Raster is an image format, and thus accurately represent plots with translucency and smooth 
color gradations. Sun Raster files can be created in either of two formats—the standard format, 
which is not compressed, and a byte-encoded format, which is compressed. 

When you select Sun Raster in the Export dialog, you 
have the following options:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing 
all frames, or everything shown in the work-
space.

• Use Width of Image on Screen - Select 
this option to generate an image file the same 
size as the current plot on the screen. This 
option is required, if you use on-screen 
image rendering in the Display Performance
dialog. See Section 28 - 3, “Performance 
Dialog,”for details.

• Enter Width - Select this option to specify 
a width (in pixels) for the generated image. A 

larger width increases the quality of your image. However, the greater the width 
you specify, the longer it will take to export the image and the larger the 
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exported file. This option is not available if you have chosen to use on-screen 
image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.

• Encoding - You may select Standard, which will create an uncompressed file, 
or Byte-Encoded, which will create a compressed file. You should select Byte-
Encoded unless you have a compelling reason to do otherwise.

24- 2.5 TIFF Export
TIFF (Tagged Image File Format) is an image format, and thus accurately represent plots with 
translucency and smooth color gradations. Tecplot generates both color and gray-scale TIFF 
images.

When you select TIFF in the Export dialog, you have the fol-
lowing options:

• Color - Choose between color and gray-scale TIFF 
output.

• Region - Choose to export only the current frame, 
or the smallest rectangle containing all frames, or 
everything shown in the workspace.

• Use Width of Image on Screen - Select this option 
to generate an image file the same size as the current 
plot on the screen. This option is required, if you use 
on-screen image rendering in the Display Perfor-
mance dialog. See Section 28 - 3, “Performance Dia-

log,”for details.

• Enter Width - Select this option to specify a width (in pixels) for the gener-
ated image. A larger width increases the quality of your image. However, the 
greater the width you specify, the longer it will take to export the image and the 
larger the exported file. This option is not available if you have chosen to use 
on-screen image rendering.
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• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5 “Antialiasing Images” for details.

• Convert to 256 Colors - Select this check box generate an image with only 
256 colors (down from a possible 16 million colors). Tecplot selects the best 
color match. The image will have a greatly reduced file size, but for plots with 
many colors, the results may be suboptimal. Using this option with transpar-
ency, smooth color gradations, or antialiasing may result in poor image quality.

• Depth - For gray-scale images, this specifies the number of shades of gray by 
how many bits of gray-scale information is used per pixel. The larger the num-
ber of bits per pixel, the larger the resulting file. Your options are:

• On/Off - One bit per pixel using an on/off strategy. All background 
pixels are made white (on), and all foreground pixels, black (off). This 
setting creates small files and is good for images with lots of back-
ground, such as line plots and contour lines.

• 1 Bit/Pixel - One bit per pixel using gray scale values of pixels to 
determine black or white. Those pixels that are more than 50 percent 
gray are black; the rest are white. This setting creates small files that 
might be useful for a rough draft or a preview image.

• 4 Bit/Pixel - Four bits per pixel resulting in sixteen levels of gray 
scale. This setting generates fairly small image files with a fair num-
ber of gray levels. This setting works well for most preview image 
purposes.

• 8 Bit/Pixel - Eight bits per pixel resulting in 256 levels of gray. This 
setting is useful for full image representation, but the files generated 
by this setting can be large.

24- 2.6 X-Windows Format (XWD) Export
XWD (X-Windows format) is an image format, and thus accurately represent plots with 
translucency and smooth color gradations. XWD can be generated on Windows, Macintosh, and 
UNIX versions of Tecplot.

When you select XWD in the Export dialog, you have the same options as BMP or PNG. See Sec-
tion 24- 2.1, “BMP Export,”or Section 24- 2.3, “PNG Export,”for details.
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24 - 3 Movie Format
Movie files can be created in Tecplot using any of the options in the Animate menu or by selecting 
AVI, Flash or Raster Metafile from the Export dialog (accessed via the File menu).

24- 3.1  AVI Export
The AVI (Audio-Visual Interleaved) format is used for viewing movies created in Tecplot. AVI is 
an image format, but Tecplot uses only 256-color images with AVI files. Thus, AVI can accurately 
represents some plots with translucency and smooth color gradations. The AVI export options are 
shown in 

When you select AVI in the Export dialog, you have the 
following options:

• Region - Choose to export only the current 
frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen - Select this 
option to generate an image file the same size as 
the current plot on the screen. This option is 
required, if you use on-screen image rendering 
in the Display Performance dialog. See Section 
28 - 3, “Performance Dialog,”for details.

• Enter Width - Select this option to specify a 
width (in pixels) for the generated image. A 
larger width increases the quality of your image. 

However, the greater the width you specify, the longer it will take to export the 
image and the larger the exported file. This option is not available if you have 
chosen to use on-screen image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.

• Use Multiple Color Tables - Toggle-on to create an AVI file with a separate 
color table each step in the animation. If this check box is not selected, Tecplot 
scans all steps in the animation and creates one color table for the entire anima-
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tion. Multiple color tables can provide better image quality for the animation, 
but many applications display only the first color table provided.

• Animation Speed - Set the speed of the animation in frames per second.

See also: Chapter 27 - 2, “Movie File Creation Manually” and 27- 5.1 “AVI Files” on page 535.

24- 3.2 Flash Export
Flash is a movie file format commonly used on the Internet. Unlike AVI, Flash supports twenty-
four-bit “true color,” which may give better results for 3D shaded or translucent plots.

The following options are available:

• Region - Select the region of the workspace to ani-
mate.   

• Current Frame - captures only the current frame
• All Frames - captures the smallest rectangular area 
containing all frames
• Work Area - captures the workspace.

• Use Width of Image on Screen - Select this 
option to generate an image file the same size as the 
current plot on the screen. This option is required, if 
you use on-screen image rendering in the Display 
Performance dialog. See Section 28 - 3, “Perfor-

mance Dialog,”for details.

• Enter Width - Select this option to specify a width (in pixels) for the gener-
ated image. A larger width increases the quality of your image. However, the 
greater the width you specify, the longer it will take to export the image and the 
larger the exported file. This option is not available if you have chosen to use 
on-screen image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image.

• Supersample Factor - Control the amount of antialiasing used in the image.

• Image Type - Choose an image type. Your options are:
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• True Color - Select this option to create twenty-four-bit images with 
lossless (ZLIB) compression.

• JPEG - Select this option to create twenty-four-bit images with lossy 
compression. This produces smaller files than True Color, and the 
images will be of lower quality.

• 256 Colors - Select this option to reduce each image to 256 colors and 
compress it with ZLIB. This gives essentially the same output as AVI.

• Animation Speed (frames/sec) - Enter a value in the text field to set your 
speed in frames per second.

• Optimize for Speed - For True Color or 256 Colors image types, select this 
option to create the output as quickly as possible. This reduces the compression 
level and results in larger files. It does not affect playback speed.

• Optimize for File Size - For True Color or 256 Colors image types, select this 
option to produce the smallest possible files. This setting does not affect play-
back speed. 

See also: Chapter 27 - 2, “Movie File Creation Manually” and 27- 5.1 “AVI Files” on page 535.

24- 3.3 Raster Metafile (RM) Export
Raster Metafile is an image format that can accurately represent some plots with translucency and 
smooth color gradations. However, Raster Metafiles are only 256-color images (Tecplot selects the 
best color match). For plots with many colors, the results may be poor when compared to true-color 
image formats (such as PNG). Using Raster Metafiles with transparency or smooth color gradations 
may result in poor image quality.
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When you select Raster Metafile in the Export dialog, you 
have the following options:

• Region - Choose to export only the current frame, 
or the smallest rectangle containing all frames, or 
everything shown in the workspace.

• Use Width of Image on Screen - Select this option 
to generate an image file the same size as the current 
plot on the screen. This option is required, if you use 
on-screen image rendering in the Display Perfor-
mance dialog. See Section 28 - 3, “Performance Dia-
log,”for details.

• Enter Width - Select this option to specify a width 
(in pixels) for the generated image. A larger width increases the quality of your 
image. However, the greater the width you specify, the longer it will take to 
export the image and the larger the exported file. This option is not available if 
you have chosen to use on-screen image rendering.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details.

• Use Multiple Color Tables - Select this check box to create a Raster Metafile 
with a separate color table each step in the animation. If this check box is not 
selected, Tecplot scans all steps in the animation and creates one color table for 
the entire animation. Multiple color tables can provide better per-step image 
quality for the animation, but may result in flicker during playback.

See also: Chapter 27 - 2, “Movie File Creation Manually” and 27- 5.1 “AVI Files” on page 535.

24 - 4 Clipboard Exporting to Other Applications
The Cut, Copy, and Paste commands work only within Tecplot. However, the Copy Plot to Clip-
board command (Windows and Macintosh only) allows you to copy and paste Tecplot images 
directly into other applications. The Copy Plot to Clipboard dialog for Windows is shown in Figure 
24-4.
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The following options are available:

Figure 24-4. The Copy Plot to Clipboard dialog 
(Windows and Macintosh only).

• Region - Choose to export only the 
current frame, or the smallest rectangle 
containing all frames, or everything 
shown in the workspace.

• Format - On Windows, plots may be 
copied as a vector (WMF) or image 
(BMP) format. See Section 24- 2.1, 
“BMP Export,”and Section 24- 1.3, 
“WMF Export,”for a discussion of 
these formats. On the Macintosh, the 
plot is copied as a PICT image, and this 
is the only way to generate a PICT 
image from within Tecplot.

• Force Extra Sorting for All 3D 
Frames - Selecting this check box causes Tecplot to use extra sorting in all 3D 
frames.This overrides the setting in the Advanced 3D dialog. If this check box is 
not selected, Tecplot chooses sorting algorithms based on the Advanced 3D dia-
log options for a given frame. This option is only available for WMF, and thus 
only on Windows.

• Color - Choose between color and gray-scale output.

• Convert to 256 Colors - On Windows, select this check box generate an 
image with only 256 colors (down from a possible 16 million colors). Tecplot 
selects the best color match. The image will take up less memory on your Win-
dows clipboard, but for plots with many colors, the results may be suboptimal. 
Using this option with transparency, smooth color gradations, or antialiasing 
may result in poor image quality. On the Macintosh, the image is always gener-
ated with only 256 colors because that is all the PICT format supports.

• Use Width of Image on Screen - Select this option to generate an image file 
the same size as the current plot on the screen. This option is forced on if you 
use on-screen image rendering in the Display Performance dialog. See Section 
28 - 3, “Performance Dialog,”for details. This option is only available for BMP 
and PICT.



Chapter 24:Exporting

490

• Enter Width - Select this option to specify a width (in pixels) for the gener-
ated image. The greater the width you specify, the longer it will take to export 
the image and the larger the exported file. However, a larger width increases the 
quality of your image. This option is not available if you have chosen to use on-
screen image rendering. This option is only available for BMP and PICT.

• Antialiasing - Select this option to smooths jagged edges in the image. See 
Section 24 - 5, “Antialiasing Images,”for details. This option is only available 
for BMP and PICT.

• Supersample Factor - Control the amount of antialiasing used in the image. 
See Section 24 - 5, “Antialiasing Images,”for details. This option is only avail-
able for BMP and PICT.

24 - 5 Antialiasing Images
Antialiasing smooths jagged edges on text, lines, and edges of image output formats by the process 
of supersampling. A large intermediate image is rendered and then reduced to the final image size. 
Each pixel on the final image is created from multiple rendered pixels. The width and height of the 
intermediate image are the width and height of the final image times some scale factor. This scale 
factor is the Supersample Factor. You can use values from 2 to 16. Factors greater than 3 are seldom 
necessary. Large scale factors take a lot more time and memory. Some graphics cards limit the 
dimensions of rendered images to a maximum of 2048x2048 or 4096x4096 pixels, and thus Tecplot 
cannot antialias if the intermediate image would be larger than this limit.

Antialiasing uses many colors. Certain image formats are limited to 256 colors, and cannot 
represent all antialiased images correctly. The image formats limited to 256 color include X-
Windows, AVI, Raster Metafile, SunRaster, and any image format with the Convert to 256 
Colors option selected. With these formats, the antialiasing works fine for plots with a very 
limited selection of colors (like a red mesh on a black field). Otherwise, antialiasing with 256 
colors is a waste of time and may result in a worse plot.

The antialiasing and 256-color problem can be amplified by animation formats. Both AVI and Ras-
ter Metafile support only 256-colors, and need to use them to display multiple frames. For these 
formats, try a test animation of a few steps with antialiasing on before creating the entire animation.

Antialiasing is available only if image export rendering is per-
formed off-screen (default). In some cases, off-screen rendering 
must be turned-off (usually due problems with the graphics 

card). In UNIX you can work around this by turning-off screen render-
ing and using the -mesa flag to run the mesa version of Tecplot.
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Chapter 25 Macro Commands

This chapter focuses on the Tecplot menu options for recording and playing back macros. The 
Tecplot Reference Manual describes the Tecplot macro language in detail.

Macros are very useful for performing repetitive operations such as setting up frames, reading in 
data files and layout files, manipulating data, and creating plots. They are also necessary for run-
ning Tecplot in batch mode. See Chapter 26, “Batch Processing”

The Macro sub-menu, found under the File menu, provides the following control options:

•  Play - Use this to select a macro file to load and play.

•  View - Use this to step through or debug the macro file using the Macro Viewer dia-
log.

•  Record - Use this to record a macro using the Macro Recorder dialog.

25 - 1 Macro Creation
Tecplot’s Macro Recorder records a macro as you perform a sequence of actions interactively. After 
recording your macro, you can edit it with an ASCII text editor to remove redundant operations, 
compress repetitive actions into loops, and otherwise modify the macro. 

To record a macro with the Macro Recorder select Macro>Record from the File menu. Specify a 
macro file name in the Write Macro File dialog and click OK to initiate the recording. The Macro 
Recorder dialog will remain open during the recording session.
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While recording macros, you can use any of the following buttons on the
Macro Recorder dialog to add specific macro commands to your macro:

• Insert “Pause” - Adds a “pause” command to the macro. 
When you play a macro including a pause command, Tecplot 
displays a message box when it reaches the pause command, 
and waits for you to click OK before continuing to process the 
macro.

• Insert “Graphics Off” - Adds a “graphics off” command to 
the macro. When you play a macro containing a “graphics off” 

command, Tecplot stops displaying graphics in the workspace from the “graph-
ics off” command until a “graphics on” command is encountered.

• Insert “Graphics On” - Adds a “graphics on” command to the macro.

• Insert Raw Command - Brings up a dialog in which you can enter any valid 
Tecplot macro command. For example, you can add “$!LOOP 10” at the start 
of a section you want to repeat 10 times, then “$!ENDLOOP” at the end. See 
the Tecplot Reference Manual for information on the Tecplot macro language.

• Stop Recording - Select when you have completed the sequence of actions 
you want recorded.

The commands in a macro file typically rely on Tecplot being in a particular state. It is a good prac-
tice to use commands at the start of a macro that force Tecplot into a known state. For example, the 
$!NEWLAYOUT command deletes all data sets and frames and creates a single empty frame with a 
default size and position. 

25- 1.1 Macro Functions
When editing your macros, you can add macro function definitions and macro function calls. 
Macro functions have the following form:

$!MACROFUNCTION 
 NAME = functionname 
. 

Macros are guaranteed to be forward compatible (i.e. 
work with future releases), only if the file is started 
with a layout or stylesheet.   Refer to the Tecplot Refer-

ence Manual for more information.
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. 

. 
$!ENDMACROFUNCTION

Between $!MACROFUNCTION and $!ENDMACROFUNCTION, you can include any legal macro 
command except $!MACROFUNCTION.

For example, the following macro function turns on the Contour zone 
layer, turns off the Mesh zone layer, sets the contour plot type to Both 
Lines and Flood for zones 1, 2 and 3, then chooses gray scale color 
mapping:

The RETAIN parameter tells Tecplot to retain the macro function defini-
tion for use in subsequent macro calls; this allows you to define a macro 
function once in some macro you load every time you run Tecplot, and 
continue to use it throughout your Tecplot session.

Use the $!RUNMACROFUNCTION macro command to call your macro function. For example, to 
call the “graycontour” macro function defined above, use the following macro command:

 $!RUNMACROFUNCTION "graycontour"

You can use the $!RUNMACROFUNCTION command within other macro functions; calls may be nested 
up to ten deep.

$!MACROFUNCTION 
NAME = "graycontour" 
RETAIN = Yes 
$!FIELDLAYERS SHOWCONTOUR = YES 
$!FIELDLAYERS SHOWMESH = NO
$!FIELDMAP [1-3] CONTOUR{CONTOURTYPE = 
BOTHLINESANDFLOOD} 
$!COLORMAP 1 CONTOURCOLORMAP = GRAYSCALE 
$!REDRAW  
$!ENDMACROFUNCTION
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To access parameters from within a macro function use “|n|”, where n is the parameter number (do 
not include the double quotes). For example, the following function uses two parameters for the 
assignments to SHOWCONTOUR and SHOWMESH:

25- 1.2 Macro Linking to Text and Geometries
Each text or geometry you create can be linked to a macro function. This macro function is called 
whenever the user holds down the control key and clicks the right mouse button on the text or 
geometry.

For example, if you have pieces of text, each representing a different well, CTRL+right click 
on any piece could run a macro that brings up an XY-plot of that well’s data.

Macro functions are specified with the “Link to Macro function” field in the Geometry dialog or in 
the Text Options dialog.

25 - 2 Macro Play Back
Once you have created a macro file, you have four methods in Tecplot for playing it back:

• From the command line - You can play a macro when Tecplot is launched by 
including the name of the macro file on the command line, i.e.: 

tecplot mymacro.mcr

If your macro file does not have the .mcr extension, run Tecplot with the macro 
file by including the -p flag on the command line, such as:

tecplot -p mymacro.mmm

If you want the macro viewer to automatically appear, include the -z flag.

$!MACROFUNCTION
NAME = "AssignContourAndMesh"
$!FIELDLAYERS SHOWCONTOUR = |1|
$!FIELDLAYERS SHOWMESH = |2|
$!ENDMACROFUNCTION
.
.
.
$!RUNMACROFUNCTION 
"AssignContourAndMesh" (YES,NO)
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• From the Tecplot interface - You can play a macro from within Tecplot by 
using the Play option (accessed via Macro submenu of the File menu).

• Using the Macro Viewer - Use the Macro Viewer (accessed via 
File>Macro>View) to step through and debug your macro file. This dialog 
allows you to add and delete breakpoints, view and set watch variables, and 
view state variables local to the macro currently loaded into the Macro Viewer. 
See 25 - 3 “Macro Debugging” on page 504 for more information.

• Using Quick Macro Panel - The Quick Macro Panel allows you to quickly play 
a macro function by clicking on the button in the panel that is linked to that 
macro function. See 25- 2.1 “Quick Macro Panel” on page 503for more infor-
mation.

In Windows, you can also launch Tecplot using 
macro file by dragging and dropping a macro file 
onto the Tecplot icon. However, in this case, the 
macro file must have the.mcr extension. Other-
wise, the file will be treated as an ASCII data file.
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25- 2.1 Quick Macro Panel
The Quick Macro Panel is Tecplot’s quick access mechanism for stor-
ing and retrieving your favorite, commonly used macro functions. 

The Quick Macro Panel is linked to a special macro file that contains 
only macro function definitions. When Tecplot first launches, it looks 
for this file under one of the following names, in the following order:

1.The file tecplot.mcr in the current directory.

2.The file .tecplot.mcr in your home directory 
(UNIX), or tecplot.mcr in the your home directory 
(Windows). Under Windows, your home directory is deter-
mined by the two environment variables HOMEDRIVE and 
HOMEPATH. If they are not set, Tecplot skips your home 
directory.

3.The file tecplot.mcr in the Tecplot home directory.

If Tecplot finds the file, it loads it and associates each button on the 
Quick Macro Panel with a specific macro function.

You can specify a different Quick Macro file by adding the -qm
option flag in front of the macro file name to the command line.

The following command starts Tecplot and installs the macro func-
tions defined in the file myteccmd.mcr into the Quick Macro Panel:

tecplot -qm myteccmd.mcr

If you want Tecplot to call up the Quick Macro Panel immediately after start up, include the    -
showpanel flag at the end of the command.

To see an example of a macro function file, look at the Quick Macro file qmp.mcr located in the 
examples/mcr sub-directory below the Tecplot home directory.

25 - 3 Macro Debugging
Use the Macro Viewer to step through and debug your macro file. This dialog allows you to add 
and delete breakpoints, view and set watch variables, and view state variables local to the macro 
currently loaded into the Macro Viewer. The Macro Viewer is accessed via Macro>View in the File
menu.
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The Macro Viewer dialog displays the text of the currently loaded macro file at the top of the dia-
log. The greater-than symbol (“>”) marks the currently active line. It moves to the next command 
after the currently active command is evaluated.

The Macro Viewer dialog has the following 
options:

• Load Macro - Select this button 
to load a macro file into the Macro 
Viewer. This calls up the Load/
Play Macro File dialog for you to 
specify which macro file to load. 
Macro files typically have the 
extension .mcr.

• Step - Use the Step button to 
evaluate a macro command. 
When a $!RUNMACROFUNC-
TION command is encountered, 
the Macro Viewer steps into the 
called function.

• Step Over - The Step Over but-
ton also processes each macro 
command, line-by-line. However, 
when a $!RUNMACROFUNC-
TION command is encountered, 
the entire function is processed.

• Go - plays the macro without stopping after each step.Tecplot continues until it 
either receives a stop signal from the Stop button, it finishes playing the macro, 
or it encounters a breakpoint.

• Reset - Restarts the evaluation of a macro within the Macro Viewer.

Note: If your macro assumes Tecplot is in a 
particular state when it starts processing then 
you must make sure Tecplot is in this state 

before you click Reset.
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• Macro - The Macro field displays the name of the macro or macro function 
you are currently evaluating. In most cases, this field displays the name MAIN, 
(indicating that the macro commands currently shown in the macro text display 
are from within the main macro body. 

If the macro you are viewing contains a call to a macro function, then the name 
displayed in the Macro field when the called function is active.

If you switch context to the called macro function using the up and downs 
arrows, the $!RUNMACROFUNCTION command that called the macro is dis-
played with a ^ (caret) in front of it. This helps you quickly determine which 
command line called the macro function currently under evaluation. The down 
arrow then moves you back down a level to the called macro you were just 
viewing.

• Macro Command Display Format Changes - Tecplot displays the macro in 
the viewer in one of two formats: 

• List Commands [default] - a short format that lists the macro com-
mands, one command per line, 

• Expand Commands - a long format which expands a single, simple 
macro command to show all of its sub-commands and parameters. 

• Breakpoint Addition and Deletion - An important debugging feature that the 
Macro Viewer provides is the ability to add breakpoints within a macro’s com-
mand stream. A breakpoint is a flag you can insert anywhere in a macro that 
tells Tecplot to immediately suspend evaluation. Tecplot stops the action of a 
playing macro at the breakpoint to allow you to explore what is happening at 
that point in the macro file. 

• Add Break - Add a breakpoint at the selected macro command. A B
displayed at the beginning of the highlighted macro command indi-
cates the breakpoint’s placement.

• Delete Break - Remove the breakpoint from the selected command.
• Delete All Breaks - Removes all breakpoints set in the macro.

• Watch Variables - The Watch Variables dialog provides is the ability to spec-
ify and view specific user defined, or system defined internal variables
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Watch Variables
To specify a watch variable in a macro, select Watch Variables in the Macro Viewer dialog. In the 
Macro Variables dialog, type the name of the variable you want to watch in one of the User-Defined
or Internal Variable text fields.

While your macro is playing, an alert dialog is displayed when-
ever the tagged variable is accessed by the macro.

The Macro Variables dialog also automatically displays the val-
ues of any loops and the parameter values of any macro function 
calls to the stack as the macro is playing. 

•Loops - When the macro viewer evaluates a loop macro 
command it automatically displays the current iteration 
value in the Value text fields. The total iterations value of 
that loop are displayed in the End Value text fields.

•Call Stack - When the macro viewer evaluates a nested 
macro command, the parameter values that the nest macro is 
called with are displayed in the Call Stack parameter text 
fields.

25 - 4  Macros Moved to Different Computers or Directories
The file tecplot.phy is created each time you run Tecplot interactively. It contains information 
about the physical characteristics of your computer system as well as information about the size of 
the Tecplot process window used during the last Tecplot session. It also contains the name of the 
last layout file used by Tecplot. If you are developing macros on one computer, but using them for 
batch processing on a different computer, you must transfer the  

All the text fields in this dialog are edit-
able, including the value text fields. This 
means you can change the value of a watch 
variable or parameter value as the macro is 
running to correct a problem or test a situa-

tion.
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tecplot.phy file from the development computer to the computer where you will run Tecplot in 
batch mode. Under UNIX, the same is true if you are developing macros in one directory, but will 
be processing them in batch mode in a different directory. See Section 28 - 5, “Tecplot.phy File 
Location Configuration,”for information on the location of your tecplot.phy file.
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Chapter 26 Batch Processing 

You can run Tecplot in batch mode to create plots without displaying any graphics to the screen. 
This saves time when processing multiple files for printing or export. In batch mode, Tecplot can be 
executed locally on your workstation computer or remotely using an ASCII terminal (UNIX only). 
The only limitation for batch mode operation is that under UNIX, you must use the Mesa version of 
Tecplot if your macro creates export files in bitmap formats. (The OpenGL version requires screen 
resources not available in batch mode.)

26 - 1 Batch Processing Setup
To prepare for batch processing, follow these basic steps:

1. Create a macro file to control the batch processing. You may do this either by 
using File>Macro>Record and recording a Tecplot session, or using an ASCII 
text editor. See Chapter 25, “Macro Commands”

2. Create layout and stylesheet files, as necessary.

3. Prepare data files.

4. Debug the macro file by running Tecplot while not in batch mode.

Macros are required for batch processing. When Tecplot is launched in batch mode it requires that 
you provide the name of a macro file to execute. The minimal command to launch Tecplot in batch 
mode is as follows:

tecplot -b -p macrofile

Macros are guaranteed to be forward compatible (i.e. 
work with future releases), only if the file is started 
with a layout or stylesheet.   Refer to the Tecplot Refer-

ence Manual for more information.
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The -b flag instructs Tecplot to run in batch mode and the -p macrofile tells Tecplot the name of 
the macro file to execute. Refer to the Quick Reference Guide for more command line options.

26 - 2 Batch Processing Using a Layout File
Combining layout files with batch processing is both powerful and flexible. It is also the recom-
mended method. With layout files you can organize a plot using one or more frames in a single 
file. The layout file manages data sets and can be altered on the fly, either on the command line or 
within a macro that loads the layout file.

For example, to do the following sequence of tasks in batch mode:

•  Load a data file from a user supplied file name.

•  Create a specific style of plot.

•  Create a PostScript file of the plot.

You can set up the batch script as follows:

1. Obtain a representative data file to be plotted.

2. Create a layout of the style of plot you want. (For this example, name the file 
batch.lay).

3. Use a text editor to create the following macro (For this example call this 
macro batch.mcr):

4. Use the following command to run the job in batch mode:

#!MC 1100 
$!EXPORTSETUP ExportFormat = PS 
$!PRINTSETUP PALETTE = MONOCHROME
$!EXPORTSETUP PRINTRENDERTYPE = VECTOR
$!EXPORTSETUP EXPORTFNAME = "myfile.ps" 
$!EXPORT
EXPORTREGION = CURRENTFRAME 
$!Quit
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tecplot -b -p batch.mcr -y psoutput.ps batch.lay mydatafile.

26 - 3 Multiple Data File Processing
In Section 26 - 2, “Batch Processing Using a Layout File,”we set up Tecplot to process a user-
supplied data file (or data files) and create a single output file. If the above procedure is to be 
repeated for a large number of input files (one at a time), you can do this by using a loop: either 
outside Tecplot in the operating system or within Tecplot using the flow-of-control commands in 
the Tecplot macro language.

26- 3.1 Looping Outside Tecplot
The following examples show the command files for launching Tecplot in an operating system loop 
on two different operating systems. Tecplot processes five data files named dnn.plt and creates 
ten output files named dnn.out where nn goes from 1 to 10.

Looping Outside Tecplot (UNIX).  Create a shell script with the following commands:

tecplot -b launches Tecplot in batch mode
-p tells Tecplot to use the following 

macro file
batch.mcr macro file
-y tells Tecplot to use the following 

export file
psoutpt.ps export file
batch.lay layout file to use
mydatafile data file to use

#!/bin/sh 
n=1 
while test $n -le 10 
do 
    tecplot -b -p batch.mcr -y d$n.out batch.lay 
d$n.plt 
    n=`expr $n+1  ̀
done
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Looping Outside Tecplot (Windows).  Create a batch file with the following commands:

26- 3.2 Looping Inside Tecplot
In Section 26- 3.1, “Looping Outside Tecplot,”we set up Tecplot to process multiple data files using 
the operating system language to do the looping. There are two drawbacks to this procedure:

•  The operating system languages are not portable between different operating 
systems.

•  Tecplot must be continuously started and stopped each time a new data set is 
processed.

A more efficient approach is to loop through the data files inside Tecplot. Here, the layout file and 
the data files are all named within the Tecplot macro. The command line in this example is simple, 
as follows:

 tecplot -b -p batch.mcr

The Tecplot macro is set up as follows:

The $!OPENLAYOUT command loads in batch.lay but replaces the data file referenced in the 
layout with the file names in the ALTDATALOADINSTRUCTIONS sub-command. The 
$!EXPORTSETUP command is used in two places. Initially it is used to set the export format. 

for %%f in (d1 d2 d3 d4 d5 d6 d7 d8 d9 d10) 
do tecplot -b -p batch.mcr -y %%f.out batch.lay %%f.plt

#!MC 1100 
$!EXPORTSETUP EXPORTFORMAT = PS
$!PRINTSETUP PALETTE = MONOCHROME 
$!LOOP 10 
$!OPENLAYOUT "batch.lay" 
 ALTDATALOADINSTRUCTIONS = "d|LOOP|.plt" 
$!EXPORTSETUP PRINTRENDERTYPE = VECTOR 
$!EXPORTSETUP EXPORTFNAME = "d|LOOP|.out"
$!EXPORT
EXPORTREGION = CURRENTFRAME 
$!ENDLOOP 
$!QUIT
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Later it is used just to change the name of the file to export to. The $!EXPORT command does the 
actual exporting.

26 - 4 Batch Processing Diagnostics
Each time Tecplot is run in batch mode it creates a file defined by the name in the 
BATCHLOGFILE environment variable, or, if the environment variable is not defined, by a file 
named batch.log in the directory where Tecplot was started. If the name given in the 
BATCHLOGFILE environment variable is a relative path, the directory name where Tecplot was 
started is prefixed. A running commentary on actions performed in Tecplot, as well as warning and 
error messages, are sent to the batch.log file.

If you want to make many different plots 
using the same data set, stylesheets will be 
more efficient than layout files.



Chapter 26:Batch Processing

514



515

Chapter 27 Animation

Tecplot provides a variety of methods for creating animated plots, and exporting them to movie 
files for playback at a later time. There are three basic animation methods available:

• Animation Tools- Perform simple animations using the dialogs in the Animate
menu. The Animate menu allows you to animate zones, mappings, iso-surfaces, 
IJK-planes, IJK-blanking, slices time or streamtraces. The animation is viewed 
within Tecplot, or exported to a movie file.

• Movie File Creation Manually- Interactively create movies by creating an 
initial plot, exporting the image as either a AVI, Flash or Raster Metafile movie, 
then repeatedly changing and appending new images to the same movie file.

• Movie Creation with Macros- Use a macro to perform multiple, repetitive 
changes, and write each image to a movie file.

27 - 1 Animation Tools
Use the Animate menu to have Tecplot cycle through your data, automatically displaying zones, 
IJK-planes, or any of several other plot elements, one after the other, until your entire data set has 
been displayed. The following plot elements may be animated using the dialogs in the Animate
menu:

•  Time Animation

•  IJK-Plane Animation.

•  IJK-Blanking Animation

•  Iso-Surfaces Animation

•  Mapping Animation

•  Slice Animation
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•  Streamtrace Animation

•  Zone Animation

27- 1.1 Time Animation

To animate over time, simply press the button in the Sidebar. The active frame will be ani-
mated from the Current Solution Time (displayed in the Sidebar) to the last time step.

Alternatively, you may select Time from the Animate
menu. The Animate page of the Time Details dialog has 
the following options:

• Start Time - Enter the value of the first solu-
tion time to include in the animation. If the 
SolutionTime entered does not exist, the near-
est SolutionTime less than the entered time is 
used. The default value is the first solution 
time. The value of the first solution time in the 
data set is displayed in Min.

• End Time - Enter the value of the last solu-
tion time to include in the animation. If the 
SolutionTime entered does not exist, the near-
est SolutionTime less than the entered time is 

When you need a particular size for your 
animation image, such as 300 by 250 pix-
els, first edit your frame to the correct 
width and height. Then export only the 
current frame.

This option is available for transient field 
plot data ONLY.
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used. The default value is the last solution time. The value of the last solution 
time in the data set is displayed in Max.

• Time Step Skip - Enter the skip number between time steps. A value of 2 
results in every other time steps being animated, a value of 3 animates every 3 
time steps, and so on.

• Number of Time Steps - a read-only field that displays the number of time 
steps in the data between the Start Time and the End Time.

• Destination - Specify the output format for the animation, On Screen or To 
File.

Selecting To File, brings up the following options:

• File Format - Select from: Flash (default), AVI or Raster Metafiles
• Generate Animation File - Select this button to launch the Export 

dialog associated with the selected file format.

Selecting On Screen, brings up the following options:

• Operation - Select from the following options:
•Forward – Animation makes one pass from the current step 
to the ending value

•Backward – Animation makes one pass from the current step 
to the starting value.

•Loop – Animation starts at the current step and proceeds to 
the ending value, at which point it jumps to the starting value 
and continues to the ending value, until interrupted by press-
ing the ‘Stop’ button.

•Bounce – The animation starts at the current step and pro-
ceeds to the ending value, then “bounces” backward and ani-
mates to the starting value. This continues until interrupted by 
pressing the ‘Stop’ button.

• Animation Step - This field displays the time step for the current 
frame of the animation. The field is updated while an animation is in 
progress.

• Go To - Use the Go To button to jump to the nth animation step, where 
n is the value entered in the Animation Step field.

• Slider – The slider can be dragged to change the current solution time.
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•  – Jumps to the value in Start Time

•  – Moves toward the value in Start Time by one step.

•  – Runs the animation as specified by the ‘Operation’ 

field. The Play button becomes a Stop button while the ani-
mation is playing.

•  – Moves toward the value in End Time by one step.

•  – Jumps to the value in End Time.

• Limit Animation Speed - Toggle-on to limit the animation speed to 
the value specified in the Max Speed field

• Drop dialog during animation - Toggle-on this option to close the 
dialog during animation. The dialog will reopen after the animation is 
complete.

27- 1.2 IJK-Plane Animation
Use the Animate IJK-Planes dialog to display all or a specified sub-set of the IJK-planes in the cur-
rent data set, one at a time. You can choose to animate either the I-, J-, or K-planes.

Toggle-on Drop dialog during animation
and close any other time-sensitive dialogs 
for any animations where speed is impor-
tant [On Screen animation only].

To stop the animation when the dialog is 
“dropped”, press the STOP button located 
on the status bar.
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To animate IJK-planes, select IJK-Planes from the 
Animate menu. The Animate IJK-Planes dialog has 
the following options:

• Planes to Animate - specify the set of 
planes to animate: I, J or K-Planes.

• Index - Specify a start index (the first 
plane you want displayed), an end index, 
and an index skip in the fields provided. 
If you specify a start index having a 
higher number than the end index, Tec-
plot cycles backward from the start to the 
end.

• Animate To - Use the Animate drop-down menu to select the output format for 
the animation. You can animate to AVI file, to RM file, to Flash file or 
On Screen. See also: 24 - 3 “Movie Format” on page 484.

• Animate - Select the Animate button to run the animation automatically, or use 
+ and - in the Current Index area to “step through” the animation one plane at a 
time. Both options cycle through the range of planes specified by Start Index
and End Index; if your range is reversed, so are their actions.
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Figure 27-1 shows an example of animating I-planes in an IJK-ordered zone.
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Figure 27-1. An animated sequence of I-planes.

27- 1.3 IJK-Blanking Animation
Use the Animate IJK-Blanking dialog to animate a sequence of Tecplot renderings starting with an 
initial set of blanked IJK indices and proceeding in a series of interpolated steps to a final set of 
blanked IJK indices. Before you can animate IJK-blanking, you must first activate IJK-Blanking.
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To animate a sequence of IJK-blankings, you must first 
turn on IJK-blanking and then select IJK-Blanking from 
the Animate menu The Animate IJK-Blanking dialog has 
the following options:

• Starting Index (% of Max) - Specify an ini-
tial set of blanked IJK-indices in the text fields. 
Enter a range of indices for: I, J, and K (index 
values are entered as percentages of the maxi-
mum index).

• Ending Index (% of Max) - Specify a final 
set of blanked IJK-indices. Enter a range of 
indices for each of I, J, and K. 

• Number of Steps - Specify the number of 
steps. The minimum number is two.

• Animate - Select the destination for the ani-
mation: On Screen, to AVI file, to RM file 

or to Flash file.

• Animate Button - Select the Animate button to run the animation automati-
cally, or use + and - in the Current Index area to “step through” the animation 
one plane at a time.

27- 1.4 Iso-Surfaces Animation
Use the Animate page of the Iso-surface Details dialog to define iso-surfaces to animate either on 
screen or to a file. 

To animate iso-surfaces, select Iso-Surfaces from the Animate menu. Alternatively you can open 
the Iso-Surfaces Details dialog from the Plot menu or Sidebar and select the Animate page.

Specify a starting value, an ending value, and the number of steps in the fields provided. If 
you specify a start level having a higher number than the end level, Tecplot cycles backward from 
the start to the end.

The remaining controls are dependent upon the Destination selected. 
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On-Screen Animation
If you select “On-Screen” as the animation destination, 
you have the following controls:

• Operation

• Forward – Animation makes one pass from 
the current step to the ending value
• Backward – Animation makes one pass 
from the current step to the starting value.
• Loop – Animation starts at the current step 
and proceeds to the ending value, at which 
point it jumps to the starting value and contin-
ues to the ending value, until interrupted by 
pressing the ‘Stop’ button.
• Bounce – The animation starts at the current 
step and proceeds to the ending value, then 
“bounces” backward and animates to the start-
ing value. This continues until interrupted by 
pressing the ‘Stop’ button.

• Current Step – Indicates the active step of the animation. This may be edited 
to jump to a specific step.

• Current Value – Displays the iso-surface value at the current step.

• GoTo – While an on-screen iso-surface animation is playing, the iso-surface 
can be repositioned (independently of the animation) via the Definitions page, a 
macro or an add-on. Use the GoTo button to reset the position to the step value 
in the Current Step field.

• Slider – The slider can be dragged to change the current solution time.

•  – Jumps to the value in Start Time

•  – Moves toward the value in Start Time by one step.
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•  – Runs the animation as specified by the ‘Operation’ field. The 

Play button becomes a Stop button while the animation is playing.

•  – Moves toward the value in End Time by one step.

•  – Jumps to the value in End Time.

• Limit Animation Speed – If the animation on screen is too fast you may limit 
the animation speed by enabling this toggle.

• Max Speed (fr/sec) – This specifies the maximum frames per second that will 
be displayed during the animation. This guarantees that the frame rate will be 
no faster than the value specified. However, the frame rate may be slower than 
the value specified, depending on the complexity of the animation and size of 
the dataset.

• Drop dialog during animation - Toggle-on this option to close the dialog dur-
ing animation. The dialog will reopen after the animation is complete.

Animation To File
If you select “To File” as the animation destination, select the file format (AVI, Flash or Raster 
Metafile) and press the Generate Animation File button.

Toggle-on Drop dialog during animation
and close any other time-sensitive dialogs 
for any animations where speed is impor-
tant [On Screen animation only].

To stop the animation when the dialog is 
“dropped”, press the STOP button located 
on the status bar.

This option will not work when animating 
to a file, if Image Export Options is set to Safe 
on the Rendering page of the Performance dia-

log (see 28- 3.1 “Rendering” on page 548).
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27- 1.5 Mapping Animation
Use the Animate Mappings dialog to display all or a specified subset of the XY or Polar Line map-
pings defined in the current frame, one at a time. 

To animate mapping select Mappings from the Animate menu. 
The Animate Mappings dialog has the following options

• Start Map - Specify the first line mapping you want 
displayed.

• End Map - Specify the last line mapping you want 
displayed.   If you specify a Start Map having a higher 
number than the End Map, Tecplot cycles backward 
from the start to the end.

• Max Skip - Specify the number of maps to skip.

• Animate To - Use the Animate drop-down menu to select the output format for 
the animation. You can animate to AVI file, to RM file, to Flash file or 
On Screen. See also: 24 - 3 “Movie Format” on page 484.

• Animate - Select the Animate button to run the animation automatically, or use 
+ and - in the Current Index area to “step through” the animation one plane at a 
time. Both options cycle through the range of planes specified by Start Index
and End Index; if your range is reversed, so are their actions.

You can try this with the demo data file, demo/xy/rainfall.plt.
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27- 1.6 Slice Animation
To animate slices, select Slices from the Animate menu. Alternatively you can open the Slice Details 
dialog from the Plot menu or Sidebar and select the Animate page.

Specify a starting value, an ending value, and the number of skips in the fields provided. If 
you specify a start level having a higher number than the end level, Tecplot cycles backward from 
the start to the end.

The remaining controls are dependent upon the Destination selected. 

Note: Only the primary slice of the current slice group 
(specified on the Position page) is changed during anima-
tions. The start and end slice and any intermediate slices of 
the current slice group are unchanged. It is entirely possible 

that the animated primary slice will overlap the start slice, end slice or an 
intermediate slice. The animation will proceed, without changing those val-
ues.



Chapter 27:Animation

526

On-Screen Animation
If you select “On-Screen” as the animation destination, you have the following controls:

• Operation

• Forward – Animation makes one pass from the current step to the 
ending value

• Backward – Animation makes one pass from the current step to the 
starting value.

• Loop – Animation starts at the current step and proceeds to the ending 
value, at which point it jumps to the starting value and continues to the 
ending value, until interrupted by pressing the ‘Stop’ button.

• Bounce – The animation starts at the current step and proceeds to the 
ending value, then “bounces” backward and animates to the starting 
value. This continues until interrupted by pressing the ‘Stop’ button.

• Current Step – Indicates the active step of the animation. This may be edited 
to jump to a specific step.

• Current Value – Displays the slice value at the current step.

• GoTo – While an on-screen Slice animation is playing, the Slice can be reposi-
tioned (independently of the animation) via the Position page, a macro or an 
add-on. Use the GoTo button to reset the position to the step value in the Cur-
rent Step field.

• Slider – The slider can be dragged to change the current solution time.

•  – Jumps to the value in Start Time

•  – Moves toward the value in Start Time by one step.

•  – Runs the animation as specified by the ‘Operation’ field. The 

Play button becomes a Stop button while the animation is playing.

•  – Moves toward the value in End Time by one step.
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•  – Jumps to the value in End Time.

• Limit Animation Speed – If the animation on screen is too fast you may limit 
the animation speed by enabling this toggle.

• Max Speed (fr/sec) – This specifies the maximum frames per second that will 
be displayed during the animation. This guarantees that the frame rate will be 
no faster than the value specified. However, the frame rate may be slower than 
the value specified, depending on the complexity of the animation and size of 
the dataset.

• Drop dialog during animation - Toggle-on this option to close the dialog dur-
ing animation. The dialog will reopen after the animation is complete.

Animation To File
If you select “To File” as the animation destination, select the file format (AVI, Flash or Raster 
Metafile) and press the Generate Animation File button. 

Toggle-on Drop dialog during animation
and close any other time-sensitive dialogs 
for any animations where speed is impor-
tant [On Screen animation only].

To stop the animation when the dialog is 
“dropped”, press the STOP button located 
on the status bar.

This option will not work when animating 
to a file, if Image Export Options is set to 
Safe on the Rendering page of the Perfor-
mance dialog (see 28- 3.1 “Rendering” on 

page 548).
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27- 1.7 Streamtrace Animation
To animate your streamtraces, select Streamtraces from the Animate menu

Specify the number of steps per cycle and the number of cycles in the fields provided in the Ani-
mate Streamtraces dialog.

• Use the Animate drop-down menu to select the output format for the animation. 
You can animate to AVI file, to RM file, to Flash file or On Screen (see 
also: 24 - 3 “Movie Format” on page 484).

27- 1.8 Zone Animation
To animate zones, select Zones from the Animate menu. From the Animate Zones dialog, specify 
the start zone, end zone, and zone skip in the fields provided.

Before you can animate streamtraces, you 
must turn on either the timing dashes or tim-
ing markers or both, using the Streamtrace 
Details dialog under the Plot menu. See 

Section 14- 1.4, “Timing Page,”for details
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• If you specify a start zone having a higher number than the end zone, Tecplot 
cycles backward from the start to the end. Use the Animate drop-down menu to 
select the output format for the animation. You can animate to AVI file, to 
RM file, to Flash file or On Screen. (See also: 24 - 3 “Movie Format” on 
page 484).

 Use the Mode drop-down menu to select from the following options:

• Step by Number - animate all zones from the first zone to the last zone with a 
skip specified in the Zone Skip field. A Zone Skip of 1 animates all zones.

• Group Step by Number - animate zones in groups (as specified by the 
Group Size field). A Group Size of 2 will animate all zones in groups of 2 
(i.e. zones 1 & 2, followed by zones 3 & 4).

• Step by Time - legacy option. Use this option if you have the Com-
mon.Time variable in your auxiliary data otherwise use time animation (see 
27- 1.1 “Time Animation” on page 516).

27 - 2 Movie File Creation Manually
You can create a sequence of AVI, Flash or Raster Metafile images interactively using the 
Export option in the File menu. In the Select Export File dialog, specify either a filename or a URL 
destination.

27- 2.1 Record Animation File dialog
The Record Animation File dialog will be launched after you have selected your movie file name.

The Animate Zones dialog is not available for 
transient data sets.
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Select Record Next Image for each snapshot of the current frame you wish to record.

27 - 3 Movie Creation with Macros
The Tecplot macro language expands the capabilities of Tecplot’s standard animation features. The 
macro commands allow you to do almost anything you can do interactively, and export images to 
movie files. You can also use loops to repeatedly rotate 3D objects, cycle from one active zone to 
another, and so on, to create your movie. See Chapter 25, “Macro Commands,”for detailed infor-
mation regarding the Tecplot macro language.

A typical macro file for making movies has the following form:

#!MC 1100 
... optional commands to set up the first image 
$!EXPORTSETUP EXPORTFORMAT = AVI 
$!EXPORTSETUP EXPORTFNAME = "mymovie.avi" 
$!EXPORTSTART 
EXPORTREGION = CURRENTFRAME 
$!LOOP 50  
... commands to set up next image 
 $!REDRAWALL 
 $!EXPORTNEXTFRAME 
$!ENDLOOP                                                 
$!EXPORTFINISH
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For example, the following macro file duplicates the actions performed by the Animate Zones dia-
log:

27 - 4 Advanced Animation Techniques

27- 4.1 Text Changes
There may be times when you want to include information in your animation which tells viewers 
about the time step, current zones, or a mapping. There are several ways this can be done.

Using Dynamic Text
The best way to do this is to add dynamic text to your text box. See 21- 1.4 “Dynamic Text” on 
page 426.

#!MC 1100 
## Set up Export file type and file name. 
$!EXPORTSETUP EXPORTFORMAT = AVI
$!EXPORTSETUP EXPORTFNAME = 
"C:\temp\timeseries.avi"
## Begin Animating 
$!LOOP |NUMZONES| 
## The |Loop| variable is equal to the current 
## loop cycle number. 
 $!ACTIVEFIELDZONES = [|Loop|] 
 $!REDRAWALL 
## This series of $!IF statements ensures 
## that a new AVI file will be created when 
## the macro is started. 
 $!IF |Loop| == 1 
    $!EXPORTSTART
    EXPORTREGION = CURRENTFRAME  
 $!ENDIF 
 $!IF |Loop| != 1 
    $!EXPORTNEXTFRAME  
 $!ENDIF 
$!ENDLOOP                                                       
$!EXPORTFINISH
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 by Attaching Text to Zones
This method works best if you are using animating zones. First, create several text strings in your 
data file, and use the ZN= parameter to attach each text string to a zone or mapping. (See section 
for details on attaching text to zones.) You should have a separate text string for each zone that will 
be used in your animation. For example:

ZONE T= "Temp. distribution, Distance = 0.5 m" 
I=51, J=51 F=POINT
.
.
.
list of variable values
.
.
.
TEXT X=70, Y=90, T= "Distance = 0.5 m", F=COURIER, 
CS=FRAME, H=2, ZN=1

ZONE T= "Temp. distribution, Distance = 1.0 m" 
I=51, J=51 F=POINT
.
.
.
list of variable values
.
.
.
TEXT X=70, Y=90, T= "Distance = 1.0 m", F=COURIER, 
CS=FRAME, H=2, ZN=2
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You can also use Tecplot's dynamic text feature (see Section 21- 1.4 “Dynamic Text” on page 426) 
to insert a zone name into your text strings. For example:

ZONE T= "Distance= 1.0 m" I=51, J=51 F=POINT
.
.
.
list of variable values
.
.
.
TEXT X=70, Y=90, T= "&(ZONENAME:2)”, F=COURIER, 
CS=FRAME, H=2, ZN=2
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27- 4.2 Multiple Frames Animation
Animation of plots in multiple frames requires the use of a macro. The $!FRAMECONTROL 
PUSHTOP command is used to switch between each frame. The following template demonstrates 
how this is done with a layout where each frame contains a similar plot:

#!MC 1100 
##Set the number of images (movie frames) in the 
animation. 
$!VARSET |NumCycles| = 10 
$!EXPORTSETUP EXPORTFORMAT = RASTERMETAFILE
$!EXPORTSETUP EXPORTFNAME   = "2frames.rm" 
BITDUMPREGION = ALLFRAMES 
. 
Insert commands to set up first frame, if necessary. 
. 
## Outer loop. 
$!LOOP |NumCycles| 
## Inner loop cycles through each frame in the current 
layout. 
 $!LOOP |NumFrames| 
.
Insert commands to change the plot in the current frame. 
. 
##push the active (top) frame to the back. 
$!FrameControl PushTop 
$!EndLoop
## This series of $!IF statements ensures 
## that a new AVI file will be created when 
## the macro is started. 
$!IF |Loop| == 1 
    $!EXPORTSTART 
    EXPORTREGION = CURRENTFRAME 
$!ENDIF 
$!IF |Loop| != 1 
    $!EXPORTNEXTFRAME  
$!ENDIF 
$!ENDLOOP
$!EXPORTFINISH



535

Movie File Viewing

27 - 5  Movie File Viewing
The following tools allow you to view movie files you have created with Tecplot.

27- 5.1 AVI Files
AVI format is the standard video format for Windows platforms. Below are some applications that 
can be used to view and/or edit AVI files:

• Media Player - A standard movie viewer included with Windows.

• Xanim - A program for playing a wide variety of video formats on UNIX X11 
machines. More information is available at xanim.polter.net.

• Premier - A powerful tool for professional digital video editing. More infor-
mation is available at www.adobe.com.

27- 5.2 Flash Files

Playback:
•  Flash movies can be played in several freely distributed Flash players. Swiff Player 
is a very good stand-alone player that enables Flash users to easily play their Flash 
movies. 

•  You can play Flash movies in QuickTime. 

•  There are several tools at Download.com that can help manage, browse, convert, 
and display all kinds of Flash files on your computer. 

Flash in Powerpoint:
The easiest way to insert and play SWF files into Microsoft PowerPoint presentations is to down-
load the Swiff Point Player — a free Microsoft PowerPoint Add-In. 

A secondary option is to play it in a PowerPoint presentation using a specific ActiveX control and 
the Macromedia Flash Player. To run the Flash file, you add an ActiveX control to the PowerPoint 
slide and create a link from it to the Flash file. You also have the option of embedding the file in the 
presentation. Below are links to several tutorials that will help you do this: 

•  Flashgeek Tutorial - http://www.flashgeek.com/tutorials/02_embed_01.asp

•  Microsoft Web site - http://office.microsoft.com/en-us/assistance/
HA010348071033.aspx

http://www.download.com
http://www.flashgeek.com/tutorials/02_embed_01.asp
http://www.flashgeek.com/tutorials/02_embed_01.asp
http://office.microsoft.com/en-us/assistance/HA010348071033.aspx
http://office.microsoft.com/en-us/assistance/HA010348071033.aspx
http://office.microsoft.com/en-us/assistance/HA010348071033.aspx
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•  Macromedia Web site - http://www.macromedia.com/cfusion/knowledgebase/
index.cfm?id=tn_14235

 Flash on the Web 
Flash files can be inserted into Web and HTML documents using several different Web design tools 
such as Macromedia Dreamweaver and Adobe GoLive, as well as free tools and using straight-
hand code. 

Once inserted, Flash movies play directly within your browser. An outside media player is not 
needed to launch the animation. 

27- 5.3 Raster Metafiles Viewing in Framer
Raster Metafile is a NASA-defined standard format for storing bit images and may contain one or 
more images. You can create a Raster Metafile in Tecplot either interactively, or using a Tecplot 
macro. For many types of repetitive plots (such as rotations, where each image is a slightly rotated 
version of the previous image), macros provide a very convenient means of simplifying Raster 
Metafile creation. 

The Raster Metafile format is defined in the following reference:

Taylor, N., Everton, E., Randall, D., Gates, R., and Skeens, K., NASA TM 102588, Raster 
Metafile and Raster Metafile Translator. Central Scientific Computing Complex Document G-
14, NASA Langley Research Center, Hampton, VA. September, 1989.

Once you have created your Raster Metafile, you can view the resulting file with Framer. Framer is 
a utility program that is included with Tecplot. It allows you to view files stored in Raster Metafile
format and runs independently of Tecplot1.

The Unix version of Framer is run from your shell prompt; the Windows version can be launched 
from the Tecplot program folder under the Start button. You may freely distribute the Framer exe-
cutable to allow others to view your animation. 

To launch Framer at a command line (shell prompt, Run command, and so forth), use the following 
command: 

framer [options] [rmfile] 

where [rmfile] is the name of a file containing Raster Metafile bitmaps created by Tecplot, and
[options] is one or more of the options listed in B - 2 “Framer” on page 602.

To run Framer on UNIX type:

http://www.macromedia.com/cfusion/knowledgebase/index.cfm?id=tn_14235
http://www.macromedia.com/cfusion/knowledgebase/index.cfm?id=tn_14235
http://www.macromedia.com/cfusion/knowledgebase/index.cfm?id=tn_14235
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framer [filename]

If you do not specify a file name, Framer prompts you for one. In this dialog, you can choose to set 
buffering [equivalent to the -b flag] and/or multiple color maps [equivalent to the -m flag].) For a 
list of Framer command lines, see B - 2 “Framer” on page 602

Figure 27-2 shows the main Framer window under Windows. 

Figure 27-2. The Framer application window under Windows.
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Chapter 28 Customization

Use the Preferences menu (accessed via the File menu) and the Options menu to customize Tecplot. 
 This chapter discusses the Preferences menu. Please refer to 3 - 4 “Workspace Management - 
Options Menu” on page 74 for information pertaining to the Options menu.

28 - 1 Configuration Files
A Tecplot configuration file is a special type of Tecplot macro file that Tecplot reads on start up. 
Use customized configuration files to override any or all of Tecplot’s factory default settings.

You can create a configuration file from scratch using any ASCII text editor, or using the Prefer-
ences>Save Configuration option in the File menu.

28- 1.1 Loading Configuration Files in Tecplot
Tecplot looks for configuration files (named tecplot.cfg) in one of three places: the current 
working directory, the user’s home directory, and the Tecplot home directory. Tecplot looks for the 
configuration file (in the order listed) and uses the first configuration file found.

If you want to force Tecplot to load a specific configuration file, instead of one of the standard files 
named above, you may use the -c command line option when starting Tecplot.

System administrators can use the tecplot.cfg file in the Tecplot home directory to set sys-
tem-wide defaults, then others on the system can copy the system configuration file to their own 

The names of the default configuration files used in 
Tecplot vary from platform to platform; this chapter 
concentrates on UNIX and Windows files.
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home directories and make any desired changes. The settings in your local configuration file are 
used instead of the settings in the system configuration file. 

Tecplot under Unix has a second type of configuration file, an X11 resource file (app-defaults file) 
that controls the appearance of the Tecplot application and its dialogs. Most users do not need to 
concern themselves with this file; nothing in the resource file has any affect on the plots you create 
with Tecplot, either on screen or on paper. However, if you are an experienced Unix and X11 user, 
you may want to modify some of the resources to improve the appearance of Tecplot’s windows 
and dialogs on your display. Section 28 - 4, “Interface Configuration (UNIX),”explains how to do 
this.

28- 1.2 Configuration File Creation
The simplest way to create a configuration file is to change the appropriate settings using the 
Tecplot interface, then save the configuration. For example, suppose you want to have your paper 
orientation default to portrait and have your default export format be Encapsulated PostScript 
(EPS). You can modify the settings using the appropriate Tecplot dialogs, then save the 
configuration file.

To save a Tecplot configuration file, change settings as desired using Tecplot dialogs and select 
Preferences>Save Configuration from the File menu.

A configuration file needs to include only those 
options for which you want to override defaults.
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Include Factory Defaults.
If Include Factory Defaults is toggled-on, The created file contains factory defaults for the following 
types of Tecplot settings:

•  Interface details.

•  RGB color assignments for Tecplot’s basic colors.

•  Default paper layout.

•  Print and export setup information.

If you modify any setting from these four types interactively and then save your configuration, the 
modifications are saved. However, modifications to other types of settings will not be saved.

28- 1.3 Editing the Configuration File
You are not limited to customizing only those settings which appear in the saved configuration file. 
Most settings which can be modified by one of Tecplot’s SetValue, Field, LineMap or
Interface macro commands can be changed in the configuration file directly.

The simplest way to do this is to create a layout or macro with the settings you want, then copy and 
paste the appropriate commands into your configuration file. See the Tecplot Reference Manual for 
complete details on macro commands.

SetValue Commands
For example, suppose you want your 2D axes to appear cyan. You can add this preference to your 
configuration file as follows:

1. Using the Tecplot interface, create a 2D plot with cyan axes, either recording 
your steps as a macro, or saving the result as a Tecplot layout.

2. Edit the resulting macro or layout, scanning for the lines that set the 2D axis 
colors. The following example shows the commands that specify the X- and Y-
axis details in a layout of a 2D plot with cyan axes:

$!TWODAXIS XDETAIL{RANGEMIN = -3}
$!TWODAXIS XDETAIL{RANGEMAX = 15}
$!TWODAXIS XDETAIL{GRIDLINES{SHOW=YES}}
$!TWODAXIS XDETAIL{AUTOGRID=NO} 
$!TWODAXIS XDETAIL{GRSPACING = 5}
$!TWODAXIS XDETAIL{GRIDLINES{COLOR = CYAN}}
$!TWODAXIS YDETAIL{GRIDLINES{SHOW = YES}}
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$!TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}

3. Discard everything but the lines that actually set the color:
$!TWODAXIS XDETAIL{GRIDLINES{COLOR = CYAN}}
$!TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}

4. Paste the resulting lines into your configuration file.

Plot Default Setting - FIELDMAP and LINEMAP
A single $!FIELDMAP command can be included to set plot defaults. The zone cannot be 
specified in the configuration file and the command is not effective for values set dynamically by 
Tecplot, such as Mesh Color. In the example below, the default contour type is Flood, scatter 
symbol shape is Delta, and scatter size is 1.8.

In the same way, a single $!LINEMAP command can be added for line mapping defaults. In the 
example below, XY and Polar Line mappings will have a dashed line pattern, and symbols will be 
filled circles.

Interface Configuration
The many members of the $!INTERFACE macro help you configure Tecplot’s user interface and 
graphics drawing capabilities. Although some of these commands can be executed in any Tecplot 
macro the best place to put these is in the Tecplot configuration file, tecplot.cfg. Below are a 
few examples. Refer to the Tecplot Reference Manual for a complete listing.

General Interface Configuration Options

$!INTERFACE followed by:

$!FIELDMAP CONTOUR{CONTOURTYPE = FLOOD}
$!FIELDLAYERS SHOWSCATTER = YES
$!FIELDMAP SCATTER{SYMBOLSHAPE{GEOMSHAPE = DEL}}
$!FIELDMAP SCATTER{FRAMESIZE = 1.8}

$!LINEMAP LINES{LINEPATTERN = DASHED}
$!LINEPLOTLAYERS SHOWSYMBOLS = YES
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = 
CIRCLE}}
$!LINEMAP SYMBOLS{FILLMODE = USELINECOLOR}
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• MOUSEACTIONS {MIDDLEBUTTON {SIMPLEDRAG=ZOOMDATA}} - 
Specify the action of the middle mouse button click and drag. Several other 
options for the middle and right mouse buttons are listed in the Tecplot Refer-
ence Manual. These commands can only be executed in the Tecplot configura-
tion file.

• UNIXHELPBROWSERCMD = string - Specify the browser for viewing the 
Help files (UNIX only). This command can only be executed from the Tecplot 
configuration file.

• SHOWWAITDIALOGS = (YES, NO) - Disable the launch and display of all 
Wait dialogs by setting this to NO. (Wait dialogs are launched during long oper-
ations and give you the ability to cancel the operation.) This is useful on some 
Linux systems where transient dialogs do not drop properly, leaving a gray box 
that obscures part of Tecplot’s drawing area.

• USESTROKEFONTSONSCREEN = (YES, NO) - If set to YES all text drawn in 
the work area will be drawn using Tecplot's internal stroke fonts. If set to NO
the native True Type fonts will be used instead. This option has no effect under 
UNIX.

• USESTROKEFONTSFOR3DTEXT = (YES, NO) - If set to YES all 3D text 
drawn in the work area will be drawn using Tecplot's internal stroke fonts. 3D 
text consists of ASCII scatter symbols, and node and cell labels when the cur-
rent plot type is 3D Cartesian. For 3D text, this setting overrides the setting of 
USESTROKEFONTSONSCREEN. If set to NO the native True Type fonts will be 
used instead. This option has no effect under UNIX.

OpenGL-Specific Configuration Options.

Several options are available to further tune Tecplot to operate with the OpenGL capabilities of 
your platform. To assign values to these parameters you must use the $!INTERFACE 
OPENGLCONFIG command. A complete list of these options is given in the Tecplot Reference 
Manual.

$!INTERFACE OPENGLCONFIG followed by:

• {ALLOWHWACCELERATION = (YES, NO)} - In some cases, bugs in 
OpenGL drivers cause problems in Tecplot. In these situations, Tecplot will 
typically behave better if this options is set to NO. However, Tecplot will also 
be slower.
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• {SCREENRENDERING {DOEXTRADRAWFORLASTPIXEL = (YES, NO)}} - 
Some OpenGL implementations use an optimization for line drawing that omits 
the last pixel in the line. Set this to YES to change all line drawing to force the 
last pixel to be drawn. This setting applies only to drawing on the screen.

• {SCREENRENDERING {STIPPLEALLLINES = (ALL, CRITICAL, NONE)}}
- Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use 
stippling for stroke and user-defined fonts. Set to NONE to disable stippling. 
This setting applies only to drawing on the screen.

• {IMAGERENDERING {DOEXTRADRAWFORLASTPIXEL = (YES, NO)}} - 
Some OpenGL implementations use an optimization for line drawing that omits 
the last pixel in the line. Set this to YES to change all line drawing to force the 
last pixel to be drawn. This setting applies only to exporting images from Tec-
plot.

• {IMAGERENDERING {STIPPLEALLLINES = (ALL, CRITICAL, NONE)}} - 
Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use 
stippling for stroke and user-defined fonts. Set to NONE to disable stippling. 
This setting applies exporting images from Tecplot.

28- 1.4 Default File Name Extensions
The default extensions for file names in file input-output dialogs can also be changed in the config-
uration file. These settings are changed via the FNAMEFILTER sub-command in the $!FILE-
CONFIG macro command.

$!FILECONFIG FNAMEFILTER followed by:

•  COLORMAPFILE = <string> - Specifies the default extension for color map 
files.

•  INPUTDATAFILE = <string> - Specifies the default extension for input data 
files.

•  OUTPUTASCIIDATAFILE = <string> - Specifies the default extension for 
ASCII output files.

•  OUTPUTBINARYDATAFILE = <string> - Specifies the default extension for 
binary output files.

•  INPUTLAYOUTFILE = <string> - Specifies the default extension for input lay-
out and layout package files.
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•  OUTPUTLAYOUTFILE - Specifies the default extension for output layout files.

•  OUTPUTLAYOUTPACKAGEFILE = <string> - Specifies the default extension 
for output layout package files.

•  STYLEFILE = <string> - Specifies the default extension for stylesheet files.

•  MACROFILE = <string> - Specifies the default extension for macro files.

•  EQUATIONFILE = <string> - Specifies the default extension for equation files.

For example, to change the default extension for input data files to be .tbl use:

28- 1.5 Default Temporary Directory
Tecplot writes out a number of temporary files. To tell Tecplot where to place these files, put the 
following macro command in the tecplot.cfg file:

where tempfilepath is the new path. The default path is system dependent.

28 - 2 Interactive Customization
Using the Preferences submenu from the File menu, you can interactively control the colors used 
throughout Tecplot, the size options available in most Tecplot dialogs, and several miscellaneous 
parameters.

 $!FILECONFIG FNAMEFILTER {INPUTDATAFILE = "*.tbl"}

   $!FILECONFIG    TEMPFILEPATH = "tempfilepath"
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28- 2.1 Color Preferences Dialog
To change the RGB values of Tecplot’s basic colors, use the 
Color Preferences dialog (accessed via Preferences>Colors
from Tecplot’s File menu).

To change a color, click on it in the palette and alter its RGB 
values with the sliders. As you move the sliders, the box in 
the upper right corner of the dialog shows the color as cur-
rently specified. You may alter multiple colors by selecting 
those colors and changing their RGB values. Choosing 
Reset Selected Color or Reset All Colors will restore the 
default RGB values.

See also: 4 - 4 “Select Color” on page 97.

28- 2.2 Size Preferences Dialog
To set size options, use the Size Preferences dialog 
(accessed via Preferences>Sizes from the File menu).

These options determine the choices available in drop-down such as Line Thickness that occur 
throughout the interface.

You can control the following sets of sizes:

•  Line thickness.
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•  Symbol size.

•  Pattern length.

•  Arrowhead size.

•  Tick mark length.

•  Text height (in both points and frame units).

•  Translate step size.

•  Rotate step size.

•  Magnification step size.

•  Stroke font line thickness.

28- 2.3 Miscellaneous Preferences dialog
Use the Miscellaneous Preferences dialog (accessed via File>Preferences>Miscellaneous) to custom-
ize the following settings.

• Allow Old Text Formatting - Beginning with version 10, Tecplot uses 
HTML-like formatting tags. Selecting “allow old text formatting” will cause 
Tecplot to process text first using the HTML-style formatting rules and second 
using the old character-by-character formatting rules.

• Allow Data Sharing - Selecting this option enables zones to share variables 
and connectivity. If a variable or connectivity list is shared, then only a single 
copy of it exists and is used by two or more zones. Refer to help on the Data 
Sharing Page page of the Data Set Info dialog for more information on data 
sharing.

28 - 3 Performance Dialog
Use the Rendering page of the Performance dialog (accessed via the Options menu) to adjust the 
Plot Approximation, Graphics Cache and Image Export Options. Use the Miscellaneous page of the 
Performance dialog (accessed via the Options menu) to adjust Data I/O, Load On Demand, Variable 
Derivation and Status Information. 
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28- 3.1 Rendering
The Rendering page has the following options:

• Use Auto Redraw - When selected, Tecplot will automatically redraw the plot 
whenever style or data changes. Some users prefer to turn this option off while 
setting multiple style settings and then manually pressing Tecplot's Redraw or 
Redraw All button on the sidebar to see a full plot. 

•  Plot Approximation

•  Graphics Cache

•  High Quality Font Usage

•  Image Export Options

Plot Approximation

• Approximate Plots for Better Speed - When selected, Tecplot builds an 
approximate representations of the plot. The degree of detail of the approxima-
tion is controlled by the following settings:

Auto-redraw can be interrupted with a 
mouse click or key press.
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• Automatic - When the number of data points is above the point threshold, Tec-
plot will render the approximate plot for style, data, and interactive view 
changes, followed immediately by the full plot. This option provides for good 
interactive performance with the final plot always displayed in the full repre-
sentation.

• Non-Current Frames Always Approximated - When only one frame exists 
this option is equivalent to automatic mode. If more than one frame exists, the 
current frame is set to automatic mode while the other frames are approxi-
mated.

• All Frames Always Approximated - When the number of data points is 
above the point threshold, Tecplot will render the approximate plot in any 
frame. To see the full representation press the Redraw or Redraw All button on 
the sidebar.

• Point Threshold for Automatic Approximation - This value controls when 
Tecplot will consider using approximate plots. The value to use is highly 
dependent on the computer's hardware capabilities. 

• Approximate Plot as % of Full Plot - This value controls the percentage of 
geometric detail represented by the approximate plot. The larger the percentage 
the more closely the approximation represents the original plot. However, the 
interactive performance is reduced. This number should be adjusted until there 
is a balance between good interactive performance and sufficient detail. Typi-
cally the percentage should be set to be less than or equal to 50. If values larger 
than 50% are needed to provide sufficient detail, consider not using approxi-
mate plots at all.

Graphics Cache
Tecplot uses OpenGL to render plots. OpenGL provides the ability to cache graphic instructions for 
rendering and can re-render the cached graphics much faster. This is particularly true for interactive 
manipulation of a plot. However, this performance potential comes at the cost of using more mem-
ory. If the memory need is too high, the overall performance could be less. 

Use one of the following Graphics Cache modes to optimize your computer’s performance:

• Cache All Graphics - When selected, Tecplot assumes there is enough mem-
ory to generate the graphics cache. If this is valid, Tecplot's rendering perfor-
mance will be optimal for interactive manipulation of plots.
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• Cache Only Lightweight Graphics Objects - Lightweight objects include 
approximate plots and some other minor items but do not include full plots. For 
memory constrained problems this is a good setting. Consider using this option 
in conjunction with the “Plot Approximation” mode set to “All Frames Always 
Approximated”.

• Do Not Cache Graphics - When memory constraints are very limited con-
sider using this option. If you intend to interact with the plot, also consider set-
ting the Plot Approximation mode set to All Frames Always Approximated. 

High Quality Font Usage
The Windows and Linux 32 bit versions of Tecplot support high quality TrueType font usage. Win-
dows platforms are shipped with the TrueType fonts used by Tecplot. On the Linux platforms they 
have to be obtained and installed (see the Release Notes). 

Tecplot has three high quality font modes: 

• When Possible - Tecplot uses any of its TrueType fonts that are available for 
any size text. This produces the best rendering quality. However, performance 
is slower for large amounts of text.

• For Large Characters Only - Tecplot uses the TrueType fonts for large char-
acters only. Small characters will use Tecplot's built-in stroke fonts. This is a 
good blend of quality and performance.

• Never - Tecplot never uses TrueType fonts. This is the default mode for plat-
forms other than Windows and Linux 32 bit.

Image Export Options
Some graphics card hardware does not support off-screen rendering (needed for exporting images). 
In addition, most graphic hardware is slower at producing images off-screen than on-screen. 

To accommodate a variety of graphic hardware Tecplot provides two image export modes:

• Safe (Render Image Off-Screen) - Tecplot will render all exported images 
off-screen. This allows images to be created that are not bound by the physical 
size and state of the Tecplot drawing area.

• Fast (Use On-Screen Image) - Tecplot will grab the pixels from the physical 
Tecplot drawing area. Any rendering damage, such as occluding windows or 
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partially drawn images will become part of the exported image. In addition, the 
image size is bound by the physical size of the Tecplot drawing area.

Best Practices For Rendering Performance
The factory settings in the Performance dialog are designed for moderately sized data and occa-
sionally may need to be adjusted to optimize Tecplot's rendering performance.

There are many combinations of Plot Approximation and Graphics Cache modes. However, two 
combinations meet most user's needs:

• Moderate to large size data - 

• Toggle-on Plot Approximation
•With one frame - set the Plot Approximation mode to Auto-
matic (DEFAULT)

- or - 
•With multiple frames -   set the Plot Approximation mode to 
Non-Current Frames Always Approximated

• Set the Graphics Cache mode to Cache All Graphics

• Large to very large size data - set the Graphics Cache mode to Cache only 
Lightweight Graphics Objects.

• For ordered data, setting the Plot Approximation mode to All Frames 
Always Approximated can be helpful.

• For finite-element data, toggle-off Plot Approximation to reduce up-
front load time. However, this setting may result in unacceptably slow 
view changes (rotation, translation, zooming, etc.).

With either case, adjust the Approximate Plot as% of Full Plot value to give an acceptable balance 
between interactive performance and plot detail.

The size of the data isn’t the only factor. If you plot includes 
slices or iso-surfaces, you may also need to adjust your plot 
approximation mode and graphics cache settings.
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28- 3.2 Miscellaneous

Data I/O

• Use Memory Mapped I/O - When toggled-on, Tecplot will use system level 
memory mapping functions to map Tecplot variables directly over block data in 
a binary data file or layout package file. The advantage of mapping variable 
data is that Tecplot will only load the variable when it is first used. In addition 
the mapped variable data can be shared between other Tecplot sessions running 
on the same machine. Memory mapped I/O is most useful when there is a large 
number of data points to load from a file and they are not all being used by Tec-
plot at the same time. Only variable data that is in a binary block format (the 
default for plt files generated by Tecplot) can be memory mapped.

Load On Demand
With load-on-demand activated, Tecplot generates plots faster using less memory by only loading 
data that is needed for the plot. If changes to the plot style require additional variables to be loaded, 
Tecplot will automatically load them and if necessary unload variables that are no longer used. Tec-
plot's ability to automatically load and unload variables on demand allows you to examine data that 
is much larger than the physical or virtual memory of your computer.

For large data sets, only the zones and variables currently in use will be loaded. However, for small 
data sets, some other zones and variables may be loaded for you (based on the Memory Threshold).
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• Unload Strategy - Specifies how to manage unloading variables and other 
load-on-demand resources. 

• Auto Unload - This strategy attempts to keep Tecplot's memory use 
within the defined Min and Max Memory Thresholds.Tecplot uses 
these values to determine when and how much it should unload. This 
is the best option for exploring data as Tecplot only unloads when 
if the memory threshold has been exceeded. 

• Minimize Memory Use - This strategy is used if more aggressive 
unloading of variables and other load-on-demand resources is 
required. This option is best suited for animating through a very 
large number of time steps where each time step consumes a sig-
nificant part of the computer's available physical and virtual 
memory.

•  Never Unload - This strategy disables the unloading capability of 
load-on-demand while still preserving the ability to load variables on 
demand.

• Memory Threshold (%) [Auto Unload ONLY] - When Tecplot uses at least 
the maximum percentage of the available physical and virtual memory, it will 
attempt to unload variables and other load-on-demand resources until the avail-
able physical and virtual memory is at or below the specified minimum per-
centage.

Variable Derivation
When Tecplot needs to create a nodal variable from a cell centered one it uses a prescribed deriva-
tion method. Tecplot provides two such derivation methods: fast and accurate.

• Fast (Linear) - When selected, Tecplot uses simple averaging to derive a 
nodal variable from a cell centered one.

• Accurate (Laplacian) - When selected, Tecplot uses Laplacian interpolation 
to derive a nodal variable from a cell centered one.

Most users should select either the “Auto 
Unload” or “Minimize Memory Use” 
options.
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Status Information
Sometimes the updating the status line slows down processing (mainly when remotely displaying 
Tecplot on X terminals) or is just annoying so Tecplot provides several toggles to turn on or off the 
status line and tool tips. In addition you can control what kind of information is shown on the status 
line.

28 - 4 Interface Configuration (UNIX)
In UNIX, the style of the graphical user interface for Tecplot is configured for the most part by a 
resource file called Tecplot360 which resides in the app-defaults sub-directory below the 
Tecplot home directory. If you edit this file the changes will affect all users. Alternatively, if you 
want the changes to apply only to your own execution of Tecplot, you can add entries to a file 
called .Xdefaults which resides in your own $HOME directory. If the file .Xdefaults does 
not already exist in your home directory, you can create one.

28- 4.1 Default Size of Tecplot
The resource lines that affect the default Tecplot process window size are:

*Tecplot.main_dialog.width: 900
*Tecplot.main_dialog.height: 720

Changing either the value 900 or the value 720 will change the default size of the Tecplot process 
window.

28- 4.2 Look and Feel
Tecplot now ships with two options, using the “old” look and feel, where the text is bold and larger 
or using the “new” look and feel, where the interface is closer to a Windows style. In order to 
change from option to the other, refer to the Tecplot360 file as mentioned above.

28 - 5 Tecplot.phy File Location Configuration
Whenever Tecplot starts, it tries to load a tecplot.phy file. This file contains information useful 
for running macros in batch mode (see Chapter 26, “Batch Processing,”) and also the name of the 
last layout file used in Tecplot. Whenever Tecplot exits, a new tecplot.phy file is written.

The place Tecplot looks for the tecplot.phy file is based on the following search:

1. Tecplot checks the environment variable TECPHYFILE. If this variable is set, 
Tecplot uses the value of this variable as the name of the tecplot.phy file. 
By default, this variable is not set. You can set this environment variable to 
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control the location and name of the tecplot.phy file on a user-by-user 
basis.

2. (Windows Only) Tecplot checks the Windows registry for the key 
HKEY_LOCAL_MACHINE\SOFTWARE\Tecplot, Inc\Tecplot 360. 
If the value PhyFile is set under this key, then it is used as the name of the 
tecplot.phy file. This value is set by the installation program. You can use 
the command regedit from the Start Menu's Run option to edit the registry 
if you want to change or delete this key.

3. Tecplot uses the file called tecplot.phy in the directory where Tecplot is 
started. Note that this is the default behavior under UNIX.

Thus, using the default installation, Windows versions of Tecplot will write a tecplot.phy to 
one specific location (usually the Tecplot home directory), and UNIX versions will always use a 
tecplot.phy file in the directory where Tecplot is started.

The Windows version can be made to act like the UNIX version by deleting the value PhyFile
from HKEY_LOCAL_MACHINE\SOFTWARE\Tecplot, Inc.\Tecplot 360 in the Win-
dows registry with regedit.

Under both Windows and UNIX, the environment variable TECPHYFILE can be set to override 
this behavior.

28 - 6 Custom Character and Symbol Definition
When Tecplot launches, it reads the font file (“tecplot.fnt”). This file contains information that 
defines the appearance of text characters on the screen. Tecplot defines and draws characters on the 
screen as a set of straight lines called strokes. These stroked characters approximate the appearance 
of characters for the screen.

The font file is an ASCII file. You can modify the shape, size, and resolution of existing stroke-font 
characters or add completely new ones. In PostScript print files, text characters are generated using 
PostScript defined fonts, not the stroked fonts. If you are using the Windows version of Tecplot and 
the Windows print drivers are active, then all text except text using the User-Defined fonts is ser-
viced by the Windows printer driver. However, the text characters in bitmap export files are in 
stroked fonts (since they are generated from the screen). The inter-character spacing in all output 
files is determined by the character-width definitions in the font file. When using PostScript print 
files or the Windows print drivers, changing the font commands affects only the character shape for 
User-Defined fonts and the character spacing for all fonts.
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The Font File is structured as follows:

#!FF 4 
 CharCellHeight 
 Stroke command set for Helvetica Font 
 Stroke command set for Greek Font 
 Stroke command set for Math Font 
 Stroke command set for User-Defined Font 
 Stroke command set for Times Font 
 Stroke command set for Times Italic Font 
 Stroke command set for Courier Font

The file type and version are on the first line (“FF” refers to Font File). CharCellHeight is the inter-
line spacing (the height of a capital M plus some vertical space) in the units of a two-dimensional 
coordinate system used to define the stroke-font characters. The baseline of the characters is at 
zero. Before Tecplot uses the character definitions, they are normalized by the character cell height.

Following the character cell height, there are seven sets of stroke commands, one set for each font 
as shown above. Each stroke command set consists of definitions for the characters in the font. 
Each font has a base set of 96 characters (character indices 32 to 127). Some fonts also include an 
extended set of characters (character indices 160 to 255). The extended characters are needed to 
complete the character sets for most of the common European languages.

All seven stroke command sets must be present, and each must have at least one character defined. 
Each stroke command set begins with the definition for a space (character index 32). After that, 
characters within a stroke command set may be defined in any order. If a character is not defined in 
the Font File, it is drawn as a blank.

Each character in a stroke command set is defined as follows:

CharIndex NumCommands CharWidth 
 Command1 
 Command2 
 Command3 
. 
. 
. 
 CommandNumCommands

CharIndex is the character index which ranges from 32 to 127 and 160 to 255 for each font (see 
Table 21-2 for the matching of the character index to the English, Greek, Math, and standard User-
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Defined font characters), NumCommands is the number of stroke commands defining the character 
that follows, and CharWidth is the character width, which determines the spacing of the characters.

A command may be in one of the following forms:

•  m x y.

•  d x y.

•  mr dx dy.

•  dr dx dy.

Where:

•A command that begins with an m is a move command. 
•A command that begins with a d is a draw command. 
•Commands mr and dr are relative move and relative draw commands. 
•The x and y are the absolute coordinates within the character cell. 
•The dx and dy are the relative coordinates with respect to the previous location (incre-

ments from the position attained by the previous command). 
•All coordinates are specified as integers. 
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Figure 28-3 shows an example of a character cell and the commands used to define the lowercase 
letter “y.” The height of the character cell is 48.

y
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m 4 23
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Figure 28-3. Defining a user-defined character.

Figure 28-4 shows a symbol being defined. Symbols should be centered about (0, 0) so that they are 
centered about the point they mark. The font file included with Tecplot contains many User-
Defined font stroke commands. Most of these are for creating extra plotting symbols, accessible 



559

Custom Character and Symbol Definition

when you use the Symbol Type “Other,” enter an ASCII character, and specify the User-Defined 
font.
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Figure 28-4. Defining a user-defined plotting symbol.
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Chapter 29 Add-Ons

Add-ons are a way to extend the basic functionality of Tecplot. They are executable modules 
designed to perform specific tasks. Tecplot has produced a number of add-ons that load data in a 
variety of formats, allow advanced editing, or extend Tecplot’s capabilities. By using the Tecplot 
Add-on Developer’s Kit (ADK), users can create their own add-ons to generate plots, transform or 
analyze data, or perform a broad range of specialized tasks.

Add-ons are external programs that attach themselves to Tecplot and are accessed through the Tec-
plot interface. When Tecplot is started, it goes through various initialization phases, including the 
processing of the tecplot.cfg file, the loading of the Tecplot stroke font file (tecplot.fnt) 
and the initialization of the graphics. After all of this has been completed, Tecplot begins to look for 
add-ons. 

29 - 1 Add-on Loading
You can load add-ons using the Tecplot.add File, Command Line Specification for Add-ons or by 
Specifying a Secondary Add-On Load File.

29- 1.1 Tecplot.add File
The tecplot.add file is a special macro file that is executed at startup time and contains one or 
more $!LoadAddOn commands to load add-ons into Tecplot. $!LoadAddOn is the only macro 
command allowed in a tecplot.add file. The syntax for the $!LoadAddOn command is:

$!LoadAddOn "libname" 
 AddOnStyle = addonstyle

where

libname - The name of the shared object library file (see below). This 
must be in quotes.
addonstyle - The add-on style. This can be either V7Standard 
(default) or V7ActiveX.
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Special rules govern how libname name is specified. In all cases the filename extension is omitted. 
If you assign libname to the base name of the shared object library, then Tecplot will do the follow-
ing:

• UNIX - The shared library to load will come from the file specified by: Tec-
plot-Home-Directory/lib/lib+basename+platform-specific-extension, 
where platform-specific-extension is .sl for HP platforms and .so for all oth-
ers.

• Windows - If the add-on is of type V7Standard and just the base name is 
supplied, the add-on basename.dll will be searched for in the following 
directories (in this order):

• The directory where the Tecplot executable resides.
• The Windows system directories.
• The directories in your PATH environment variable.

On Windows using V7ActiveX style add-on libraries, Tecplot connects to the 
add-on via the libname entry in the registry.

If an absolute path name is used in libname, then in Windows, .dll is appended and in UNIX .so
or .sl is appended. 

Add-Ons Loaded by All Users
In a normal installation of Tecplot, the add-ons you want loaded by all users of Tecplot are named 
in an add-on load file called tecplot.add, located in the Tecplot home directory. The following 
is an example of a typical tecplot.add file:

#!MC 1100
$!LoadAddOn "cfdtool"
$!LoadAddOn "streamtool"
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29- 1.2 Command Line Specification for Add-ons
You can also instruct Tecplot to load a particular add-on via the command line. The following flags 
are available:

You may specify the -loadaddon or -loadaxaddon flag as many times as you want on the 
command line.

If your add-on is named with the proper suffix for your platform (.dll for Windows, .sl for HP 
UNIX, and .so for all other UNIX platforms) you can simply name the add-on on the command 
line without using the -loadaddon flag.

After add-ons are loaded, Tecplot re-processes all command line arguments not processed earlier 
(for graphics and add-on initialization). This ordering allows for a data reader add-on (discussed 
later) to be used to load data specified on the command line.

29- 1.3 Specifying a Secondary Add-On Load File
You may also instruct Tecplot to load a different list of add-ons by naming a second add-on load 
file using one of the following methods:

•  Include -addonfile addonfilename on the command line.

•  Set the environment variable TECADDONFILE.

Both of these methods tell Tecplot the name of another add-on load file to process.

29 - 2 Add-ons included in the Tecplot 360 distribution
The following add-ons are loaded automatically:

• Data file loaders or converters are loaded automatically:

• plot3d - A PLOT3D data loader.

-loadaddon libname
-loadaxaddon activeXname

where: 

libname - The full name (including path and extension) of a 
V7Standard add-on (the only choice in UNIX).
activeXname - The name of an ActiveX style add-on. (The supplier 
of the add-on will tell you what type it is.)
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• loadxls - An Excel file loader (Window).
• loadss - A spreadsheet file data loader.
• gridgen - A GridGen file data loader.
• loaddxf - A Data eXchange Format (DFX) data loader.
• loadhdf - A Hierarchical Data Format (HDF) data loader.
• h5load - An HDF5 data loader
• loaddem - A Digital Elevation Map (DEM) data loader.
• loadcgns - A CFD General Notation System (CGNS) data loader.
• fluent - A Fluent data loader for .cas and .dat files (versions 5 to 

6.1).
• loadensight - An EnSight Gold data loader.

These show up under the Load Data File(s) option of the File menu. The primary 
difference between loaders and converters are that loaders have more complex 
options than converters. See Appendix E “Data Loaders” on page 633 for infor-
mation on working with each data loader.

• Extended curve-fits with XY Line plots (accessed by selecting the Curve 
Type’s “Extended” option, located on the Curves page Mapping Style dialog).

• crvstineinterp - A curve-fit using Stineman interpolation.
• crvgen - A curve fit where users define the equation.

See 18 - 10 “Data Interpolation” on page 323 for information on working with 
each of these add-ons.

• The add-ons described in 29 - 3 “Working with Tecplot Add-ons” 

• Advanced Quick Edit
• Circle Stream
• Create Multiple Frames
• Create Finite-Element Sub-Zone
• Export DXF
• Extend Macro
• Extrude
• Prism-Grid
• Sort
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• Statistics Calculator
• Tecplot GUI Builder
• Tetra-Grid
• View Binary
• Write Data as Formatted Text

29 - 3 Working with Tecplot Add-ons
The add-ons discussed in this section can be loaded into Tecplot using the methods described in 
Section 29 - 1.

29- 3.1 Advanced Quick Edit
Selecting the Advanced Quick Edit Tool option from the Tools menu allows you to make rapid 
changes to text and geometries selected in the current frame. This tool allows operations that cannot 
be performed with the standard Quick Edit dialog (accessed via the Sidebar).

Controls on the Advanced Quick Edit Tool dialog are sensitive to user input only when one or 
more text and/or geometries are selected. Some controls are specific to either text or geometries, 
while others apply to both. If the selected objects are a mix of text and geometries, the controls that 
apply only to geometries will only affect the geometries you have selected. Similarly, controls that 
apply specifically to text will only affect text, even if the selected objects are a mix of text and 
geometries.
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The following options are available:

• Geometry Coordinate System - Change selected 
geometries to the Frame or Grid coordinate system 
by clicking the appropriate button in the Coord Sys/
Char Height section located at the top of the dialog. 
Changing the coordinate system via this dialog will 
modify each geometry's anchor position and size 
such that it appears visually unchanged on the 
screen. 

• Text Coordinate System and Character Height 
Units - Change the position coordinate system and 
character height units of all selected text by clicking 
the appropriate button in the Coord Sys/Char Height
section located at the top of the dialog. There are 
four valid combinations: Frame/Frame, 
Frame/Point, Grid/Grid, and Grid/Frame. 
Changing a coordinate system via this dialog will 
modify each text object's anchor position and char-
acter height such that it appears visually unchanged 
on the screen.

• Text Box Margin - Change the text box margin of 
all selected text using the Text Box Margin button.

• Text Line Spacing - Change the line spacing of all selected text by using the 
Text Line Spacing button. 

• Text Anchor Location - Change the text anchor point for all selected text by 
selecting one of the nine possible anchor points from the button grid located in 
the middle of the dialog.

• Text and Geometry Scope - Change the scope of all selected text and geome-
tries by clicking either Local or Global scope. Objects with local scope appear 
only in the frame in which they were originally created. If the objects are 
defined as having global scope they will appear in all “like” frames, that is, 
those frames using the same data set as the one in which the objects were origi-
nally created.
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• Text and Geometry Zone or Map Attachment - Change the zone or map 
with which the selected text or geometries are associated by clicking Zone 
Attachment Select. This calls up the Attachment Selection dialog. The Attach-
ment Selection dialog lists zone names or numbers when Tecplot is in the 2D or 
3D Cartesian, or Sketch plot types, and mappings when Tecplot is in the XY 
Line plot type. The “<Unattach Object>” entry dissociates each selected text or 
geometry from its zone or map.

29- 3.2 Circle Stream
The Circle Stream add-on is used to place a “rake” of streamtraces starting 
from a selected circle geometry. To place a rake of streamtraces in a circular 
pattern, create one or more circle geometries and place them where you want 
the streamtraces to start. Then, select the circle geometries you want 
streamtraces to emanate from, and launch the Circle Stream tool from the 
Tools menu. Select the direction you want the streamtraces to travel in the 
Circle Stream dialog

See also: Chapter 14 “Streamtraces” on page 233.

29- 3.3 Create Multiple Frames
Use the Create Multiple Frames add-on to make a set of new frames with uniform size and spacing 
within the current frame. The total number of new frames will be the product of the frames across 
and the frames down.

To set the number of streamtraces that are placed 
around the circle, edit the Number of Sides field in 
the Geometry dialog (double-click on the circle to 
call up the Geometry dialog).
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The Create Multiple Frames dialog has the following 
options:

•  Frames Across - Enter the number of frames to 
be made in each row of frames.

•  Frames Down - Enter the number of rows of 
frames.

•  Space Between Frames - Enter the amount of 
space to be used between each frame in each direc-
tion, in paper ruler units.

See “Frame Creation” on page 65 for information on creating a single frame.

29- 3.4 Create Finite-Element Sub-Zone
Selecting the Create SubFEZone option from Tecplot’s Tools menu allows you to create a finite-
element zone containing all elements that are completely visible in the current frame. This option is 
only available for 2D Cartesian plot types, and all elements must be of the same type, either trian-
gular or quadrilateral. 

29- 3.5 Export DXF
The DXF Export add-on exports data in DXF (drawing interchange) format. 
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The entity created is dependent upon the data structure (FE or ordered), the data structure type (i.e. 
I-ordered), and the plot type. Table 29-1 displays the conditions required to create each entity type.

Data 
Struc-
ture

Data Structure Type Plot Type Entity 
Created

FE triangle or quadrilat-
eral

3D DXF 3DFACE

FE triangle or quadrilat-
eral

2D, XY, Polar  DXF POLYLINE

FE brick, tetrahedral ALL NONE
Ordere
d

I -Ordered 3D DXF POLYLINE

Ordere
d

IJ or IJK-Ordered 3D DXF 3DFACE

Ordere
d

All 2D, XY, Polar DXF POLYLINE

See also: E- 3.1 “Load DXF File Dialog” on page 640

29- 3.6 Extend Macro
The Extend Macro add-on extends Tecplot’s macro language with macro commands. $!ADDON-
COMMAND ADDONID='extendmcr' has the following command options (called by $!ADDON-
COMMAND ADDONID='extendmcr' COMMAND='commandname parameters' :

Table 29-1. Entities created for DXF export.

QUERY.ZONENAMEBYNUM nnn 
VVV

Get the string for zone nnn and assign to 
variable VVV.

QUERY.MAPNAME-
BYNUM nnn VVV

Get the string for map nnn and assign to 
variable VVV.

QUERY.VARNAME-
BYNUM nnn VVV

Get the string for variable nnn and assign to 
variable VVV

Table 29-2. Command Options for Extend Macro
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QUERY.ZONENUM-
BYNAME “zonename” VVV

Get the number of zone named zonename 
and assign to variable VVV

QUERY.VARNUMBYAS-
SIGNMENT assignment 
VVV

Get the number of variable by assignment 
and assign to variable VVV

QUERY.DATASETTITLE 
VVV

Get the string for the data set title and 
assign to variable VVV

STRING.LENGTH Str-
Source VVV

Get the length of string StrSource and 
assign to variable VVV.

STRING.FINDPATTERN      
StrSource StrPattern VVV

Get the sub-string from StrSource start-
ing at pattern StrPattern and going to 
the end of StrSource. Returns “NOT-
FOUND” if not found.

STRING.SUBSTRING Str-
Source start end VVV

Get the sub-string from StrSource start-
ing at position start and ending at position 
end. Put the result in VVV.

QUERY.ACTIVEZONES 
VVV

Get the set of active zones and put the result in VVV.

Note: The set string does not include any 
blank spaces. If zones 2, 4, 6, 7 and 8 are 
active, VVV would have the string “2, 4, 6-
8.”

QUERY.MAPNAME-
BYNUM nnn VVV

Returns a string (the name of the map) and 
places it in variable VVV. The current plot 
must be XY-Line or Polar-Line.

QUERY.ISADDON-
LOADED ADDONID VVV

 Return “YES” if Add-on ADDONID is 
loaded, otherwise return “NO”

QUERY.FILEEXISTS “file-
name” VVV

 If the file exists, VVV will be “YES” other-
wise VVV will be “NO”

QUERY.ISZONEACTIVE 
ZZZ VVV

Test to see if zone ZZZ is currently active. If 
so, VVV is set to “YES,” otherwise it is set to 
“NO.”

Table 29-2. Command Options for Extend Macro
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VVV may have any of the following values:

•  X - Variable assigned to the X-axis.

•  Y - Variable assigned to the Y-axis.

•  Z - Variable assigned to the Z-axis.

•  U - Variable assigned to be the U-vector component.

•  V - Variable assigned to be the V-vector component.

•  W - Variable assigned to be the W-vector component.

•  C -Variable assigned to contours.

•  S - Variable assigned to scatter sizing.

•  B - Variable assigned to the first constraint for value-blanking.

29- 3.7 Extrude
The Extrude add-on creates a 3D volume or surface zone by duplicating the source zone and trans-
lating it in the Z-direction until the specified number of K-cells are created. If the source zone is a 
surface, a volume zone will be created. If the source zone is a line, a surface zone will be created.

The following options are available:

•Source Zone - Select the surface or line zone defining 
the initial surface or edge.

•Z-Variable - Select the variable which will be incre-
mented to create the volume or surface zone.

•Number of K-Cells - Enter the number of K-cells to be 
added.

•Extrusion Distance - Enter the total distance, in the Z-
direction, that the initial zone is extruded. The Z-distance 
between planes in the Z-direction is (Extrusion Dis-
tance)/(Number of K Cells).
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Macro Processing
The Extrude add-on may be invoked from the macro language by using the following command:

$!ADDONCOMMAND ADDONID = 'Extrude'

COMMAND = “ExtrudeGrid SourceZone=<int> Variable=<int> NumLayers=<int> Distance=<dou-
ble>”

If a variable is not specified in COMMAND, it will use the defaults (SourceZone=1, Variable=3, Num-
Layers=10, and Distance=1.0).

Extrude Example
An example of using Extrude would be to create a cylindrical (open ended) surface by extruding a 
circular line. For simplicity, the circular line will be created as a sub-zone of a 2D, Tecplot-gener-
ated, circular zone.

To do this, perform the following steps:

1. Generate a circular zone by selecting Create Zone>Circular from the Data 
menu. 

2. In the Create Circular Zone dialog, Set K to 1 and click Create.

3. Select the Extrude from the Tools menu. 

4. In the Extrude dialog, set the Extrusion Distance to “5”, use the defaults for the 
other fields, then click OK.
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5. Answer Yes when asked if you want to create the Z-variable. The result is 
shown in Figure 29-5

Figure 29-5. A cylinder created with the Extrude 
add-on.

.

29- 3.8 Prism-Grid
 The Prism-Grid add-on creates a 3D volume grid from a surface grid. (For example, measured 
points defining the bed and banks of a river.) The volume grid, composed of layers of prisms, 
extends from the bottom to the surface. Points in the original surface zone above the specified water 
lever are not used in the definition of the volume grid.
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The following options are available:

•Source Zone - Select the surface zone defining 
the bottom (depth) of the body of water.

•Depth Variable - Select the variable containing 
the water depth in the source zone.

•Positive is Down - Select if the depth variable is 
increasingly positive for increasing depth in the 
source zone. In the final volume zone, increasing 
depth will always be increasingly negative.

•Shift so Surface is Zero - If the water level is 
specified as something other than zero, the depth 
(Z) variable in the volume zone may be shifted so 
that it is zero at the surface of the water.

• Water Level - Enter the water level, where 
negative values indicate that the water level 

is lower than normal.

• Number of Layers - Enter the number of layers of prismatic cells between the 
bottom of the body of water and surface. The number of points in the vertical 
direction is one greater than the number of layers (10 layer will have 11 points 
in the vertical direction).

Macro Processing
The Prism-Grid add-on can be invoked from the macro language by using the following command:

$!ADDONCOMMAND ADDONID = 'Prism Grid'

COMMAND = 'Caricatured SourceZone=<int> DepthVar=<int> NumLayers=<int>

WaterLevel=<double> PositiveDown=<Boolean>

ShiftSurface=<Boolean>'
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The COMMAND string should be on one line. If a variable is not specified in COMMAND, it will use the 
defaults (SourceZone=1, DepthVar=3, NumLayers=10, WaterLevel=0.0, PositiveDown=\'F\', and 
ShiftSurface=\'F\').

Prism Grid Example
An example of using Prism-Grid would be to define the bottom of a body of water. Normally the 
data defining the bottom (depth) of the body of water would be read from a file. In this example, 
however, we generate a rectangular zone with a simple parabolic variation of depth.

To do this, perform the following steps:

1. Generate a rectangular zone by selecting Create Zone>Rectangular from the 
Data menu. 

2. In the Create Rectangular Zone dialog, set XMin to “-1”, YMin to “-1”, and the 
I- and J-dimensions to “50”. Accept the defaults for the rest of the fields.

3.  Open the Specify Equations dialog (accessed via Data >Alter) sub-menu. 

4. Create the depth variable with the equation {Depth} = x**2 + y**2 - 
0.5.

5. Select Prism-Grid from the Tools menu. Accept the defaults and click OK.



Chapter 29:Add-Ons

576

Sections of the surface which are above the water level (zero) are removed, the rest of the surface is 
triangulated, and the volume between the bottom and the water level is filled with ten layers of tri-
angular prisms. The result is shown in Figure 29-6

Figure 29-6. An example of using Prism-Grid.

. 

At this point, experimental data, such as water temperatures or velocities, could be interpolated to 
the volume data and iso-surface, slices, or streamtraces could be generated.
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29- 3.9 Sort
The Sort add-on sorts the values of a data set using one variable as a key. Additional variables can 
be selected in order to further define how the data is sorted. Sort will only work with ordered 
data. 

• Sort Type - Data may be sorted in either ascending or descending order. 

• Sort Option - 

• In Place - the data will be sorted within its current zone. 
• To Zone - the sorted data will be placed in a new zone or zones. The 

original data will not be altered. There will be a new I-ordered zone 
created for each zone sorted.

Macro Language
While recording a macro, a macro function is recorded for Sort upon a successful sort operation. 
Sort uses the macro command $!ADDONCOMMAND. See the Tecplot Reference Manual for 
additional information.

An example of the syntax of $!ADDONCOMMAND for Sort is:

$!ADDONCOMMAND ADDONID = 'sort'
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COMMAND = 'Z=1,Z=3,V1=4,V2=5,V3=2,Increasing,ToZone'

The above command sorts zones 1 and 3, using variable 4 as the key. If variable 4 has values that 
are equal, variable 5 is used to determine the order. Likewise if variable 5 has equal values, variable 
2 is used to determine the proper order. If variable 2 also has equal values, the original order of 
variable 4 is used. The data will be sorted in increasing order, and it will be sorted to a zone.

Syntax of COMMAND

Each zone that is to be sorted will have the syntax Z={zone num}, multiple zones may be speci-
fied in the same COMMAND. The key variable is V1={key}, the secondary variable is V2={key 
2}, and the final key is V3={key 3}. The sort type is either Increasing or Decreasing. 
Finally, the sort options are either InPlace or ToZone, these options must be spelled as one word, no 
spaces. For all options, case is ignored. All the variable keys default to variable 1. The default for 
Sort Type is Increasing, the default for Sort Option is ToZone.

29- 3.10 Statistics Calculator
The Statistics Calculator extends Tecplot’s capability to compute simple descriptive statistics. It 
computes mean, median, variance, standard deviation, average deviation, geometric mean, and chi 
square.

Statistics are computed for the current frame only. A frame must be selected, and contain a data set 
in order for the Statistics Calculator to perform a computation.

The Statistics dialog has the following options:
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• Select a Statistic - Select one or more statistics by activating the associated 
toggle button. Calculations are not affected by value blanking.

• Select a Format - The Statistics Calculator can display results in two formats: 
scientific notation and fixed floating point. The scientific notation format has 
three digits of precision, while the floating point format has five digits of preci-
sion. If any statistic has a magnitude greater than 1010, and less than infinity, 
the format will automatically revert to scientific notation.

• Select All Zones or Active Zones/Maps - The Statistics Calculator includes 
all variables in its calculation, select which zones to apply the calculations to 
using: All Zones or Active Zones/Maps.

• All Zones - When enabled, Statistics Calculator uses data points from 
all zones in the current frame.

• Active Zones/Maps - When enabled, Statistics Calculator only uses 
data points from the active zones. Zones can be activated and deacti-
vated through the Zone Style dialog. When working with Lines, Statis-
tics Calculator computes the statistics for the zones referenced by the 
active mappings.

• Compute Button - When Compute is clicked, the Statistics Output dialog is 
launched. The format of the output is dependent on the choices made on the 
main Statistics dialog. The scroll bars may be used to see all the statistics. The 
output is limited to 2,100 statistics, which translates to 300 variables if all 
seven statistics are calculated. This value is defined in the file stats.c, the vari-
able is MAXSTATS.

• Write Output to File Button - The Write Output to File button is on the Statistics 
Output dialog. Clicking this button will launch the Save Text File dialog. The 
data will be saved in ASCII format and will appear as seen on the Statistics 
Output dialog.

Macro Language
While recording a macro, a macro function is recorded for the Statistics Calculator upon success-
fully writing output to a file. The Statistics Calculator uses the macro command $!ADDONCOM-
MAND, see the Tecplot Reference Manual for additional information. An example of the syntax of
$!ADDONCOMMAND for the Statistics Calculator is as follows:

$!ADDONCOMMAND
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ADDONID = 'stats'
COMMAND = 'Mean,Median,SD,GeoMean,ChiSquared,ActiveZones,Scientific, 
AUX,FNAME=myfile.txt'

Syntax of COMMAND

The only required portion of COMMAND is the file name. If the file name is not specified or not valid, 
an error message will be displayed and the macro will abort. The file name must be preceded by the 
string 'FNAME=' similar to the example above. The word 'FNAME' must be followed by an equals 
sign (=). If the string 'FNAME=' is missing or misspelled, the macro will display and error message 
and abort.

If the All/Active Zones or Scientific/Float options are left out, a warning message will be dis-
played and the default values of All Zones and Scientific Notation will be used. The order of 
the string does not matter. All items must be delimited by commas, spaces between items do not 
matter. Any statistic either not specified, or misspelled will not be calculated. If no statistics are 
specified in the string, all statistics will be calculated.

The spelling and capitalization for each item is as follows (case is ignored):

•  Mean- Mean.

•  Median- Median.

•  Variance- Variance.

•  Standard Deviation- SD.

•  Average Deviation- AvgDev.

•  Geometric Mean- GeoMean.

•  Chi Squared- ChiSquared.

•  All Zones- AllZones.

•  Active Zones/Maps- ActiveZones.

•  Scientific Notation- Scientific.

•  Floating Point- Float.

Statistics Calculator Formulas
The formulas used for the statistics calculator are as follows. In each case, X represents the data set, 
n represents the total number of points in the data set, and Xi represents a given point in the data set 
(where i = 1, ..., n). 
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• Mean 

X 1
n
--- Xi

i 1=( )

n

∑=

• Median - middle quantitative value of a data set.

• Odd N - If the data set contains an odd number of data points, the data 
point in the middle of the sorted data set determines the median. How 
the median is determined for data sets containing an odd number of 
data points is described by the formula:

• Even N - If the data set contains an even number of data points, the 
value is determined by the average of the two central data points. How 
the median is determined for data sets containing an even number of 
data points is described by the formula:

• Variance - Variance is the sum of the squares of the deviations of the sample 
values from the mean, divided by n-1. It measures the dispersion, or variance, 
of the sample values from the mean. Variance is calculated by the formula:
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• Standard Deviation - Standard deviation is the square root of the variance. 
Standard Deviation is calculated by the formula:

σ 1
n 1–( )

--------------------- Xi X–( )

i 1=

n

∑=

• Average Deviation - Average deviation is the sum of the magnitudes of the 
deviations of the sample values from the median, divided by n. Average Devia-
tion is calculated by the formula:

Xaveragedeviation
1
n
--- Xi Xmedian–( )

i 1=

n

∑=

• Geometric Mean - Geometric mean is the nth root of the product of a series. If 
any value of the data set is zero, the result will be zero. For large data sets, or 
data sets with large values, this statistic will overflow. Geometric Mean is cal-
culated by the formula:

Xgeometricmean

Xilog
i 1=

n

∑
n

-----------------------=

The geometric mean can also be described by the use of logarithms. The repre-
sentation of the geometric mean, as seen below, is used by the Statistics Calcula-
tor. Given the formula geometric mean, it is easy to see that if any value of the 
data set is zero, the geometric mean is zero. Although the logarithm of zero is 
undefined, the Statistics Calculator will return zero if any member of the data set 
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is equal to zero. Likewise, the geometric mean is only useful for data sets with 
all positive members. If any member of the data set is negative, the Statistics 
Calculator will return infinity for the geometric mean.

• Chi Squared - Chi Squared is the measure of how close observed values were 
to expected values. The smaller the result, the closer the observed values are to 
the expected values. Chi Squared assumes a contingency table of one column 
and n rows, where n is the number of data points for the particular variable. The 
expected value is assumed to be the mean. If the mean is zero, Chi Squared will 
return infinity. Chi Squared is calculated by the formula:

Xchisquared
Xi X–( )2

X
----------------------

i 1=

n

∑=

29- 3.11 Tecplot GUI Builder
The Tecplot GUI Builder is used to generate graphical user interfaces for Tecplot add-ons. You will 
commonly start with the file, gui.lay, which was created by default if you used the Add-On 
Wizard or CreateNewAddOn shell scripts to create your add-on. To build an interface, open this 
layout file in Tecplot and add an assortment of controls to modal or modeless dialogs. Refer to the 
ADK User’s Manual for more information on working with the Tecplot GUI Builder.

29- 3.12 Tetra-Grid
The Tetra-Grid add-on takes well data and generates a tetrahedral mesh. Value-blanking may be 
used to eliminate wells and/or data points within wells.

The following requirements must be met for Tetra-Grid to work:

•  The wells must be I-ordered zones.

•  There must be at least three wells.

•  Each well must contain at least two data points that are not blanked.

Xgeometricmean( )log Xi

i 1=

n

∏
⎝ ⎠
⎜ ⎟
⎜ ⎟
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1
n
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The Tetra-Grid dialog contains a list of I-ordered zones in the current data set. Choose the zones 
you want to use and click OK. The tetrahedral zone will be created and added to the end of the list 
of zones. You must activate this zone yourself.

As an example of using Tetra-Grid, say data for five different wells has been collected. Some wells 
have three data points, others have four. The data for each well is assigned to a separate I-ordered 
zone in Tecplot.

The input data is:

VARIABLES = "Easting (m)" "Northing (m)" "Elevation (ft)"
ZONE T= "41-14-08" I=3, J=1, K=1,F=POINT
 3.437500000E+00 9.375000000E-02 2.819946289E+00
 3.375000000E+00 9.375000000E-02 1.811889648E+00
 3.437500000E+00 9.375000000E-02 8.199462891E-01
ZONE T= "41-14-09" I=4, J=1, K=1,F=POINT
 2.687500000E+00 1.796875000E+00 2.212158203E+00
 2.687500000E+00 1.796875000E+00 1.500000000E+00
 2.437500000E+00 1.796875000E+00 1.179992676E+00
 2.375000000E+00 1.796875000E+00 1.799926758E-01
ZONE T= "41-14-11" I=3, J=1, K=1,F=POINT
 1.875000000E+00 4.000000000E+00 2.509948730E+00
 1.875000000E+00 4.000000000E+00 1.509948730E+00
 1.812500000E+00 4.000000000E+00 5.018920898E-01
ZONE T= "41-15-02" I=4, J=1, K=1,F=POINT
 0.000000000E+00 2.375000000E+00 2.089965820E+00
 0.000000000E+00 2.375000000E+00 1.089965820E+00
 0.000000000E+00 2.375000000E+00 5.089965820E-01
 0.000000000E+00 2.375000000E+00 8.996582031E-02
ZONE T= "41-15-03" I=3, J=1, K=1,F=POINT
 1.250000000E+00 0.000000000E+00 2.000000000E+00
 1.500000000E+00 0.000000000E+00 1.016113281E+00
 1.250000000E+00 0.000000000E+00 4.687308319E-10
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The wells do not have to be vertical or even straight. The resulting plot is shown in Figure 29-7. 
The figure shows the wells before and after running Tetra-Grid. A slice is added to the plot with the 
new tetrahedral mesh to show how you can demonstrate volume properties with the new zone.

Figure 29-7. Tetra-Grid example. The original well data (A), tetrahedral zone from the 
well data (B) 

Macro Processing
The Tetra-Grid add-on can be invoked from the macro language by using the following command:

$!ADDONCOMMAND ADDONID = 'Tetra Grid' COMMAND = “SOURCEZONES = zoneset”

Where zoneset is the set of I-ordered zones to use to generate the tetrahedral zone. Zoneset is spec-
ified using the standard set notation for the macro language.

29- 3.13 View Binary
The ViewBinary add-on allows you to view the information in a Tecplot binary data (.plt) file.
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The ViewBin dialog has the following option:

• Show Raw Data - Select this option to view zone data.

On some machines the font used to display the header information may not be a mono-pitched font 
and consequently some of the results may not line up directly below the table header. 

29- 3.14 Write Data as Formatted Text
Data from an XY Line Plot will be written to a text file with the format *.csv for comma separated 
data or *.txt for any other data separators.

All frames with an XY Line Plot style are listed under Choose XY Frames. You can choose whether 
frame names, variables names and additional text from the data will be included in the text file. 
Values will be written in the “best format”, except variables named Time or Date.  

The following options for choosing frames to write are allowed:

• Current Frame

•  Select whether to include data from all data sets (zones), or select data 
sets from the list.

• Select whether to include all variables, or select variables from the list.
• If you toggle-off All for data sets or variables, but you do not select 

anything from the list, all will still be written.
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• Selected Frames - Because different frames may have different data sets and 
different variables, the user is not allowed to select data sets or variables.  All 
data sets and all variables will be written for each frame selected.

• All - Because different frames may have different data sets and different vari-
ables, the user is not allowed to select data sets or variables.  All data sets and 
all variables will be written for each frame.
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Appendix A Command Line Options

A - 1 Tecplot Command Line
The general form of the Tecplot command line is:

tecplot [options] [layoutfile] [datafiles] [macrofile] 
where: 

[layoutfile] - file with extension *.lay or *.lpk. See also 22 - 1 “Layout Files, Layout Package 
Files, Stylesheets” on page 448.
[datafiles] - one or more data files. If both a layout file (*.lay only) and data files appear on 
the command line, Tecplot substitutes the data files referenced in the layout file with the data 
files listed in the command line.
[macrofile] - macro file name. See also Chapter 25 “Macro Commands” on page 498.
[options] is one or more of the following:

-addonfile filename Load add-ons listed in filename.
-b Run Tecplot in batch mode (-p option is also 

required).
-c cfgfile Use cfgfile for the configuration set up instead 

of the default configuration file. 
-d or -display computer-
name

Displays Tecplot on computer computername 
(UNIX only). The computer, computername, 
must have X-server capability with the GLX 
extension.

-datafile filename load a data file “as-is”, the “+” character is not 
processed

-datasetreader reader-
name

Instruct Tecplot to use the data set reader read-
ername when loading data files specified on the 
command line. See Section A - 4, “Specifying 
Data Set Readers on the Command Line,”for 
details.
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-debug dbugfile Send debug information to the file dbugfile. 
Information is displayed to aid in debugging a 
new Tecplot configuration file, macro file, or 
binary data file. You may specify the minus 
sign (“-”) for dbugfile to send the debug output 
to the “standard output” (UNIX only). 

-demo Run Tecplot in demo mode (only reads demo 
files).

-develop Launch Tecplot in a mode used to develop add-
ons (UNIX only).

-f fontfile Use fontfile for the font file instead of the 
default font file tecplot.fnt. 

-h homedir Use homedir for the Tecplot home directory 
instead of the default home directory or the 
directory stored in the operating system envi-
ronment variable TEC360HOME. 

-loadaddon “addon-
name”

Load add-on addonname.

-loadaxaddon “axaddon-
name”

Load Active-X add-on axaddonname (Win-
dows only).

-m cmapfile Select initial color map file to load.
-n List node information (UNIX only).
-nobatchlog Suppress creation of the file batch.log dur-

ing batch mode operation.
-nostdaddons Do not load add-ons in tecplot.add.
-notoolbar run tecplot with the toolbar deactivated
-p macfile Play the macro in the file macfile. Note that if 

your macro file has an .mcr extension you do 
not need to use -p. 

-q Use quick playback mode. Ignores delay and 
pause commands. 
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-qm quickpanelfile Load macro functions for the Quick Macro 
Panel from quickpanelfile instead of the 
default file tecplot.mcr.

-r prtfile Set the default file name for routing Print Files 
to prtfile. This name can be reassigned interac-
tively while running Tecplot.

-s stylfile Use stylfile as a stylesheet for the first Tecplot 
frame.

-showpanel Show the Quick Macro Panel immediately 
when Tecplot starts up.

-v Print version number of Tecplot.
-x Run Tecplot full screen.
-y exportfile Same as -r except for exported files. 

-z Show to macro viewer (allows you to see macro 
commands prior to their launch).

Most of the Tecplot command line options 
are available in Windows. To use them, 
you should start Tecplot from the Run 
command or the command prompt

Command Line Input Result
tecplot run Tecplot without pre-loading any 

data files
tecplot ex1.plt run Tecplot loading the data file 

ex1.plt as the first data set
tecplot ex1.plt ex2.plt ex3.plt run Tecplot loading the data files 

ex1.plt, ex2.plt, and ex3.plt 
as the first data set

Table 1-1. Tecplot Command Line Examples
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A - 2 Using Command Line Options in Windows Shortcuts
All of the command line options that can be entered at the DOS or Command prompt by using the 
Run command can also be used in a Windows shortcut.

tecplot -h /usr/myhome -c /usr/
myhome/myset.cfg

 run Tecplot using /usr/myhome 
as the Tecplot home directory and 
loading the Tecplot configuration 
file /usr/myhome/myset.cfg

tecplot sumtr1.lay run Tecplot using layout file 
sumtr1.lay

tecplot calc.lay temp.plt read a Tecplot layout file calc.lay 
and replace the first data set refer-
enced in the layout file with the data 
file temp.plt

tecplot t.lay a.plt b.plt+c.plt if the layout file t.lay has two 
frames and the two frames reference 
different data sets. This will start 
Tecplot, load t.lay, and have frame 
one use the data set defined in a.plt 
and have frame two use the data set 
defined by loading in b.plt and 
c.plt together

tecplot amt.lay 
ds1a.plt+ds1b.plt ds2.plt 
ds3a.plt+ds3b.plt

In this case, the files ds1a.plt and 
ds1b.plt a re combined and replace 
the first data set, ds2.plt replaces 
the second data set, and ds3a.plt 
and ds3b.plt are combined to 
replace the third data set in 
amt.lay.

Command Line Input Result

Table 1-1. Tecplot Command Line Examples



Command Line Options

594

If you frequently run Tecplot using the same command line flags, it may be useful to create a 
shortcut on your Windows desktop that launches Tecplot with the desired command line flags. 
Here's how this can be done:

1. Right click in any blank space on your Windows desktop.

2. Select New>Shortcut from the resulting Menu.

3. In the Create Shortcut dialog, type the location of the Tecplot executable, 
along with any command flags you want to specify. An example command 
line is:

"C:\Program Files\TEC360\BIN\Tecplot.exe" -p C:\Me\mymacro.mcr

4. Click Next.

5. Select a name for your shortcut, then click on Finish. 

6. A new shortcut icon will be placed on your Windows desktop.

A- 2.1 Changing Shortcuts
You can alter an existing shortcut by doing the following:

1. Right-click on the shortcut icon you want to change and select Properties.
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2. On the Shortcut page, modify the command line by changing the setting for 
Target. To change the working directory that Tecplot runs under, change the 
Start in location.

A - 3 Additional Command Line Options in Unix
Under UNIX, you can use additional command line flags which are passed to the window manager 
to control how the application window is displayed. These include -geometry (for specifying the 
location and position of the application window), -fg and -bg (for specifying foreground and 
background window colors), and others. See the X11 reference for your system for complete details 
on these options.

To determine the path or alias that the tecplot command calls, you would use:

which tecplot
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A - 4 Specifying Data Set Readers on the Command Line
Special care should be taken when using the -datasetreader option on the command line. The 
following rules apply if -datasetreader is used:

• The -datasetreader flag must be followed by the data set reader name 
and then immediately followed by a space separated list of commands to be 
passed on to the data set reader. No further Tecplot options are allowed after 
this point.

• The data set reader name must be placed in quotes if it contains spaces.

• Only one data set reader can be specified on the command line.

• If a layout file is also specified (prior to -datasetreader) then you can 
only override the first data set load instructions referenced in the layout file.

Following is an example:

Suppose you have a layout file (mylayout.lay) that uses the PLOT3D loader. To launch Tec-
plot via the command line and override the PLOT3D load instructions use:

   tecplot mylayout.lay -datasetreader "plot3d loader" -ISET 1,,5 -b 
-3DW -GF blunt.g

Everything from the -ISET parameter and following are instructions to be sent to the PLOT3D 
loader. Note that the instructions themselves are not entirely contained within any quotes. If your 
data reader requires instructions that themselves contain spaces then you must surround those 
instructions with quotes.
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Appendix B Tecplot Utilities

The following utilities are included with the Tecplot distribution:

• Excel Macro - allows you to load Excel spreadsheet data directly into Tecplot

• Framer - A shareware utility for viewing Raster Metafile animations created 
by Tecplot.

• LPK View - A utility to catalog, preview or unpack a layout package file into 
its component data and layout files.

• Preplot - A utility to convert an ASCII data file into a Tecplot binary file.

• Raster Metafile to AVI (rmtoavi) - A utility to convert a Raster Metafile anima-
tion into an AVI animation.

• Pltview - A utility to view the header information for a Tecplot binary file.

B - 1 Excel Macro
The Excel Macro provides a convenient way to load data directly from your Excel spreadsheet into 
Tecplot. When loaded it adds an option to Excel’s Tools menu called Tecplot, and a toolbar 
containing a button marked Tecplot. Both launch Tecplot and load the data in the highlighted region 
of the spreadsheet. The Excel macro offers many advantages over the Excel loader in Tecplot 
(accessed from the Load Data File(s) option from the File menu).

These include:

• Highlight and Plot - The Excel macro is easier to use than the conventional 
Excel loader. Click in the upper left cell of the region or highlight the entire 
region, and then click on the Tecplot button in the tool bar or on the Tecplot 
option in Excel’s Tools menu.

• Multiple Zones - The Excel Macro makes loading multiple zones much easier. 
Highlight the entire region and then click on the Tecplot button in the tool bar 
or on the Tecplot option in Excel’s Tools menu. If your zones are separated by 
blank rows or columns, then the macro will load them to Tecplot.
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• Formulas - The highlighted region of the spreadsheet can contain formulas, or 
can be created entirely with formulas. The current Excel loader (using the Load 
Data File option from the File menu) does not work where formulas are present.

A Read Me file, located in the Util/Excel directory, further describes installation and use of 
this macro.

As an example, let’s say you have 3D data obtained by drilling a number of wells and measuring 
contaminant concentrations of various chemicals at different depths. Your data is in Excel, and you 
want to load the data into Tecplot to get a visual representation of the contamination. The data has 
nine variables and twenty-seven zones, as shown in Figure B-8.

Figure B-8. The beginning well data displayed in Excel.

Perform the following steps to import your data and visualize the contaminant plumes:
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1. Load your Excel data using the new Excel macro. (Accessing this dialog is 
shown in Figure B-9))

Figure B-9. Accessing the Excel Loader macro via Excel’s 
menu bar.

 

2. Starting with the top left-hand cell, highlight all twenty-seven zones and nine 
variables.

3. Click on Tecplot in Excel’s Tools menu. The menu option launches Tecplot 
with the selected data loaded.

Make sure you have a blank row separating 
the zones in Excel.
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4. Switch to 3D Cartesian plot mode to see the location and measurement depths 
of the well samples. The resulting plot is shown in Figure B-10.

Figure B-10. The Excel well data plotted in Tecplot.

 Your wells 

have different depths, so the number of measurements are not the same for 
each well (there are only three measurements at well five).

B - 2 Framer
To launch Framer from a command line, use the following command: 

framer [options] [rmfile] 
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where [rmfile] is the name of a file containing Raster Metafile bitmaps created by Tecplot, and
[options] is one or more of the following:

-b [nf] Use buffered mode. Framer reads nf frames into 
memory and displays only those frames. Frames not 
read are not displayed. This mode displays images 
much faster, but requires extra memory. If nf is not 
specified, Framer reads as many frames as possible 
up to the total limit on frames (see -max parameter).

-c nc Use no more than nc colors (X-Windows only). On 
some machines, you may need to use “-c 128” to 
allow two copies of Framer to run at the same time.

-cycle nn Start Framer in “cycle” mode (as if C were pressed), 
and continue for nn complete cycles, and then exit.

-d dfile Send debug information to dfile. Use “-d2,” “-d3,” 
“-d4,”, etc., for more detailed debug information.

-f start,end,skip Display frames starting with frame number start 
and ending with frame number end, skipping by 
skip frames.

-g Use gray scale
-help Print help information.
-loop nn Start Framer in “loop” mode (as if L were pressed), 

and continue for nn complete loops, and then exit.
-m Allow for multiple color maps. Without this flag, 

Framer assumes the first color map in the Raster 
Metafile is valid for all images in that file.

-max nn Specify upper limit on total number of images in the 
Raster Metafile. The default value is 512.

-noinfo Do not print initial copyright notice, help info, or 
count of buffered frames.
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If you do not specify a file name, Framer prompts you for one. You can choose to set buffering 
(equivalent to the -b flag) and/or multiple color maps (equivalent to the -m flag).

While Framer is running, you can press the following keys to control it:

-p ms Pause at least ms milliseconds between each frame. 
This does not affect the rate of the single frame keys 
(+ and -). 

-s Use only a single color map for all images in the file. 
This option may result in better performance and 
reduce flickering on some platforms. However, 
image files that use multiple color maps will not be 
displayed correctly.

-w wc Width correction. (Use “-w -1” for Tecplot Version 
4 images.)

-x Run full screen.

B Move backward through frames (or left mouse button).
C Cycle forward and backward through frames.
F Move forward through frames (or middle mouse button on a three-

button mouse or right mouse button on a two button mouse).
L Loop repeatedly forward through frames.
Q Quit Framer (or right mouse button on three button mouse) or 

Escape key.
S Stop cycling or looping (or spacebar).
R Redraw the current frame.
1 Move to the first frame.
+ Move forward one frame.
- Move backward one frame.
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On Windows platforms, these Framer commands are also available from the Go and Step menus. 
See also Section 27- 5.3, “Raster Metafiles Viewing in Framer,”

B - 3 LPK View
As a convenience a command line utility, lpkview, is provided to catalog and unpack layout 
packages. In its simplest form (when no options were included), the utility to unpack the preview 
image (if present), the layout, and all associated data files into the directory in which the utility was 
run. 

For example:

    lpkview myplot.lpk

might unpack the following files in the current directory:

    myplot.png 
    myplot.lay 
    myplot_1.plt 
    myplot_2.plt 
    myplot_3.plt

Tecplot determines the names for unpacked files when the package is created. Tecplot eliminates 
name conflicts within the package by appending unique numbers to non-unique names. However, 
no attempt is made by lpkview to ensure that names are unique with other files located in the 
directory where the items are unpacked.

The utility's syntax is as follows:

    lpkview [[-t] | [-ild] | [[-c <preview command>] -p]] filename

< Increase the minimum delay between frames by 50 milliseconds. 
This decreases the speed at which frames are displayed.

> Decrease the minimum delay between frames by 50 milliseconds. 
This increases the speed at which frames are displayed.
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Brackets ([]) surround optional parameters and the vertical bar (|) separates one mutually exclu-
sive set of options from another. The options are described as follows:

-t Show table of contents.
-i Extract image (for example, a Portable Network Graphics or 

.png format).
-l Extract layout.
-d Extract data.
-c (UNIX only) Specify preview command.
-p (UNIX only) Preview image.

Option -t may not be used with any other options, and options -i, -l, and -d may not be used 
with options -c and -p. If no command line options are specified -i, -l, and -d are assumed by 
default.

Note: (UNIX only) if the -p option is specified without specifying a preview command, -c, the 
following default preview command is used:

        $MOZILLA_HOME/netscape -remote “OpenURL(%s)”

where %s is substituted by lpkview with the file name of the temporarily extracted preview 
image. The default command assumes: the environment variable $MOZILLA_HOME is set, 
Netscape is installed under $MOZILLA_HOME, and that lpkview has been added to Netscape as 
a helper application.

To add lpkview as a helper application, bring up Netscape's Preferences dialog and select the 
Applications page. Within the Applications page select New and add lpkview as a new helper 
application by entering the following information:

Description-<optionally leave this blank>
MIMEType- application/x-tecplot-lpk
Suffixes- lpk
Handled By- <select “Application”>
Application- $TEC360HOME/bin/lpkview -p %s

If you choose to specify your own preview command, there are several requirements:

•  The path to the preview command must be fully specified.
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•  If relative, it must be located in one of the directories specified in your $PATH
environment variable

•  The command must contain a %s that can be substituted by lpkview with the file 
name of the temporarily extracted preview image.

For example, if you want the preview command to be the UNIX file utility. Then, running the 
following command:

        lpkview -c "file %s" -p myplot.lpk

might produce the following output:

        /var/tmp/aaaa005L7:    data

Where file /var/tmp/aaaa005L7 is the temporarily extracted preview image. The temporary 
file is removed as soon as the preview command completes.

B - 4 Preplot
The following options are used with standard Tecplot data files:

-d Turn on debug echo. Use -d2, -d3, -d4 for more detailed 
debug information.

-r Reverse the bytes of the output binary data file (generally not 
required).

-iset [zone], [start], [end], [skip]
Create the binary data file using only the specified range and 
skipping for the I-index. The zone parameter specifies which 
zone this option affects; if not specified, all zones are affected. 
The start parameter is the starting I-index; the default is one. 
The end parameter is the ending I-index; the default is the last 
index value. The skip parameter specifies the I-interval, that is, 
the distance between indices; one means every index is used, 
two means every other index, and so on. 
For example, -iset 1, 3, 7, 2 indicates that for zone 1 only 
I-index values of 3, 5, and 7 are used. Only one -iset option is 
allowed per zone.
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The following options are used with PLOT3D data files:

-jset [zone], [start], [end], [skip]
Same as -iset above, except with respect to the J-index.

-kset [zone], [start], [end], [skip]
Same as -iset above, except with respect to the K-index.

-zonelist start[:end[:skip]], ...
Specify the zones to process. You may supply more than one 
specification. By default Preplot processes all zones.

-d Turn on debug echo. Use -d2, -d3, -d4 for more 
detailed debug information.

-r Reverse the bytes of the output binary data file (generally 
not required).

-plot3d Input file is in PLOT3D format. This flag is required for 
PLOT3D data.

-b Input file is binary.
-f Input file is binary-FORTRAN, that is, there are record 

markers.
-foreign Reverse bytes of input file.
-function The .q file is a .f file.
-functionandq There are both .f and .q files present.
-gridonly Read grid variables only.
-i Input file includes PLOT3D IBLANK variable.
-m Input file is multi-grid (usually more than one grid 

block).
-ip ilist Extract planes of constant i for all i in ilist. (Requires 3D 

whole data.)
-jp jlist Extract planes of constant j for all j in jlist. (Requires 3D 

whole data.)
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Raster Metafile to AVI (rmtoavi)

See also: ASCII Data File Conversion in the Data Format Guide.

B - 5 Raster Metafile to AVI (rmtoavi)
The rmtoavi utility will convert a Raster Metafile animation to an AVI animation. The following 
is a description of the utility's syntax. Brackets ([]) surround optional parameters. Options must be 
specified separately.

 rmtoavi [options] filename[.rm] [outputfilename]

Filename is the name of the Raster Metafile to convert. Only one file name may be specified. The 
input file must end with the.rm extension.

The [outputfilename] is the name of the converted output AVI file. If the output file name is not 
specified, the input file name is used with an.avi extension. If any of the file names contain 
spaces, they must be enclosed in quotes.

For example, the command rmtoavi test.rm will create the file test.avi. If the output file 
exists, rmtoavi will prompt to overwrite it unless the -y option is used (see below).

The [options] are described as follows

-kp klist Extract planes of constant k for all k in klist. (Requires 3D 
whole data.)

-1d Input PLOT3D file is 1-D.
-2d Input PLOT3D file is 2D.
-3dp Input PLOT3D file is 3D planar.
-3dw Input PLOT3D file is 3D whole.

-help Prints help information.
-q Suppress startup banner and information message.
-y Suppress query to overwrite an existing AVI file.
-d [nn] Progress indicator. This prints a dot (.) every [nn] 

frames processed. If [nn] is not specified, it 
defaults to ten.
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B - 6 Pltview
Pltview is a command line utility to examine the header information for binary Tecplot data files. 
An example session using the pltview utility is shown in Figure B-11.

Figure B-11. The Pltview utility.

-m Use multiple color palettes in the converted AVI file. 
Each frame of an AVI or Raster Metafile animation 
is limited to 256 colors. AVI animations can use 
either one set of 256 colors for the entire animation 
or a separate set of 256 colors for each frame. If you 
use the -m option, then each frame of the output AVI 
file will use a separate set of 256 colors. Since color 
information is read from the input Raster Metafile, 
this option only affects the output AVI animation if 
the Raster Metafile was originally exported using 
multiple color palettes. 

-speed nn Sets the speed of the output AVI file to nn frames 
per second. The default is ten.
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Appendix C Keyboard & Mouse 
Shortcuts

Extended Mouse Operations
The middle and right mouse buttons are powerful tools you may use to immediately zoom and 
translate your data without having to switch to the Zoom or Translate tools on the toolbar. This 
advanced mouse/keyboard functionality is available when using any 3D rotate, Contour, Geometry 
(except Polyline), Probe, Slice, Streamtrace Placement, Translate, Zoom, or Zone Creation tools. If 
you have a two button mouse use the CTRL key in conjunction with the right mouse button to 
achieve middle mouse button capabilities.

The following table lists all of the capabilities of the middle and right mouse buttons, when the 

active mouse tool is the “Selector” or the “Adjustor”.

On Unix platforms, Num Lock interferes 
with keyboard shortcuts.

Action Middle Button/
CTRL+Right Button Right Button

Click Redraw. If the pointer is in the current 
frame then the current frame is redrawn. 
Otherwise, redraw all frames.a

Switch from the 
current tool to 
the Selector.b
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Some toolbar buttons have special capabilities tied to mouse buttons or keyboard key and are listed 
below:

Drag Smoothly zoom in or out. An upward 
motion zooms out. A downward motion 
zooms in.

Translate.

Alt-Drag In 3D Cartesian plots, move the viewer 
further from (upward motion) or closer 
to (downward motion) the object. In all 
other plot types, this behaves like the 
Drag action

Same as the 
Drag action.

a. This is the default action for a click. It may be configured with the                                      
$!INTERFACE MOUSEACTIONS {MIDDLEBUTTON... command.

b. This is the default action for a click. It may be configured with the                                      
$!INTERFACE MOUSEACTIONS {RIGHTBUTTON... command.

Action Middle Button/
CTRL+Right Button Right Button
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3D Rotate tools: 

Contour Add tool: 

Contour Remove tool: 

Drag Rotate about the defined rotation origin with the active 
Rotate tool

Alt-Drag Rotate about the viewer position using the active Rotate 
tool.

C Move rotation origin to probed point, ignoring zones.
O Move rotation origin to probed point of data.
R Rollerball rotation.
S Spherical rotation.
T Twist rotation.
X X-axis rotation.
Y Y-axis rotation.
Z Z-axis rotation.

Alt-Click Place a contour line by probing on a streamtrace, slice, or 
iso-surface.

Click Place a contour line.
CTRL+Click Replace the nearest contour line with a new line.
Drag Move the new contour line.
- Switch to the Contour Remove tool.

Click Removes the contour line nearest to the probed location.
+ Switch to Contour Add tool if you are using Contour 

Remove.
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Geometry Polyline tool: 

Probe tools.

A Allow translation of polyline segments in all directions.
H Restrict translation of current polyline segment to hori-

zontal.
U Pen up, while drawing polyline.
V Restrict translation of current polyline segment to verti-

cal.

Click If the pointer is over a valid cell, the interpolated 
field values from all nodes in the cell are 
returned.
If multiple cells are candidates:
for 2D, the cell from the highest number zone is 
used
for 3D,the cell closest to the viewer is used.

CTRL+Click If the pointer is over a valid cell, the field values 
from the nearest node in the cell are returned.
If multiple cells are candidates:
for 2D, the cell from the highest number zone is 
used
for 3D, the cell closest to the viewer is used. 
If the pointer is not over any cell then the field 
values from nearest data point as measured in 
distance on the screen are returned.
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Shift-CTRL+Click The field values from the nearest point on the 
screen is returned (ignoring surfaces, zone num-
ber and depth of the point). 
This is useful in 3D for probing on data points 
that are on the back side of a closed surface 
without having to rotate the object. In 2D this is 
useful for probing on data points for zones that 
may be underneath other zones because of the 
order in which they were drawn.

Alt-Click Same as Click except zones are ignored. (Probe 
only on streamtraces, iso-surfaces, or slices.)

Alt-CTRL+Click Same as CTRL+Click zones are ignored. (Probe 
only on streamtraces, iso-surfaces, or slices.)

Alt-CTRL+Shift-Click Same as Shift-CTRL+Click except zones are 
ignored. (Probe only on streamtraces, iso-sur-
faces, or slices.)

T, R
X, Y

When probing, press R or T on your keyboard to 
switch dependencies in Polar Line or X or Y in 
XY Line.
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Slice tools: 

Streamtrace Placement tools (3D Cartesian plots only): 

+ Turn on the start slice if no slices are active, or 
turn on the end slice if slices are already active.

- Turn off the end slice if the end slice is active, or 
turn off the start slice if the end slice is not 
active.

Click Place a start slice.
Drag Move the start slice.
Alt-click/Alt-drag Determine the XYZ-location by ignoring zones 

and looking only at derived volume objects 
(streamtraces, slices, iso-surfaces, slices).

Shift-click Place the end slice.
Shift-drag Move the end slice.
I, J, K (ordered zones 
only)

Switch to slicing constant I-, J-, or K-planes 
respectively.

X, Y, Z Switch to slicing constant X-, Y-, or Z-planes 
respectively.

1-4 Numbers one through four switch between slice 
groups.

D Switch to streamrods.
R Switch to streamribbons.
S Switch to surface lines.
V Switch to volume lines.
1-9 Change the number of streamtraces to be added when placing a 

rake of streamtraces.
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Translate/Magnify tool: 

Zoom tool: 

Picked Object Options

Drag Translate the data.
Shift-Drag Translate the paper.
- If the drag was started with Shift, this will reduce the magni-

fication of the paper. Otherwise, this will reduce the magnifi-
cation of the data.

+ If the drag was started with Shift, this will increase the mag-
nification of the paper. Otherwise, this will increase the mag-
nification of the data.

- drag Decrease magnification on the paper.
+ drag Increase magnification on the paper.

Click Center the zoom around the location of your click.
Drag Draw a box to set the frame view.

- Reduce the size of the object. If multiple objects are selected, 
all object positions will be shifted towards the first object 
selected.

+ Increase the size of the object. If multiple objects are selected, 
all object positions will be shifted away from the first object 
selected.

Del Delete picked object(s).
CTRL+C Copy picked object(s) to the clipboard.
CTRL+V Paste picked object(s) from the clipboard.
CTRL+X Cut picked object(s).
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Other Keyboard Operations 

Workspace View Options

CTRL+A Paste View - Paste stored frame view to current frame.
CTRL+C Copy - place selected objects to paste buffer. Copy works 

only within Tecplot.
CTRL+D Redraw all frames.
CTRL+F Fit to full size - fit the entire plot into the frame (including 

data, text and geometries)
CTRL+L Last - Restore last frame view.
CTRL+O Open layout.
CTRL+P Print.
CTRL+Q Exit Tecplot.
CTRL+R Redraw the current frame.
CTRL+S Save current layout.
CTRL+U Call up the Publish dialog to control Web publishing.
CTRL+W Save current layout as a specified file.

CTRL+SHIFT+F fit selected frames to workspace
CTRL+SHIFT+A fit all frames to workspace
CTRL+SHIFT+P fit paper to workspace
CTRL+SHIFT+L last workspace view
CTRL+SHIFT+M maximize workspace
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Appendix D Glossary

The following terms are used throughout the Tecplot User’s Manual and are included here for your 
reference.

2D Plotting in two dimensions. Line plots of one or more variables (XY 
and Polar Line plots) are not considered 2D.

2D Cartesian Plot A plot of some variable by location on a single plane using two axes.

3D Plotting in three dimensions. Three-dimensional plotting can be sub-
divided into 3D surface and 3D volume.

3D Cartesian Plot A plot displaying a 3D scattering of points, surfaces, or volumes 
using three orthogonal axes.

3D Sorting

The process Tecplot uses to determine which surface to plot first. In 
this process, the cells are sorted relative to the viewer and plotted 
beginning with the farthest away point and ending with the closest. 
Sorting is used when printing 3D plots or rendering translucent 3D 
objects on the screen.

3D Surface Three-dimensional plotting confined to a surface. For example, the 
surface of a wing.

3D Volume
Three-dimensional plotting of data that includes interior data points 
of a volume, as well as those on the surface. For example, the vector 
field around a wing.

Active Zone A zone that is displayed in the current plot, as determined in the Zone 
Style dialog.

Antialiasing The process of removing or reducing the jagged distortions in curves 
and diagonal lines

ASCII Data File A data file composed of human-readable statements and numbers 
using ASCII characters.

Aspect Ratio The ratio of lengths of the sides of an object. In the 3D Cartesian plot 
type, the ratio is that of the longest side to the shortest side.

Auxiliary Data Metadata attached to zones, data sets, and frames.
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Banded Contour 
Flooding

A field plot where the region between contour lines is filled with a 
constant color.

Bars Mapping 
Layer

Mapping Layer (XY line plots only) where bars are used to depict the
relationship between the dependent and independent variables

Binary Data File A data file composed of machine-readable data. This type of file is 
created by converting ASCII data files with Preplot, or by directly 
creating them from an application.

Blanking A feature of Tecplot that excludes certain cells and points from a plot. 
There are three types of blanking: Value-Blanking, IJK-Blanking, 
and Depth-Blanking.

Block A data file format in which the data is listed by variable. All the point 
values of the first variable are listed first, then all the point values of 
the second variable, and so forth.

Boundary Cell 
Faces

A set of un-blanked cell faces in a 3D volume zone which have only 
one neighboring volume cell. In contrast, interior cell faces have two 
neighboring volume cells, one on either side, which share the face. 
For an IJK-ordered zone the boundary cell faces are on the exterior 
of the zone. That is, the first and last I-planes, the first and last J-
plans, and the first and last K-planes. For a finite-element 3D vol-
ume zone, boundary cell faces are on the exterior of the zone and the 
surface of any voids within the zone.

Bounding Box of 
Data

The smallest rectangular box, aligned with the coordinate axes, 
which completely encloses all data points.

Brick An element type of finite-element volume data composed of eight 
node points arranged in a hexahedron-like format. This element type 
is used in 3D volume plotting.

Carpet Plot A 3D surface plot formed by a 3D plot where the variable is plotted 
in the third dimension and is singular-valued with respect to the inde-
pendent variables.

Cell Either an element of finite-element data, or the space contained by 
one increment of each index of IJ- or IJK-ordered data.

Cell-Centered 
Values

Values located at the center of the cell (assumed to be the centroid).
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Color Map A color spectrum used to plot contour flooding and multi-colored 
objects.

Connectivity List
The portion of a finite-element data file which defines the elements or 
cells by listing the relationships between points. The number of 
points per cell is determined by the element type.

Continuous 
Contour Flooding

A field plot where a color is assigned to each point in a mesh, based 
upon the contour variable and the color map. Each face is filled with 
colors interpolated between the corner nodes. This results in a 
smooth variation of color over the surface.

Contour A field plot type that plots iso-valued lines, or color flooding based 
on the values of a specified variable.

Curve Type The function used to fit the data points in an XY-plot.

Custom Labels

Text strings contained within a data file or text geometry file which 
define labels for your axes or contour table. You may select Custom 
Labels anywhere you can choose a number format, the result is the 
text strings in place of numbers.

Cutaway Plot A 3D volume plot where a portion of a 3D volume zone is cut-away 
by blanking to reveal the interior.

Cutting Plane A planar surface used to slice 3D volume or surface zones.

Data File A file that contains data used for plotting in Tecplot.

Data Format The type of zone data as specified by the format parameter in a Tec-
plot data file, such as: BLOCK, POINT, FEBLOCK, or FEPOINT.

Data Loader A Tecplot add-on which allows you to read non-Tecplot data files.

Data Point An XYZ-point at which field variables are defined.

Data Set
A set of one or more zones. A data set may be plotted in one or more 
frames. However, a single frame may only plot one data set. A data 
set may be created by loading one or more data files.

Dependent An axis mode requiring the axes to maintain a fixed ratio to one 
another.
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Depth For image export, the number of bits stored per pixel. For depth-
blanking, the component of distance from the viewer position in a 
screen normal coordinate system.

Depth-Blanking A blanking option which excludes cells in a 3D plot, based upon their 
depth into the image. Cells closer than a plane of a certain depth, as 
well as cells further than a plane of another depth, may be blanked.

Derived Volume 
Objects

Graphic objects which are visible in the plot and created from zone 
data, but are not zones, i.e. an Iso-Surface, a Slice, or a Streamtrace.

Display List A group of OpenGL commands that have been stored for subsequent 
execution. Using display lists can, depending upon the hardware 
involved, dramatically speed up graphics rendering. Using display 
lists also requires more memory.

Draw Level A draw behavior setting for modifying the image quality and render-
ing speed during various operations, such as rotation. Options vary 
from Trace, a simplified wire-frame mesh which is rendered quickly, 
to Full.

Edge A 2D or 3D field plot option. Plotting the edge of a zone plots the 
connection of all outer lines (IJ-ordered zones), finite-element sur-
face zones, or planes (IJK-ordered zones).

Element Type The form of individual elements in a finite-element zone. There are 
four types: Triangle and Quadrilateral (finite-element surface types), 
and Tetrahedron and Brick (finite-element volume types). The ele-
ment type of a zone determines the number of nodes per element and 
their orientation within an element.

Error Bars Map-
ping Layer

XY Line mapping layer where a second dependent variable (error) is 
used to show the accuracy of the first dependent variable, typically 
used in conjunction with Bars Mapping Layer.

Exposed Cell 
Faces

The set of those cell faces in 3D volume zones that have only one un-
blanked neighboring volume cell. By comparison, interior cell faces 
have two neighboring cells, one on either side, which share the face. 
The exposed cell faces include boundary cell faces and interior cell 
faces exposed by blanking. (One of the neighboring cells has been 
blanked.)
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Extended Curve-
Fit

A Tecplot add-on which extends Tecplot’s XY-plot curve-fitting capa-
bilities.

Extra 3D Sorting Perform extra work to resolve hidden surface problems encountered 
during 3D sorting.

FE An abbreviation for finite-element, a common means of arranging 
data for calculations. (Often referred to as “unordered.”)

FEBLOCK A data file format for finite-element zones in which the node data is 
listed by variable. All the node values of the first variables are listed 
first, then the node values of the second variable, and so forth. This 
section is followed by a Connectivity List.

Fence Plot A plot of planes of a 3D data field.

FEPOINT A data file format for finite-element zones in which the node data is 
listed by point-by-point. All the variable values of the first point are 
listed first, then the variable values of the second point, and so forth. 
This section is followed by a connectivity list.

FE Surface A finite-element zone of the element type Triangle or Quadrilateral. 
These zones are used for 2D and 3D surface plots.

FE Volume A finite-element zone of the element type Tetrahedron or Brick. These 
zones are used for 3D volume plots.

Field Map A collection of zones for 2D and 3D field plots. A common style can 
be easily applied to all zones in the selection.

Field Plot Includes 2D Cartesian and 3D Cartesian plot types. Generally used 
to display the spacial relationship of data. Mesh, Contour, Vector, 
Scatter and Shade are all considered field plots. XY and Polar Line 
plots and the Sketch plot type are not field plots.

File Path An option which specifies the directory for Tecplot to search for a 
given type of file. For instance, a linked layout saved with absolute 
file path contains the complete directory structure to load the associ-
ated file.
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Finite-Element A type of data point ordering. Data is arranged by listing the data 
points (called nodes), and then listing their relationships (called ele-
ments). The element type of the zone determines the number of nodes 
which are contained in each element, as well as the exact relation-
ship of nodes within an element. There are four different element 
types supported by Tecplot: Triangle,Quadrilateral,Tetrahedron and 
Brick. See also: Connectivity List and Node

Font Modifier The modifier used to embed Greek, Math, or User-Defined charac-
ters in a text string.

Frame Area within the workspace where sketches and plots are created.

Grid Area One or more rectangular regions defined and bounded by the grid 
axes.

Grid Axes An axis option which displays the coordinates of the grid along the 
various spatial dimensions.

Gridline A set of lines drawn from one or more axes that extend from the tick 
marks on an axis across the grid area.

Grid Point In 2D, the intersection of gridlines.

Hidden Line Mesh type where mesh lines that appear behind other plot layers are 
not drawn.

I-Ordered A type of data point ordering where each point is listed one at a time 
(that is, by one index). Used mainly in XY-plots. In 2D or 3D, this 
type of data point ordering is sometimes called irregular, and is only 
useful for scatter plots, or for interpolating or triangulating into 2D, 
3D surface, or 3D volume zones. (This type of data can also be used 
for 2D or 3D vector plots if streamtraces are not required.)

IJ-Ordered A type of data point ordering where the points are arranged in a 2D 
array used for 2D and 3D surface plotting.

IJK-Blanking A feature to include or exclude portions of an IJK-ordered zone 
based on index ranges.

IJK-Ordered A type of data ordering where the points are arranged in a 3D array. 
Used for 3D volume plotting as well as 2D and 3D surface plotting.

Image Format Any of the raster or bit-mapped graphic formats supported by Tec-
plot.
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Inactive Zone A zone loaded into Tecplot which does not appear in the plot. A zone 
can be deactivated using the Zone Show option on any page of the 
Zone Style dialog.

Independent Axis mode allowing each axis to have a range that is not affected by 
the ranges of other axis or axes.

Interpolate To assign new values for the variables at data points in one zone 
based on the data point values in another zone (or set of zones).

Interpolate Mode  When probing is activated using a single mouse click, the value
returned is linearly interpolated from all nodes in the cell. See also: 
“Nearest Point Mode” on page 626

Internal Macro 
Variable

A read-only macro variable which allows you to access certain key 
values in Tecplot. For example, $NUMVARS gives the number of 
variables.

I-Plane In an ordered zone, the connected surface of all points with a con-
stant I-index. In reality, I-planes may be cylinders, spheres, or any 
other shape.

Irregular Data Points which have no order, or at least no order which can be easily 
converted to IJ- or IJK-ordering.

Iso-Surface A surface within a 3D zone where the contour variable has a con-
stant value at all locations.

Journal Log of data manipulation/creation/deletion instructions.

J-Plane In an ordered zone, the connected surface of all points with a con-
stant J-index. In reality, J-planes may be cylinders, spheres, or any 
other shape.

K-Plane In an IJK-ordered zone, the connected surface of all points with a 
constant K-index. In reality, K-planes may be cylinders, spheres, or 
any other shape.

Layout File A specialized macro file which preserves a plot created within Tec-
plot. When the layout is opened, it restores Tecplot to the state it was 
in when the layout file was saved.

Layout Package File A binary layout file with the data embedded.
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Line Map A set of points from a single zone where one variable is assigned to 
an X-axis and another is assigned to a Y-axis. You can define many 
XY-maps for an XY-plot.

Macro A file containing a list of instructions, called macro commands, 
which can duplicate virtually any action performed in Tecplot.

Macro Command An instruction given to Tecplot in a macro file. Macro commands 
always start with a dollar sign and then an exclamation mark. For 
example, $!Redraw refreshes a plot view.

Macro File A file which contains a series of macro commands. Macro files are 
run from the command line, or through the Play option of the Macro 
sub-menu of the File menu.

Macro Function A self-contained macro sub-routine.

Macro Variable A holding place for numeric values in a macro file. There are two 
types of macro variables: user-defined (you set and retrieve the 
value), or internal (Tecplot sets the value and you may retrieve it).

Map Layer One way of displaying a line mapping, such as with line, bars, sym-
bols, and so forth. One mapping may be displayed with one or more 
layers.

Median Axis In 3D, the grid axis which when scaled is not the shortest nor the 
longest axis.

Menu Bar The top bar of the Tecplot screen used to select menu options.

Mesh A 2D or 3D field plot type which plots connections between data 
points.

Multi-Colored Any Tecplot object which is colored by the value of the contouring 
variable. Multi-colored objects may include mesh, scatter symbols, 
vectors, contour lines, and streamtraces.

Nearest Point Mode  When probing is activated using a CTRL+click, the value returned is 
the precise value of the closest data point. See also: “Interpolate 
Mode” on page 625.

Node A point in finite-element data.

Number Format The style of numbers to display for a data or axis label; exponent, 
integer, float, and so forth.
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OpenGL A graphics library for high-end 3D graphics. It usually takes advan-
tage of hardware acceleration for 3D rendering.

Ordered Data A type of data point organization which consists of a parameterized 
series of points. There are seven types of ordered data: I-, J-, K-, IJ-, 
JK-, IK-, and IJK-ordered. I-, IJ-, and IJK-ordered are the most com-
mon.

Overlay Mesh type where mesh lines are drawn over all field-plot layers, 
except for vector and scatter layers.

Plot Type Determines the type of plot which is displayed in a frame. For exam-
ple, 2D Cartesian plot, 3D Cartesian plot, XY Line plot, Polar Line 
plot, or Sketch plot.

PLOT3D A plotting package developed by NASA. Useful because the file for-
mat can be converted to a Tecplot binary data file by Preplot.

Point A data file format for an I-, IJ-, or IJK-ordered zone in which the 
data is listed by point. All of the variable values for the first data 
point are listed first, then all the variable values for the second data 
point, and so forth.

Polar Line Plot A plot of radius versus angle, or visa versa. The polar axes are the 
radial axis (by default zero at the origin) and theta axis (by default 
zero for any data on the right running horizontal line).

Precise Dot Grid In 2D, the points of intersection of the imaginary lines extending 
from the X- and Y-axes’ tick marks.

Primary Corner The point in an ordered zone’s cell that has the minimum index values 
for that cell, or the first listed node of a finite-element cell.

Quadrilateral An element type of finite-element surface data which is composed of 
four node points arranged in a quadrilateral. Used in 2D and 3D 
surface plotting.

Quick Macro Panel A user-defined panel accessed from the Tools menu which allows 
quick access to your macro functions.

Rake A specified line from which two or more streamtraces are generated.

RGB Color Flood-
ing

The assignment of color based on Red, Green, and Blue components 
defined at field data locations.

Ribbon (See Streamribbon.)
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Rod (See Streamrod.)

Scatter 2D or 3D field plot type which plots a symbol at each data point.

Shade Plot 2D or 3D field plot type which plots solid color or colors with light-
ing effect over the cells of the data.

Sharing Variable sharing allows a single storage location to be used by more 
than one party. For example, if the X-variable is shared between 
zones five and seven only one storage location is created. The stor-
age is not freed by Tecplot until the number of parties accessing the 
data is reduced to zero. Variables and connectivity information may 
be shared.

Sketch Plot A plot which displays only text and geometries. 

Slice A set of data created by the intersection of a plane with 3D zones.

Snap-to-Grid Lock any object on the screen to the closest grid point. The position 
and size of the object will be affected by changes to the grid.

Snap-to-Paper Lock any object on the screen to the underlying paper. The position 
and size of the object will not be affected by changes to the grid.

Sort A measurement from one to two of the amount of work Tecplot should 
do to resolve hidden-surface problems during 3D sorting. Selecting 
two will increase the time required for each redraw and will generate 
messages about the number of cells with a potential conflict.

Specular Highlights Rendering a surface such that it displays qualities similar to those of 
a smooth reflecting surface such as metal.

Stream Particle traces through the vector field

Stream Format The current type of streamtraces being placed in Tecplot. For exam-
ple, Surface Line, Volume Line, Volume Ribbon, or Volume Rod.

Streamline A 2D or 3D line which is parallel to the vector filed along its entire 
length. For a steady state vector field, this is the same as a simple 
particle trace which marks the path of a massless particle in the vec-
tor field.

Streamribbon A particle trace with a width which not only follows the flow field (its 
center being a regular streamline), but which also twists with the 
vorticity of the vector field.
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Streamrod A particle trace with a polygonal cross-section and a width which not 
only follows the flow field (its center being a regular streamline), but 
which also rotates with the vorticity of the vector field.

Streamtrace Any type of particle trace: streamlines, streamribbons, or stream-
rods.

Streamtrace Zone Any streamtrace which has been extracted to form a new zone.

Stylesheet A type of file which contains the definition of how the plot in a single 
frame is to be plotted. The stylesheet does not contain any zone data 
but does contain information about views, axes positions, zone 
attributes, and so forth.

Supersampling Fac-
tor

When antialiasing an image for export, the factor Tecplot uses when 
creating an intermediate image that is then resized down to the final 
image size. The larger the value, the smoother the resulting image at 
the cost of performance. Values of more than 3 are seldom necessary.

Surface Line A type of 3D streamline which is confined to remain on a 3D surface. 
Also used to refer to 2D streamlines.

Symbols Mapping 
Layer

Line plot where symbols are used to depict the relationship between 
the dependent and independent variables.

Tetrahedron An element type of finite-element surface data which is composed of 
four node points arranged in a tetrahedron. (Used in 3D volume 
plotting.)

Translucency A property allowing you to see through an object to areas within or 
beyond it. In Tecplot you may vary the amount of translucency, con-
trolling the extent that an object closer to you obscures one it over-
lays.

Triangle An element type of finite-element surface data which is composed of 
three node points arranged in a triangle. (Used in 2D and 3D surface 
plotting.)

Unordered or Unor-
ganized Data

(See Irregular Data.)

Value-Blanking A feature of Tecplot used to trim or eliminate cells based on one or 
more user-defined constraints for variable values.

Variable One of the values defined at every data point in a Tecplot data set or 
data file.
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Vector Layer A field plot showing the direction and or the magnitude of vector 
qualities.

Volume Line A type of 3D streamline which is not confined to remain on a surface 
and may travel through 3D volume data.

Volume Zone Any zone that is IJK-ordered, finite-element tetrahedron, or finite-
element brick.

Vorticity The measurement of the tendency of a vector field to rotate about a 
point. (Also called “curl.”)

Wire Frame Mesh type where mesh lines are drawn behind all other plot layers.

Workspace The portion of your screen where you can create Tecplot frames. This 
includes but is not limited to the region covered by the displayed 
paper.

XY-Dependent A 3D axis mode where X and Y are fixed (dependent), but Z is free to 
vary in ratio (independent).

XY Line Plot Plots one variable assigned to one axis versus another variable 
assigned to another axis. Log plots, bar charts, curve fitted lines are 
all examples of XY Line plots.

Zone A subset of a data set which is assigned certain plot types. Zones may 
be activated (plotted) or deactivated (not plotted). Each zone has one 
type of data ordering: I-, IJ-, IJK-, or finite-element. Zones are typi-
cally used to distinguish different portions of the data. For example, 
different calculations, experimental versus theoretical results, differ-
ent time steps, or different types of objects, such as a wing surface 
versus a vector field around a wing.

Zone Layers One way of displaying a 2D or 3D plot’s data set. The plot is the sum 
of the active zone layers, which may include mesh, contour, vector, 
shade, scatter and edge.
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Appendix E Data Loaders 

Tecplot allows you to load data in a number of formats with loaders that Tecplot or third parties 
have produced using the Add-on Developer’s Kit.   Use the File>Load Data File(s) command to 
load a data file. The Select Import Format dialog allows you to load the following file types:

E - 1 “CGNS Loader” on page 634
E - 2 “DEM Loader” on page 638
E - 3 “DXF Loader” on page 639
E - 4 “EnSight Loader” on page 641
E - 5 “Excel Loader” on page 643
E - 6 “FEA Loader” on page 649
E - 7 “Fluent Loader” on page 655
E - 8 “General Text Loader” on page 660
E - 9 “Gridgen Loader” on page 673
E - 10 “HDF Loader” on page 674
E - 11 “HDF 5 Loader” on page 675
E - 12 “Kiva Loader” on page 678
E - 13 “PLOT3D Loader” on page 679
E - 14 “PLY Loader” on page 687
E - 15 “Tecplot-Format Loader” on page 687
E - 16 “Text Spreadsheet Loader” on page 696

See also: The Data Format Guide for Tecplot 360.
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The Select Import Format dialog is shown in Figure E-1.

Figure E-1. The Select Import Format dialog, accessed via 
the File menu.

New data loaders are posted at our Web site, www.tecplot.com, as they become available. You can 
also build your own data loaders using the Add-on Developer’s Kit.

E - 1 CGNS Loader
The CGNS Loader supports files created with CGNSLib Version 2.4 or earlier. You can choose to 
load either all or specific bases, zones, and solutions into Tecplot zones. You can also select field 
variables individually, define index ranges to load specific sub-zone blocks or planes for structured-
grid zones.

Only CGNS bases and zones with valid grids can be read by the CGNS Loader. For unstructured 
grids Version 2.1 of the CGNS Loader supports BAR_2, TRI_3, QUAD_4, TETRA_4, PYRA_5, 
PENTA_6, HEXA_8, MIXED element types and their combinations on every section. However, 
the CGNS Loader does not support higher-order element types.

Only vertex and cell-centered field variable locations are supported. Cell-centered data is averaged 
to the nodes when the file is read. For cell-centered structured grids, arithmetic averaging is used. 
Rind data is used in the averaging (if available). For cell-centered unstructured grids, either Lapla-

http://www.tecplot.com
http://www.tecplot.com
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cian averaging or arithmetic averaging can be selected to average the cell data to the surrounding 
nodes

The CGNS Loader dialog has the following options:

• File - Enter the name of the file to load

• Specify Options - Active when a valid file is entered or selected. This option 
allows you to control the data loaded from your CGNS file, including loading 
only particular zones, field variables, or partial zones.

• Load Cell-Centered Data Directly - Toggle-on to load cell-centered data 
directly [default]. When the option is toggled-off, cell-centered data will be 
averaged to the nodes (using the averaging method specified below).

• Averaging - This option is available only if “Load Cell-Centered Data 
Directly” is not selected. When the field variables are stored at cell centers, 
either Laplacian averaging or arithmetic averaging may be used to average the 
cell data to the nodes they surround. This can result in a bias at the boundary 
nodes. Arithmetic averaging is automatically used for ordered/structured zones. 
When available, Rind data is used in the averaging.

If Specify Options is not selected, every 
base, zone, solution, and variable is 
loaded into Tecplot 
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• Select Zones - Launches the Load CGNS Options: Zones dialog, which allows 
you to select specific zones and partial zones to load.

• Select Variables - Launches theLoad CGNS Options: Variables dialog, which 
allows you to select specific field variables to load. Grid variables are always 
loaded automatically.

• CGNS Section Mapping - CGNS files sometimes have multiple node-maps 
(referred to as sections) for each finite-element zone. A zone may contain sec-
tions with different cell-types and cell dimensions. 

•  one Tecplot zone per CGNS zone/solution (default) - all sections will 
be combined with the zone cell-dimension into one Tecplot zone. 

• Load each section as separate Tecplot zone - a separate Tecplot zone will 
be created for each section regardless of cell dimension.

• Transient Options 

• Assign Strand IDs to all zones - Toggle-on to assign Strand IDs to 
transient zones. Refer to 6 - 2 “Time Aware” on page 157 for more 
information on working with transient data.

E- 1.1 Load CGNS Options: Zones dialog
Tecplot zones are not always equivalent to CGNS zones. The CGNS Options: Zones dialog allows 
you to specify zones to load from CGNS data files.
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Each solution for a CGNS zone is considered a unique Tecplot zone. The CGNS base (B), zone (Z), 
and solution (S) hierarchy orders the zones. The integer preceding the word Zone is the Tecplot 
zone number assigned to that zone. The integer following Zone represents the order the zone was 
found in the CGNS file. 

Table E-1 describes the zone description listed in the dialog box. The zone description includes the 
CGNS hierarchy information. “CGNS B, Z, S =” followed by three integers representing the CGNS 
order for the base, zone, and solution, respectively. “CGNS Z, S =” and two integers are displayed 
if a single base is found. The description also indicates whether the zone is ordered (structured) or 
finite-element (unstructured). I-, J-, and K-dimensions are provided for ordered zones; the number 
of nodes and elements are provided for finite-element zones.

int Zone int {CGNS B, Z, s = x, y, 
z}

[Ordered, 
FE]

Tecplot 
Zone num-
ber

“Zone
”

order in 
CGNS file

x = Base number
y = Zone number
z = Structure num-
ber

“Ordered”
or
“FE”

By default, all zones are selected for reading and displayed in Zones to Load.   Use the Move, Move 
All, Remove or Remove All buttons to edit the list.

CGNS Loader Options: Index Ranges Dialog. 

The Load CGNS: Index Ranges dialog allows you to specify a sub-set of the selected ordered/struc-
tured zone(s) to be loaded, define a block, plane, or line of points for extraction on loading. To load 
a partial zone or sub-zone, highlight the zone of interest in Zones to Load region of the CGNS 
Loader: Zones dialog, and select the Index Ranges for Zone(s) button. 

Each index requires Start, End, and Skip values. Start and End points are always loaded. If multiple 
zones are selected prior to calling up the CGNS Loader: Index Ranges dialog, “Mx” (the maximum 
value for each zone) is the default value for End. You may enter any value for End. However, if the 
value is greater than the maximum index for a zone, End is replaced by the maximum index.

For multi-dimensional zones, more than one point must be specified to load for the I- and J-direc-
tions. If the inputs for Start, End, and Skip result in a single point in either direction, an error mes-
sage appears. 

Table E-1. Zone Description in the Load CGNS: Zones dialog
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E- 1.2 Load CGNS Options: Variables dialog
The CGNS Loader: Variables dialog includes the Variables from CGNS and Variables to Load list 
boxes.

The Variables from CGNS list includes all field variables in the CGNS data file, independent of their 
zone(s). The Variables to Load list contains the field variables that have been selected to load into 
Tecplot. Initially, both lists are the same. A Tecplot variable number is assigned to each CGNS field 
variable that appears in the Variables to Load list. 

Because Tecplot requires every zone to have the same number of variables, each zone that is loaded 
into Tecplot will include every variable in the Variables to Load list (regardless of whether the zone 
included that field variable in the CGNS file). The variables that were not originally in the zone 
will be set to zero. The field variables that do not appear in the Variables to Load list will not have a 
Tecplot variable number assigned to them. 

Use the Move, Move All, Remove or Remove All buttons to edit the Variables to Load  list.

E - 2 DEM Loader
The DEM Loader allows you to load Digital Elevation Map files that have the same file format as 
the U.S. Geological Survey’s standard DEM format. The DEM Loader will not accept Spatial Data 
Transfer Standard (SDTS) formatted data.

DEM files are available on the Web for a number of states within the U.S. For more information, 
refer to the following references:

• General: http://edc.usgs.gov/geodata/samples.html

http://edcwww.cr.usgs.gov/doc/edchome/ndcdb/ndcdb.html 
http://edc.usgs.gov/geodata/samples.html
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• User’s guide: http://edc.usgs.gov/products/elevation/dem.html.

The DEM Loader first launches a multi-file selection dialog. After choosing one or more DEM files 
to load, you are presented with a simple dialog where you can set the I- and J-skipping. Since DEM 
files are quite large, you will likely want to set both of these to be 10 or more.

E - 3  DXF Loader
The DXF Loader add-on can import AutoCAD DXF (drawing interchange) files. When importing a 
file, Tecplot creates an appropriate geometry for each of the following entity types:

•  Text.

•  Lines.

•  Arcs.

•  Circles.

•  Points.

•  Solid.

•  3D faces.

Note: When importing a DXF file, no zones are created. Instead, the geometries representing each 
entity type are simply added to the frame. Be aware that a typical DXF file can contain several 
thousand geometries, and these are all included when you save a layout file.

http://edc.usgs.gov/products/elevation/dem.html
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E- 3.1 Load DXF File Dialog
The Load DXF File dialog has a variety of features, most of which are self-explanatory.

You can select any of the following:

• Import - Select any or all geometries to 
import -- Text, Lines, Arcs, Circles, 
Points, Solids, 3D Faces.

• Font - Select the font to use for text.

• Attach Imported Items to Zone -
Specify a zone to which all imported 
geometries will be attached. Clicking the 
Select Zone button produces a menu of 
zone options.

• Polylines/Import as 2D - All lines and 
polylines are stored with three coordi-
nates in DXF files. If you select this 
option, the loader will add 2D line geom-

etries for all lines and polylines in the DXF file (the third coordinate will be 
ignored).

• Polylines/Import as 3D - If you select this option, the loader will add 3D line 
geometries for all lines and polylines in the DXF file. To view a 3D DXF file, 
create or load a 3D zone, import your DXF file, then choose Fit to Full Size 
from the View menu.

• Hide Invisible Layers - If this option is checked, objects in layers which are 
“off” in the DXF file will be imported with the background color.

E- 3.2 DXF Loader Limitations
The DXF Loader does not create any field data. Loading a DXF file only adds geometries to your 
existing frame.

Since most geometries in Tecplot are 2D, best results will be obtained by loading “flat” DXF files, 
such as maps.

Binary AutoCAD (*.dwg) are not supported in this release.
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E - 4 EnSight Loader
The EnSight Data Loader allows you to load EnSight Gold and EnSight 6 files with extensions: 
case (.case), geometry (.geo), or variable (.*). Geometry and variable files can be in either ASCII or 
binary format, although binary is recommended. Files from earlier versions of EnSight need to be 
resaved in Gold format using File>Save>Geometric Entities. To determine what format the files are 
in, view the case file and look under the FORMAT section.

EnSight data is stored in a case file, which contains references to all associated geometry and 
variable files. Loading the case file will load all of the files contained within. EnSight parts are 
translated into Tecplot zones with the caveat that unstructured parts with dissimilar element types 
(i.e.: a volume element and a surface element) will only load the primary element type. 
Unstructured zone names will be prefixed by the type of zone they represent (point, line, surface, or 
volume). Vector, tensor, and tensor9 variables are expanded into the appropriate number of 
variables with the variable name followed by a suffix. Complex 'imaginary' variables will have an 
'I' following the name to distinguish them from the 'real' variable. The EnSight Data Loader dialog 
is shown in Figure E-2.

Figure E-2. EnSight Loader Dialog - 
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Use the Case File tab to specify the name of the case file you wish to load. The Structured Index 
Skips allow structured zones to be loaded with fewer nodes. A value of 1 (default) will read 
every data point, 2 will read every other data point, and so on.

Figure E-3. EnSight Loader Dialog - Select 
Parts/Variables

The Select Parts/Variables tab (shown in Figure E-3) allows you to load specific zones/parts and/or 
variables. 

•Parts (zones in Tecplot) - selectable list of zones, extracted from the description line in 
the geometry file.

•Variables - selectable list of variables, named by the description name from the case file. 
Spatial (x, y, z) and IBlank variables are always loaded and are not included in the list.

•All zones - loads all zones
•All variables - loads all variables
•None - loads no variables

Macro Commands for the EnSight Loader

The macro subcommands for $!READDATASET that are specific to the EnSight data loader are:

Parameters Syntax Default

FILENAME_CASEFILE = <string> NULL
STANDARDSYNTAX = 
<boolean>

1

ISKIP = <string> 1
JSKIP = <string> 1
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E - 5  Excel Loader
The Excel Loader add-on can read numeric data from.xls files for Microsoft Excel version 5.0 or 
higher. 

The Excel Loader is useful for basic formats only. Your Excel file must contain values only (no 
equations). Tecplot recommends use of the Excel macro from the Util/Excel folder as an easier 
method to open Excel data with Tecplot (see B - 1 “Excel Macro” on page 599). Use the Text 
Spreadsheet loader for delimited files (E - 16 “Text Spreadsheet Loader” on page 696).

If your spreadsheet is arranged asTable Format or Carpet Format, the Excel Loader is a point-and-
click operation. Once you have selected an Excel file to load into Tecplot, the Excel Loader leads 
you through a series of dialogs, prompting you to specify a variety of attributes, including: the data 
format in the Excel spreadsheet, the variables to read into Tecplot, and zone information.

E- 5.1 Spreadsheet Data Formats
The Excel Loader will automatically identify blocks of data in Table Format or Carpet Format. The 
loader will list blocks of data in standard Excel notation. For example, a block found on worksheet 
sheet1, cells A1-D8, is listed as follows: (sheet1! A1:D8).

If you select a user-defined format (or if the loader did not identify any carpet or table blocks), you 
will be prompted to enter the names and number of variables, and one or more zones and associated 
properties. You will also need to enter the location of the field data in the spreadsheet for each zone.

KSKIP = <string> 1
ZONECOUNT = <string> NULL
ZONE = <string> NULL
VARCOUNT = <string> NULL
VAR = <string> NULL

The Excel Loader is available for Windows 
platforms ONLY.

Parameters Syntax Default
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Table Format.  Use Table format for data that will be plotted in line plots (i.e. data with an 
independent and one or more dependent variables). Many spreadsheets containing data to be plot-
ted in 2D or 3D Cartesian plots will also satisfy the conditions of table format.

 A table formatted data set has the following characteristics:

•  The data set is arranged in one or more adjacent columns.

•  Each column is the same length

•  Each cell contains numeric data.

•  The first row is a header row containing the variable name for its corresponding 
column.

•  The spreadsheet data set is imported as a single I-ordered zone in POINT format 
with N variables, where N is the number of columns in the table.

The block of data must be surrounded by empty cells, text-filled 
cells, or table boundaries. The loader will not recognize a block 
of data as being in table format if any cell adjacent to the block 

is filled with a number

There must be no blank cells within the block of data. An empty cell will 
prevent the loader from recognizing the block. You can satisfy this con-
dition by filling blank cells with 0.0.
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Figure E-4 shows an Excel block in table format.

Figure E-4. A block of data in table format.

Carpet Format. Use carpet format for spreadsheet data to be plotted in a 2D or 3D Cartesian 
plot. 

The carpet formatted data set, shown in Figure E-5. , has the following characteristics:

• The spreadsheet data set is imported as an IJ-ordered zone. See section 4.2.2, 
“IJ-Ordered Data.”

In Figure E-5, the spreadsheet is imported as I=4 and J=4. The three variables 
are X, Y and V. In the spreadsheet cell 2B is index 1, 1, cell 3B is index 2, 1. 

• The top row in the block contains the values of the X-variable, the first column 
of the block contains the values of the Y-variable, and the V-values are the inte-
rior data. This format is useful if your data set was generated from a function f, 
such that f(X, Y) = V.

• The block is a rectangular arrangement of numeric data in the spreadsheet, 
with a blank cell in the upper left hand corner.
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• There must be no blank cells within the block of data. An empty cell will pre-
vent the loader from recognizing the block. You can satisfy this condition by 
filling blank cells with 0.0.

• The block of data must be surrounded by empty cells, text-filled cells, or table 
boundaries. The loader will not recognize a block of data as being in carpet for-
mat if any cell adjacent to the block is filled with a number.

Figure E-5. The carpet table shows values as a simple arithmetic 
function of X and Y.

Other Formats. The Other format option gives you a great deal of flexibility in loading data 
into Tecplot. A series of dialogs leads you through the process of describing your data, similar to 
the way you would specify this information in a Tecplot ASCII file. 

• Default format - The Excel Loader offers a semiautomatic option that requires 
only that you specify the upper left and lower right corners of your data block. 
Once you’ve specified those corners, it handles the data in the same way that 
Tecplot handles an unformatted block in an ASCII file. It assumes one zone of 
I-ordered data in POINT format.

• Custom format - Using the Custom format option, you can specify character-
istics of your data set. Custom format has the following features:

• It allows you to work with spreadsheets containing blank cells or text 
cells.

• For XY-, IJ- and IJK-ordered data, specify the loader the boundaries of 
the block to load, and how many data points there are within that 
block (IMax, JMax, KMax).

• For finite-element data, the number of data points is implied by the 
number of nodes and number of elements.

• Allows you to load blocks of cells that you delimit interactively. 
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• It is the only option for loading finite-element, IJK-ordered, or zone 
data from Excel. If a user wants to read in data from an Excel spread-
sheet into more than one Tecplot zone the custom format must be 
used. The default assumes that all data read should be put in a single I-
ordered zone. 

E- 5.2 Excel Loader Restrictions
A block of data is a rectangular group of numbers in the spreadsheet. The Excel Loader places the 
following restrictions on blocks:

• Carpet and table format (which the loader detects and loads automatically) are 
narrowly defined. All other formats must be loaded on the user-defined path-
way.

• Numeric cells within each block should contain only numbers or numeric char-
acters such as +, -, and so forth. A cell containing “X=34” is interpreted by the 
loader as text, because it begins with text. 

• Cells containing formulas (therefore displaying calculated values) will be 
skipped by the loader. You can convert the formulas to values within Excel, by 
pasting your table using the “Paste Special” function, with “values only” 
selected.

• The spreadsheet file must have been written by Excel Version 5.0 or higher.
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E- 5.3 FEPOINT Excel File in User-Defined Format Example
The Excel spreadsheet in TEC360HOME/examples/loaders/xls/fe1.xls (Figure E-6) 
contains data in finite-element POINT format. The procedure for loading the data into Tecplot is as 
follows:

1. Select the Excel Loader from Load Data File(s) dialog (accessed via the File
menu).

2. In the Read Excel File region of the Excel Loader dialog, specify a path and a 
file, and click OK.

3. In the Import Excel File—Step 1 dialog, you are restricted to Other format, 
because fe1.xls does not satisfy the conditions of table or carpet format. 
Select Next>.

4. In the Step 2 of 4 dialog, add seven variables of type Double, and a title if you 
wish. Select Next>.

5. In the Step 3 of 4 dialog, Select Add.

6. From the Add menu select the Edit Zone option and specify that:
•  the block of data that extends from B1 to H33.
• The format of the data file is FEPOINT.
• The data set contains 13 nodes.

Figure E-6. Excel file fe1.xls, used in the example in Section E- 5.3 
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• Those nodes are connected into 20 elements.
• The element type is TETRAHEDRON.

7. Click OK. The Step 3 of 4 dialog now displays the zone you have described, 
with a + button that you can press to display your parameters.

8. Select Next>.

9. Confirm your choices in the Import dialog and select Finish.

10.The initial plot is 2D Cartesian, which you can convert to 3D Cartesian (via 
the Sidebar) for a full view of the finite-element volume (Figure E-7).

 
Frame 001 ⏐ 26 Jun 1998 ⏐ Converted Excel Data
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Figure E-7. Excel spreadsheet fe1.xls 3D Cartesian plot.

E - 6 FEA Loader
Tecplot 360 includes the ability to load input and solution files from many popular finite-element 
analysis (FEA) solvers. Supported formats are:

Solver/File Format File Name/Extension
ABAQUS Data .fil
ABAQUS Input .inp
ABAQUS Output Database (Windows only).odb
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Files of each of these formats may be loaded by selecting Load Data File from the File menu, 
choosing the file format from the resulting dialog, and clicking OK. FEA formats have “(FEA)” 
appended to the format names. 

Choosing any one of these will display the main dialog for the corresponding FEA Loader. The 
selected format will be displayed in the title bar. 

The FEA Loader dialog for the ANSYS Result file for-
mat is shown here:

• Select the  button to choose the file you 
wish to load. 

• Subdividing Zones - Each zone loaded from 
an FEA file typically represents the entire 
solution at a particular time step or load incre-

ment. Sometimes a solution will consist of many components that you may 
wish to display individually. To activate this option, choose the Subdivide Zones
toggle and select the desired subdivision option from the menu. Tecplot pro-
vides you with two ways to subdivide zones: by Component and by Element 
Type.

ANSYS Input .cdb
ANSYS Result .rst,.rth,.rfl
FIDAP Neutral .fdneut
LS-DYNA Input .dyn,.k
LS-DYNA Taurus State D3PLOT
NASTRAN Bulk Data .bdf
NASTRAN Bulk Data .bdf
NASTRAN Output2 .op2
PAM-CRASH DAISY .dsy,.daisy
PATRAN Neutral .out
SDRC IDEAS Universal .unv
Stereo Lithography .stl

Solver/File Format File Name/Extension
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• Subdividing Zones by Component - Some FEA file formats include 
the ability to identify components or sub-regions. If this information is 
available, you may direct Tecplot to apply it by selecting the by Com-
ponent option. Components within each solution step will be identi-
fied by sequentially numbered zone names in Tecplot, for example, 
“Component 1 Step 1 Incr 1,” “Component 2 Step 1 Incr 1,” and so on.

• Subdividing Zones by Element Type - If component information is not 
available in a solution file, the above option will produce only one 
component per solution step and increment. In this case, it may still be 
possible to achieve the desired effect if sub-regions in the solution are 
represented by different element types, such as shell elements and 
brick elements. Selecting by Element Type from the subdivision option 
menu creates a separate Tecplot zone for each element type present in 
the solution file. Tecplot zone names will then represent each element 
type, for example, “Quadrilaterals Step 1 Incr 1" and “Tetrahedrals 
Step 1 Incr 1." This makes it easy to operate on individual components 
or sub-regions in Tecplot's Zone Style dialog by selecting the desired 
zones by name.

• Selecting Zones and Variables to Load - See  “Selecting Zones and Variables to 
Load” on page 651.

• Auto Assign Strand IDs for Zones - Regions or components of solutions 
throughout an unsteady solution are tracked by Strand IDs. All zones that rep-
resent a particular region or component are assigned the same Strand ID. 
Selecting this option directs Tecplot to assign Strand IDs to the loaded zones. 
This ensures that only the zones representing the chosen solution time are dis-
played in Tecplot. Zones that do not have Strand IDs assigned are displayed at 
all solution times. See also 6 - 2 “Time Aware” on page 157.

• Add Zones to Existing Strands - If you are appending data to an existing data 
set, select Auto Assign Strand IDs to Zones, in order for Tecplot to append the 
new zones to existing strands. This is appropriate where the new data represent 
the same regions or components as are represented in the existing data set, such 
as an additional solution time level of an unsteady solution.

Selecting Zones and Variables to Load 

• By default, Tecplot will load all zones and variables present in the solution file, 
unless multiple steps or increments are present. In this case, Tecplot will not 
load step 0 increment 0 (which normally has no solution data associated with 
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it). If you wish to load step 0 increment 0, or a subset of the available zones or 
variables, choose the Select Zones and Variables toggle in the main loader dia-
log. When you then click OK, the FEA Loader Options dialog will be dis-
played, as shown 

Figure E-8. FEA Loader Options dialog - Select Variables and Zones.

Figure E-8:

Use the Move All, Move, Remove and Remove All buttons to add or subtract zones or variables from 
the list.
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The Variables page is displayed above. The Zones page displays the zone list. If you elected to sub-
divide zones, the zones will be subdivided in the list. Figure E-9 shows a zone list where Subdivide 
Zones by Component has been chosen:

Figure E-9. Zones page of the FEA Loader Options dialog, when Subdivide Zones by 
Component was selected in the FEA Loader dialog.

When you have chosen the zones and variables you wish to load, click OK.

The resulting Tecplot zones for each step and increment in the file will be named accordingly in 
Tecplot, beginning with Step 1 Incr 1. The precise meanings of “Step” and “Increment” are solver- 
and problem-dependent, but normally correspond to time steps in unsteady cases, load increments 
in steady-state cases, or frequencies or vibrational modes in harmonic analyses.

E- 6.1 Appending Finite-Element Data to an Existing Data Set
If you wish to add a finite-element solution to data you have already loaded, select Add to current 
data set in the Import File Warning dialog. The Import File Warning dialog will appear after you 
have selected the file and zones and/or variables to load.
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Zones from the file will be added sequentially at the end of the current zone list, and new variables, 
if any, will be appended to the current variable list. The new zones will not be plotted, however; to 
plot the appended zones, select them in the Zone Style dialog, click the Zone Show button, and 
choose “Activate”.

E- 6.2  Post-Processing Finite-Element Data
When you load an FEA solution into Tecplot, the FEA Post-Processing dialog is displayed (unless 
you are appending to an existing solution) (Figure E-10). You may re-display it at any time by 
selecting FEA Post-Processing from the Tools menu.

Figure E-10. FEA Post-Processing dialog.

The three sections of the dialog allow you to deform the plot using deformation read from the solu-
tion file, to animate the deformation, and to derive new variables from the solution variables.

• Deforming the FEA Plot - Finite-element solutions commonly include defor-
mations calculated from applied loads. When a solution is initially read in, the 
un-deformed geometry is displayed. If the file contained deformation data, you 
can display the deformed geometry by toggling-on Deform Plots by Factor. The 
deformation factor is displayed to the right of this toggle. You may enter the 
deformation factor in this text field, or use the up or down arrows next to it to 
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change it. By default, the Deform Plot by Factor toggle is checked and the field 
is set to “1”.

• Animating the FEA Plot - This feature is normally used only with steady-
state deformations after you have set the deformation factor as described above. 
If your FEA solution file contains multiple steps of an unsteady solution, it is 
more likely that you will animate your entire solution using Tecplot's zone or 
time animation features. For steady-state solutions, or for a single step of an 
unsteady solution, the animation available via this dialog animates the defor-
mation of that step by sequentially applying positive or negative factors to the 
deformation. To use this feature, choose whether to animate to the screen or to a 
file in the Animate Deformation menu, enter the number of steps (frames) you 
wish to see in the animation and the number of cycles, then click Animate. For 
one cycle, the animation will begin at zero deformation, then step up to maxi-
mum deformation, then down to the negative of that maximum, and then back 
to zero. Upon completion of the animation, the plot will be restored to the pre-
vious deformed plot.

• Deriving New Variables from an FEA Solution - FEA solutions may consist 
of various types of stress and strain, or gradients of scalar quantities such as 
temperature. The lowest section of this dialog allows you to calculate certain 
other quantities of interest that may be derived from these basic solution vari-
ables. For tensor quantities such as stress and strain, the principal stresses or 
strains plus Von Mises stress are available. For vector quantities, the vector 
magnitude may be calculated. Choose the derivation you want in the Derive list, 
and a list of candidate source variables in the solution will be displayed in the 
From list. Choose the source variable and click Calculate to add the desired 
quantity to the data set. If Tecplot's Calculate-on-Demand feature is active, the 
variable will only actually be calculated when it is displayed. In this case, may 
notice no delay when you click Calculate, but some delay later when you 
choose to display the variable by selecting it, for example, as the contour vari-
able.

E - 7 Fluent Loader
The Fluent Data Loader allows you to read Fluent Version 5 and 6 case (.cas) and data (.dat) 
files into Tecplot. To load files from earlier versions of Fluent, you must first import them into 
Fluent 5 or 6, then save them as Fluent 5 or 6 files.
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The following options are available:

• Load Case and Data Files - Loads both a case and a data file. The grid comes 
from the case file, and the solution comes from the data file.

• Load Case File Only - Loads the grid from a case file.

• Load Residuals Only- Loads the residual data (convergence history) from a 
data file. The residuals are not scaled or normalized.

• Load Multiple Case and Data Files [DEFAULT]- Displays the File List 
form in the dialog. You can load matched pairs of case and data files, or one 
case file and any number of data files that match it (that is, that have the same 
zones).

For all load options above except Load Multiple Case and Data Files, the following controls are 
available:
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• Case File - Type the name of the case file you wish to load, or click Select, 
then select the name of the file from the resulting dialog.

• Data File - The data (.dat) file contains the solution and the residual (conver-
gence history) data. Type the name of the data file, or click Select, then select 
the name of the file from the resulting dialog.

For the Load Multiple Case and Data Files load option, the following controls are available:

• Add Files - Choose case and data files to load from a file selection dialog. 
Selected files are appended to the file list.

• Remove - Remove files you have selected in the file list.

• Remove All - Remove all files in the file list.

• Flow is Unsteady - Indicates that the set of case and data files represents an 
unsteady solution. The loader adds a TIME auxiliary data item to each loaded 
zone. Tecplot does not use this data, but other add-ons may.

• Flow Solution is Unsteady/Time Interval - The Fluent data loader saves the 
problem time of each solution as the solution time variable. There are two 
options for determining the time to save for each one (1) Reading the flow-time 
entry from each .dat file, or (2) applying a constant time interval to succes-
sive .dat files.

• Read Time from Data Files - If this option is selected, Tecplot reads 
the flow-data parameter from each .dat file. If no .dat files are 
included (i.e. only .cas files are loaded), the solution time variable 
will not be created for the zones.

• Apply Constant Time Interval - If this option is selected, Tecplot 
applies the time interval specified in the Time Interval text field to 
zones created from successive .cas or .dat files. The zones from 
the first .cas/.dat files are given time 0. Times for successive 
files are calculated by incrementing the time of the previous files by 
the specified time interval.

• Assign Strand IDs for Zones - Toggle-on to have Tecplot assign 
Strand IDs to transient zones. Common strand IDs will be assigned to 
each cell or boundary zone with matching Fluent zone IDs
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• Add Zones to existing Strands - Toggle-on to add the appended 
zones to StrandIDs in the current data set.

• Time Interval - If “Apply Constant Time Interval” is selected, the time inter-
val entered in the text field is included.

For the load options other than Load Residuals, some or all of the following controls are available:

• Load Cells and Boundaries - Loads the cell (solution) and boundary zones 
from the case file. Each fluid or solid cell zone and each boundary zone will be 
displayed as a separate zone in Tecplot.

• Load Cells Only - Loads only the cell (solution) zones. Each zone will be dis-
played as a separate zone in Tecplot.

• Load Boundaries Only - Loads only the boundary zones. Each zone will be 
displayed as a separate zone in Tecplot.

• Select Zones and Variables to Load - Select in a separate dialog which zones 
and variables to load. The option requires the loader to pre-scan all files, which 
can be time-consuming.

• Include Particle Data - Some Fluent simulations include the effects of dis-
crete particles, such as sand grains or water droplets. Select this option to load 
this particle data along with the flow solution. All particles from a particular 
injection will be displayed in a single Tecplot zone (one zone per injection). If 
you have chosen to select which zones and variables to load, this option is dis-
abled, but the particle zones and variables will be displayed in the selection 
lists, allowing you to load them with the flow solution.

• Average to Nodes - Selecting this option directs the loader to average Fluent's 
cell-centered data to the grid nodes. This can speed up subsequent operations in 
Tecplot, especially slicing. Fluent stores solution data at cell centers (face cen-
ters for boundary zones). By default, the Fluent data loader loads the data cell-
centered as well. However, you have the option to average the data to the nodes 
using Arithmetic or Laplacian averaging. Arithmetic averaging is faster, but 

Add Zones to existing Strands is available 
only when the current data set is being 
appended and Assign Strand IDs for 
Zones is toggled-on.
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calculates values at hanging nodes (nodes in the center of a cell face or edge) 
only from those cells where the node is a corner. This can lead to discontinuous 
contours. Laplacian averaging option takes additional neighboring cells into 
account, and results in smoother contours when hanging nodes are present.By 
default, non-grid variables are stored at cell centers, consistent with Fluent. 

• Arithmetic - A simple, fast arithmetic averaging will be performed.

• Laplacian - A more accurate, much slower averaging will be performed that 
accounts for hanging nodes and cell sizes.

If you chose the Select Zones and Variables to Load option, the select only those zones and variables 
you wish to load from the files Fluent Loader Options dialog.

This dialog has a Zones page and a Variables page. The left-hand list of each page shows, respec-
tively, all zones and variables contained in the files you selected. The right-hand list of each page 
shows the zones and variables that will be loaded when you select OK.   Use the Move, Move All,
Remove or Remove All buttons to edit the Zones/Variables to Load   lists.

See also 6 - 2 “Time Aware” on page 157 for information on working with transient data sets in 
Tecplot.
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E - 8 General Text Loader
The General Text Loader add-on allows you to read ASCII text data files in a variety of formats. 
You can specify variable and data set title information or indicate specific places in your data file to 
read them from. Instruction settings for reading a type of file can be saved and restored so they do 
not have to be entered again each time a new file of the same type is loaded.

The following options are available:

• Titles - call up the Dataset Title
dialog, which allows you to specify 
data set title properties.

• Variables - calls up the Variable 
Import Instructions dialog which 
allows you to specify data set vari-
able properties.

• Data - calls up the General Text 
Loader: Data dialog which allows 
you to specify data set field proper-
ties.

• General Filters - calls up the 
General Text Loader: Filters dialog 
which allows you to specify gen-

eral filters when reading your file.

• Configuration File List - This list shows available configuration files. Con-
figuration files can be edited using a text editor, although this is not usually 
necessary and is not recommended. The format of these files is listed on the 
Configuration page.

• Load - Loads a single configuration file from any location.
• Save - Saves a single configuration file to any location.
• Rename - Renames a configuration file.
• Delete - Deletes a configuration file.
• New - Creates a new, untitled configuration file.

• Data Preview
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• View Raw Data - This displays the data exactly how it looks in the 
file without any processing.

• View Processed Data - This displays the processed and filtered data 
which will be loaded.

• View Options - calls up the General Text Loader: View Options which 
allows you to select the viewing options.

E- 8.1 Dataset Title
The Dataset Title dialog allows you to specify options for General Text Loader titles.

• Use Title - manually enter the data set title, rather than have General Text 
Loader scan the file for it.

• Use line number - enter the line number of the data set title in the file. The 
General Text Loader skips white space on the line until text, and then reads 
until the delimiter indicated is found. To include spaces in the title, enclose 
them in double quotes.

• Use first line containing keyword - enter a keyword for the data set title line. 
The title will be read first line containing this keyword (case insensitive). Gen-
eral Text Loader searches for a title on this line in the following order, (unless 
the delimiter is specified as fixed):

1. First, it will look for any text enclosed in double quotes. If it finds this, then 
the enclosed text will be read as the title. 

2. If no text in double quotes is found, the first non-white space text after the 
keyword, ending with the indicated delimiter, will be used. 
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• Text Delimiter - The text delimiter indicates when the end of text has been 
reached. You can set it to one of the following:

•Auto - Space, tab, comma, semicolon.
•Fixed - Each width number of characters on the line is a token field. White 
space is removed from the beginning and end of the field.

•Width - If the delimiter is fixed, enter the width of each field here.

E- 8.2 Variable Import Instructions
The Variable Import Instructions dialog of the General Text Loader allows you to specify: the loca-
tion of the variable names in the data file and which variables to load.

• Scan for variable names - specify the following

• Start line - Enter the starting line of variable names in the file.
• End line - Enter the ending line of the variable names in the file. This 

is typically the same as the starting line.
• Delimiter - The delimiter indicates when the end of each variable 

name has been reached. You can set it to one of the following:
•Auto - Space, tab, comma, semicolon.
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•Fixed - Each 'width=n' number characters on the line is a variable. White 
space is removed from the beginning and end of the field. For example, if 
the line length is 60 and the width is ten, the columns 1-10,11-20,21-30, and 
so forth, are variable names. Spaces are removed from the beginning and 
end of the variable names. 

• Width - If the delimiter is fixed, enter the width of each field here.

• Enter Variable names - Select this option to enter a list of variable names in 
the dialog box. Variable names should be separated by carriage returns.

• Select Variables to Load - Launches the Variable to Load dialog.

• Variables to Skip - Displays a list of variables that will be skipped.
• Variables to Load - Displays a list of variables that will be loaded.
• Use the Move, Move All, Remove or Remove All buttons to edit the Vari-

ables to Load   list.
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E- 8.3 General Text Loader: Data
The Data Import Instructions dialog of the General Text Loader allows you to specify: the location 
of the data names in the data file and what data to load.

• Start Identification

• First all-numeric line - Select if the data begins at the first line of the 
file which contains only numbers. NOTE: if you have specified multi-
ple zones, all non-numeric lines will be skipped at the beginning of 
each zone.

• First line after line with keyword - Select if the data begins at the 
first non-blank line after the line containing the specified keyword. 
The keyword is case insensitive.

• Start at line number - Select to specify the line number where the 
data begins. Blank lines are ignored in the data section.

• End Identification



665

General Text Loader

• All lines up to first non-numeric line - Select if the data ends at the 
first non-blank line containing any text.

• Stop at line number - Select to specify the line number where the data 
ends.

• All lines up to line with keyword - Select if the data ends at the first 
line before the line with the specified keyword. The keyword is case 
insensitive.

• End of file - Select if the data ends at the end of file.

• Data Identification

• Point format - In this format all values of all variables are given for 
the first point, then the second point, etc.

• Block format - In this format all values for the first variable are given, 
then all values for the second variable, etc.

• Data value delimiter - The data value delimiter indicates when the 
end of a data value has been reached. You can set it to one of the fol-
lowing:

•Auto - Space, tab, comma, semicolon.
•Fixed - Each 'width=n' number characters on the line is a token field. White 
space is removed from the beginning and end of the field. For example, if 
the line length is 60 and the width is ten, the columns 1-10,11-20,21-30, and 
so on, are token fields.

•Width - If the delimiter is 'fixed', enter the width of each field here.

• Data Dimension - If the data dimensions are entered, General Text Loader adds 
zones as necessary depending on the number of data points found in the file. 
There must be an equal number of data points for each zone (equal to the prod-
uct of the IJK dimensions).

• Auto-Calculate IMAX - the I-dimension is calculated based on the 
number of data points found. J- and K-max are set to one.

• Specify Dimensions - specify the I-, J-, and K-dimensions for the 
data. There must be enough data points found in the file to match the 
indicated dimensions.

• Allow Multiple Zones - If checked, General Text Loader will attempt 
to read more than one zone from the data file.
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• Zone ends on line with keyword - If Allow multiple zones is selected 
and Auto-calculate IMax is selected, then you must enter a keyword 
here to mark the end of one zone and the beginning of the next. Zones 
are ended when a line containing this text is found.

• Ignore non-numeric tokens - If checked, then any non-numeric information 
in the data sections is ignored. If not checked, General Text Loader displays an 
error if any non-numeric data is found in the data section.

E- 8.4 General Text Loader: Filters
Use the General Filters dialog of the General Text Loader to filter the data file.

• Ignore All Lines Starting With -   If checked, all lines beginning with the 
entered string would be ignored. 

• Ignore All Lines Containing - If checked, all lines containing the indicated 
text are ignored.

• Ignore Character Column Position(s) - If checked, then the entered columns 
are ignored when scanning the file. Columns are entered as a single number or 
a hyphenated range, one or more of which may be separated by commas.

Note: If there are tabs in the data file, they are not 
expanded in this filter. For example, if column 1 is 
a tab and you wish to skip column 2, you should 
enter 2, even though a text editor will show more 

than one space after expanding the tab.
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• Ignore Specific Lines - If checked entered lines are ignored when scanning 
the file. Lines are entered as a single number or a hyphenated range, one or 
more of which may be separated by commas. You may also use “end” to spec-
ify the last line of the file. 

• Specify Values for Blanked Cell - If checked, you can specify a value which 
the loader uses for blank cells. 

E- 8.5 General Text Loader: View Options
The View Options dialog of the General Text Loader allows you to specify the data display.

• General Options:

• Limit lines displayed - Limits the number of lines displayed in the 
preview window. For large files, you may want to set this to a number 
less than the total number of lines. The fewer number of lines, the 
faster the preview display.

• Do not limit - If you select this toggle then the entire file will be dis-
played in preview mode.

Note: This option is only available if the data 
delimiter is a comma or semicolon. You can change 
the data value delimiter using the Data Import 
Instructions dialog.
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• Auto Process - If selected, General Text Loader automatically 
refreshes all information about the file whenever any loader settings 
are changed. For very large files (multi-megabyte), this option is not 
recommended, since re-scanning a large file can be time consuming.

• Processed Data:

• Show variables names and data - If selected, variable names and 
processed data will be displayed in the preview window.

• Show variable names only - If selected, variable names only will be 
displayed in the preview window.

• Show all non-processed lines - If selected, all lines which will not be 
loaded will be displayed in the preview window.

• Show data in columns - Shows the data in columns where each col-
umn is a variable.

• Show data in blocks - Shows the data in blocks where each block is a 
variable.

E- 8.6 General Text Loader Configuration File
A configuration file contains all of the instructions which tell General Text Loader how to load a 
particular type of text file. This information is collected from the dialog fields and written to a file 
when you click Save on the main dialog. The configuration file format is similar to the Tecplot 
macro language format. Configuration files for the general text loader are ASCII text files which 
use a command set that can describe all loading instructions. Normally you do not need to edit 
these files, as they are automatically written by the loader when you select New on the main dialog.

General Text Loader CONFIGFNAME Command
When reading a data set using General Text Loader, instead of specifying individual parameters in 
$!READDATASET, you may use the CONFIGFNAME command.

This consists of:

CONFIGFNAME = <string>

Note: Editing these configuration files by 
hand is not recommended.
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VERSION = <integer> 

    # version of the template file (default is 100)

     # Note: changing the version number may cause unpredictable 
behavior

TITLE

{

SEARCH = [NONE|LINE|KEYWORD] # default = NONE

NAME = <string> 

      # default = “New Dataset”, ignored if SEARCH is not NONE

LINE = <integer> # 1-based, ignored if SEARCH is not LINE

KEYWORD = <string> # ignored if SEARCH is not KEYWORD

DELIMITER = [AUTO|TAB|SPACE|SEMICOLON|COMMA|FIXED]

WIDTH = <integer> # Valid only if DELIMITER = FIXED

}

VARIABLES

{

SEARCH = [NONE|SCAN]

NAMES = <string> # ignored SEARCH is SCAN, <string> is a comma 
separated string

LOADED = <all|n1,n2,...nn> # list of variables to be loaded, or 
ALL to load all variables

STARTLINE = <integer> # 1-based, ignored if SEARCH=NONE, default 
= 1

{

STARTID = [FIRSTNUMERICLINE | LINE | KEYWORD]

{

KEYWORD = <string> # ignored if STARTID is not KEYWORD

ENDLINE = <integer> # 1-based, ignored if SEARCH=NONE, default = 
1

DELIMITER = [AUTO|TAB|SPACE|SEMICOLON|COMMA|FIXED]
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WIDTH = <integer> # Valid only if DELIMITER = FIXED

}

DATA

{

IGNORENONNUMERICTOKENS = <boolean> # default = TRUE

IMPORT

LINE = <integer> 

# 1-based, ignored if STARTIDENTIFICATION is not LINE

}

ENDID = [FIRSTNONNUMERICLINE | LINE | KEYWORD]

{

KEYWORD = <string> # ignored if ENDID is not KEYWORD

LINE = <integer> # 1-based, ignored if ENDID is not LINE

}

FORMAT = [POINT|BLOCK] # default POINT

DELIMITER = [AUTO|TAB|SPACE|SEMICOLON|COMMA|FIXED]

WIDTH = <integer> # Valid only if DELIMITER = FIXED

}

DIMENSION

{

AUTO=<boolean> # default = TRUE

IMAX=<integer> # ignored if AUTO = TRUE, default = 1

JMAX=<integer> # ignored if AUTO = TRUE, default = 1

KMAX=<integer> # ignored if AUTO = TRUE, default = 1

USEMULTIPLEZONES = <boolean> # ignored if AUTO = TRUE, default 
false

KEYWORD=<string> # ignored if USEMULTIPLEZONES = FALSE

}

}

GLOBALFILTERS # filters are applied cumulatively, so lines 
matching

# any of the criteria are filtered
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{

COMMENT = <string> # ignore lines beginning with <string>

NUMBER = <integer> # ignore all lines starting with line number 
<integer>

KEYWORD = <string> # ignore all containing <string> (case 
insensitive)

COLUMNS = <list> #<list> is a UNIX-style comma separated list of 
number ranges

# example: “1-80,100-end”, etc. Must be in double quotes
ROWS = <list> # same as above
USEBLANKCELLVALUE = <boolean> # if TRUE, then the value of blank cells is 
BLANKCELLVALUE

BLANKCELLVALUE = <double> # blank cell value. Ignored if 
USEBLANKCELLVALUE is FALSE

}

Where <string> is a file name or file path. Settings will be loaded from the file name specified 
in <string>. This command is only allowed in conjunction with the $!READDATASET com-
mand as described below. It may not be used inside a configuration file.

For example, instead of:

$!READDATASET '"C:\test.txt” “VERSION=100 
FILEEXT=\"*.txt\" FILEDESC=\"general text\" 
"+""+"TITLE{SEARCH=NONE NAME=\"New Dataset\" LINE=1 
DELIMITER=AUTO WIDTH=10 }"+""+"VARIABLES{"+"SEARCH=LINE 
LOADED= All STARTLINE=1 ENDLINE=3 DELIMITER=SEMICOLON 
WIDTH=5 }"+""+"DATA"+"{"+"IGNORENONNUMERICTOKENS=TRUE 
IMPORT"+"{"+"STARTID=LINE {"+"LINE=4 
}"+""+"ENDID=FIRSTNONNUMERICLINE {"+"LINE=1 
}"+""+"FORMAT=IJKPOINT DELIMITER=AUTO WIDTH=1 
}"+""+"DIMENSION"+"{"+"AUTO=TRUE 
CREATEMULTIPLEZONES=FALSE 
}"+"}"+"GLOBALFILTERS{"+"USEBLANKCELLVALUE=TRUE 
BLANKCELLVALUE=0.000000 }"'
DATASETREADER = 'General Text Loader'
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Using the CONFIGFNAME command, you can write:

Components of the Configuration File

• All General Text Loader configuration files must start with the line:

#!TECPLOT_LOADGEN

• Instruction Syntax - Each instruction file contains commands which describe 
the loading instructions.

• Comments - Any text following '#' to the end of the line is ignored.

• String Format - The <string> parameter must be enclosed in double quotes. 
You can include a double quote character in the string by preceding it with a 
backslash '\.' For example:

“This is a normal string”

“This is a \"quote\" inside a string”

• List Format - The <list> parameter type is defined as one or more number 
ranges, separated by commas, enclosed in double quotes. A number range may 
be a single number, or two numbers separated by a dash. Optionally, you may 
use “end” to indicate the last valid number. For example:

“1”

“1,2-7,3”

“10-end,3,2-5”

• Command List - The commands in the file may appear in any order, and any 
command may be divided into any number of lines (that is, all white space, 
including carriage returns, is ignored).

$!READDATASET ' “myfile.dat” 
“CONFIGFNAME=c:\config_files\myconfig.lgc” ' # contains 
all of the instructions in the example above 
DATASETREADER='General Text Loader'
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E - 9 Gridgen Loader
The Gridgen Loader add-on accepts output from Pointwise, Inc.’s Gridgen Version 11. (Tecplot, 
Inc. has not tested previous versions.) The Gridgen Loader can import the following types of Grid-
gen files into Tecplot1:

• Database Network (*.net)—one IJ-ordered zone is created for each network 
in the file.

• Volume Grid (*.dat)—one IJK-ordered zone is created for each block of 
data in the file.

The files can be in any of the following formats, which are automatically detected:

•  ASCII.

•  Binary formatted.

•  Binary unformatted.

•  Single or double precision.

The data set is given a default title of “Imported Gridgen Data,” which you may change using the 
Data Set Info dialog from the Data menu.

Variables names default to “X,” “Y,” and “Z.” These can be changed within Tecplot after the data set 
is loaded.

The Gridgen Loader leads you through several screens, each of which allows you to specify one or 
more attributes of the input files.

1. More information on Gridgen Volume Grid and Database Network files can be found in the Gridgen User’s Manual.
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Gridgen Data Loading with Tecplot
The Gridgen Loader dialog asks for the following information:

• File Type - Select the type of file you wish to import.

• I-Skip, J-Skip, K-Skip - Select the I-, J-, and K-Skip values. A value of 1 will 
read every data point, 2 will read every other data point, and so on.

After you have selected the file type and skip values, click OK and you will be prompted for one or 
more files to load. Select one or more files and click OK to load the files.

E - 10 HDF Loader
The Tecplot HDF Loader add-on can load 1-D, 2D, and 3D Scientific Data Sets (SDS) from HDF 
files1.

.When a data set from an HDF file is imported, the file is scanned and a list of all SDS in the file is 
displayed in the “Scientific Data Sets to load” portion of the HDF Loader dialog. Select one or 
more SDS to import. Each SDS that you select must have the same dimension. A rectangular I-, 
IJ-, or IJK-ordered zone (for 1-, 2-, or 3D data, respectively) is created for each SDS that you select 
to load.

The HDF Loader dialog asks the following information:

• Scientific Data Sets to load - Select one or more 
SDS's to load. Each SDS that you select must 
have the same rank (dimension).

• I-Skip - Select the I-Skip value. A skip value of 
1 loads every data point, a skip value of two 
loads every second data point, and so on.

• J-Skip - Select the J-Skip value.

• K-Skip - Select the K-Skip value.

• Select File - Select an HDF file.

1. Note: The HDF Loader uses the public-domain HDF API code library from the National Center for Supercomput-
ing Applications (NCSA), University of Illinois, Urbana-Champaign.
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• Attributes - Displays attributes of each SDS found, such as number type, rank, 
label, and so on.

E- 10.1 HDF Loader Limitations
The HDF Loader can import only Scientific Data Sets from HDF files, and these are imported in a 
manner similar to NCSA’s own HDF viewer. The way in which the data file is interpreted cannot be 
altered in this release of the loader. However, it is possible to write a Tecplot add-on (using the 
NCSA code library) which loads HDF data in a manner more suited to your particular use of the 
HDF format. See the ADK User’s Manual for more information on writing add-ons.

E - 11 HDF 5 Loader
The HDF5 loader add-on allows you to import general HDF5 files into Tecplot. The loader provides 
a mechanism for importing generic data from multiple HDF5 datasets or groups. The HDF5 loader
will load datasets within user selected groups, load one or more user selected datasets to one zone, 
load multiple user selected datasets to multiple zones, execute macros after data has been loaded, 
create implicit X, Y, and Z grid vectors as needed, sub-sample loaded data, and reference user 
selected vectors for X, Y, and Z grids. Datasets must be ordered data. 

For information regarding HDF5 format refer to: http://hdf.ncsa.uiuc.edu/HDF5/.

E- 11.1 Data Selection
HDF5 files may be viewed and selected by pressing the Select File button in the HDF5 loader dia-
log. One or more files may be selected if all selected files have an identical hierarchy. Hierarchy 
information for the selected HDF5 files is displayed in the Available Datasets window in the form: /
group/[group]…/dataset - the dimension of each dataset is displayed immediately following the 
dataset name. In this window, one or more datasets or groups may be selected for loading.

E- 11.2 Importing/Loading Data
Datasets may be loaded using one of three methods: 1) Loading Multiple Datasets to One Zone 
(default), 2)Loading Multiple Datasets to Separate Zones, or 3)Loading Datasets by Group.

Loading Multiple Datasets to One Zone (default)
Loading multiple datasets to one zone is the default method of importing HDF5 files. Using this 
method the HDF5 loader will create one zone with N variables, where N is the number of HDF5 
datasets selected in the Available Datasets window. Selected datasets may have one to three dimen-
sions. The dimension of loaded Tecplot variables will match the I, J, and K values of the selected 

http://hdf.ncsa.uiuc.edu/HDF5/
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datasets. Variable names are assigned the corresponding names of selected datasets - the dimen-
sionality of each selected dataset must be equivalent. 

To import your data, select one or more datasets from the Available Datasets window. All selected 
datasets must be identical in dimension; dataset dimensions are shown immediately to the right of 
dataset names in the Available Datasets window.

Loading Multiple Datasets to Separate Zones
Using this method the HDF5 loader will create N zones where N is the number of datasets selected 
in the Available Datasets window. Each zone contains one variable per selected dataset where each 
dataset must have one to three dimensions. The I, J, and K values of each Tecplot zone will match 
the dimensionality of each selected dataset. Variable and zone names are automatically assigned. 
Dimensionality may vary between selected datasets. 

To import your data using this method, select the Load to Separate Zones toggle. Select one or more 
datasets from the Available Datasets window. One zone will be created for each selected dataset and 
each zone will contain exactly one variable (unless you selected Create Implicit Grid Values or Ref-
erence Data Grids.

Loading Datasets by Group
Using this method the HDF5 loader will create N zones with M variables where N is the number of 
groups selected in the Available Datasets window and M is the number of datasets in each group. 
The I, J, and K indices of the Tecplot variables will be equivalent to the respective dimension of 
selected datasets. Datasets in any selected group must be equal in dimension; however datasets may 
be unequal in dimension between groups. When selecting multiple groups all groups must contain 
an equal number of datasets and dataset names must be identical between groups. The HDF5 loader
will only load datasets within the root directory or within a subgroup, i.e., the HDF5 loader will not 
load data within nested groups.

To import your data using this method, select the Load Datasets by Group toggle. Press Select File to 
open a HDF5 file. Select one or more groups from the Available Datasets window; all groups must 
contain an equal number of datasets where all datasets have identical names between groups. The 
number of selected groups determines the number of zones that load into Tecplot. Zone names will 
match the name of the corresponding group. Variable names will match the respective dataset 
name. Each zone will include as many variables as datasets per selected groups.
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E- 11.3 Additional Options
Additional options may be specified when loading HDF5 data into Tecplot. These options include: 
Using Macros, Sub-Sampling Data, Referencing Data Grids, and Grid Generation.

Using Macros
Macros may be defined within a HDF5 vector and placed in any group. Each character string in the 
selected vector must be a valid one-line Tecplot macro. Macros are executed in the order encoun-
tered and after all data are loaded.

To run a macro defined as a character vector in your HDF5 file, select the Run Macros in Selected 
Group toggle. From the Select Macro pull-down menu select the macro you want to execute. Your 
macro will run after your data has been successfully loaded into Tecplot.

Sub-Sampling Data
The HDF5 loader will sub-sample the first, second, and third dimensions of loaded datasets respec-
tively as defined by the user. The default skip-value is 1. When specifying non-unitary skip values 
the dimensionality of all selected datasets must be equivalent. Datasets will be sub-sampled using 
the user defined I-Skip, J-Skip, and/or K-Skip values – skip values must be whole numbers.

To sub-sample data in the first, and/or second, and/or third dimensions of selected datasets change 
the respective I-Skip, and/or J-Skip, and/or K-Skip values located in the HDF5 loader dialog. If the 
skip-values are non-unitary then the dimensionality of all selected datasets must be equivalent.

Referencing Data Grids
The HDF5 loader allows users to specify X, and/or Y, and/or Z grid vectors. Selected vectors are 
used for plotting all zones. Vectors are of dimension 1 and length M. The X grid vector length must 
equal to the first dimension of selected datasets, the Y grid vector length must be equal to the sec-
ond dimension of selected datasets, and the Z grid vector length must be equal to the third dimen-
sion of selected datasets. The number of selected grid vectors must equal the rank of selected 
datasets.

To define the grid vectors you may choose them from a pull-down menu. Begin by deselecting the 
Create Implicit Grid Values option and select the Reference Data Grids button. A child dialog will 
appear (Fig. 2), from the X, Y, and Z menus select the vector you want to use as the corresponding 
grid. You MUST select the toggle Use Data Grids. The number of grid vectors you specify must 
equal the rank of selected datasets.
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Grid Generation
The HDF5 loader can automatically create X, Y, and Z grid vectors as necessary for selected 
datasets. Grid vectors will be of length equal to the corresponding dimension. 

To automatically create X, Y, and Z grid vectors select Create Implicit Grid Values in the HDF5 
loader dialog – this is selected by default. The grid vectors will be created upon loading your data 
into Tecplot.

E - 12 Kiva Loader
The Kiva loader imports files in the GMV format that were exported from Kiva. 

• Select Input Files – From this button, multiple files can be selected in the
Read Kiva/GMV File dialog. Those that are in GMV format will be added to the 
list of Kiva/GMV files. Once files are added to this list, they will remain in the 
list throughout the Tecplot session, unless the Clear List button is selected. 

• File Selections - Use the File Selection options for long file lists. Identify the 
first file to load by entering a number in the Start field, and the last file to load 
by entering a number in the Stop field.  

Enter a value of 2 in the Skip field to load every other file, or 3 or greater to skip 
more files.  To see the list selections updated according to the values in the Start, 
Stop and Skip fields, click the Apply Skip button.  At any time, you can choose to 
Select All or Deselect All files.  

• Velocity Vector – Identify the naming convention for your velocity vectors.

• Loading Options:

• IsDouble - allows greater precision for your data values. 
• LoadParticleData - adds a zone for any files containing particle data.

Select Variable to Load
After clicking the OK button with one or more files selected, the Select Variables dialog appears. 
Clear All allows only variables X, Y and Z to be loaded.  You can use the Select All button to load 
all variables, or you can highlight variable names in the list.
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E - 13 PLOT3D Loader
The PLOT3D Loader add-on can import data files formatted for the PLOT3D program developed 
by Pieter Buning at the NASA Ames Research Center. Some extensions such as unstructured data 
that are now available in FAST, the successor to PLOT3D, are also supported.

E- 13.1 File Combinations
Use the File Selection page of the PLOT3D Loader dialog to specify whether to load just the grid 

file, both the grid and solution files, or just solution files. Choosing both will allow you to option-
ally specify a name file as well. The name file contains names to replace either the function or solu-
tion variable names on a 1-to-1 basis for as many names as are in either file. If a boundary file 
exists, it must have the required syntax 'gridfilenamewithextension.fvbnd' and will be automatically 
loaded.
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The following table describes all six scenarios and what the PLOT3D loader does:

Grid Only Existing data set is deleted 
and zones (one per grid are 
loaded).

New zones are added (one 
per grid). Solution vari-
ables in new zones are 
zeroed out.

Grid and Solu-
tion

Existing data set is deleted 
and zones (one for each 
grid in each solution file) 
are loaded. Each set of 
zones loaded shares spatial 
variables with the first set 
of grids loaded.

Same as “Not Appending” 
except original data set is 
preserved. Existing data set 
must have at least as many 
variables as the number 
needed by the incoming 
data.

Solution Only A data set must already be 
present. The existing data 
set is reduced to contain the 
same number of zones as 
there are grids in each 
incoming solution file. 
Solution variables in the 
first solution file replace 
the solution variables in the 
original zones. Subsequent 
solution files create new 
sets of zones with spatial 
variables shared with the 
first set of zones.

Same as “Not Appending” 
except original data set is 
preserved. Existing dataset 
must have at least as many 
variables as the number 
contained in incoming solu-
tion file. Spatial variables 
are shared with last n origi-
nal zones where n is the 
number of grids in each 
incoming solution file.

 

Load Not Appending Appending
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E- 13.2 PLOT3D File Structure
The File Structure page of the PLOT3D Loader dialog allows you to choose to have the PLOT3D 
Loader auto detect the file structure, or override and manually describe the structure.

The PLOT3D Loader can auto detect most PLOT3D file variants. ASCII files are the most difficult 
to auto detect as there are a few combinations that have the exact same signature. Pure binary files 
also have some combinations that have the same signature. If the auto-detect fails, use the manual 
settings to load in the files.

To enhance performance when loading multiple solution/function files, the primary solution/func-
tion file can be chosen to represent the structure of all subsequent files. The user must determine if 
this is appropriate. Toggle-on Assume all Solution/Function Files have the same structure to acti-
vate this option.

Unstructured Data Files. The following ASCII file conditions require special attention: 

Condition Notes

Double Precision You must tell the loader if the incoming file is single or 
double precision.
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Pure Binary Files. The following pure binary files (binary files without record markers) 
require special attention:

I-Blanking You must tell the loader if the incoming file contains I-
blanking.

3D Planar There are some cases where these files can appear 
exactly the same if they are 3D Whole. The PLOT3D 
loader always favors 3D Whole. If you need to load 3D 
Planar in 3D Planar ASCII files you must specify the 
data structure manually.

Condition Notes

3D Planar There are some cases where these files can appear 
exactly the same if they are 3D Whole. The PLOT3D 
loader always favors 3D Whole. If you need to load in 
3D Planar pure binary files you must specify the data 
structure manually.

Condition Notes
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E- 13.3 PLOT3D Data Subsets
The Data Subset page of the PLOT3D Loader allows you: to read subsets of ordered zones within 
the files, specify the desired beginning and ending index values to read and a skip value for each 
index direction. A skip of one results in every value in the specified index range being read. A skip 
of 2 reads every second value, and so on.

E- 13.4 Plot3D Time Aware Options
The Transient Options page of the PLOT3D Loader dialog allows you to choose the PLOT3D 
Loader to automatically assign Strand IDs for transient zones. This option is set to ON by default. 

Figure E-11. The Data Subset page of the PLOT 3D Loader Dialog.
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An option to add zones to current strands can be used if appending zones to existing transient data. 
This option is set to OFF by default.”

If some zones are static and some are time-aware, load the static zones and then append the time-
aware zones.

E- 13.5 Macro Language
The macro language syntax for the PLOT3D Loader shipped with Tecplot 360 has changed from 
that of previous versions. Layouts created with previous versions can still be read, but will be saved 
with the newer syntax.

New Instruction Syntax. The new loader uses the Standard syntax so layouts can be saved 
and automatically use relative paths for file names. The following table lists the standard syntax 
name-value pairs used by the PLOT3D Loader:

Keyword Value(s) Default Notes

STANDARDSYNTAX 1.0 None/
Require
d

Must be the 
first 
instruction.

FILELIST_SOLUTIONFI
LES

“n” “file-1” “file-
2”.... “file-n”

Empty

FILENAME_GRIDFILE “filename” Empty
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FILENAME_NAMEFILE “filename” Empty
IINDEXRANGE “indexrange” “1,,1” Start, End, 

Skip
JINDEXRANGE “indexrange” “1,,1” Start, End, 

Skip
KINDEXRANGE “indexrange” “1,,1” Start, End, 

Skip
APPEND “Yes” or “No” “No”
ASCIIISDOUBLE “Yes” or “No” “No”
ASCIIHASBLANK “Yes” or “No” “No”
AUTODETECT “Yes” or “No” “Yes”
DATASTRUCTURE “1D”, “2D”, “3DP”, 

“3DW”, 
or 
“UNSTRUC-
TURED”

--- Required if 
AUTODE-
TECT is 
“No,” oth-
erwise 
ignored.

ISMULTIGRID “Yes” or “No” --- Required if 
AUTODE-
TECT is 
“No,” oth-
erwise 
ignored.

STYLE “PLOT3DCLASSI
C”
“PLOT3DFUNCTI
ON”
or
“OVERFLOW”

--- Required if 
AUTODE-
TECT is 
“No,” oth-
erwise 
ignored.

Keyword Value(s) Default Notes
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E- 13.6 PLOT3D Auxiliary Data
The following auxiliary data is created by the PLOT3D Loader:

AUTOASSIGNSTRANDS “Yes” or “No” “No”
ADDTOEXISTING-
STRANDS

“Yes” or “No” “No”

Auxiliary Name Assigned To

Common.ReferenceMachNumber Data Set and Individual 
Zones (1)

Common.AngleOfAttack Data Set and Individual 
Zones (1)

Common.ReynoldsNumber Data Set and Individual 
Zones (1)

Common.IsBoundaryZone Individual Zones
Common.BoundaryCondition Individual Zones
Common.DensityVar Data Set
Common.UVar Data Set
Common.VVar Data Set
Common.WVar Data Set
Common.StagnationEnergyVar Data Set
Common.GammaVar Data Set
Common.TurbulentKineticEner-
gyVar

Data Set

Common.TurbulentDissipation-
RateVar

Data Set

Common.VectorVarsAreVelocity Data Set
Common.SpeedOfSound Data Set

Keyword Value(s) Default Notes
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Notes: (1) Auxiliary data assigned to both zones and the data set assign the value from the last zone 
processed to the data set; (2) Overflow specific constants.

E- 13.7 PLOT3D Loader Limitations
The -ip, -jp, -kp options in older PLOT3D Loader are not supported in the initial release. 
Tecplot handles I-, J- and K-planes well, so loading 3D planar files as a single zone is typically 
sufficient.

E - 14 PLY Loader
Use this loader to load 3D triangular surface files with the .ply extension. This format is often used 
to store surfaces generated from tessellation of 3D range measurement data. Files may be either 
ASCII or binary, but must contain both vertex and face elements (sections). This loader is freely1

available from the Tecplot Web site at www.tecplot.com.

E - 15 Tecplot-Format Loader
This section describes the process for loading Tecplot-format data files, as well as reading data files 
formatted for other software.   Tecplot uses the standard extensions .dat for ASCII and .plt for 
binary.

G (2) Individual Zones
B (2) Individual Zones
T (2) Individual Zones
I (2) Individual Zones
H (2) Individual Zones
H1 (2) Individual Zones
H2 (2) Individual Zones

1. Copyright for Third Party Library
This loader utilizes a modified version of a library written by Greg Turk while at Stanford University. The copyright for this library is 

repeated below. 
Copyright © 1994 The Board of Trustees of The Leland Stanford Junior University. All rights reserved.
Permission to use, copy, modify and distribute this software and its documentation for any purpose is hereby granted without fee, pro-

vided that the above copyright notice and this permission notice appear in all copies of this software and that you do not sell the 
software.

The software is provided “as is” and without warranty of any kind, express, implied or otherwise, including without limitation, any war-
ranty of merchantability or fitness for a particular purpose.

Auxiliary Name Assigned To

http://www.tecplot.com
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There are four ways to work with Tecplot-format data files:

• Generate a Tecplot-format ASCII data file. Read the file into Tecplot and work 
without conversion. If the data set is altered, save it as an ASCII data file. This 
method works for smaller data sets where the convenience of an ASCII file out-
weighs any inefficiencies.

• Generate a Tecplot-format ASCII data file. Read it into Tecplot, then save it as 
a binary data file, then work with the binary file. Once you have saved a binary 
version, you can delete the ASCII version. This works well for large data sets 
where ASCII inefficiencies are noticeable. See 22 - 3 “Data File Writing” on 
page 456.

• Generate a Tecplot-format ASCII data file, then convert it to a binary file with 
Preplot. (Preplot, a utility program included with Tecplot, converts ASCII and 
PLOT3D to binary Tecplot-format data files.) Once the binary file is created, 
delete the ASCII version to save space. This works well for identifying prob-
lems with data files, since Preplot’s error messages include precise details. This 
method also works well in batch processing, or if the ASCII data files are gen-
erated on another machine. (See Section 2- 4.2 “ASCII Data File Conversion to 
Binary” on page 55 of the Data Format Guide for a description of Preplot.)

• Generate a Tecplot-format binary data file. Read the binary data file into Tec-
plot and work without conversion. You must use routines provided by Tecplot 
to write Tecplot-format binary files from C or FORTRAN programs. See 
Appendix Chapter 3 “Binary Data” on page 71 of the Data Format Guide
Binary Data in the Data Format Guide for complete details.
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E- 15.1 Tecplot Data File Loading
The Tecplot Data Loader (accessed via File>Load Data File(s)) allows you to load ASCII (.dat) and 
Tecplot-format (.plt) files. 

Use the Multiple Files button to load more than one Tecplot file.

Tecplot allows you to specifically control what is loaded from your data files by toggling-on Specify 
Options.   After you select the file(s) to load and hit the OK button, use the Load Data File Options
dialog to specify the information to load from your data file.

E- 15.2 Load Data File Options
The Load Data File Options dialog has three pages—General, Zones, Vars (Variables).

Data File Loading General Options
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On the General page, you have the option to load a subset of record types or load only portions of 
the data.

To load specific record types from the data file, select the desired record types by choosing the 
appropriate check boxes:

Field Data Load zone records (the actual data). If not selected, the 
Zones and Vars pages of the dialog are inactive.

Text Load text records.
Geometries Load geometry records.
Custom Labels Load custom label records.

 The toggles are available only if those records exist in the data files. By 

default, all of the records in the data files are selected.

If you want to load a portion of the data points, specify skip factors for the I-, J-, and K-dimensions 
in the corresponding text fields. Each skip factor n tells Tecplot to read in every nth point in the 
specified direction. By default, all the skip factors are set to one, so every data point is loaded.

If data being loaded into Tecplot has time associated with one or more of the zones but is missing 
explicit strand ID assignments, you can direct Tecplot to assign strand ID's by toggling-on Assign 
Strand IDs for Zones. This calls a simple algorithm which groups together solutions 

Additionally, if you are appending data, you can direct Tecplot to either add the zones from the new 
data to matching strands in the dataset or simply append the new strands.
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Data File Loading Zone Options

The Zones page allows you to select specific zones to load from data files and, if appropriate, 
whether to collapse the zone list.To specify which zones to load, select them in the Select Zones to 
Load list box. By default, all zones are selected to be loaded.

If you have selected to only load specific zones and want them renumbered upon loading, select 
Collapse Zone List. (If you are loading variables by position, the check box reads Collapse Zone and 
Variable Lists.) See Section , “Zone and Variable List Collapsing,” for more information.

Data File Loading Variable Options

The Variables page loads variables by name (default) or   position. When loading variables by
name, Tecplot creates variables based on the variable names in the data files. When loading vari-
ables by position, Tecplot creates variables based on their order in the data files.The order of vari-
able order based on their order in the first data file loaded (for loading by position or by name).

Variable Loading by Name
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Using the Load Variables by Name area of the Load Data File Options dialog’s Vars page, you may 
select specific variable names to load from the data files.

When loading variables by name, variables are associated by name then loaded into Tecplot. Vari-
able names can be combined; two variables with different names in different files can be loaded 
into a single Tecplot variable. When a variable name is missing, the variable is set to zeros for all 
zones loaded from that file.

The Show Variables From list box displays variable names from the data files to load. Filter the list 
with the drop-down above the list. Choosing All Data Files shows variable names from all data files 
in order by data file and then in order by name Identical variable names from more than one file 
appears only once in the list. An asterisk (*) next to a variable name indicates the variable name 
does not exist in all the files. A number next to a variable name indicates the Tecplot variable num-
ber to be assigned to the variable.

The Variables to Load list box displays variables to be loaded into Tecplot. By default, it shows only 
variable names existing in all of the data files selected. If no matching variable names exist, the list 
is empty. An asterisk (*) next to a variable name indicates the name does not exist for all files. If 
you load a file with an asterisk, the file’s zones are set to zero for that variable. Duplicate variable 
names are not allowed. Use the Move, Move All, Remove or Remove All buttons to edit the Variables 
to Load   list.

You have limited options in changing Variables to Load when appending data files to the current 
data set or replacing the current data set while retaining the plot style. The list is partially deter-
mined by the current data set. You can add names or combine new names, but you cannot remove 
any variable names.
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When appending data files to the current data set by adding names to Variables to Load, adding a 
new name which exists in the current data set, but which was not loaded initially, forces Tecplot to 
reload the original data files to include the variable name.

Variable Loading by Position

The Load Variables By Position area of the Load Data File Options dialog’s Vars page allows you to 
select specific variables to load from data files, and to collapse the zone and variable lists when 
possible.

To specify variables to load from data files, select them in Select Variables to Load. This is a multi-
ple selection list box where you can click-and-drag, CTRL+click, or Shift-click to choose variable. 
The variable names listed come from the first data file. If variable names in the other files do not 
match those in the first, an asterisk (*) appears next to the name. The number of variables listed is 
limited to the minimum number in all of the files. By default, all of the variables are selected to be 
loaded.

If you have chosen to load specific variables and want them renumbered, select the “Collapse Zone 
and Variable Lists” check box. See “Zone and Variable List Collapsing” on page 693 for more 
information.

When appending files to the current data set or replacing the current data set while retaining the 
plot style, you cannot select the variables to load. These are determined by the variables currently 
in Tecplot. When appending files to the current data set, the new files must have at least as many 
variables as are currently in Tecplot.

Zone and Variable List Collapsing
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When loading files you have the option of reading only selected zones (and variables when loading 
by position). You may either preserve existing zone and variable numbering, or “collapse” the data 
read so zones and variables are renumbered according to their positions in Tecplot.

For example, zones 2 and 5 of a five zone data file are loaded. If the zones and variables are not col-
lapsed (the default), Tecplot reads them in as zones 2 and 5. Writing this data set to an ASCII file, it 
has five zones; zones 1, 3, and 4 have no data (“Zombie” zones). Selecting the collapse option, Tec-
plot reads them in as zones 1 and 2. Writing this data set to a file yields only two zones.

In most cases collapsing zones and variables is unnecessary. All dialogs showing zones or variables 
list the zones read in, though they may not be numbered sequentially. Do not collapse zones and 
variables when:

• You have a large data set and read a portion of the data to reduce the amount of 
memory used in processing. You then create a stylesheet to use at a later time 
with a different sub-set of the data.

• You have many zones and variables and you are familiar with certain ranges of 
them. (For example, you may know that zones 150-200 represent a known por-
tion of the data.) If you partially read the data and do not collapse it, these 
zones continue to be designated with their familiar numbers.

Load Data File: Simple Warning
A warning dialog opens when you try to load a new Tecplot file and the current frame has a data set 
attached. If the current data set is used only by the current frame, there are three options:

• Replace Data Set and Reset Frame Style - Select this to read in the new data 
set in a frame with style sheet attributes redefined to the new frame defaults.
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• Replace Data Set and Retain Frame Style - Select this to read in the new 
data set, but keep the style sheet attributes in the current data set.

• Add to Current Data Set - Select this to keep the current data set and add to 
add the new specified data file into the current data, in the current frame.

Load Data File: Complex Warning
A warning dialog opens when you try to load a new Tecplot file and the current frame has a data set 
attached to it that is also attached to other frames. The Load Data File Warning has the following 
options: 

• Create New Data Set and Reset Current Frame Style - Select this to create a 
new data set in the current frame with the style sheet attributes redefined to new 
frame defaults. The other frames will retain the original data set and style.

• Create New Data Set and Retain Current Frame Style - Select this to create 
a new data set and keep the style sheet attributes in the current frame. The other 
frames will retain the original data set and style.

• Add to Current Data Set - Select this to attach the new specified data file into 
the current data, in the current frame. The other frames will retain the original 
data set and style.

• Replace Current Data Set with New Data Set - Select this to substitute the 
new data set everywhere the current data set is used while retaining the current 
data set's style sheet attributes. 
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Select Initial Plot Type
Once you have loaded your file(s), the Select Initial Plot dialog will appear with the following 
options:

• Initial Plot Type - Set the plot type (2D or 3D, XY, Polar, Sketch, or Auto-
matic). When Automatic is chosen, Tecplot attempts to match the data to the 
best plot type using the following parameters:

• 3D Cartesian - If any finite-element volumes or IJK-zones are present
• 2D Cartesian - If finite-element surfaces or IJ-zones are present
• XY Line - all other data structures

• Show First Zone Only - Loads all zones, but displays only the first zone of a 
plot.

• Use These Settings for All Data Sets - Applies your selections to any addi-
tional plots loaded.

E - 16 Text Spreadsheet Loader
The Text Spreadsheet Loader add-on is both an example of how to write a loader add-on and a util-
ity which allows you import simple data from ASCII files. The complete source code for the Text 
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Spreadsheet Loader is included in the ADK Examples directory.

Figure E-12. Text Spreadsheet Loader dialog.

 Select the delimiter and I-skip (if 

necessary) from the Simple Spreadsheet File Loader dialog.

The Text Spreadsheet Loader can read ASCII files of the following format (blank lines are 
ignored):

 Variable 1, Variable 2, ..., Variable N
 datapoint1,datapoint2, ..., datapoint N
 .
 .
 .
 datapoint1,datapoint2, ..., datapointN

Here is an example of a valid ASCII spreadsheet file:

Month, Rainfall
1, 15.0
2, 21.0
3, 21.0
4, 32.0
5, 10.3
6, 5.1
7, 2.3
8, 0.2
9, 1.4
10, 8.3
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11, 12.2
12, 15.4 

 Text Spreadsheet Loader Limitations
All of the variable names must be on the first line.
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Symbols

Appendix F PLOT3D Function 
Reference

This chapter details the PLOT3D functions available in the Calculate dialog (accessed via the
Analyze menu). Formulae, where not trivial, are given for each function. For functions that have 
equivalent PLOT3D function numbers, the numbers are listed as well. Refer to Section , “Selecting 
a Function,” for a description of how to use these numbers.

F - 1 Symbols
The following symbols are used in formulae below. Other symbols are defined in context.

Symbol Description

Reference or free-stream quantity.

Ratio of specific heats, 

Density, mass per unit volume (area in 2D).

Generalized curvilinear coordinate in the I-direction.
Generalized curvilinear coordinate in the J-direction.
Generalized curvilinear coordinate in the K-direction.
Vorticity
Speed of sound.

Specific heat at constant pressure.

Specific heat at constant volume.

Mach number.

Mass.
Table F-1. Analyze Symbology.

( )∞

γ cp

cv
----

ρ

ξ

η

ζ

ω

a

cp

cv

M

m
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F - 2 Scalar Grid Quality Functions

F- 2.1 I-, J-, K-Aspect Ratio
The ratio of maximum edge length squared to face area:

AR Max edge length( )2

Area
-----------------------------------------------=

For a rectangle or square, this simplifies to: AR height
width
----------------=

For collapsed faces where the area is zero, the aspect ratio is set to zero.

F- 2.2 I-, J-, or K-Stretch Ratio
The ratio of the length of line segment I2-I3 to segment I1-I2 (or J or K):

stretch ratio length of segment I2-I3
length of segment I1-I2
--------------------------------------------------------= or length of segment I1-I2

length of segment I2-I3
--------------------------------------------------------  such that it is always > 1.

Pressure.

Specific gas constant 
Temperature.

Velocity vector.
X-velocity component.

Y-velocity component.

Z-velocity component.

Symbol Description

Table F-1. Analyze Symbology.

p

R p ρRT=

T

U

u

v

w
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Scalar Grid Quality Functions

If either segment has zero length, the stretch ratio is set to one.

Note: If you have specified on the Geometry and Boundaries dialog that adjacent zones are con-
nected, these stretch ratios will be made continuous across connected zone boundaries provided 
that the index directions are aligned.

F- 2.3 I-, J-, or K-Face Skewness
The ratio of the two face diagonal lengths subtracted from one (the diagonals are ratioed so that this 
number is always non-negative):

face skewness 1 length of shorter face diagonal
length of longer face diagonal
-------------------------------------------------------------------------–=  
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F- 2.4 Cell Diagonal1 or Diagonal2 Skewness
The ratio of the lengths of two body diagonals subtracted from one (always non-negative). There 
are four body diagonals. We choose pairs which would be coplanar in an unskewed cell, that is, 
(i,j,k) -> (i+1,j+1,k+1) and (i,j,k+1) -> (i+1,j+1,k).

cell skewness 1 length of shorter body diagonal
length of longer body diagonal
---------------------------------------------------------------------------–=

F- 2.5 IJ-, JK-, KI-, or Max Normals Skewness
The dot product of face unit normals for the two given faces.

IJ-skewness :     SIJ n̂I n̂J⋅=

The following figure illustrates this for IJ-skewness.

I-Face

J-face

F- 2.6 I-, J-, K-, or Min Orthogonality
One minus the absolute value of the dot product of two unit vectors which point in the direction of 
two adjacent edges of the given face.

For the K-face:     orthogonality 1 t̂I t̂J⋅–=
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F- 2.7 I-, J-, K-, or Min Nonplanarity
Two triangles are formed with the four nodes of the face, and the dot product of the two unit nor-
mals of those triangles is subtracted from one.

non-planarity of the four-node face shown below 1 n̂I1 n̂I2⋅–=

I1 I2

F- 2.8 Jacobian
For ordered zones, the Jacobian is calculated with the standard formula.

J 1
xξ yηzζ yζzη–( ) xη yξzζ yζzξ–( )– xζ yξzη yηzξ–( )+
--------------------------------------------------------------------------------------------------------------------------=
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The subscripts above represent partial derivatives. which are approximated with finite differences.

For finite-element zones, Tecplot approximates the Jacobian by inverting the average areas or vol-
umes of the grid cells surrounding each node, 1/A or 1/V.

If the denominator of the above formula is zero (ordered zones), or all cells surrounding a node 
have zero area (finite-element zones), the Jacobian is set to zero.

F- 2.9 Cell Volume
For ordered zones, the cell volume for a particular node (I, J, K) is the volume of the cell between 
nodes (I, J, K) and (I+1, J+1, K+1). In 2D, this function becomes cell area. Nodes on the IMax, 
JMax, and KMax boundaries are assigned the same value as the nodes at IMax-1, JMax-1, and 
KMax-1 respectively.

For finite-element zones, the cell volume for a node is the minimum volume (area in 2D) of all cells 
of which that node is a part.

F - 3 Vector Grid Quality Functions

F- 3.1 Grid I-, J-, or K-Unit Normal
Vectors of unit length normal to I=, J=, or K=constant grid planes.

unit normal for I n̂I=

F - 4 Scalar Flow Variables

F- 4.1 Density

The mass per unit volume of the fluid: ρ m
V
----= . PLOT3D function numbers: 100 (not normalized), 

or 101 (normalized).
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F- 4.2 Stagnation Density

ρ0 ρ 1 γ 1–
2

-----------M2+⎝ ⎠
⎛ ⎞

1
γ 1–
-----------

 (compressible)

ρ (incompressible)⎩
⎪
⎨
⎪
⎧

=  PLOT3D function numbers: 

102 (not normalized), or 103 (normalized).

F- 4.3 Pressure

p ρRT (compressible)=  

PLOT3D function numbers: 110 (not normalized), or 111 (normalized).

F- 4.4 Stagnation Pressure

p0 p 1 γ 1–
2

-----------M2+⎝ ⎠
⎛ ⎞

γ
γ 1–
-----------

 (compressible only) p 1
2
---ρ U 2 (also incompressible)+= =

PLOT3D function numbers: 112 (not normalized), or 113 (normalized).

F- 4.5 Pressure Coefficient

Cp
p p∞–
1
2
---ρ∞u∞

2
----------------=

PLOT3D function number: 114 (not normalized). There is no function number for normalized pres-
sure coefficient, since reference value normalization is not possible (the free-stream pressure coef-
ficient is zero).

F- 4.6 Stagnation Pressure Coefficient

C
p0

p0 p∞–
1
2
---ρ∞u∞

2
-----------------=
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PLOT3D function number: 115 (not normalized). As above, there is no function number for nor-
malized stagnation pressure coefficient.

F- 4.7 Pitot Pressure
Equals stagnation pressure for subsonic/incompressible flow. For supersonic flow:

p02 p

γ 1+
2

-----------M2
⎝ ⎠
⎛ ⎞

γ
γ 1–
-----------

2γ
γ 1+
-----------M2 γ 1–

γ 1+
-----------–⎝ ⎠

⎛ ⎞
1

γ 1–
-----------

---------------------------------------------------=

PLOT3D function number: 116 (not normalized).

F- 4.8 Pitot Pressure Ratio
The pitot pressure divided by the free-stream pressure. PLOT3D function number: 117 (not nor-
malized).

F- 4.9 Dynamic Pressure

q 1
2
---ρ U 2=

PLOT3D function number: 118 (not normalized).

F- 4.10 Temperature

T p
ρR
------- (compressible)=

PLOT3D function numbers: 120 (not normalized), or 121 (normalized).
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F- 4.11 Stagnation Temperature

T0 T 1 γ 1–
2

-----------M2+⎝ ⎠
⎛ ⎞  (compressible)

T (incompressible)⎩
⎪
⎨
⎪
⎧

=

PLOT3D function numbers: 122 (not normalized), or 123 (normalized).

F- 4.12 Enthalpy

per unit mass:     h cpT= cp
γR

γ 1–
----------- (compressible only)=

PLOT3D function numbers: 130 (not normalized), or 131 (normalized).

F- 4.13 Stagnation Enthalpy

per unit mass:     h0 cpT 1
2
--- U 2+=

PLOT3D function numbers: 132 (not normalized), or 133 (normalized).

F- 4.14 Internal Energy

per unit mass:     e cvT= cv
R

γ 1–
----------- (compressible only)=

PLOT3D function numbers: 140 (not normalized), or 141 (normalized).

F- 4.15 Stagnation Energy

per unit mass:     e0 cvT 1
2
--- U 2+=

PLOT3D function numbers: 142 (not normalized), or 143 (normalized).
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F- 4.16 Stagnation Energy per Unit Volume
Stagnation energy multiplied by density. PLOT3D function number: 163 (not normalized).

F- 4.17 Kinetic Energy

KE 1
2
--- U 2=

Per unit mass, one-half the square of the velocity magnitude.

PLOT3D function numbers: 144 (not normalized), or 145 (normalized).

F- 4.18 Velocity Components U, V, or W
The scalar velocity components. PLOT3D function numbers: 150 (u, not normalized), 151 (v, not 
normalized), or 152 (w, not normalized).

F- 4.19 Velocity Magnitude
The 2-norm of the velocity vector components:

U u2 v2 w2+ +=

PLOT3D function number: 153 (not normalized).

F- 4.20 Mach Number
The flow speed divided by the local speed of sound, for compressible flow:

M U
a

---------=

PLOT3D function number: 154 (not normalized).

F- 4.21 Speed of Sound

a γRT γp
ρ
----- γ γ 1–( ) e

ρ
--- 1

2
--- U 2–⎝ ⎠

⎛ ⎞  (compressible)= = =

PLOT3D function number: 155 (not normalized).
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F- 4.22 Cross Flow Velocity
This presumes that free-stream velocity is purely in the X-direction:

vcf v2 w2+=

PLOT3D function number: 156 (not normalized).

F- 4.23 Equivalent Potential Velocity Ratio
The ratio of velocity magnitude to the potential velocity, as calculated with the incompressible 

Bernoulli equation. Refer to previous sections for definitions of  and .

PLOT3D function number: 159 (not normalized).

F- 4.24 X-, Y-, Z-Momentum Component
Per unit volume, the product of density and the scalar velocity components.

momentumx ρu=

PLOT3D function numbers: 160 (X-Momentum, not normalized), 161 (Y-Momentum, not normal-
ized), 162 (Z-Momentum, not normalized).

F- 4.25 Entropy

s cv
p

p∞
------⎝ ⎠

⎛ ⎞ln cp
ρ∞

ρ
------⎝ ⎠

⎛ ⎞ln+=

PLOT3D function number: 170 (not normalized).

U p0

U

p∞
0 p–
0.5ρ

---------------

-------------------
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F- 4.26 Entropy Measure S1

s1
p

p∞
------ ρ

ρ∞
------⎝ ⎠

⎛ ⎞ γ–
1–=

PLOT3D function number: 171 (not normalized).

F- 4.27 X-, Y-, Z-Vorticity

ωx

ωy

ωz

∂w
∂y
------- ∂v

∂z
-----–

∂u
∂z
------ ∂w

∂x
-------–

∂v
∂x
----- ∂u

∂y
------–

=

PLOT3D function numbers: 180 (X-Vorticity, not normalized), 181 (Y-Vorticity, not normalized), 
182 (Z-Vorticity, not normalized).

F- 4.28 Vorticity Magnitude

PLOT3D function number: 183 (not normalized).

F- 4.29 Swirl

Swirl ω U⋅

ρ U 2
---------------=

PLOT3D function number: 184 (not normalized).

ω ωx
2 ωy

2 ωz
2+ +=



711

Scalar Flow Variables

F- 4.30 Velocity Cross Vorticity Magnitude

U ω×

PLOT3D function number: 185 (not normalized).

F- 4.31 Helicity

H U ω⋅=

PLOT3D function number: 186 (not normalized).

F- 4.32 Relative Helicity

PLOT3D function number: 187 (not normalized).

F- 4.33 Filtered Relative Helicity

 as calculated above, but set to zero when .

PLOT3D function number: 188 (not normalized).

F- 4.34 Shock

U
a
---- p∇

p∇
-----------⋅

For compressible flow:

PLOT3D function number: 190 (not normalized).

Hr
U ω⋅
U ω

------------------=

Hr U ω⋅ 0.1U∞
2<
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F- 4.35 Filtered Shock
Shock, as shown above, but set to zero when the magnitude of the pressure gradient 

.

PLOT3D function number: 191 (not normalized).

F- 4.36 Pressure Gradient Magnitude

PLOT3D function number: 192 (not normalized).

F- 4.37 Density Gradient Magnitude

PLOT3D function number: 193 (not normalized).

F- 4.38 X-, Y-, Z-Density Gradient

ρx

ρy

ρz

∂ρ
∂x
------

∂ρ
∂y
------

∂ρ
∂z
------

=

PLOT3D function numbers: 194 (X-Density Gradient, not normalized), 195 (Y-Density Gradient, 
not normalized), 196 (Z-Density Gradient, not normalized).

F- 4.39 Shadowgraph

The Laplacian of density, .

PLOT3D function number: 197 (not normalized).

∇p 0.1γp∞<

∇p px
2 py

2 pz
2+ +=

∇ρ ρx
2 ρy

2 ρz
2+ +=

∇2ρ
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F- 4.40 Divergence of Velocity

∇ U⋅ ∂u
∂x
------ ∂v

∂y
----- ∂w

∂z
-------+ +=

PLOT3D function number: 158 (not normalized).

F- 4.41 Sutherland’s Law

μ C1
T3 2⁄

T C2+
----------------=

Sutherland’s Law is a method of estimating the viscosity of a fluid from its temperature. The 
formula is:

For the constants, Tecplot uses the meters/kilograms/seconds values for air, 

C1 1.458 10 6–× kg
m s K
-----------------=  and C2 110.4K= . Unlike other functions, this function is units-

specific. Tecplot uses the meters/kilograms/seconds units for this calculation, so the input tempera-

ture (data set variable) must be in Kelvin. The resulting viscosity will be in units of kg m s⁄ .

F- 4.42 Isentropic Density Ratio

F- 4.43 Isentropic Pressure Ratio

ρ0

ρ
----- 1 γ 1–

2
-----------M2+⎝ ⎠

⎛ ⎞
1

γ 1–
-----------

=

p0

p
----- 1 γ 1–

2
-----------M2+⎝ ⎠

⎛ ⎞
γ

γ 1–
-----------

=
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F- 4.44 Isentropic Temperature Ratio

F - 5 Vector Flow Variables

F- 5.1 Velocity

The velocity vector, U . PLOT3D function number: 200 (not normalized).

F- 5.2 Vorticity
See above for vorticity components. PLOT3D function number: 201 (not normalized).

F- 5.3 Momentum
Per unit volume, density multiplied by the velocity vector. PLOT3D function number: 202 (not nor-
malized).

F- 5.4 Perturbation Velocity

U′ U U∞–=

PLOT3D function number: 203 (not normalized).

F- 5.5 Velocity Cross Vorticity

U ω×

PLOT3D function number: 204 (not normalized).

F- 5.6 Pressure Gradient
The vector of pressure partial derivatives in space:

T0

T
----- 1 γ 1–

2
-----------M2+=



∇p

∂p
∂x
------

∂p
∂y
------

∂p
∂z
------

=
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The Velocity Gradient Tensor

PLOT3D function number: 210 (not normalized).

F- 5.7 Density Gradient

∇ρ

∂ρ
∂x
------

∂ρ
∂y
------

∂ρ
∂z
------

=

The vector of density partial derivatives in space:

PLOT3D function number: 211 (not normalized).

F - 6 The Velocity Gradient Tensor

∇U

∂u
∂x
------ ∂u

∂y
------ ∂u

∂z
------

∂v
∂x
----- ∂v

∂y
----- ∂v

∂z
-----

∂w
∂x
------- ∂w

∂y
------- ∂w

∂z
-------

=

In addition to the scalar and vector variables listed in the previous sections, Tecplot can calculate 
one tensor variable, the velocity gradient:

Each component in the tensor is stored as a separate variable in the data set. The names indicate 
which component they represent, such as dUdX, dUdY and so on.
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Appendix G Limits of Tecplot 360

Item Limit

Maximum number of data points per vari-
able

Over 2 billion

Maximum number of zones per data set 32,700
Maximum number of variables per data set 32,700
Maximum number of mappings 32,700
Largest floating point absolute value 10150

Smallest non-zero floating point absolute 
value

10-150

Maximum number of data sets 2048 (Limited by the 
number of frames)

Maximum number of frames 2048
Maximum number of value blank con-
straints

8

Maximum number of contour groups 4
Maximum number of geometries limited by memory
Maximum number of polylines per line 
geometrya

50

Maximum number of points per circle or 
ellipse

720

Maximum number of custom label sets Limited by available 
memory

Maximum number of custom labels per set 5000
Minimum frame width or height 0.1 inches
Maximum frame width 500 inches

Table G-1. The following hard limits apply to Tecplot Version 360,
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: 

Maximum streamtraces per frame 32,000
Maximum number of streamtrace steps 10,000
Maximum number of color map overrides 16
Maximum preview width for EPS files 1024
Maximum preview height for EPS files 1024
Maximum number of user-defined color 
map control points

50

Maximum number of raw user-defined 
color map entries

800

Maximum number of characters in vari-
able name

128

Maximum number of characters in zone 
title

128

Maximum number of characters in data set 
title

256

Maximum number of views per view stack 16
Maximum number of characters in an aux-
iliary data string

32000

a. A polyline is a continuous series of line segments, and can be a subset of a line 
geometry.

Number of: Windows UNIX Hard Limit

Points per linea 3000 5000 500,000

Contour levels 150 400 5000
Table G-2. The following soft limits may be changed via the Tecplot configuration file

Item Limit

Table G-1. The following hard limits apply to Tecplot Version 360,
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Characters per text 
label

1023 1023 10,000

Maximum number of 
picked objects

1500 2,147,483,646

Printing Gouraud shaded plots 
with continuous flooding

On screen or exported bit-
map image only

Printing plots with translucency On screen or exported bit-
map image only

a. Points per line is the limit on the number of points allowed in the follow-
ing: line segment geometries, stream termination lines, and contour 
lines. For line segment geometries, this is the total number of points used 
in all polylines contained in the geometry.

Item Limit

Table G-3. The following hard limits apply to plot style

Number of: Windows UNIX Hard Limit

Table G-2. The following soft limits may be changed via the Tecplot configuration file
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* in equations 297

Index

Symbols
* in equations 297
** in equations 296
+ in equations 297
/ in equations 296
{ } in equations 295

Numerics
2D Cartesian plot type

shade plots 214
2D data

circular zone creation 312
2D field plots 19, 149

cell elimination 281
contour layer 177–194
edge layer 173–175
element elimination 281
mesh layer 171–173
rotating 309
scatter layer 205–211
value-blanking 281
vector layer 195–203

2D integration
conventions 365

2D Rotate dialog 309
3D Cartesian plot type 149
3D Details dialog

lift fractions 165
3D objects

placement 20
3D plots 19, 149

advanced control 163
axes reset 163
axis limits 163
contour layer 177–194
controlling 162
edge layer 173–175
lift fractions 165
light source 163, 254
mesh layer 171–173
overlay mesh 172
reset axis 162
rotation 27, 165

dialog 165
rollerball 27
spherical 27

twist 27
x-axis 27
y-axis 27
z-axis 27

scatter layer 205–211
shade layer 213–214
translate 169
vector layer 195–203
vector plots 201
view details 163
zoom 169

3D rotate tools 27
rollerball 27
spherical 27
twist 27
x-axis 27
y-axis 27
z-axis 27

3D vectors
see Vector layer

3D View Details dialog 163
3D volume data

boundary cell faces 154
extracting iso-surfaces 215
hidden line mesh 172
IJK-blanking 285
IJK-ordered data 49
interpolating irregular data 58
overlay mesh 172
probing plots 401
surfaces, plotting 154
wire frame mesh 172
zone probing 401
zones 285

A
ABAQUS files, see FEA solvers
Ablation, particle 389
Absolute path 450, 452
Absolute value

data operations 297
in integrations 364

Accuracy
calculating 390
plotting 391

Add Contour Label tool 189
Add Text Tool 419
Addition

binary operator 296
Add-On Developer’s Kit 634, 675, 697
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Add-Ons 561
$!LoadAddOn command 563
Configuration File 561
Crvgen 564
Crvstineinterp 564
Gridgen 564
hdf5 564
Loadcgns 564
Loaddem 564
Loaddxf 564
Loadfluent 564
Loadhdf 564
loading 561
Loadplot3d 563
Loadss 564
Loadxls 564
running 561
specifying on command line 563

Adjustor tool 23, 246
data editing 413
group select 24
probing 412

Algorithms
least-square 118
polynomials 118
straight line fit 117

Alignment
anchor 193
snap modes 21

to grid 21
to paper 21

Allow Data Point Adjustment option 412
Alter option 309
Analytic functions 310
Analyze menu 17

Field Variables 346
Fluid Properties 340
Geometry and Boundary 347
Reference Values 345

Anchor alignment 193
Angles

polar to rectangular coordinate transforming 306
rotating 3D view 27

Animation 515
advanced techniques 531
animate menu 16
animated sequence 528
AVI file viewing 535
blanking 515
contour levels 515, 521

destination 381
file, to a 381
Framer creation 536
Framer viewing of Raster Metafiles 536
frames, multiple 534
IJK-Blanking 520
IJK-blanking 515, 520
IJK-plane 515, 519
IJK-planes 519
image size alteration 516
iso-surfaces 521
macro animation 530
macros 515
mapping 524
mappings 515, 524
Raster Metafile conversion to AVI 609
Raster Metafile viewing with Framer 536
speed 382
streamtrace 528
streamtraces 515
techniques 531
text changes 531
time 516
value-blanking 515
zones 515, 528

ANSYS files, see FEA solvers
Antialiasing 479, 480, 482, 483, 485, 488, 490

Supersample Factor 479, 480, 482, 483, 484, 
485, 488, 490

Approximation
plot 22

Arbitrary cutting planes 229
Arccosine

data operations 297
Arcsine

data operations 297
Arctangent

data operations 297
Arithmetic

operator precedence 296
Arithmetic averaging

in Fluent loader 658, 659
Arrow

arrowheads
quick edit 41

quick edit 41
Arrowheads

filled 198
hollow 198
plain 198
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ASCII character

quick edit 41
size 200
streamtraces 239

ASCII character
ordinal values 424

ASCII files
writing in BLOCK format 458
writing in POINT format 458

ASCII terminal
Tecplot execution 509

Aspect ratio
functions in Calculate dialog 700

Attachment lines 350, 395
Auto Spacing option 260
AutoCAD (DXF) files 639–640
Auxiliary data 96

Boundary Conditions 248
Data Set Information dialog 96
equation syntax 301
PLOT3D Loader 686

Averaging, arithmetic
in Fluent loader 658, 659

Averaging, laplacian
in Fluent loader 659

AVI files
creating 485
export format 382
image creation 485
Raster Metafile conversions 609
viewing 535

Axis 257–278
3D limits 163
3D orientation 254
3D orientation axes 164
3D reset 163
change dependency 163
clip data 262
controls 257
data, clip to 262
dependent 73
grid 264
grid area 277
gridline cutoff 264
gridline draw order 265
labels 268

tick marks 268
tick marks, custom 270

length preservation 259, 261
line plots 112
lines 275

log 260
Polar 262
polar

data, clip to 262
range 258

polar 262
ranges, linked 73
reset for 3D plots 162
reversing 139
R-origin 263
rotation

x-axis 27
y-axis 27
z-axis 27

scaling 163
theta mode 262
theta period 262
Theta Value on Right Circle 263
tick marks 265

labels 268
labels, custom 270

title position 275
titles 274
variable assignment 112, 258

XY-mappings 111
XY-mapping, assign 111

Axis details dialog 139
Axisymmetric 347, 348, 364

B
Background

frame 69
Background light 255
Ballistic Coefficient 384
Bands, contour 187
Bar charts 140

map layer 20, 140
vertical or horizontal bars 140

Basic color palette 103
Batch mode

Tecplot running 509
Batch processing 590

batch.log diagnostic file 513
BATCHLOGFILE 513
bitmap format limitations 509
command line option 590
data files 511
data set looping 511
data sets, multiple 511, 512
diagnostics 513
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layout files 510
limitations 512
looping inside Tecplot 512
looping inside Tecplot limitations 512
looping outside Tecplot 511
macro file creation 509
plot styles 510
printing 509
setup 509

Batch.log file
running batch mode 513

BATCHLOGFILE 513
BDF files, see FEA solvers
Best float tick marks 269
Binary files

PLOT3D Loader 682
writing 456, 458

Binary operators 296
equations 296
precedence 297

Bit-mapped image
raster 478

Blanking 280
animation 515

IJK-blanking 520
cells 281
cutaway plots 285
data 281
depth blanking 288
effect on integrations 364
finite-element volume zones 253
IJK-blanking 281, 285
IJK-ordered zones 253, 281
IJK-ranges 287
IJ-ordered data 281
in feature extraction 394, 395
I-ordered zones 281
line plots 285
value 394
value blanking 281
zones 280

BLOCK format
writing ASCII 458

BMP files
creating 479
image creation 479

Border
frame 68, 77

Bottom error bars 139
Boundaries 348, 349

boundary zone triangulation 333
finite-element 322
finite-element extraction 321
smoothing 305
smoothing limitations (across zones) 306
wall 348

Boundaries, wall 394, 395
Boundary cell faces 154
Boundary conditions 300, 347, 350

complex 299
creating 300
no slip 248

Boundary conditions, simple 299
Boundary file 679
Boundary layer, see Edge layer
Boundary values, derivatives 299
Boundary zones 350
Branching shared variables 412
Breakpoints

macros 505
Brick

FE-volume element type 54
Buoyancy

in particle calculations 383

C
Cache Graphics 22
Calculate, on demand 358
Carpet data format

in Excel Loader 645
CAS files

Loadfluent add-on 564
CAS files, see Data loaders
CDB see FEA solvers
Cell

label 161
Cell diagonal skewness

functions in Calculate dialog 702
Cell faces

boundary 154
plotting 155

Cell Volume
functions in Calculate dialog 704

Cell-centered 55
Cell-centered data 55

shift 309
Cells

blanking 281
eliminating 281
finite-element 281
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CFD

Hexahedral 281
labeling 161
Quadrilateral 281
viewing information 405

CFD
calculate on demand 358

CGNS Data Loader
Loadcgns add-on 564

CGNS files 564
Characters

custom creation 424
customization 555

Circle
add 32

Circular zone
new 33, 312

Clamped spline
fitting 122, 123

Clipboard
copy plot to 16, 85, 488

Coefficients
detailed 383
general 383

Color map
banded color distribution 185
color cutoff 186
command line file specifying 591
continuous color distribution 185
control point movement 100
copy to file 100
cycles 186
file creation 100
file specifying 591
file specifying on command line 591
files 100
global 98
gray scale 99
Large Rainbow 99
limits in Tecplot 718
Modern 99
paste from file 100
Raw User-Defined 99
reversing 186
Small Rainbow 99
Two Color 99
User-Defined 99
Wild 99

Color Map dialog 98
Color maps

gray scale 99

Color palette 103
Color Preferences dialog 546
Color tables, multiple 382
Colors

assignment 97
basic color palette 103
continuous coloring 185
frame background 69
palette, basic 103
paper background 76
quick edit 40
RGB 100
RGB coloring options 101
streamtraces 239
surface color contrast 255

Command line
batch processing 590
color map file specifying 591
data set readers specifying 596
Framer 602
last view in frame restoration option 81
layout reading 591
macro playing 591
macro running 591
options 590
Preplot options 607
shortcut creation 594
shortcut editing 594
UNIX options 595
Windows run options 592
Windows shortcuts 593
Windows start options 592

Compressible fluid 342
Configuration File 539

Add-ons 561
creating 540
Interface Parameter 300, 542
Motif 540
Printing 465
saving 540
Set Default 590
specifying 590
System Administrator 539
Temporary Directory 545
UNIX 539, 554

Connect Adjacent Zones 349
Connectivity list 54

limitations 55
Connectivity sharing

saving to data files 457
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Constant, gravitational 383
Continuous coloring 185
Continuous flooding

limits 719
Contour

keyboard shortcuts 30
Contour Add tool

shortcuts 613
Contour Details dialog 183
Contour labels

Add Contour Label tool 189
clearing 190
definition 189

Contour layer 19, 177–194
average cell 179
bands 187
coloring

bands 187
flooding 179
keyboard shortcuts 30
label 30
labels 189
legend 191
levels 182
lines 179, 188

extract 193
plot type

average cell 179
flood 179
lines 179
lines and flood 179
primary value 180

primary value 180
quick edit 36
slices 224
value, primary 180

Contour levels
add 30
animation 515, 521
delete 30
deleting 183
exponential distribution specifying 184
limits in Tecplot 718
number 182
removing 183
specifying by range and number 184

Contour lines
extract 193

Contour plots
data requirements 177

variable selection 181
Contour Remove tool

shortcuts 613
Contour tool

label 30
level

add 30
delete 30

Contour variables 181
Controls

Contour tools shortcuts 613
coordinate systems 64
mouse tool shortcuts 79
Redraw 21
redraw 21

automatic 22
Redraw All 21
snap modes 21

to grid 21
to paper 21

Streamtrace tools shortcuts 616
Zoom tool shortcut 617

Convective variables 347
Coordinate systems 61

frame 65
Tecplot interface 64

Copy 61
Cosine function

data operations 297
Cross error bars 139
Cross flow velocity

functions in Calculate dialog 709
Crvgen add-on 564
Crvstineinterp add-on 564
Cubic spline 122
Current frame

blanking 280
Current Solution Time 158
Cursor

probe 31
select 23
select group 24
translate 26
zoom 25

Curve
write to file 133

Curve fit
Crvgen add-on 564
cubic spline 122
exponential 119
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Curve fits

extended 124
general 125
stineman 126

goodness of fit 131, 132
line segments 127
linear 117
none 127
parametric spline 122
polynomial 118
power 119, 120
R-squared 131, 132
spline 122
spline, parametric 122
weighting variable 129

Curve fits
Crvstineinterp add-on 564

Curve Information dialog 130
Curve type

exponential fit 115
linear fit 115
paraspline 116
power fit 116
spline 116

Curve-coefficient files 130
Curves

Crvgen add-on 564
Crvstineinterp add-on 564
curve-weighting variables 129
dependent and independent variables 127
detail and data point extraction 130
exponential fits 119
power fits 120
spline fit 122

Custom characters
creating 555

Custom labels 270
limits in Tecplot 717
loading records 690
saving record to file 457

Custom tick marks 269
Customize

frame header 68
CUSTOMLABELS Record 269
Cut 61
Cutaway plots

IJK-blanking 285
Cutting planes

arbitrary 229
defining with 3 points 229

Cylindrical zones

creating 312

D
d2di2 300
d2dij 300
d2dik 300
d2dj2 300
d2djk 300
d2dk2 300
d2dx2 300
d2dxy 300
d2dxz 300
d2dy2 300
d2dyz 300
d2dz2 300
D3PLOT files, see FEA solvers
DAISY files, see FEA solvers
DAT files, see Fluent Data Loader 564
Data

auxiliary 96
axis, clipping to 262
cell-centered 55
clamped spline fits 123
Data Set Information dialog 91
FE Volume 54
finite-element 162
functions 297
IJK-ordered 49, 162
IJK-ordered data blanking 253
IJK-ordered with line plots 106
IJ-ordered with line plots 106
I-ordered probe limitations 400
irregular 323
load variables by name 691
load variables by position 691
loading 687
nodal 55
operations, see also Data operations 291
partial read options 690
point probing 397
point values 323
saving custom label record 457
saving modified 291
ungridded 323
unordered 323
variables 294
writing binary 458
writing binary files 456
writing files 456
writing selected record types 457
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Data alteration
equations 291–??

Data analysis
boundary conditions 347
dimensions 339
geometry and boundary 347
reference values 345
variables 346

convective 347
state 347

Data file
write 291

Data files
batch processing 511
command line readers 596
custom label record loading 690
geometry records 690
PLOT3D Loader 681
readers 633
specifying zones in files 691
text records 690
variables 294
write points to file 32
write points to file (polyline) 33
writing ASCII 458
writing ASCII files 456
writing ASCII in BLOCK format 458
writing ASCII in POINT format 458

Data fit 79
Data format

DEM 638–639
DXF 639–640
EnSight 641–642
Excel 643–649
FEA 649–653
Fluent 655–659
Gridgen 673–674
HDF 674–678
Kiva 678
PLOT3D 679–687
PLY 687
Tecplot 687–696
Text 660–672
Text Spreadsheet 696–698

Data Format dialog 336
Data journal

in error analysis 392
in feature extraction 395
in geometry and boundaries 351
in integrations 368

Data labels 161
Data Loaders 634

DEM 638–639
DXF 639–640
EnSight 641–642
Excel 643–649
FEA 649–653
Fluent 655–659
GMV, see Kiva
Gridgen 673–674
HDF 674–678
Kiva 678
PLOT3D 679–687
PLY 687
SDS 674–678
Tecplot 687–696
Text 660–672
Text Spreadsheet 696–698

Data menu 16
2D Rotate option 309
Alter option 309
Create SubZone option 318
Create Zone option 310
Data Set Info option 90
Delete Variable option 323
Delete Zone option 322
Duplicate option 315
Enter Values option 317
Extract option 320, 321
Interpolate option 325, 327, 330
Inverse Distance option 327
Kriging option 330
Linear option 325
Mirror option 315
Points from Geometry option 320
Points from Polyline option 320
Probe At option 401
Smooth option 304
Transform Coordinates option 306
Triangulate option 57, 333

Data operations
1D line zone creation 310
2D data rotation 309
absolute value 297
addition 296
Adjustor tool editing 413
adjustor tool editing 413
analytic functions 310
Arccosine 297
Arcsine 297
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Data points

Arctangent 297
binary equation operators 296
boundary smoothing 305
boundary zone triangulation 333
circular zone creation 312
coordinate transforming 306
coordinate variable smoothing 304
Cosine function 297
cylindrical zone creation 312
data editing with Probe 413
data point adjustment 412
data rotation 309
data set modifying 292
derivative functions 298
difference functions 298
discrete point extraction 320
edit with Probe 397, 413
equation file loading 304
equation indices 302
equation operators 296
equation restriction overriding 302
equation variables 294
equations in macros 303
exponentiation 296, 297
functions 297
geometry point extraction 320
interpolating 323
interpolation, inverse-distance 326
interpolation, linear 324
inverse-distance interpolation 326
irregular point triangulation 332
kriging interpolation 329
linear interpolation 324
Logarithms 297
macro use 498
macros, equations 303
mirror zone creation 315
multiplication 296
polyline point extraction 320
probe editing 397
rectangular zone creation 311
rotation in 2D 309
Rounding function 297
shift pseudo-cell centered 309
Sine function 297
smoothing 304
smoothing limitations 306
spreadsheet alteration 336
square root 297
tangent function 297

triangulation of irregular data points 332
Truncate function 297
variables 294
zone creation, circular 312
zone creation, cylindrical 312

Data points
discrete point extracting 320
extracting 130
labeling 161
labels 161
limits in Tecplot 717
probing 412

Data Set Information dialog 90, 91
Aux Data page 96
auxiliary data 96
Data Set page 93
Journal page 95
Sharing page 94
Zone/Variable page 91

Data sets 62
auxiliary data 96
center 80
clamped spline fits 122
curve-weighting variables 129
Data Set Information dialog 91
exponential curve fits 119
fitting to frames 79
information 93
journal 89, 95
limits in Tecplot 717
modifying 291, 292
power fits 120
probing 402
processing multiple 511
sharing 89, 94
spline fit 122
title limits in Tecplot 718
triangulated FE-surface data 57
variables, maximum number 717
view

data fit 79
fit to full size, nice 79
make current view nice 79

Data structure
finite-element 52

Database Network
importing GRIDGEN files 673

-datasetreader flag 596
ddi 299
ddj 299
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ddk 299
ddx 299
ddy 299
ddz 299
Defaults

extensions for file names 544
DEM Data Loader 638–639
DEM files 638–639
DEM Loader 564
Density

fluid property 341
functions in Calculate dialog 704

Density gradient
functions in the Calculate dialog 712, 715

Density gradient magnitude
functions in the Calculate dialog 712

Dependent variables
assign with Mapping Style dialog 128

Depth blanking 288
Derivative functions 298, 299, 300

boundary conditions 300
restrictions 300

Derivatives
boundary values 299
equations, in 298

Derived object 20
animation

streamtrace 528
iso-surface 215–219
placement plane 20
slice 28, 221–231
streamtrace 29, 233–249

tools 29
Detailed coefficients

for particles with mass 387
in particle calculations 383

Dialogs
Edit Boundary 352
Enter Range 366
Error Analysis 390
Extract Flow Features 350, 393
Fluid Properties 340, 372
Geometry and Boundaries 348, 349, 350, 351, 

361, 701
Group Zones by Time Step 355
Integrate 362
Particle Mass Options 382
Particle Paths and Streaklines 377
Reference Values and Field Variables 347
Select Function 359

Select Variables 347
Difference functions 298

boundary conditions, simple 299
complex boundary conditions 299
restrictions 300

Difference functions, in equations 298
Digital Elevation Map (DEM) files 638–639
Dimensions 339
Discrete particles

in Fluent loader 658
Discrete points

extracting 320
Discrete Points option 320
DISPLAYBOUNDARIES

macro command 351
Dissipation Rate

turbulence functions 375
Divergence of Velocity

functions in Calculate dialog 713
Division

binary operator 296
Domain

IJK-blanking 287
of integration 364

Dot product
integrating 365

Drag
calculating 361

Drag coefficient 387
DSY files, see FEA solvers
Duplicate option 315
Duplication

frames 82
geometries 82
objects 82
text 82
zones 315

DXF Data Loader 639–640
DXF files 639–640

viewing in 3D file 640
DXF Loader

Loaddxf add-on 564
DYN files, see FEA solvers
Dynamic pressure

functions in Calculate dialog 706
Dynamic viscosity 375
Dynamically linked libraries

loading add-ons 562
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Edge layer 173–175

E
Edge layer 173–175

displaying 175
quick edit 38
slices, on 228

Edit Boundary dialog 352
Edit menu 16, 82

Copy Plot to Clipboard 16
select all 84

Element type
brick 54
quadrilateral 54
tetrahedron 54
triangle 54

Elements
eliminating 281

Ellipse
add 32

Encapsulated PostScript files 475
End field

in Enter Range dialog 366
EnSight Data Loader 641–642
EnSight files 641–642
Enter Mapping Name dialog 109
Enter Range dialog 366
Enter XY-Values to Create a Zone dialog 317
Enthalpy

functions in Calculate dialog 707
Entropy

functions in Calculate dialog 709
Entropy measure S1

functions in Calculate dialog 710
Environment variables

accessing in macros 369
add-on loading 563
as text 435
BATCHLOGFILE 513
integration results 369
INTEGRATION_DRAG 369
INTEGRATION_LIFT 369
INTEGRATION_SIDE 369
INTEGRATION_TOTAL 369
INTEGRATION_XFORCE 369
INTEGRATION_XMOMENT 369
INTEGRATION_YFORCE 369
INTEGRATION_YMOMENT 369
INTEGRATION_ZFORCE 369
INTEGRATION_ZMOMENT 369
MOZILLA_HOME 606
TEC360HOME 15

tecplot.phy set up and location 554
EPS files

format 475
limits in Tecplot 718
printing 475

Equation files
ASCII text editor 303

Equation of state
caloric 341, 342
thermal 341, 342, 346

Equations 291–??
ASCII text editor for files 303
auxiliary data 301
binary operators 296
boundary conditions 300
derivative 298
derivative and difference functions 298
derivatives

boundary values 299
difference functions 298
file loading 304
functions 297
index, specifying 302
indices 302
letter codes 296
macros 303
macros, in 303
operators 296
reference values 345
restriction overriding 302
state

caloric 341
thermal 341

syntax 294
variable sharing 302
variables 294
zone number 301
zone numbers 301

Equivalent potential velocity ratio
functions in the Calculate dialog 709

Error Analysis dialog 390
Error bars

bottom 139
cross 139
crossbar size 139
horizontal 139
left 139
map layer 20
modifying 138
quick edit 39
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right 139
spacing 139
thickness 139
top 138
type selection 138
vertical 139

Example
3D unorganized data 58
triangulation 57
unorganized volume data 58

Excel Data Loader 643–649
limitations 647
Loadxls add-on 564
spreadsheet data format 643
table data format 644

Excel files
load data from 643–649

Exponential curve fit 119
Exponential Fit option 115
Exponential tick marks 269
Exponentiation

binary operator 296
data operations 297

Exponents
plotting 297

Export
format 473
plots into other applications 473, 488
raster graphics files 473
vector graphics files 473, 477

Exposed cell faces 155
Extended curve fit 116, 124

general 125
Stineman 126

Extract
discrete points 320
iso-surfaces 215
points from geometry 320
points from polyline 320

Extract Data Points dialog 320
Extract FE-Boundary dialog

image 321
Extract Flow Features dialog 350, 393
Extract option 320, 321
Extract Streamtraces dialog 249
Extracting shock surfaces 394
Extrapolation, Richardson 393

F
F1 key (Help) 42

Face skewness
functions in Calculate dialog 701

FDNEUT, see FEA solvers
FE boundary

extract 173
FE data

see Finite-element
FEA Data Loader 649–653
FEA solvers 649–653
FE-line 54
FE-surface 54
FE-volume 54
FIDAP files, see FEA solvers
Field data

loading options 690
Field plots 149

2D 19
3D 19
attributes 150
contour layer 177–194
edge layer 173–175
index skipping 153
mesh layer 171–173
modification 150
points, to plot 153
scatter plot 205–211
shade layer 213–214
surfaces 154
surfaces to plot 154
vector layer 195–203

Field variables 346
FIL, see FEA solvers
File

points, write to 32
write points to (polyline) 33

File format
DEM 638–639
DXF 639–640
EnSight 641–642
Excel 643–649
FEA solvers 649–653
GMV 678
Gridgen 673–674
HDF 674–678
Kiva 678
PLOT3D 679–687
PLT, see Tecplot Data Loader
PLY 687
SDS 674–678
Tecplot 687–696
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File menu 16

Text 660–672
Text Spreadsheet 696–698

File menu 16
Print option 463
Print Preview option 470
Publish option 455
Save Configuration option 539
Save Layout As option 451
Save Layout option 451
Write Data File option 291
Writing Data File option 457

Files
Batch mode printing 509
batch processing layout files 510
BMP 479
Color Map 100, 591
command line file reading 591
configuration 539
data file batch processing 511
equation file loading 304
export format 473
font file 556, 591
formats 448
layout 448
layout file batch processing 510
layout file composition 451
layout package 448
layout package file use 451
macro specifying 591
Motif configuration files 540
movie 515
multiple file printing 509
name extension 303
name extension defaults 544
PNG 481, 487
Raster Metafile (RM) 529, 535
saving via HTTP 452
streamtrace formats 233
stylesheet formats 448
stylesheets 448
Sun Raster 482
Tagged Image File Format (TIFF) 483
writing ASCII 456, 458
writing ASCII in BLOCK format 458
writing ASCII in POINT format 458
writing binary 456, 458

Filled arrowheads 198
Filtered relative helicity

functions in the Calculate dialog 711
Filtered Shock

functions in the Calculate dialog 712
Finite-difference formulae

to calculate gradients 360
Finite-element 52

boundary extraction 322
boundary lines 322
cells 281
connectivity list limitations 55
data connectivity list 54
FE-line 54
FE-surface 54
FE-volume 54
gradient calculations 360
irregular data point triangulation 334
iso-surface zones 219
limitations 55
line description 53
quadrilateral element type 54
spreadsheet data viewer 334
surface description 53
surface triangulated data sets 57
tetrahedron element type 54
triangle element type 54
triangulated data sets 57
volume data 54
volume description 53
volume zone blanking 253
zone boundary extraction 322
zone formats 405
zone probing 405
zone smoothing limitations 306
zones 332

Finite-element data
edge layer 173
FE boundary, extract 173
plotting surfaces 155

Finite-element zones
integrating 361

First-derivative 299
Fit All Frames to Workspace 82
Fit Paper to Workspace 82
Fit Selected Frames to Workspace 82
Fit to Full Size 79, 640
Floating tick marks 269
Flooding

continuous 179, 186, 469, 470
contour layer 179
RGB continuous 101

Flow features 393
Flow variables 356
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functions in Calculate dialog 704
Flow-of-control commands

processing data sets 511
Fluent Data Loader 655–659
Fluent Loader

Loadfluent add-on 564
Fluent Loader Options dialog 659
Fluid Properties

density 341
dynamic viscosity 342
gamma 343
gas constant 343
incompressible 341
specific heat 342

Fluid properties 340
compressible 342

Fluid Properties dialog 340, 372
Fonts

creating 555
file 556
font file specifying 591
quick edit 42
size (scatter layer) 208
user-defined 555

Foreign data formats 633
Frame linking 70

attributes 70
axis ranges, linked 73
between frames 71
within a frame 73

Frame menu 17
Framer 381, 515, 536, 602

animation creation 536
commands 602, 604
Motif version 536, 602
Raster Metafile format 536
Raster Metafile viewing 536
Windows options 605

Frames 61, 65
animation 534
axis ranges, linked 73
background 69
blanking 280
border 68

invisible 77
clipboard, copy plot to 85
coordinate systems 61, 64, 65
copying 82
copying views 82
Create Frame mode 65

cutting 82
delete 65
deleting groups 66
fitting data 79
fitting plots to 61
header

custom 68
show/hide 68

height minimum 717
limitations 65
limits in Tecplot 717
linking

see Frame linking
macro use 498
multiple view copying and pasting 82
name 69
new 32, 65
order 70
Pasting views 82
popping 69
positioning 67
pushing 69
resizing 67
resizing with mouse 67
resizing with Translate/Magnify 80
sizing 67
stack 70
stacking 69
title 69
translate/magnify 80
units 65
view stack 81
width maximum 717
working with 61

Frequency
turbulence functions 375

FTP
reading via 452

Function
selecting for PLOT3D 359

Function reference 699
Functions

data manipulation 297
FX library 393

G
Gamma

fluid property 343
Gas Constant

fluid property 343
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General coefficients

General coefficients
for particles with mass 384
in particle calculations 383

General Text Loader 660–672
GEO files, see EnSight data loader
Geometries

alignment 444
alignment with Quick Edit 444
alignment with Selector 444
circle 32, 436
copying 82
cutting 82
ellipse 32, 436
keyboard shortcuts 614
limits in Tecplot 717
macro linking 444
macro links 501
pasting 82
point extraction 320
polyline 31, 435
popping 438, 442
pushing 438, 442
rectangle 32, 437
shortcuts 614
Sketch plot type creation 435
square 31, 436

Geometry and Boundaries dialog 348, 349, 350, 
351, 361, 701

Geometry dialog 445
Geometry record 457

loading options 690
Geometry tool

shortcuts 614
Global color map 98
GMV, see Kiva Data Loader
Gouraud shade plot types 252
Gouraud shading 252
Gradient calculations

in PLOT3D functions 359
performance considerations 349

Gradients
in finite-element zones 360

Graphics
cache 22

Gravitational constant 383
Gravity

in particle calculations 383
Gray scale 99

macros 500
Grid

axis 264
display 77
snap to 21, 77
spacing 77
units 77
workspace 77

Grid area 277
Grid quality 356
Grid quality functions

scalar, in Calculate dialog 700
vector, in Calculate dialog 704

Gridgen Loader 673–674
add-on 564
Gridgen add-on 564

Gridlines
draw order 265

Group Select dialog 444
Group Zones by Time Step dialog 355
Groups 222

H
H

keyboard shortcut to restrict horizontal 
adjustment 410

HDF Loader 674–678
limitations 675
Loadhdf add-on 564

HDF Loader dialog 674
HDF5 Loader

Loadhdf5 add-on 564
Headers

showing or hiding 68
Height, exported image 382
Helicity

functions in Calculate dialog 711
Help

accessing 42
by pressing F1 42
from the status line 42
Technical Support 43
Tecplot license 17

Help menu 17, 42
Hexahedral

cells 281
Hidden Line mesh plots 172
Hollow arrowheads 198
Horizontal error bars 139
Hot keys 611

contour 30
slice 28
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zoom 617
HTML

creating with Publish 455
HTTP

saving via 452

I
Icon

Windows, with command line options 593
IJK-blanking 281, 285

animation 515, 520
domain 287
Exterior option 287
IJK-ranges 287
Interior option 287

IJK-Blanking dialog 286
IJK-ordered data 48, 49, 162

blanking 253, 281, 285
I,J,K plane plotting 155
line plots 106
plotting planes 156

IJK-ordered zones 285
smoothing limitations 306

IJK-plane
animation 515, 519

IJK-planes
animation 519

IJK-skip 690
IJ-ordered data

blanking 281
line plots 106

IK-ordered data 48
I-lines 52

family 52
Image Geometry Details dialog 441
Image region

exporting Raster files 483
Images

Antialiasing 479, 480, 482, 483, 484, 485, 488, 
490

Include IJK-Blanking option 287
Incompressible

fluid property 341
reference values 346

Incompressible fluid 341
Independent variables

assign with Mapping Style dialog 128
Index offsets

for equations 302
Index range buttons

in Integrate dialog 365
Index ranges

in integrations 364
Indices

cell display 403
equations 302
point display 403

INP, see FEA solvers
Insert menu 16
Integer

constant 301
Integer tick marks 269
Integrate dialog 362
Integration

2D conventions 365
domain 364
streamtraces 246

Integration results
accessing from macros 369
environment variables 369

Integration time step
for particle path calculations 378

INTEGRATION_DRAG
environment variable 369

INTEGRATION_LIFT
environment variable 369

INTEGRATION_SIDE
environment variable 369

INTEGRATION_TOTAL
environment variable 369

INTEGRATION_XFORCE
environment variable 369

INTEGRATION_XMOMENT
environment variable 369

INTEGRATION_YFORCE
environment variable 369

INTEGRATION_YMOMENT
environment variable 369

INTEGRATION_ZFORCE
environment variable 369

INTEGRATION_ZMOMENT
environment variable 369

Interface
default resetting 554
frame 61
grid 77
Help 42
macro running 502
quick edit 35
ruler 77
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Interior option 287

status line 34
workspace 34

Interior option 287
Internal energy

functions in Calculate dialog 707
Interpolate 323

blanking variable 394
Kriging 324, 329
linear 324

Interpolate mode
line plot probing 409
probing 397

Interpolate option 325, 327, 330
Inverse Distance Interpolation dialog 327
Inverse Distance option 327
Inverse-distance algorithm 328
Inverse-distance interpolation 326
I-ordered data

blanking 281
probe limitations 400

I-planes 51
plotting 154

Irregular data 323
Isentropic density ratio

functions in the Calculate dialog 713
Isentropic pressure ratio

functions in the Calculate dialog 713
Isentropic temperature ratio

functions in the Calculate dialog 714
ISO-Latin 1 characters 424
Iso-Surface Details dialog

Definition page 216
Style page 217

Iso-surfaces 215–219
animation 521
contour flooding 217, 218
contour line color 218
contour line thickness 218
contour lines 218
contour type 218
contour variables 215
display 217
extraction 219
FE-surface zones 219
generating 215
groups 215
lighting effect 218
mesh 217
mesh color 217
mesh line thickness 217

shade color 218
shading 218
translucency 218
type 217
variables 215
zone extraction 219
zone, create from 219

J
Jacobian

functions in Calculate dialog 703
JK-ordered data 48
J-lines 52
Journal 89, 95
J-planes 51

plotting 154

K
K files, see FEA solvers
Keyboard

shortcut 611
Keyboard shortcuts 611

3D rotation 28
Contour Add tool 613
contour level tools 30
Contour Remove tool 613
F1 help 42
geometries 614
mouse tool modes 79
plot translation 169
plot zooming 169
restrict horizontal and vertical adjustment 24, 

410
rotate 28, 613
Slice tools 616
slice tools 28
streamtraces 616
Translate/Magnify tool 617
UNIX creation 554
Zoom tool 617

Kinematic viscosity 375
Kinetic Energy

functions in Calculate dialog 708
turbulence functions 375

Kiva Loader 678
K-planes 51

plotting 154
Kriging 329

algorithm 332
interpolation 329
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Kriging dialog 330
Kriging option 330

L
Label Points and Cells 161
Labels

cells 161
contour 189
Custom 270
CUSTOMLABELS Record 270
data points 161
limits in Tecplot 717
on contour levels 189
tick mark label spacing 268, 270
tick mark, axis 268
tick mark, custom 270

Laplacian averaging
in Fluent loader 659

Large Rainbow color map 99
Last Workspace View 82
Latent heat, particle 389
Layers

draw order 162
Layout files

see also Layout package files
 448

batch processing 510
command line reading 591
format 448
saving 451
saving via FTP 452
saving via HTTP 452
saving via URL 452
what they include 451

Layout Package files 448, 451
archiving 451
using 451
viewing with lpkview 451

Least-squares
algorithm 118
standard and weighted regression 117

Left error bars 139
Legends

contour 191
line 113
Line Legend 142
line plots 142
RGB 102
scatter 210

Letter codes

equations 296
Levels, contour 182
License number 17
Lift

calculating 361
Lift fractions 163, 165
Light source 163, 254

3D Light Source dialog 163
background light 255
intensity 255
position 163
surface color contrast 255

Light Source Position control 254
Lighting 20, 252

Gouraud 252
light source 254
optimizations 256
paneled 252
shade layer 213–214
specular highlights 255
translucency 251

Lighting effect 173
iso-surfaces 218
streamribbons 241
streamrods 241
streamtraces 241

Limitations
axis 164
finite-element data 55
frame, number of 65
smoothing 306
Tecplot 717

Limits
3D axis 163, 164

Line Legend dialog 142
Line legends 113, 142
Line pattern

quick edit 41
Line plots 20, 113, 114

animation 524
bar charts 106, 140
blanking 285
IJK-ordered data 106
IJ-ordered data 106
interpolate mode probing 409
least-squares fit 117
legends 142
line color 114
line patterns 114
lines 106
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Line segments 115

log axes 260
Mapping Style dialog 106
point labels 161
polar 20

line layer 20
symbol layer 20

polar line 19
probing 408
quick edit 38
requirements 47
symbol attributes 134
symbols 106
XY line 19

error bar 20
line layer 20
symbols layer 20

XY line plots
bar layer 20

Line segments 115
curve fit 127

Line Segments option 115
Line thickness

editing with Quick Edit 114
specifying 139
XY-plots 114

Line type
Line Segments 115

Linear Fit option 115
Linear interpolation 324
Linear Interpolation dialog 325
Lines

axis 275
contour 188
contour layer 179
domain of integration 364
lift fraction controls 163
line plot color 114
line plots 106
separation and attachment 348, 350, 395
specify thickness 136
streamline color 239

Lines map layer 20
mappings 135

Load on Demand 552
Loadcgns add-on 564
Loaddxf add-on 564
loadensight 564
Loadfluent add-on 564
Loadhdf add-on 564
Loadhdf5 add-on 564

Loading add-ons
$!LoadAddOn command 563

Loadss add-on 564
Loadxls add-on 564
Log axes 260
Log file

see also Data sets, journal
Log scale 260
Logarithms

data operations 297
plotting 297

Logical space 52
LPKView utility 451, 605

example 605
LS-DYNA files, see FEA solvers

M
Mach number

functions in Calculate dialog 708
Macro commands

accessing integration results 369
DISPLAYBOUNDARIES 351
PLOT3D Loader 684
SETGEOMETRYANDBOUNDARIES 351

Macro Recorder dialog 498
Macro Viewer dialog 505

debugging with 502, 504
loading with 504

Macros
animation 515
animation creation 530
batch processing 509
breakpoints 505
color map files 100
command display format 505
computer moving 507
data file reading 498
data operations 498
directory moving 507
duplicating actions 498
editing 499
equations, in 303
file debugging 502, 504
file playback 591
file recording 498
file specifying 591
file viewing 502, 504
frame set up 498
function definitions 499
function file example 503
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function installation 503
geometry linking 444, 501
gray scale 500
ignoring messages 591
interface running 502
layout file reading 498
loading with Macro Viewer 504
looping 498
message ignoring 591
modifying 498
movie creation 530
moving 507
playback 498, 501, 591
playing from the command line 591
Quick Macro Panel running 503
record 498
repetitive actions 498
retaining functions 500
text linking 444, 501
view 498
watch variable specifying 506

Magnification factor 80
Magnify 80
Make Current View Nice option 16, 79
Map layers 19, 106, 142

activate 111
animation 515, 524
axis variables 111, 112
bar charts 20, 140
coefficient extraction 130
curve-weighting variables 129
deactivate 111
defaults 542
Dependent Var 110
dependent variable 127
editing 111
error bar 20
Independent Var 109, 110
independent variable 127
indices 142
line 113
line legends 113
lines 20, 114, 135
Lines map layer 114
name 109
name changes 111
new 107
symbols 20, 114
variables 127
varying index 141

X- and Y-variables 111
X-Axis Num 110
Y-Axis Num 110
zone names 109
zones 111, 113

Mapping Style dialog 106
assign dependent variables 128
assign independent variables 128
clamped spline fits 122, 123
Curves page 115, 118, 119, 120, 121, 122, 123
definition 111
Dependent Variable option 127
error bars 139
Error Bars page 138
Fill color 135
Indices page 106, 141, 142
Line Thck 114
Line thickness 135
Line Type 115
Outline color 135
Symbols page 134

Mass flow rate 372
Mass, particle 387
Mass, particles with 378, 382
Mass, total 371
Maximize Workspace 82
Maximum accuracy

for Richardson extrapolation 391
Maximum value 297
Menu bar 15
Menus

Analyze 17
Animate menu 16
Data 16
Edit 16, 82
File 16
Frame 17
Help 17, 42
Insert 16
Menu Bar 15
Options 17
Plot 16
Tools 17
View 16

Mesh
quick edit 35
structure 52

Mesh layer 19, 171–173
3D overlay 172
definition 171
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Mesh plots

Hidden line 172
iso-surfaces 217
quadrilateral 322
slices, on 227
streamribbons 240
streamrods 240
streamtraces 240
triangular 322
types 172
wire frame 172

Mesh plots
modifying 171

Minimum value 297
Mirror zone 315
Mode

adjust 23
Adjustor tool 413
Create Frame 65
mouse tool shortcuts 79
Probe 31
Probe Nearest Point 402, 412
select 23
snap 21

to grid 21
to paper 21

Snap to Grid 77
Snap to Paper 77
translate 26
Translate/Magnify 80
zoom 25

Modern color map 99
Moments

calculating 361
Momentum

in vector flow 714
Momentum components

in scalar flow 709
Mopup string 467
Motif

command line options 595
configuration files 540
Framer running 602
print setup 466
printing 466

Mouse mode
add slice 28
adjust 23
contour

label 30
level add 30

level delete 30
Create Frame 65
probe 31
resizing frames 67
select 23
streamtrace

add 29
termination line 29

tool shortcuts 79
translate 26, 79
zoom 25, 79

Mouse modes
Add Contour Label tool 189
Adjustor tool 413
Probe 397
shortcuts 611
Translate/Magnify 80

Movies 515
AVI file viewing 535
files 515
Raster Metafile viewing with Framer 536

Multiple color tables 382
Multiplication

binary operator 296

N
Names

variable name display 404, 407
NASTRAN files, see FEA solvers
Nearest N option 328, 331
Nearest Point mode

data set indices 402
probe 397, 411, 412

Nice Fit to Full Size option 16, 79
Nodal 55
Nodal data 55
Nodal Proximity 349
Nodes

labeling 161
Nonplanarity

functions in Calculate dialog 703
Normalized calculations

for PLOT3D functions 357
Normals skewness

functions in Calculate dialog 702
Nusselt number 389

O
Object

adjust 23
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group select 24
move 26
select 23
translate 26
zoom 25

Object Details 21, 413
Object placement 193
Octant option 328, 331
ODB, see FEA solvers
Offsets, for equations 302
One Line per Variable option 404, 407
OP2 files, see FEA solvers
OpenGL

configuration options 543
Operations

coordinate systems 61, 64
cut, copy and paste 61
working with frames 61

Operator precedence 296
Options menu 17
Ordered data

mesh structure 52
plotting planes 156
spreadsheet viewer 334
three-dimensional 49
two-dimensional 48

Ordinal values
ASCII characters 424

Orientation
paper 466
printing 466

Orthogonality
functions in Calculate dialog 702

Orthographic projection 169
zooming 170

OUT files, see FEA solvers
Outline Color 135
Overlay plots 69, 172

P
Page layout 76
PAM-CRASH files, see FEA solvers
Paneled, lighting 252
Paper

background color 76
coordinate systems 64
displaying 76
fill color 76
landscape orientation 76
layout 76

orientation 76, 465
Orientation option 466
Paper Fill Color option 466
portrait orientation 76
setup 465
size 75, 465
snap to 21
zoom 79

Paper Fill Color option 466
Paper setup 74, 464

paper orientation 465
paper size 465

Parametric spline 122
Parent Zone 248
Parentheses ( ) 298
Parsing zone names 356
Particle ablation 389
Particle latent heat 389
Particle Mass Options dialog 382
Particle paths 353, 377

coloring with a variable 379
Particle Paths and Streaklines dialog 377
Particle release frequency

for streakline calculations 380
Particle Reynold’s number 383, 388
Particle temperature 389
Particle termination 389
Particles

in Fluent loader 658
Paste 61

color map from file 100
PATRAN files, see FEA solvers
Pattern length

specifying 114
Pause in Framer 604
Performance

graphic cache 22
plot approximation 22

Period, theta axis 262
Perspective plots

zooming 170
Perturbation velocity

functions in Calculate dialog 714
Pitot pressure

functions in Calculate dialog 706
Pitot pressure ratio

functions in Calculate dialog 706
Placement plane 20
Plain arrowheads 198
Planes
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Plot

domain of integration 364
Plot

center 80
magnify 80
translate 80
zoom 78, 80

Plot approximation 22
Plot layer 19

boundary, see edge
contour 19, 177–194
edge 173–175
mesh 19, 171–173
scatter 19, 205–211

font 208
size 208

shade 19, 213–214
vector 19, 195–203

arrowheads 200
Plot menu 16

Advanced 3D Control option 163
Reference Vector 202
Slices option 221
Vector Arrowheads option 200, 201

Plot results as toggle
in Integrate dialog 368

Plot type 19
2D Cartesian 19, 149
3D Cartesian 19, 149
Polar Line 19, 20, 627
Sketch 19, 419
view stack 81
XY Line 19, 20, 105

PLOT3D
boundary file 679
function reference 699
functions 356

PLOT3D Loader 679–687
auto detect option 681
auxiliary data 686
binary files 682
file combinations 679
instruction syntax 684
limitations 687
Loadplot3d add-on 563
macro language 684
unstructured data files 681

PLY Loader 687
PNG files

creation 481, 487
image creation 481, 487

Point
data, label 161

POINT format 644, 646, 648
writing ASCII 458

Points
extracting 320

Points from Geometry option 320
Points from Polyline option 320
Points to Plot 153
Polar axis 262
Polar line plot

line layer 20
symbol layer 20

Polar plot 19, 20, 627
axis

data, clip to 262
theta mode 262
theta period 262

axis range 262
drawing characteristics 143
range, axis 262

Polyline
add 31
create from zones 316
limits in Tecplot 717
point extraction 320

Polynomial curve-fit 118
Polynomials

algorithms 118
Positioning

anchor 193
PostScript

exporting 477
print format 468
print precision 467

Power cover fit 119
Power curve fit 120
Power curves

fitting 120
Power Fit option 116
Predictor-corrector algorithm

streamtraces 246
Preferences

color 545
size 545

Preplot 607
command line options 607
converting ASCII to binary 688
special character requirements 421

Pressure
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functions in Calculate dialog 705
Pressure coefficient

functions in Calculate dialog 705
Pressure gradient

functions in Calculate dialog 714
Pressure gradient magnitude 394

functions in the Calculate dialog 712
Print

Batch mode printing 509
continuous flood plot limits 719
EPS files 475
Extra Precision option 467
file name specifying 592
mopup strings 467
Motif systems 463, 466
multiple files 509
paper color 76
Paper Fill Color option 466
paper orientation 76, 465, 466
paper setup 74, 465
paper size 75
PostScript print format 468
precision controls 467
precision with PS 467
preview 470
Print Preview option 470
print spoolers 466
PS files 475
spool commands 466
Spooler Cmd option 466
startup strings 467
Tecplot version number 592
translucent plot limits 719
translucent plots 252
UNIX print spoolers 466
UNIX spool commands 466
version number, Tecplot 592

Print dialog 463
Preview option 470

Print files
destination 592
file name specifying 592

Print option 463
Print Preview option 470
Print Render Options dialog 469

Color option 469
Force Extra Sorting for all 3D Frames option 469
Image option 469
Resolution option 470
Vector option 469

Print Setup dialog
Extra Precision option 467

Probe 397
3D volume 401
Adjustor tool editing 412
at index 402
cell center values 407
controls 401
data editing 413
data modification interactively 397
data points 397
data set indices 402
data viewing 403
editing 397
field plot data 403
finite-element zones 405
Interpolate mode 397
I-ordered data limitations 400
line plots 408
line plots with Interpolate 409
Nearest Point mode 397, 411
nearest point mode 402
points 397
precise controls 401
shortcuts 614
spatial coordinates 401
specific locations 401
tool 31
variable values 404
viewing values of all variables 397

Probe At option 401
Probe dialog 397, 400, 403, 404, 407, 408, 410
Probe Interpolate mode 410
Probe mouse mode 31, 397
Probe Nearest Point mode 412
Probe tool 31, 412
Probe/Edit Data dialog 412, 413
Projection

orthographic 169
PS files

printing 475
Publish Options dialog 455

Q
Quadrilateral

cells 281
element type 54
mesh 322

Quick Edit 35, 150
alignment 42
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Quick Macro Panel 503

arrowhead 41
arrows 41
bars 39
color 40
contour 36
edge 38
error bars 39
font 42
geometry alignment 444
line 38
line pattern 41
line thickness 114
line types 115
mesh 35
order 42
scatter 37
Scatter symbols 207
shade 38
symbol 40
symbol attributes 135
symbols 38
text alignment 444
vector 37

Quick Macro Panel 503

R
Radius, particle 387
Random data 323
Range

polar axis 262
Range best float tick marks 269
Range, axis 258
Raster formats 478

export region 476, 478, 479, 480, 481, 482, 483, 
485, 487, 489

file export 473
Raster Metafiles 381

AVI conversions 609
bitmaps 536, 603
Framer viewing 536
interactive creation 529
viewing 535

Raw User-Defined color map 99
Recirculation regions 395
Record type 690
Rectangle

add 32
Rectangular zone

new 33, 311
Redraw 21

automatic 22
Redraw All 21
Reference scatter symbol 209
Reference values 345
Reference Values and Field Variables dialog 347
Reference vector 202
Reference Vector dialog 202
Regression

least-squares methods 117
Relative helicity

functions in the Calculate dialog 711
Relative path 450, 452
Relevant zone 159
Reynold’s number, particle 383, 388
RFL, see FEA solvers
RGB coloring

channel variable range 102
channel variables 101
continuous 101
description 100
legend 102
of streamtraces 239
options 101

RGB Legend 102
Richardson extrapolation 390, 391, 393
Right error bars 139
rmtoavi utility 609
Rotation

3D plots 165
3D view 27
rollerball 27
shortcuts 28, 613
spherical 27
x-axis 27
y-axis 27
z-axis 27

Rotation tool 27
Rounding function 297
R-squared

curve fit 131, 132
RST, see FEA solvers
RTH, see FEA solvers
Rulers

display 77

S
Save Configuration option 539
Save Layout As option 451
Save Layout option 451
Scalar flow variables
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functions in Calculate dialog 704
Scalar grid quality functions

functions in Calculate dialog 700
Scalar variables

integrating 361
Scatter layer 19, 205–211

index skipping 153
legend 210
limit points 153
modification 205
multi-color options 206
quick edit 37
reference symbol 209
size, symbol 208
sizing by variable 209
symbol

font 208
symbol lift fraction controls 163

Scatter Legend dialog 210
Scatter symbols

3D shapes 207
quick edit 207
reference 209

Scatter-sizing variable 296
Scientific Data Set Loader 674–678
SDRC IDEAS Universal, see FEA solvers
SDS Loader 674–678
Second Order option 305
Second-derivative 300
Select All 84
Select Function dialog 359
Select Variables dialog 347
Selector tool 23, 246, 444
Separation bubbles 395
Separation lines 350, 395
SETGEOMETRYANDBOUNDARIES

macro command 351
Shade layer 19, 213–214

iso-surfaces 218
light source 254
lighting, Gouraud 252
lighting, Paneled 252
printing 252
quick edit 38
slices, on 227

Shadowgraph
functions in the Calculate dialog 712

Shared library
loading add-ons 562

Shared variable 302

branching 412
data editing 412

Shift Pseudo-cell centered data 309
Shock

functions in Calculate dialog 711
Shock surfaces, extracting 394
Shortcuts 611

3D Rotate 613
3D rotation 28
contour level 30
Contour tools 613
creating and editing in UNIX 554, 594
geometries 614
Help by pressing F1 42
keyboard 611
mouse tool modes 79
plot translation 169
plot zooming 169
restrict horizontal and vertical adjustment 24, 

410
rotate 28, 613
slice 28
Slicing tool 616
Streamtrace tools 616
streamtraces 616
Translate/Magnify tool 617
Windows icon with command line options 593
Zoom tool 617

Show tabulated results option
in Integrate dialog 368

Side force
calculating 361

Sidebar 17
controls

graphic cache 22
Derived Objects 20
placement plane 20
plot types 19
quick edit 35

alignment 42
arrow 41
arrowhead 41
bars 39
color 40
contour 36
edge 38
error bars 39
font 42
line 38
line pattern 41



747

Sine function 297

mesh 35
order 42
scatter 37
shade 38
symbol 38, 40
vector 37

redraw 21
automatic 22

show/hide 78
snap modes 21

to grid 21
to paper 21

Sine function 297
Size

default size changes 554
Size Preferences dialog 546
Sketch plot type 19, 419

ASCII files 555
ellipses 436
geometries 435
geometry alignment 444
polylines 435
rectangles 437
squares 436
text addition 419
text alignment 444
User-Defined fonts 555

Skewness
functions in Calculate dialog 701

Skip factors 690
Slice 221–231

add 28
arbitrary slice extraction 228
contour, display 224
creation 221
cutting plane, specifying 229
edge, display 228
extraction 228
groups 222
keyboard shortcuts 28
location 222
mesh, display 227
position 222
pre-defined slice extraction 228
shade, display 227
vector, display 226
zone, create from 228

Slice tool 28
shortcuts 616

Small Rainbow color map 99

Smooth
IJK-ordered zones limitations 306

Smoothing
boundary conditions 305
coordinate variables 304
data 304
finite-element zone limitations 306
limitations 306
zone boundaries limitations 306

Snap modes 21
to grid 21
to paper 21

Snap to Grid mode 77
Snap to Paper mode 77
Solution Time Level

streakline particle release option 380
Solution time levels 354
Solution time, current 158
Sorting

controls 163
Sound speed

functions in Calculate dialog 708
Space

logical 52
Spatial coordinates

probing plots 401
Specific heat

fluid property 342
for particles with mass 389
non-constant 343
ratio, see Gamma

Specify Equations 291–??
Specify Equations dialog 292, 294
Specular highlights 255
Speed of sound

functions in Calculate dialog 708
Spline 116, 122

clamped 122, 123
cubic 122

Spooler Cmd option 466
Spreadsheet Loader

limitations 698
Loadss add-on 564

Spreadsheets
data alteration 336
data alteration with Data Format 336
data format 643
data viewer 334

Square
add 31
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Square root
data operations 297
plotting 297

Stagnation density
functions in Calculate dialog 705

Stagnation energy
functions in Calculate dialog 707

Stagnation energy per unit volume
functions in the Calculate dialog 708

Stagnation enthalpy
functions in Calculate dialog 707

Stagnation pressure
functions in Calculate dialog 705

Stagnation pressure coefficient
functions in Calculate dialog 705

Stagnation temperature
functions in Calculate dialog 707

Startup string 467
State Equations

caloric 341
thermal 341

State variables 347
Static zones 158
Status line 34

help 42
Steady-state 354
Step size

translation 80
Stereo Lithography files, see FEA solvers
Stineman curve fit 126
STL files, see FEA solvers
Strand 158
StrandID 159
Streaklines 353, 379
Stream markers 242

creating 243
restricting 243
timing 243

Streamlines 238
volumes 233, 238

Streamribbons 234, 240
contour flooding 241
lighting effect 241
mesh 240
shade color 241
shading 241
translucency 241
width 240

Streamrods 234, 240
contour flooding 241

lighting effect 241
mesh 240
shade color 241
shading 241
translucency 241
width 240

Streamtrace 233–249
add 29
add streamtrace tool 29
animation 515, 528
arrows 239
boundary conditions 248
color 239
contour flooding 241
formats 233
integration 246
lighting effect 241
limits in Tecplot 718
line thickness 239
lines 238
lines in volume streamtraces 233, 238
location 235
markers 242
mesh 240
Multi-Color options 239
no slip 248
paths 238
position 235
predictor-corrector algorithm 246
ribbon 240
rod 240
rod points 240
rod/ribbon width 240
shading 241
step number 247
streamlines 238
streamribbons 240
streamrods 240
style 234
termination line 29, 244
termination line in 3D Cartesian plots 244
timing 241
translucency 241
vector layer 233
volume 234
volume ribbons 234, 240
volume rods 234, 240
zone data type 249

Streamtrace Details dialog 240, 243, 245, 247, 528
Line page 238
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Streamtrace tool

Streamtrace tool
add 29
shortcuts 616
termination line 29

Stretch factor 347
Stretch ratio

functions in Calculate dialog 700
grid quality function 349

Stylesheets 448
format 448
specifying 592

Subscripts
creating 421

Subtraction
binary operator 296

Subzone 318
Sun Raster files

creating 482
image creation 482

Supersample Factor 479, 480, 482, 483, 484, 485, 
488, 490

Superscript
tick marks 269

Superscripts
creating 421

Surface color contrast 255
Surfaces

FE volume data 155
I,J,K- planes 155
plotting 154

Surfaces to plot 154, 172
boundary cell faces 154
exposed cell faces 155
FE volume data 155
I,J,K-planes 51, 155

Sutherland’s Law
functions in Calculate dialog 713

Swirl
functions in Calculate dialog 710

Symbol
font 208
quick edit 40
size 208

Symbol layer 20
quick edit 38
see also Scatter layer

Symbols
attributes 134
custom creation 424
customization 555

for functions 699
line plots 106, 134
Quick Edit 135

Symbols layer 20, 114
Syntax, equation 294

T
Table data format

in Excel Data Loader 644
Tangent function

data operations 297
Technical Support 43

information 43
Tecplot version number printing 592

Tecplot
Add-Ons 561
command line 590
command line options, UNIX 595
Help 42
home directory 591
license information 17
limits 717
starting 14
starting add-ons 561
Technical Support 43

Tecplot Data Loader 687–696
tecplot.cfg 539
tecplot.fnt file 591
tecplot.phy file

configuring location 554
Temperature

functions in Calculate dialog 706
in particle calculations 383

Temperature Time Constant 384, 385
Temperature, particle 389
Temporary Directory 545
tensor 715
Termination lines 244

3D Cartesian plots 244
activating 246
controlling 245
displaying 246

Termination, particle 389
Tetrahedron element type 54
Text

add 31
alignment 444
copying 82
cutting 82
dynamic 426



Index

750

font
quick edit 42

pasting 82
popping 438, 442
pushing 438, 442
quick edit 42
tool 31

Text Details dialog 420
Text Options dialog 445
Text record 457
Text Spreadsheet Loader 696–698

limitations 698
Text strings

subscript creation 421
superscript creation 421

Text tool 419
Theta mode axis option 262
Theta Period 262
Theta Value on Right Circle option 263
Tick marks 265

axis 265
labels 268
labels, custom 270

best float 269
custom 269
direction 268
display options 16, 79
exponential 269
floating 269
Integer 269
label formats 268
label spacing 268, 270
labels 268
labels, custom 270
length 267
minor 268
range best float 269
superscript 269

TIFF files
creating 483
image creation 483

Time
animation 516

Time Animation 516
Time aware

current solution time 158
relevant zone 159
solution time, current 158
static zones 158
strand 158

strandID 159
transient zones 158

Titles
axis 274

Tool Details 21
Toolbar 22

adjustor tool 23
group select 24

circle 32
contour tool

label 30
level 30

create frame 32
ellipse 32
extract points 32
extract points (polyline) 33
polyline 31
probe 31
rectangle 32
rotation 27

rollerball 27
spherical 27
twist 27
x-axis 27
y-axis 27
z-axis 27

selector tool 23
show/hide 78
slice tool 28
square 31
streamtrace tool

add 29
add streamtrace 29
termination line 29

text 31
translate tool 26
zoom tool 25

Tools
Add Contour Label 189
Adjustor 246, 412
Create Frame 65
Probe 31, 412
quick edit 35
Quick Macro Panel 503
Selector 246, 444
shortcuts 611
Text 419
Translate 169
Zoom 169

Tools menu 17



751

Top error bars 138

Top error bars 138
Total mass 371
Trace, current slice 230
Transient zones 158
Translate 80, 169
Translate tool 26, 169
Translate/Magnify 80

shortcuts 617
Translate/Magnify dialog 80
Translucency 251

iso-surfaces 218
limits 719
plot printing 252
shade layer 213–214
streamribbons 241
streamrods 241
streamtraces 241

Triangle element type 54
Triangular mesh 322
Triangulate option 57, 333
Triangulation 333

example 57
Trigonometric functions

plotting 297
Truncate function 297
Turbulent dissipation rate 375
Turbulent frequency 375
Turbulent kinetic energy 375
Turbulent viscosity 375
Two Color color map 99

U
Undo 16

frames 81
Ungridded data 323
Unit normal vectors

grid quality in Calculate dialog 704
Unit normals 364
Unit Solution Time

streakline particle release option 380
Units 339
UNIX

command line options 595
Framer 602
interface default resetting 554
looping outside Tecplot 511
multiple data sets 511
print setup 466
print spoolers 466
printing 466

Spooler Cmd option 466
Tecplot customization 539

Unordered data 323
Unsteady 354
UNV, see FEA solvers
URL

saving via 452
User-Defined color map 99
User-defined data format

in Excel Loader 646
User-Defined fonts

Sketch plot type 555
Utilities

Framer 536, 602
LPKView 451, 605
Preplot 421, 607
rmtoavi 609

V
V

keyboard shortcut to restrict vertical 
adjustment 410

Value-blanking 281
2D field plots 281
3D field plots 281
animation 515

Value-Blanking dialog 282
Variable

axis, assign to 258
calculate on demand 358
deletion 323
dependent 127
independent 127
share 89
vector 196
weighting, curve fit 129

Variable location 55
Variable sharing 628

data editing 412
saving to data files 457

Variables
cell center viewing 407
collapsing lists 693
contour 181
convective 347
coordinate variable smoothing 304
creating new 293, 295
curly braces 295
curve-weighting 129
data operations 294
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dependent and independent 127
equations 294
field 346
for functions 699
letter codes 295
loading by name options 691
location 55
maximum number per data sets 717
name display 404, 407
name length limits in Tecplot 718
name reference 295
selecting for CFD calculation 347
shared 302
specifying Double precision 458
specifying Float precision 458
state variables 347
system macros 506
value viewing 404
values 161

Varying index
mappings 141

Vector
arrowheads 200
components 195, 233
controlling length 201
field 233
length 201
length in 3D 201
quick edit 37
reference vector 202
variable selection 196

Vector Arrowheads dialog 200
Vector dot product

integrating 365
Vector flow variables

functions in Calculate dialog 714
Vector functions

for PLOT3D functions 357
Vector graphics

exporting files 473
Vector grid quality functions

functions in Calculate dialog 704
Vector layer 19, 195–203

3D vectors 201
customization 196
index skipping 153
limit vectors 153
modification 196, 197
streamtraces 233

Vector Length dialog 201

Vector variables
integrating 361

Vectors
lift fraction controls 163
slices, on 226

Velocity
functions in Calculate dialog 714

Velocity components
functions in Calculate dialog 708
in integration 364

Velocity cross vorticity
functions in Calculate dialog 714

Velocity cross vorticity magnitude
functions in Calculate dialog 711

Velocity gradient eigenmodes
vortex core extraction method 394

Velocity gradient tensor
functions in the Calculate dialog 715

Velocity magnitude
functions in Calculate dialog 708

Version number
printing 592

Vertical error bars 139
View

angular orientation 163
center 80
controlling plot view 61
data fit 79
distance 163
Fit All Frames to Workspace 82
Fit Paper to Workspace 82
Fit Selected Frames to Workspace 82
fit to full size, nice

Fit to full size, nice 79
last 81
Last Workspace View 82
light source 163
magnify 25
make current view nice 79
Maximize Workspace 82
orientation 163
plot projections 170
plot translation 170
plot zooming 170
position 163
redraw 21

automatic 22
rotation

rollerball 27
twist 27
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View menu 16

x-axis 27
y-axis 27
z-axis 27

sidebar 78
toolbar 78
translate 26, 79
zoom 25, 79

paper 79
plot 78

View menu 16
3D details 163
3D Rotate option 165
Copy View 82
fit plot to full frame 79
Fit to Full Size option 79, 640
Paste View 82

View stack 81
limits in Tecplot 718

Viscosity
fluid property 342
turbulence functions 375

Volume Grid
importing GRIDGEN files 673

Volume ribbons 234
width 240

Volume rods 234
width 240

Volumes
domain of integration 364

Vortex cores 347, 394
Vortex strength 395
Vorticity

in scalar flow 710
in vector flow 714

Vorticity magnitude
functions in Calculate dialog 710

Vorticity vector
vortex core extraction method 394

W
Wall boundaries 348, 394, 395
Watch variables

specifying 506
Weighting

inverse-distance 324
Width, exported image 382
Wild color map 99
Windows

command line run options 592
command line shortcuts 593

command line start options 592
Copy and Paste options 488
Framer commands 605
looping outside Tecplot 512

Windows Metafile export
in Unix and Windows 477

Wire Frame plots 172
Workspace 34

grid 77
managing 74
regenerating 21
ruler 77
ruler spacing 77

Write
curve details 133
data points 133
points to file 32
points to file (polyline) 33

Write Data File 291
Write Data File Options dialog 457
Write Macro File dialog 498

X
X-Axis Var versus All Other Variables 107
X-Axis Var versus Y-Axis Var for All Zones 107
X-Axis Var versus Y-Axis Var for One Zone 107
XY bars layer

quick edit 39
XY line plots 19, 20, 105

error bar layer 20
line layer 20
map layers 20
Mappings 106
symbols layer 20

XY-axes
log 260

XY-variables
mappings 111

Y
Y-Axis Var versus All Other Variables 107

Z
Zombie zones 694
Zone effect

lighting 252
translucency 251

Zone effects 20
see also Shade layer
lighting 173
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Gouraud 252
light source 254
paneled 252

Zone layers 19
boundary, see edge
contour 19, 177–194
draw order 162
edge 19, 173–175
mesh 19, 171–173
scatter 19, 205–211
shade 19, 213–214
vector 19, 195–203

Zone mirror 315
Zone name

animation 532
Zone size

in integrations 366
Zone Style dialog 150

Contour page 179
Effects page 251
Mesh page 171, 213
Points page 153
Scatter page 205
Surfaces page 154
Vector page 197, 198

Zones
3D volume 285, 401
animation 515, 528

zone name 532
blanking 280
boundary extraction 322
boundary smoothing limitations 306
boundary zone triangulation 333
collapsing 691, 693
data point values 323
definition 62
delete 322
dimension reporting 403
duplicate 315
duplicating full zones 315
effects 20
equations, zone number 301
finite-element 332

boundary extraction 322
volume zone blanking 253

finite-element formats 405
finite-element zone smoothing limitations 306
integration 361, 365
iso-surface zone extraction 219
lighting 20, 253

mappings 111, 113
mirror 315
new 310

1D line 310
circular 33, 312
contour lines, from 193
from polyline 316
iso-surface, from 219
mirror zone 315
one-dimensional zone 310
rectangular 33, 311
slice, from 228
subzone 318

Ordered format 405
relevant (transient) 159
reporting numbers 403
solid flooding 214
static 158
streamtrace zone data types 249
subzone 318
title limits in Tecplot 718
transient 158

static 158
strand 158
strandID 159

type reporting 403
viewing information 405
weighting 324
XY-mappings, assign to 111
zombie 694

Zones, boundary 350
Zoom 80

3D 169
orthographic plots 170
paper zooming 79
perspective plots 170
plot zooming 78
shortcuts 617
tool 25, 169
zooming plots 61

Zoom tool 25, 169
shortcuts 617
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